
		
			[image: Cover1.png]
		

	
		
			ΜΙΛΤΙΑΔΗΣ ΧΑΛΙΚΙΑΣ

			Αναπληρωτής ΚαθηγητήςΑΕΙ Πειραιά ΤΤ

			ΑΛΕΞΑΝΔΡΑ ΜΑΝΩΛΕΣΟΥ

			Msc Biostatistics

			ΠΑΝΑΓΙΩΤΑ ΛΑΛΟΥ

			Phd Mathematics

			Μεθοδολογία Έρευνας και Εισαγωγή στη Στατιστική Ανάλυση Δεδομένων με το IBM SPSS STATISTICS

			[image: ]

			Μεθοδολογία Έρευνας και Εισαγωγή στη Στατιστική Ανάλυση Δεδομένων με το IBM SPSS STATISTICS

			Συγγραφή

			Μιλτιάδης Χαλικιάς

			Αλεξάνδρα Μανωλέσου

			Παναγιώτα Λάλου

			Κριτικός αναγνώστης

			Χρήστος Κίτσος

			Ομότιμος καθηγητής Τεχνολογικού Εκπαιδευτικού Ιδρύματος Αθηνών

			Συντελεστές έκδοσης

			Γλωσσική Επιμέλεια: Μέμα Χαραλάμπους

			Τεχνική Επεξεργασία: Ιωάννης Λιόμας

			ISBN: 978-960-603-123-6

			Copyright © ΣΕΑΒ, 2015

			[image: ]

			Το παρόν έργο αδειοδοτείται υπό τους όρους της άδειας Creative Commons Αναφορά Δημιουργού - Μη Εμπορική Χρήση - Όχι Παράγωγα Έργα 3.0. Για να δείτε ένα αντίγραφο της άδειας αυτής επισκεφτείτε τον ιστότοπο https://creativecommons.org/licenses/by-nc-nd/3.0/gr/

			Σύνδεσμος Ελληνικων Ακαδημαϊκων Βιβλιοθηκών

			Εθνικό Μετσόβιο Πολυτεχνείο

			Ηρώων Πολυτεχνείου 9, 15780 Ζωγράφου

			www.kallipos.gr

			Πίνακας συντομεύσεων-ακρωνύμια

			
				
					
					
				
				
					
							
							ANOVA

						
							
							Analysis of Variance

						
					

					
							
							APA

						
							
							American Psychological Association

						
					

					
							
							FPR

						
							
							False Positive Rate

						
					

					
							
							IBM

						
							
							International Business Machines Corporation

						
					

					
							
							IEEE

						
							
							Institute of Electrical and Electronics Engineers

						
					

					
							
							ISBN

						
							
							International Standard Book Number

						
					

					
							
							MLA

						
							
							Modern Language Association

						
					

					
							
							NPV

						
							
							Negative Predictive Value

						
					

					
							
							OR

						
							
							Odds Ratio

						
					

					
							
							PDF

						
							
							Portable Document Format

						
					

					
							
							PPV

						
							
							Positive Predictive Value

						
					

					
							
							ROC

						
							
							Receiver Operating Characteristic

						
					

					
							
							SPSS

						
							
							Statistical Package for the Social Sciences

						
					

					
							
							TPR

						
							
							True Positive Rate

						
					

					
							
							VIF

						
							
							Variance Inflation Factor

						
					

					
							
							XHTML

						
							
							eXtensible HyperText Markup Language

						
					

					
							
							XML

						
							
							EXtensible Markup Language

						
					

				
			

			Πρόλογος

			Το βιβλίο αυτό χρηματοδοτήθηκε από το πρόγραμμα Κάλλιππος και προορίζεται για φοιτητές ελληνικών ΑΕΙ. Μπορεί να φανεί χρήσιμο, όμως, σε όποιον επιθυμεί να πραγματοποιήσει σωστά μια έρευνα και σε όποιον επιθυμεί να αναλύσει δεδομένα έρευνας με το IBM SPSS STATISTICS.

			Τα πρώτα δύο κεφάλαια προέρχονται από υλικό που είχα χρησιμοποιήσει κατά τη διδασκαλία του μαθήματος «Μεθοδολογία Έρευνας για Διοικητικά Στελέχη» για τα έτη 2013-2014 και 2014-2015 στο τμήμα Διοίκησης Επιχειρήσεων του ΑΕΙ Πειραιά ΤΤ. Τα υπόλοιπα κεφάλαια (3-7) αποτελούν μία εισαγωγή στο στατιστικό πακέτο SPSS που είναι το πιο διαδεδομένο στατιστικό πακέτο στην Ελλάδα.

			Στο σημείο αυτό θα ήθελα να ευχαριστήσω τους αποφοίτους του τμήματος Διοίκησης Επιχειρήσεων Γιάννη Πέρο και Γιάννη Φλουρή για τη συμβολή τους στην παράγραφο των πειραματικών σχεδιασμών και στην παράγραφο των δημοσκοπήσεων αντίστοιχα. Ακόμα θα ήθελα να ευχαριστήσω τις αποφοίτους του μεταπτυχιακού προγράμματος «Διεθνής Διοικητική των Επιχειρήσεων», Ευαγγελία Τριανταφύλλου, Ιωάννα Νταβή και Γεωργία Τσιτμηδέλη για την επισύναψη των ερωτηματολογίων των διπλωματικών τους εργασιών.

			Οποιαδήποτε παρατήρηση για ενδεχόμενα λάθη και παραλείψεις είναι καλοδεχούμενη και θα ληφθεί υπόψη σε μελλοντική επανέκδοση.

			Μ. Χαλικιάς

			Εισαγωγή

			Στόχος του βιβλίου είναι να γίνει χρήσιμο σε αναγνώστες που δεν έχουν ιδιαίτερες γνώσεις στατιστικής ή φιλοσοφίας της επιστήμης. Γι’ αυτό και όπου υπάρχει ανάγκη γίνεται μια θεωρητική αναφορά σε στατιστικούς όρους.

			Στο πρώτο κεφάλαιο επιχειρείται μια σύντομη αναφορά στα είδη της επιστημονικής έρευνας. Για την πληρέστερη κατανόηση του θέματος κρίθηκε απαραίτητο πρώτα να δοθούν κάποια στοιχεία για την επιστημολογία (τη γένεση και την εξέλιξή της). Ακολούθως καθορίζονται οι σκοποί της επιστημονικής έρευνας, διευκρινίζονται οι απλές στατιστικές έννοιες (πληθυσμός, δείγμα, μεταβλητή, κ.ά.), καθώς και τα τεχνικά θέματα της δειγματοληψίας και της μεθοδολογίας καθορισμού μεγέθους δείγματος. Διεξοδικά εξετάζεται τόσο ο τρόπος διεξαγωγής της έρευνας, όσο και τα πλεονεκτήματα και μειονεκτήματα της έρευνας πεδίου, των πειραματικών σχεδιασμών και των μη αντιδραστικών ερευνών.

			Στο δεύτερο κεφάλαιο εξετάζονται τεχνικά ζητήματα της δειγματοληπτικής έρευνας, η οποία θεωρείται ως η πιο διαδεδομένη ερευνητική μέθοδος. Συγκεκριμένα ελέγχεται η εγκυρότητα και η αξιοπιστία ερωτηματολογίου, η παρουσίαση και  ανάλυση αποτελεσμάτων, καθώς και η σύγκριση των ευρημάτων µε άλλες μεθόδους έρευνας. Τέλος καταγράφονται τα πλεονεκτήματα και μειονεκτήματα της δειγματοληπτικής έρευνας.

			Στο τρίτο κεφάλαιο γίνεται λόγος για την καταχώρηση δεδομένων στο IBM SPSS STATISTICS καθώς και για τις βασικές εντολές διαχείρισης των δεδομένων από το SPSS. Αρχικά γίνεται αναφορά στο περιβάλλον του SPSS και συγκεκριμένα στις επιλογές Run the Tutorial, Type in data, Run an existing query, Create new query using Database Wizard και στα φύλα Data View και Variable View. Ακόμα γίνεται αναφορά στην καταχώρηση δεδομένων στο IBM SPSS (χειρόγραφη καταγραφή δεδομένων και μεταφορά δεδομένων από αρχείο Excel), και στην κωδικοποίηση δεδομένων ερωτηματολογίων. Από το μενού Edit View Data αναλύονται οι εντολές Sort Variables, Transpose, Select Cases, Merge Files (ενοποίηση δεδομένων από διαφορετικά αρχεία), Split File (διαχωρισμό των παρατηρήσεων του αρχείου σε μικρότερες εικονικές διαμερίσεις), Weight Cases (στάθμιση σύμφωνα με τις τιμές μιας άλλης μεταβλητής), Restructure (αναδιοργάνωση του αρχείου μετατρέποντας τις μεταβλητές σε παρατηρήσεις και αντίστροφα) Recode (επανακωδικοποίηση εφαρμόζεται για τη δημιουργία νέας μεταβλητής), Compute (δημιουργία νέων μεταβλητών υπό την εφαρμογή μιας μαθηματικής έκφρασης), Replace Missing Values (αντικατάσταση των ελλειπουσών τιμών).

			Στο τέταρτο κεφάλαιο γίνεται αναφορά στον υπολογισμό μέτρων και γραφημάτων με χρήση του στατιστικού πακέτου. Αρχικά περιέχονται βασικές έννοιες και ορισμοί για την περιγραφική στατιστική, τις έννοιες του πληθυσμού και δείγματος και τα είδη των μεταβλητών. Γίνεται αναφορά στον υπολογισμό περιγραφικών στατιστικών στο SPSS μέσω των διαδρομών Descriptive Statistics > Frequencies, Descriptive Statistics > Descriptives, Descriptive Statistics > Explore, Descriptive Statistics > Crosstabs. Παράλληλα εξηγούνται οι στατιστικές έννοιες όπου χρειάζεται.

			Γίνεται αναφορά στην έννοια της συσχέτισης, στους συντελεστές συσχέτισης και στον τρόπο υπολογισμού τους (μέσω της επιλογής Correlate). Γίνεται αναλυτική περιγραφή της εντολής Multiple Response (Analyze > Multiple Response > Define Multiple Response Sets). Τέλος γίνεται αναφορά στα διαγράμματα μέσω του μενού Graphs. Συγκεκριμένα περιγράφονται τα Ραβδογράμματα, τα Γραμμικά, τα Γράφηματα Περιοχής, τα Κυκλικά, Τα Υψηλών-Χαμηλών τιμών (High-Low), τα Θηκογράμματα ή Πλαισίου Απολήξεων, τα Διασποράς και τα Ιστογράμματα.

			Στο πέμπτο κεφάλαιο περιέχονται βασικές έννοιες και ορισμοί του ελέγχου υποθέσεων, γραφικοί έλεγχοι κανονικότητας μέσω των ιστογραμμάτων και των P-P plots. Στατιστικοί έλεγχοι κανονικότητας One-Sample Kolmogorov-Smirnov (K-S) Test και Shapiro-Wilk Τest.

			Στο έκτο κεφάλαιο παρουσιάζονται οι γνωστότεροι παραμετρικοί και μη παραμετρικοί έλεγχοι. Συγκεκριμένα οι έλεγχοι: T-Test για τον έλεγχο Μέσης Τιμής Πληθυσμού, T-test για τον έλεγχο της διαφοράς δύο μέσων από ανεξάρτητα δείγματα, Mann-Whitney U, T-test για τον έλεγχο της διαφοράς δύο μέσων από συσχετιζόμενα δείγματα, Wilcoxon, Means, One-Way ANOVA για ανεξάρτητα δείγματα, Kruskall-Wallis, Two-Way ANOVA για ανεξάρτητα δείγματα, Friedman, Χ2-test, Mc Nemar test.

			Τέλος, στο τελευταίο κεφάλαιο γίνεται εκτενής αναφορά στην απλή και πολλαπλή γραμμική παλινδρόμηση, και περιληπτική αναφορά στη λογιστική παλινδρόμηση. Σε κάθε περίπτωση παρέχονται απλές εφαρμογές και παραδείγματα.

			Συνοψίζοντας θα λέγαμε ότι το βιβλίο συνδυάζει την παρουσίαση μεθόδων έρευνας, με έμφαση στις δειγματοληπτικές έρευνες, με την παρουσίαση σχετικά απλής στατιστικής ανάλυσης δεδομένων στο SPSS. Λόγω του σκοπού του βιβλίου καθώς και της περιορισμένης έκτασής του δεν περιέχονται άλλες μορφές γενικευμένων γραμμικών μοντέλων καθώς και μέθοδοι πολυμεταβλητής στατιστικής ανάλυσης (π.χ. factor, cluster, discriminant) που μπορούν να είναι χρήσιμα εργαλεία σε όλα τα είδη ερευνών. Το κενό αυτό ευελπιστούμε ότι θα καλυφθεί σε μελλοντικό σύγγραμμα.

			Οι συγγραφείς

			Μ. Χαλικιάς, Α. Μανωλέσου, Π. Λάλου

		

	
		
			Κεφάλαιο 1

			Τα είδη έρευνας

			Σύνοψη

			Στο κεφάλαιο αυτό επιχειρείται μια σύντομη αναφορά στα είδη της επιστημονικής έρευνας. Για την πληρέστερη κατανόηση του θέματος κρίθηκε απαραίτητο πρώτα να δοθούν κάποια στοιχεία για την επιστημολογία (τη γένεση και την εξέλιξή της). Ακολούθως καθορίζονται οι σκοποί της επιστημονικής έρευνας, διευκρινίζονται οι απλές στατιστικές έννοιες (πληθυσμός, δείγμα, μεταβλητή κ.ά.), τα τεχνικά θέματα της δειγματοληψίας και η μεθοδολογία καθορισμού μεγέθους δείγματος. Διεξοδικά εξετάζεται τόσο ο τρόπος διεξαγωγής της έρευνας, όσο και τα πλεονεκτήματα και μειονεκτήματα της έρευνας πεδίου, των πειραματικών σχεδιασμών και των μη αντιδραστικών ερευνών. Στις δειγματοληπτικές έρευνες θα προσπαθήσουμε να εμβαθύνουμε περισσότερο στο δεύτερο κεφάλαιο.

			Προαπαιτούμενη γνώση

			Ως προαπαιτούμενη γνώση θεωρείται μόνο η δυνατότητα χρήσης των στατιστικών πινάκων της κανονικής κατανομής και της κατανομής Student για τον καθορισμό μεγέθους δείγματος. Καλύτερη κατανόηση του κεφαλαίου όμως είναι δυνατόν να επιτευχθεί εάν ο αναγνώστης έχει γνωστικό υπόβαθρο επιστημολογίας, προκειμένου να κατανοήσει καλά τα φιλοσοφικά ρεύματα έρευνας ώστε να αντιληφθεί ουσιαστικά και όχι μηχανιστικά τις επιστημονικές μεθόδους που θα κληθεί να εφαρμόσει στη μελλοντική επαγγελματική ενασχόλησή του. Η ικανή εξοικείωσή του επίσης με απλές στατιστικές έννοιες θα του επιτρέψουν να γνωρίσει καλύτερα τον τρόπο υπολογισμού του μεγέθους ενός δείγματος. Σημαντικά και ενδιαφέροντα στοιχεία στα θέματα αυτά μπορεί κάποιος να αναζητήσει στα βιβλία των Στ. Θεοφανίδη, Σ.Θεοφανίδη & Γ.Μπένου, Χ.Φράγγου,  E. Babbie, J. Mason, M. Grawitz, J. W. Creswell , Y. C. Gagnon. (βλ. βιβλιογραφικές αναφορές).

			1.1 Εισαγωγή

			Έχοντας ήδη ορίσει ως επιθυμητή την επαφή με κάποια επιστημολογικά προβλήματα, θα επιχειρήσουμε μια προσέγγιση της γένεσης και της εξέλιξης του γνωστικού φαινομένου, θα αναφερθούμε στον τρόπο με τον οποίο αναπτύχθηκε ιστορικά ο έλεγχος της ορθότητας της γνώσης και ποια είναι τα όρια του κύρους της. Στο επόμενο βήμα, θα εξετάσουμε τις μεθόδους που χρησιμοποιήθηκαν για την επιστημονική τεκμηρίωση της γνώσης στις διάφορες επιστήμες και θα έρθουμε σε μια πρώτη πρώτη γνωριμία με τη μεθοδολογία και τα προβλήματά της.

			Ο καθορισμός των σκοπών της έρευνας θα είναι το άλλο θέμα που θα μας απασχολήσει. Η χρήση της επιστημονικής έρευνας γενικά, αλλά και ειδικότερα στη στατιστική γίνεται πιο εύκολη και αποτελεσματική, εάν κάποιος ξέρει τα αίτια δημιουργίας του φαινομένου που εξετάζει, τί ανάγκες καλύπτει και πως αυτό λειτουργεί σε βάθος. Οι γνώσεις αυτές θα του επιτρέψουν να προσδιορίσει ακριβέστερα τί θέλει να ανακαλύψει, αλλά και να σχεδιάσει ορθότερα την έρευνα που καλείται να διεξάγει, αφού η επιστημονική έρευνα δεν είναι τίποτα παραπάνω από παρατήρηση και ερμηνεία των ορθών στοιχείων που απαιτούνται για να υλοποιηθεί ένα οποιοδήποτε σχέδιο. Για αυτό πρέπει κάθε φορά να συγκεκριμενοποιείται επακριβώς, τί πρόκειται να παρατηρηθεί και να αναλυθεί, το γιατί και το πώς.

			Ο σχεδιασμός έρευνας περιλαμβάνει τις εξής βασικές παραμέτρους.

			
					Βασικοί σκοποί της έρευνας,

					Λογική της έρευνας,

					Μονάδες ανάλυσης (τί ή ποιος) θα μελετηθεί,

					Εναλλακτικοί τρόποι διαχείρισης του χρόνου στην έρευνα (συγχρονικές και διαχρονικές μελέτες).

			

			1.2 Επιστημολογία και φιλοσοφικά ρεύματα

			1.2.1 Εισαγωγή

			Σήμερα είναι γενικά αποδεκτό, ότι η επιστημονική έρευνα στον κάθε τομέα είναι αποτέλεσμα παρατηρήσεων.

			Ποιο όμως είναι το αντικείμενο μιας επιστήμης, πότε πρωτοεμφανίστηκαν, τί ανάγκες κάλυπταν, γιατί λέμε ότι οι επιστήμες γεννήθηκαν στην Ελλάδα, αφού αξιόλογα τεχνικά επιτεύγματα κατά πολύ παλαιότερα υπάρχουν σε πολλές χώρες (Αίγυπτο, Βαβυλωνία κ.λπ.);

			Για τη διαλεύκανση αυτών των ερωτημάτων κρίνεται απαραίτητη μια σύντομη ιστορική αναδρομή στο επιστημονικό φαινόμενο καθώς και στη σχέση του με τη φιλοσοφία. Αφού οριοθετηθεί το ζήτημα σαφώς, θα επιχειρήσουμε μία σύντομη αναφορά των μεθόδων που η επιστημολογία χρησιμοποιεί με έμφαση τη δειγματοληπτική έρευνα, η οποία έχει πολλές εφαρμογές στις επιστήμες διοίκησης και οικονομίας καθώς και στις κοινωνικές επιστήμες.

			Αναμφίβολα θεωρείται πλέον κοινός τόπος ότι ο κόσμος και η κοινωνία είναι ένα γοητευτικό μεν σύστημα, ιδιαίτερα όμως περίπλοκο, αντιφατικό και δυσκολονόητο, στο οποίο συντελούνται άπειρες διεργασίες. Η κατάκτηση της γνώσης, όπως είναι φυσικό, έγινε σταδιακά, μέσα από πολλές πλάνες και λαθεμένες αντιλήψεις. Από όλους αναγνωρίζεται πλέον ότι υπάρχουν πάρα πολλά ζητήματα που τα αγνοούμε ακόμη, και ότι σ’ αυτό το γεγονός οφείλεται και η ποικιλία των φιλοσοφικών και ερευνητικών ρευμάτων στα οποία θα αναφερθούμε πιο κάτω.

			Η επιστήμη είναι το εργαλείο που δημιούργησε ο άνθρωπος στην προσπάθειά του να κατανοήσει συγκεκριμένους τομείς της πραγματικότητας γύρο του, ώστε να προβλέπει γεγονότα που μπορεί να συμβούν, με σκοπό να τα ελέγχει, ή και να τα αλλάζει προς όφελός του, αν είναι εφικτό σε συγκεκριμένους υλικούς τομείς (Θεοδωρίδης 1955). Εύκολα γίνεται αντιληπτό ότι ο σκοπός της είναι συγγενικός με αυτόν της φιλοσοφίας, που όμως έχει στόχο να γνωρίσει και να οργανώσει τον κόσμο στο σύνολό του και όχι μόνο σε επί μέρους ζητήματα. Άμεσα προκύπτουν λοιπόν τα επόμενα ερωτήματα: πότε πρωτοεμφανίζονται η φιλοσοφία και η επιστήμη; ποια η σχέση των δύο αυτών γνωστικών αντικειμένων και ποια τα όριά τους;

			 Η συστηματική εξέταση φιλοσοφικών θεμάτων, δηλαδή η τάση του ανθρώπου να κατακτήσει την «καθολική γνώση» στηριζόμενος στη λογική εμφανίζεται πρώτα ιστορικά. Λίγο αργότερα, όμως, αρχίζει να γίνεται αντιληπτή η δυσκολία του όλου εγχειρήματος, οπότε σταδιακά αρχίζει να αυτονομείται από τη φιλοσοφία η κάθε επιστήμη, ακολουθώντας θα έλεγε κανείς μία παράλληλη πορεία με αυτήν του γνωσιολογικού προβλήματος (που είναι ένα από τα ζητήματα που εξετάζει η φιλοσοφία). Η γνωσιολογία αναπτύχθηκε αργότερα από τα άλλα δύο φιλοσοφικά πεδία (οντολογικό και ηθικό), όπως αποδεικνύεται ιστορικά, αν και είναι, φυσικά, το πιο καθοριστικό, αφού στην περίπτωση που ο άνθρωπος δεν μπορεί να αποκτήσει έγκυρη γνώση, δύσκολα μπορεί να αντιληφθεί κάποιος πώς νομιμοποιείται να συζητάει άλλα φιλοσοφικά θέματα. Από το σημαντικό αυτό πεδίο της γνωσιολογίας αυτονομήθηκε βαθμιαία η επιστημολογία, δηλ. η επιστήμη που μελετά την εξέλιξη των επιστημών, τον τρόπο που αυτές λειτουργούν και τα θεμέλια στα οποία στηρίζουν την ανάπτυξή τους, δηλ. τη μεθοδολογία που ακολουθούν για την τεκμηρίωση των εκάστοτε συγκεκριμένων καταστάσεων που εξετάζουν.

			1.2.2. Βασικές έννοιες

			Η επιστημολογία πραγματεύεται προβλήματα της επιστημονικής γνώσης. Ο όρος «επιστημολογία» δεν είναι αρχαιοελληνικός, όπως θα μπορούσε κάποιος να υποθέσει, αλλά ένας νεολογισμός Ευρωπαίων φιλοσόφων. Ο όρος αποδίδεται ως επιστημολογία ελληνικά, epistemology αγγλικά, epistemologie γαλλικά κ.λπ., αυτολεξεί σημαίνει λόγος περί της επιστήμης, από το αρχαιοελληνικό ρήμα επίσταμαι δηλαδή γνωρίζω και το ουσιαστικό λόγος (Suchting 2006). Η χρήση της λέξης, αν και για ορισμένους ταυτίζεται με αυτήν της γνωσιολογίας, σήμερα γενικά θεωρείται ότι πρέπει να είναι πιο περιορισμένη (Μπιτσάκης, 1987), αφού η γνωσιολογία ασχολείται όχι μόνο με την εξέλιξη των επιστημών, αλλά και με τη φύση της γνώσης αυτής καθαυτής. Απαντά σε ερωτήματα σχετικά με το πώς απέκτησε ο άνθρωπος τη δυνατότητα να σκέπτεται, να μαθαίνει, να γνωρίζει και γενικότερα εξετάζει το θέμα φιλοσοφικά, ενώ η επιστημολογία ερευνά τη γένεση των επιστημών και την εξέλιξή τους, αναδεικνύοντας τα αίτια που καθόρισαν την όποια εξέλιξη (θεωρία - πείραμα - χαρακτήρα των επιστημονικών κρίσεων κ.λπ.) και τη λογική που διέπει κάθε επιστήμη, ανάλογα με τη φύση του αντικειμένου και την κατάταξή τους (φυσικές επιστήμες, μαθηματικά, κοινωνικές επιστήμες κ.λπ.).

			Σε μια προσπάθεια να διακρίνουμε καλύτερα τα όρια φιλοσοφίας και επιστήμης θα μπορούσαμε να πούμε ότι η φιλοσοφία παράγει καθολική γνώση, γενικεύει τα αποτελέσματα των επιστημών καλύπτοντας την ανάγκη του ανθρώπου για οργάνωση, τάξη και ενότητα και μας δίνει μια συνολική εικόνα του κόσμου. Εξετάζει τις δυνατότητες της γνώσης, δημιουργώντας και βαθαίνοντας το γνωστικό επίπεδο, δημιουργεί συστήματα φιλοσοφικά με τα οποία προσπαθεί να ερμηνεύσει τον κόσμο (παράγει δηλαδή ιδεολογία), θέτει ηθικά ζητήματα, που είναι απαραίτητα στην πρακτική ζωή, μας βοηθάει στην ανάπτυξη της κριτικής σκέψης και απαντά στα μεταφυσικά προβλήματα. Βασικό της εργαλείο είναι οι κατηγορίες (η ομαδοποίηση των εννοιών σε κατά το δυνατό μεγαλύτερα σύνολα και η ταξινόμησή τους). Το αντικείμενό της δεν είναι αυστηρά προσδιορισμένο και η μεθοδολογία της ποικίλλει. Ο κάθε καινοτόμος φιλόσοφος κρίνει τα υπάρχοντα φιλοσοφικά συστήματα έχοντας ως στόχο τη δημιουργία μιας νέας κοσμοαντίληψης για την ορθότερη οργάνωση του κόσμου ώστε να ορίσει με περισσότερη επιτυχία τη θέση του ανθρώπου στην κοινωνία.

			Η επιστήμη αντίθετα παράγει γνώσεις σε συγκεκριμένους τομείς, που έχουν αποκτηθεί βάσει συγκεκριμένων μεθόδων και τεχνικών, ανάλογα με το είδος της επιστήμης και είναι γενικά αποδεκτές από τους ειδικούς. Ο κάθε επιστήμονας στηρίζεται στις γνώσεις των προκατόχων του, τις οποίες έχει ως βάση για να εμβαθύνει περισσότερο στα όποια προβλήματα είναι ακόμα αναπάντητα. Στόχος της είναι να αναζητήσει μεθόδους που θα της επιτρέψουν να κατανοήσει τη λειτουργία του συγκεκριμένου τομέα πληρέστερα, ώστε η όποια παρέμβασή της να είναι πιο αποτελεσματική, αφού θα επιτρέπει την πρόβλεψη και τον έλεγχο των μελλοντικών γεγονότων, κατά τη διάρκεια της εφαρμογής της.

			1.2.3. Σκοπός και γένεση των επιστημών

			Ένα πρώτο ζήτημα που τίθεται προς απάντηση είναι ποιες είναι οι απαρχές της επιστήμης και η σχέση της με τη φιλοσοφία, όπως ήδη αναφέρθηκε.

			Η γένεση της προεπιστημονικής γνώσης πραγματοποιήθηκε ιστορικά σε πολύ μακρινούς χρόνους, και κάποια γεγονότα σχετικά με αυτή θα μείνουν για πάντα άγνωστα. Όταν οι ειδικοί π.χ. προσπαθούν να απαντήσουν στο ερώτημα αν τα μαθηματικά ανακαλύφθηκαν ή εφευρέθηκαν, σίγουρα η όποια απάντηση εξαρτάται από την ιδιοσυγκρασία του κάθε επιστήμονα, αφού πλέον ο πρώτος άνθρωπος που σκέφτηκε κάποια θεωρήματα κ.λπ. έχει χαθεί για πάντα. Ακόμα αναμφίβολα όποια αρχαιολογική ανακάλυψη κι αν πραγματοποιηθεί σχετικά με το θέμα, ποτέ δε θα μπορεί κανείς να ισχυριστεί ότι τα ευρήματα αυτά είναι σίγουρα τα παλαιότερα και πολύ περισσότερο δεν θα μπορεί να πετύχει την πλήρη ανασύσταση του όποιου πνευματικού υπόβαθρου των δημιουργών αυτού του επιτεύγματος. Είναι δυνατόν μόνο να γίνουν ορισμένες εικασίες, που ασφαλώς θα στηρίζονται και αυτές με τη σειρά τους σε κάποια κοσμοαντίληψη. Παρόλα αυτά τα δεδομένα που διασώθηκαν, μας επιτρέπουν να σχηματίσουμε μια, έστω μερική, εικόνα για την εμφάνιση του φαινόμενου της γνώσης στον κόσμο.

			 Αναμφίβολα οι πρώτοι άνθρωποι δεν ήταν σε θέση να αντιλαμβάνονται ορθά τις αιτίες των σεισμών ή άλλων φυσικών φαινομένων, ή δεν ήξεραν τις πραγματικές αιτίες που άλλοτε πετύχαιναν και άλλοτε αποτύγχαναν στο κυνήγι τους, ή στο ψήσιμο των αγγείων τους κ.λπ. Ήταν όμως επιτακτική ανάγκη για αυτούς να καταλάβουν τη φύση και τις δυνάμεις της για να μπορέσουν να επιζήσουν πρωταρχικά οι ίδιοι, και αργότερα να βελτιώσουν τη ζωή τους όσο μπορούσαν. Η ανάγκη αυτή γέννησε τα πρώτα σπέρματα της φιλοσοφίας και της επιστήμης. Για να πετύχουν τους σκοπούς αυτούς αναγκάζονταν οι άνθρωποι να παρατηρούν, να σκέφτονται και να κάνουν κάποιες γενικεύσεις που συνήθως κατέληγαν σε κοσμοαντιλήψεις που ενείχαν πολλά στοιχεία μυθοπλασίας, αλλά και κάποια σπέρματα αλήθειας που τους βοηθούσαν να συμβιώνουν και να θέτουν τα προβλήματά τους σε κάποια τάξη. Ταυτόχρονα με τις ίδιες διαδικασίες περίπου δημιουργούσαν τα πρώτα εργαλεία και τις τεχνικές τους για την άμεση ικανοποίηση των πρακτικών αναγκών τους. Η αναζήτηση λοιπόν των πηγών της φιλοσοφίας και των προεπιστημονικών γνώσεων οδηγεί αναμφίβολα στις θρησκευτικές και τις μυθολογικές δοξασίες των διάφορων λαών και στις πρώτες τεχνολογικές τους κατακτήσεις.

			Επόμενο ήταν ότι οι άνθρωποι θα αντιλαμβανόντουσαν κάποια στιγμή ότι οι απαντήσεις τους ήταν ανεπαρκείς και χρειάζονταν είτε συμπλήρωση, είτε αναθεώρηση κ.λπ., έτσι βαθμιαία τα προβλήματα και οι απαντήσεις έπαψαν να είναι απλοϊκά και άρχισε να γίνεται σταδιακά αντιληπτή η πολυπλοκότητα και η πολυμορφία τους. Η στιγμή που κάποιος θα αισθανόταν την ανάγκη τακτοποίησης αυτού του γνωστικού χάους όλο και πλησίαζε. Και αυτό συνέβη όταν ένας σημαντικός θησαυρός γνώσεων είχε πλέον κατακτηθεί και επομένως το βήμα αυτό ήταν δυνατό να πραγματοποιηθεί. Αν ο βαθμός συσσώρευσης κάποιων γνώσεων ήταν απαραίτητος, άλλο τόσο χρειάζονταν και οικονομικές και κοινωνικές συνθήκες που θα ευνοούσαν την ανάπτυξη νέων αντιλήψεων. Ο συνδυασμός αυτών των παραγόντων επιτεύχθηκε στις πόλεις της Ιωνίας στη Μ. Ασία (ανάπτυξη του εμπορίου, ναυτιλίας, άμεση γνωριμία άλλων πολιτισμών και σκέψεων κ.λπ. και ταυτόχρονα ανάπτυξη της πολιτικής σημασίας των δήμων) και κάπως έτσι δημιουργήθηκαν οι συνθήκες που επέτρεψαν στον άνθρωπο να περάσει από τις διάφορες θρησκευτικές αντιλήψεις και τη μυθολογία στη φιλοσοφία σε πρώτο βήμα και λίγο αργότερα από την προεπιστήμη στην επιστήμη. Αυτό που διαφοροποιεί τους Ίωνες φιλοσόφους του ٦ου αι. π.Χ. από τη μέχρι τότε σκέψη είναι ότι οι κοσμοερμηνείες τους στηρίχτηκαν σε φυσικές εξηγήσεις των φαινομένων και ότι βασικό εργαλείο σε αυτή τη διάσταση είχαν τη λογική τους. Ο κόσμος δε δημιουργήθηκε πλέον γι’ αυτούς, όπως τον εξιστορούσε ο Ησίοδος στη Θεογονία, από τους έρωτες της Γης και του Ουρανού, αλλά από το νερό (για τον Θαλή), ή από τον αέρα (για τον Αναξιμένη) κ.λπ.

			 Οι πρώτες θεωρίες των Ιώνων σοφών, αν και απλοϊκές συχνά, ήταν τολμηρές και επιχείρησαν να δώσουν καθολική ερμηνεία του κόσμου, δηλαδή έθεσαν τα θεμέλια της φιλοσοφίας. Οι δυσκολίες που συναντούσαν, όμως, καθώς και τα λογικά κενά που κάποιος μπορούσε να εντοπίσει σ’ αυτές, παρακίνησαν κάποιους άλλους ανθρώπους, για να καλύψουν πληρέστερα κάποιες ανάγκες τους, να στραφούν όχι τόσο στη γενική ερμηνεία του κόσμου, αλλά στη μελέτη συγκεκριμένων φαινομένων, έστω και αν δεν γνώριζαν τη σχέση που αυτά μπορούσαν να έχουν με τον υπόλοιπο κόσμο, έτσι γεννήθηκαν οι επιστήμες. Η προεπιστημονική εφεύρεση ήταν συμπτωματική και όχι συστηματική, περιοριζόταν σε καθαρά ωφελιμιστικό στόχο, χωρίς να ενδιαφέρεται να αναζητήσει ριζικές λύσεις που θα βελτίωναν τα μέχρι στιγμής δεδομένα (Hawkes & Wooley, 1963). Ένα παράδειγμα προεπιστημονικής γνώσης μας δίνει μία επιγραφή που βρέθηκε στη Νινευί, τον 17 αι. π.Χ. και η οποία δίνει συστηματικές οδηγίες για το πώς κάποιος μπορεί να κατασκευάσει φαγεντιανή. Στο κείμενο καταγράφεται λεπτομερώς τί πρέπει να γίνει για να επαναληφθεί με επιτυχία η όποια επιχειρούμενη κατασκευή φαγεντιανής. Από τη μελέτη της επιγραφής προκύπτει ότι οι τεχνικοί της εποχής είχαν κάνει κάποια πειράματα, γεγονός που θεωρείται το πρώτο βήμα προς την επιστήμη. Στο σχετικό κείμενο, όμως, δεν υπάρχει ούτε αιτιολόγηση γιατί πρέπει να ακολουθηθεί αυτή η μέθοδος και όχι άλλη ούτε αναφέρονται ποιες οι όποιες αλλαγές υπέστησαν τα υλικά, στοιχεία που σίγουρα είχαν τη δυνατότητα να παρατηρήσουν μέχρι την παραγωγή του τελικού προϊόντος οι τεχνικοί, οι οποίοι όμως δεν επιχείρησαν τη σχετική καταγραφή. Οι επιστήμες που αναπτύχθηκαν, όμως, στον «αρχαιοελληνικό κόσμο» στηρίζονταν πια σε αυστηρά δομημένο και συνεκτικό σύστημα προτάσεων (θεωρημάτων και πορισμάτων) με βάση ένα σύνολο ορισμών, αποδείξεων, κ.λπ. και θα παρήγαγαν γνώση με γενική αποδοχή π.χ. την ευκλείδεια γεωμετρία.

			1.2.4. Τα πρώτα βήματα της φιλοσοφίας και των επιστημών

			Από όλα τα ζητήματα που τίθενται επί τάπητος από τους φιλοσόφους: μεταφυσικά, ηθικά γνωσιολογικά, το τελευταίο αναδύεται ως το θεμελιώδες, όπως ήδη αναφέρθηκε.

			Ερευνώντας τη φύση της γνώσης, οι πρώτοι φιλόσοφοι εστιάζουν το ενδιαφέρον τους κυρίως στον ορισμό της και όχι τόσο στη μεθοδολογία της. Ο Λεύκιππος και ο Δημόκριτος επιχειρούν να ερμηνεύσουν τα διάφορα φυσικά φαινόμενα που προσεγγίζουν στηριγμένοι σε παρατηρήσεις, δηλαδή στον εμπειρισμό, δυστυχώς όμως το «Περί νου», όπου ο Δημόκριτος αναπτύσσει τις απόψεις του συστηματικά, δεν έχει διασωθεί. Ο Πλάτωνας αναζητά τις απαντήσεις του για τον κόσμο στη νόηση. Κατά τη γνώμη του, οι ιδέες-έννοιες δε βρίσκονται στον αισθητό κόσμο, αλλά είναι αιώνιες, αμετάβλητες και συλλαμβάνονται με το νου. Ο Αριστοτέλης, λίγο αργότερα, δεν διστάζει να έλθει σε αντιπαράθεση με τον Πλάτωνα και να θέσει τα θεμέλια της λογικής (των μεθόδων της νόησης και της εξαγωγής συμπερασμάτων), τα οποία πιστεύει ότι πρέπει να στηρίζονται στη μελέτη του υλικού κόσμου. Λίγο αργότερα οι στωικοί εντοπίζουν τις αδυναμίες των θεωριών των δύο μεγάλων φιλόσοφων της αρχαιότητας και θέτουν τα θεμέλια της σχετικότητας στη γνώση.

			Εντωμεταξύ συντελείται και η μερική αυτονόμηση των επιστημών. Στο βαθμό που η κάθε επιστήμη αποκτά τη δική της μέθοδο και τα δικά της κριτήρια για ανάπτυξη είναι πλέον δυνατό να προχωρήσει μόνη της. Οι πρώτες επιστήμες που θα αυτονομηθούν από τη φιλοσοφία θα είναι τα μαθηματικά, η αστρονομία και η ιατρική (ήδη από τα τέλη του 5αι. π.Χ.).

			Τα μαθηματικά επωφελούνται πρώτα, γιατί μελετούν αρχικά τουλάχιστον γενικές ιδιότητες των σωμάτων, σχήματα, ποσότητες κ.λπ., ιδιότητες που ο άνθρωπος μπορεί να συλλάβει ευκολότερα εξετάζοντας τα αντικείμενα και να εμβαθύνει σε αυτές. Με την πρόοδο π.χ. της χωρομετρίας οι άνθρωποι φθάνουν στη γεωμετρία, κατά την παρατήρηση των άστρων σε συνδυασμό με την παράλληλη μελέτη των μαθηματικών αρχίζει η ανάπτυξη της τριγωνομετρίας κ.λπ. Με τη σειρά της η αστρονομία, μια επιστήμη που δε στηρίζεται στο πείραμα, αλλά στην παρατήρηση των ουράνιων σωμάτων, επωφελούμενη και από την πρόοδο στα μαθηματικά παίρνει ιδιαίτερη ώθηση, αφού είναι απαραίτητη τόσο στη γεωργία, όσο και στη ναυσιπλοΐα. Στην ιατρική, παρά τις ελλιπείς γνώσεις ανατομίας και φυσιολογίας, προφανώς λόγω της αμεσότητας των ζητημάτων, προωθείται επίσης η προσεχτική κλινική ανάλυση σε συνδυασμό με την ιατρική δεοντολογία, που βασίζεται στον ορθολογισμό της εποχής. Τα θεμέλια της ιατρικής επιστήμης δημιουργούνται αυτή την εποχή από τον Ιπποκράτη. Οι άλλες επιστήμες παραμένουν σε όλη την αρχαιότητα συνδεδεμένες με τη φιλοσοφία. Η πειραματική διαδικασία που θα τους έδινε τεράστια ώθηση επρόκειτο να εδραιωθεί βραδύτερα με αργά και κοπιώδη βήματα για να μπορέσει με τον Γαλιλαίο και τον Νεύτωνα να φθάσει στα πρώτα ικανοποιητικά αποτελέσματα.

			Με την καθιέρωση του χριστιανισμού οι γνωσιολογικές θεωρίες επανεξετάζονται, φυσικά, με αποτέλεσμα οι πατέρες της εκκλησίας να υιοθετήσουν όσες απόψεις των Ελλήνων φιλοσόφων δεν έρχονται σε αντίθεση με τον χριστιανισμό. Ούτε ο φιλόσοφος, ούτε ο επιστήμονας, μπορούν να διερευνούν θέματα που έρχονται σε αντίθεση με τις γραφές (έτσι ανοίγει ο δρόμος για διάφορες αλχημικές τάσεις και απόκρυφες φιλοσοφίες που θα αναπτυχθούν στα περιθώρια της χριστιανικής σκέψης).

			Κατά την περίοδο του Μεσαίωνα κυριαρχεί ο σχολαστικισμός που βασίζεται κύρια στις αριστοτελικές απόψεις και έχει ως βασικό χαρακτηριστικό την ταύτιση της φιλοσοφίας με τον χριστιανισμό. Παράλληλα φυσικά συνυπάρχουν διάφορες νεοπλατωνικές αντιλήψεις σε συνδυασμό με τον πυθαγόρειο επιστημονικό προσανατολισμό.

			Κάποια στιγμή όμως οι εμπειρικές διαπιστώσεις επιστημόνων, που στρέφονται στην παρατήρηση και σε στοιχειώδη πειράματα για την απόκτηση γνώσεων φθάνουν στη διατύπωση του πρώτου κριτηρίου οριοθέτησης των σύγχρονων επιστημών: ο υλικός κόσμος είναι προσιτός μέσω των αισθήσεων (Losee, 1993). Είναι γνωστή η θεωρία του Occam [το ξυράφι του Όκαμ - (Occam’s Razor)], σύμφωνα με την οποία η «οικονομία» στην επιστήμη, δηλαδή η γρηγορότερη και αποτελεσματικότερη μέθοδος για την απόκτηση γνώσης των φυσικών φαινομένων είναι η άμεση παρατήρηση. Ο ίδιος, φυσικά πρεσβεύει ότι η έννοια του Θεού δεν μπορεί να γίνει αντικείμενο των φυσικών επιστημών αλλά είναι και πρέπει να μείνει το αναμφισβήτητο έργο της θεολογίας και ότι τις «καθολικές έννοιες» μπορεί να τις αντιλαμβάνεται μόνο ο Θεός και να τις αποκαλύπτει στους πιστούς. Οι επιστήμες οφείλουν να εγκαταλείψουν την αναζήτηση της βαθύτερης ουσίας των πραγμάτων και να προσανατολιστούν στη μελέτη των φυσικών φαινομένων. Με αυτό τον τρόπο, όμως, καθιερώνονται δύο αλήθειες: η επιστημονική και η θεολογική, σε περίπτωση αντιφατικών απόψεων, η εξ αποκαλύψεως άποψη θεωρείται ορθότερη. Καρπός, όμως, της θεωρίας αυτής είναι η οριοθέτηση της ανθρώπινης γνώσης, αναγνωρίζεται η αξιοπιστία των αισθήσεων και είναι δυνατόν πια να θεμελιωθούν βαθμιαία οι φυσικές επιστήμες. Ο επιστήμονας επιτρέπεται τώρα να πιστεύει στις αλήθειες της φύσης και να τις διερευνά ως κάτι υπαρκτό, και όχι ως μια απλή υπόθεση χωρίς φυσική αντιστοιχία.

			Για να υπάρξουν βέβαια ουσιαστικά αποτελέσματα στην έρευνα θα χρειαστεί χρόνος ακόμη. Η πραγματική πρόοδος θα επέλθει από ανακαλύψεις που δημιουργούν διαδοχικά πλήγματα στις αντιλήψεις του Αριστοτέλη, που κυριαρχούν μέχρι την εποχή εκείνη. Από τις πρώτες απόψεις που καταρρίπτονται είναι αυτή σύμφωνα με την οποία ένα σώμα διατηρείται σε κίνηση μόνο με τη δράση μιας συνεχούς εξωτερικής δύναμης. Κατά την αριστοτελική άποψη, ένα βλήμα που κινείται μέσω του αέρα οφείλει τη συνεχή κίνησή του σε δίνες ή δονήσεις που υπάρχουν στο περιβάλλον. Σε περίπτωση απουσίας αυτών δυνάμεων, το σώμα μένει ακίνητο σχεδόν αμέσως. Ο Jean Buridan, ένας Γάλλος ιερέας, όμως, παρατηρεί ότι η κίνηση διατηρείται από μια ιδιότητα του σώματος-βλήματος: την ώθηση. Το βλήμα αποκτά αυτή την ιδιότητα όταν τίθεται σε κίνηση, ο ίδιος θα υποστηρίξει ότι η ώθηση μειώνεται λόγω της αντίστασης του αέρα και της βαρύτητας στην πορεία. Στη συνέχεια ο Κοπέρνικος αποκαλύπτει νέους φυσικούς νόμους και η θεωρία ότι η θέση της γης είναι στο κέντρο του σύμπαντος εγκαταλείπεται οριστικά. Ο Γαλιλαίος συμβάλλει ουσιαστικά στην πρόοδο της μεθοδολογίας με την καθιέρωση της ευρετικής διαδικασίας (ανάλυση για εντοπισμό αιτίων και σύνθεση για την επιβεβαίωση των προτάσεων) στα μαθηματικά. Η φύση αντιμετωπίζεται πλέον ως ένα μηχανικό σύστημα, η φυσική μαθηματικοποιείται και είναι ένα βήμα πια από την καθιέρωση του πειράματος. Η αρτιότητα της επιστημονικής διαδικασίας θα συμπληρωθεί λίγο αργότερα από τον Νεύτωνα με τις παρατηρήσεις του για τη φύση του φωτός. Η αναζήτηση της επιστημονικής αλήθειας έχει βρει το δρόμο της και είναι έτοιμη να αυτονομηθεί πλέον οριστικά από τη φιλοσοφία. Όσο αργά ήταν τα πρώτα βήματα των επιστημών μέχρι τότε, τόσο αυτά επιταχύνονται ευνοούμενα από τις κοινωνικοοικονομικές συνθήκες. Το γεγονός θα αναδείξει φυσικά την αναγκαιότητα απόκτησης και νέων επιστημονικών μεθόδων, που όμως θα βρίσκονται σε στενή συνάφεια πάντοτε με τις γνωσιολογικές και φιλοσοφικές εξελίξεις.

			1.2.5. Ερωτήματα της γνώσης-φιλοσοφικά ρεύματα και μεθοδολογικές προτάσεις

			Απαραίτητο νομίζουμε είναι να δούμε κάπως πιο συγκεκριμένα το γνωσιολογικό ζήτημα, αφού από αυτό όπως ήδη αναφέραμε δημιουργήθηκε η επιστημολογία.

			Αν και το αντικείμενο της γνώσης είχε απασχολήσει ήδη τους αρχαίους Έλληνες και ο Πλάτων την όριζε ως την αληθή δόξα μετά λόγου, δηλαδή ως την πεποίθηση που προέρχεται μεν από τις αισθήσεις, αλλά έχει υποστεί τον απαραίτητο κριτικό έλεγχο της λογικής και έχει βρεθεί αληθής, θα χρειαστούν αρκετοί αιώνες για να θεμελιωθεί η γνωσιολογία ως αυτοτελής και συστηματικός κλάδος της φιλοσοφίας, από τους R. Descartes (1596-1650), J. Locke (1632-1704) και Em. Kant (1724-1804). Ο Descartes είναι ο πρώτος που αντιλαμβάνεται την ανάγκη εξέτασης της μεθόδου που χρησιμοποιούσε μέχρι τότε η γνωσιολογία. Δέχεται το λόγο ως το όργανο για την κατάκτηση της γνώσης. Ακόμα αναγνωρίζει την ύπαρξη αξιωμάτων από τα οποία με αυστηρούς απαγωγικούς συλλογισμούς μπορεί κάποιος να κατακτήσει τη γνώση περαιτέρω. Ο Locke μελετά το ίδιο πρόβλημα, θεωρώντας όμως ως όργανο της γνώσης τις αισθήσεις και μεταθέτοντας το θέμα της έρευνας που μέχρι τότε ήταν η μεταφυσική (δηλαδή η προέλευση του κόσμου και η βαθύτερη ουσία του), στη μελέτη της ανθρώπινης νόησης, δηλαδή στην πραγματικότητα. Λίγο αργότερα ο Kant επιχειρεί να συγκεράσει τις 2 αυτές απόψεις υποστηρίζοντας ότι είναι απαραίτητη η συνεργασία του νου και των αισθήσεων για τη δημιουργία των γνώσεων.

			Εξετάζοντας τα βασικά ερωτήματα που θέτει η μεθοδολογικά οργανωμένη πλέον γνωσιολογία διαπιστώνουμε ότι την απασχολούν:

			
					Το αντικείμενο της γνώσης,

					Η πηγή της γνώσης,

					Το εάν είναι δυνατή η απόκτηση της απόλυτης γνώσης.

			

			Η εφαρμογή της επιστημονικής έρευνας στο σύντομο, σχετικά, χρονικό διάστημα ανάπτυξής της, όπως ήταν φυσικό, στηρίζεται στο πείραμα, ή τον έλεγχο των όποιων παρατηρήσεων των ερευνητών δημιουργώντας μια σειρά κριτήρια για την επαλήθευση των υποθέσεών της.

			Η πιο παλιά χρησιμοποιούμενη μεθοδολογία, στις νεότερες επιστήμες, είναι αυτή του εμπειρισμού που στηρίζεται σε πειράματα που ακολουθούν είτε την παραγωγική είτε την επαγωγική μέθοδο και στην εξ αυτών εξαγωγή συμπερασμάτων. Η σαφήνεια της πειραματικής διαδικασίας βασικά προκύπτει από τη δυνατότητα που μας παρέχουν τα διαδοχικά βήματα αυτής της διαδικασίας να τα παρατηρήσουμε και να τα καταγράψουμε με τις αισθήσεις μας. Αυτή ακριβώς η δυνατότητα της αισθητηριακής παρατήρησης μας επιτρέπει να φθάσουμε στην αξιολόγηση του πειράματος και να αποκτήσουμε κάποια βεβαιότητα για το τί συμβαίνει στον κόσμο. Έχοντας συνείδηση των ορίων του πειράματος και της παρατήρησης οι ειδικοί, που την εφαρμόζουν, προτείνουν και το σχετικό περιορισμό του επιστημονικού αντικειμένου, αφού η όποια επαλήθευση δεν μπορεί να ολοκληρωθεί με λογική αυστηρότητα και ο έλεγχος μπορεί να είναι μόνο ενδεικτικός.

			Ο θετικισμός θεωρεί ότι κάθε αξιόπιστη γνώση βασίζεται στην εμπειρία, πιστεύει, όμως, ότι η διατύπωση γενικών νόμων είναι δυνατή όταν επαληθεύεται με τη μαρτυρία γεγονότων, τα οποία ναι μεν δεν προέρχονται από άμεση παρατήρηση, αλλά αποτελούν έννοιες άλλων γενικών επιστημονικών θεωριών.

			Ο Karl Raimund Popper (1902-1994) προσπάθησε να λύσει το πρόβλημα της επαλήθευσης στηριζόμενος στη θεμελιώδη ασυμμετρία μεταξύ επαλήθευσης και διάψευσης μιας θεωρίας. Ανέδειξε δηλαδή το ότι ως αλήθεια αποδεχόμαστε, γενικά, κάτι που αντιστοιχεί με την πραγματικότητα. Είναι πιο λογικό να συνδυάσουμε δύο πράγματα που μοιάζουν, παρά δύο πράγματα που δεν μοιάζουν· το τραπέζι, π.χ. μπορεί να συνδυαστεί με έννοιες όπως η συνδιάσκεψη, το φαγητό κ.λπ., αλλά όχι με αταίριαστες έννοιες, όπως το φεγγάρι, ο ρουχισμός κ.ά. Ο ίδιος επισημαίνει ότι δεν είναι λογικό να επικροτούμε συσχετισμούς αταίριαστων πραγμάτων. Κατά τη γνώμη του η ορθή επιστημονική θεωρία ξεχωρίζει από τις άλλες ακριβώς επειδή μας προμηθεύει κριτήρια βάσει των οποίων μπορούμε να συλλάβουμε σε ποιες περιπτώσεις δεν είναι δυνατό να εφαρμοστεί μία θεωρία, πότε δηλαδή αυτή διαψεύδεται.

			Ο εμπειρικός ρεαλισμός ένοιωσε επίσης την ανάγκη περιορισμού του επιστημονικού αντικειμένου, καθώς στάθηκε στη διττή φύση των εξεταζόμενων προβλημάτων. Κάποια θέματα, κατά την άποψή του, είναι ατομικά-ιδιωτικά, δηλαδή ο νους για να συλλάβει και να εξετάσει ένα ζήτημα, πρέπει να το έχει ο ίδιος νοιώσει, με την έννοια ότι αν κάποιος δεν πονά, το μυαλό του δεν έχει κάτι να παρατηρήσει και να αντιληφθεί τί είναι ο πόνος. Η επιστήμη σ’ αυτή την περίπτωση δεν έχει συγκεκριμένο πεδίο (δύο άνθρωποι δεν μπορούν να έχουν την ίδια άποψη για τον πόνο, ή την επιθυμία κ.λπ.). Άλλα θέματα είναι δημόσια και ο νους έχει τη δυνατότητα να τα εξετάσει αντικειμενικά (τη φύση, τα αντικείμενα κ.λπ.) γιατί υπάρχουν ανεξάρτητα από αυτόν, και ο καθένας μπορεί να τα εξετάσει και να τα κατανοήσει σύμφωνα με την κοινή λογική.

			Ο κριτικός ρεαλισμός αξιοποιώντας τα επιτεύγματα της επιστήμης επιχειρεί με την αποκάλυψη των δομών των φαινομένων και την κατανόησή τους να συλλάβει κάποιες γενικές αλήθειες. Δεν απαιτείται, κατά τη γνώμη του, άπειρη σειρά επαληθεύσεων, αφού η γνώση των εσωτερικών νομοτελειακών λειτουργιών που καθορίζουν το φαινόμενο αποτελεί και την απόδειξη της ισχύος μιας πρότασης. Γνωρίζουμε, π.χ. ότι ο ήλιος θα ανατείλει αύριο, όχι γιατί έτσι η εμπειρία μας έχει δείξει, αλλά γιατί ξέρουμε πια από τους νόμους του Νεύτωνα την κίνηση του ήλιου και που ακριβώς βρίσκεται αυτός κάθε στιγμή. Θεωρεί δε ότι με τον εντοπισμό των μηχανισμών εξέλιξης των φαινομένων, ανοίγει και η προοπτική περαιτέρω επίδρασης σε αυτά. Οι επικριτές της θεωρίας, όμως, επισημαίνουν ότι και πάλι δεν είναι δυνατή η απόλυτη βεβαιότητα, αφού η αντίληψη των δομών των φαινομένων δεν είναι άμεση, αλλά στηρίζεται σε λογικές ερμηνείες.

			Η φαινομενολογία με ιδρυτή τον Edmund Husserl (1859-1938) επιχειρεί να περιορίσει τα σφάλματα του εμπειρισμού, του θετικισμού κ.λπ. Προσπαθεί να ξεκαθαρίσει το ερευνητικό πεδίο από τα συμπτωματικά και υποκειμενικά στοιχεία της παρατήρησης με στόχο η ουσία του φαινομένου να μείνει ελεύθερη και να γίνει καλύτερα αντιληπτή. Ένα σχετικό παράδειγμα μπορούμε να δούμε στην άποψη του Σεφέρη για τον Κάλβο. Ο Σεφέρης, όπως ο ίδιος αναφέρει, είχε διαβάσει Κάλβο αρκετές φορές, η κρίση του δε γι’αυτόν διέφερε από ανάγνωση σε ανάγνωση, ο Κάλβος τον άφηνε αδιάφορο αρχικά, ενώ μετά από κάποια στιγμή κατέληξε να τον θαυμάζει. Η ταυτότητα της ποιητικής τέχνης του Κάλβου είναι ανεξάρτητη, όμως, από την ψυχική διάθεση του Σεφέρη ή άλλου ποιητή και αυτή ενδιαφέρει την έρευνα που καλείται να αποφύγει την πολυγνωμία και να εντοπίσει την καθαυτό αξία του Κάλβου.

			Διάφορα σύγχρονα ρεύματα της ερμηνευτικής κοινωνιολογίας θεωρούν ότι για τη μελέτη των προβλημάτων του ανθρώπου απαιτείται πιο εξειδικευμένη μεθοδολογία και στρέφουν την προσοχή τους σε εργαλεία μέτρησης κατάλληλα για τη μελέτη της καθημερινής ανθρώπινης πραγματικότητας και πώς αυτή νοηματοδοτείται στην απλή βιωματική εμπειρία. Το γεγονός όμως ότι οι σχετικές έρευνες διενεργούνται σε μικρό αριθμό ατόμων περιορίζει την εγκυρότητα των αποτελεσμάτων και τις όποιες δυνατότητες γενίκευσης.

			Ο σύγχρονος πραγματισμός, τέλος, αναζητά επίσης νέα εργαλεία μέτρησης για να κατανοήσει τις ενέργειες της ανθρώπινης γνώσης σε όλη την πολυπλοκότητά τους (αξιακή, γνωσιολογική και εμπειρική). Σύμφωνα με τους πραγματιστές η «ωφελιμότητα» και η «αλήθεια» δεν είναι πια διαχωρισμένες η μία από την άλλη, αλλά εμφανίζονται ως οι δύο όψεις της αυτής πραγματικότητας.

			1.2.6. Επισημάνσεις συμπεράσματα

			Σήμερα έχοντας διανύσει ένα αρκετά μακρύ διάστημα εφαρμογής σημαντικών επιστημονικών προγραμμάτων μπορούμε να υποστηρίξουμε ότι παρά τις όποιες κριτικές δέχτηκε η φιλοσοφία κατά την ιστορική διαδρομή της είναι σαφές ότι στο σύμπαν τα πάντα βρίσκονται σε κάποια σχέση μεταξύ τους. Ο χωρισμός της φιλοσοφίας από τις επιστήμες κρίθηκε απαραίτητος λόγω των δυσκολιών στην κατάκτηση της γνώσης, ώστε να διευκολυνθεί η μελέτη των διάφορων αντικειμένων. Δεν παύει, όμως, να είναι ένας τεχνητός χωρισμός, η ανάγκη για καθολική γνώση δεν μπορεί να αγνοηθεί. Οι όποιες επιστημονικές πεποιθήσεις, είναι ειδικές και δεν απαντούν σε όλα τα θέματα που θέτει η ανθρώπινη φύση (ηθικά, μεταφυσικά), έτσι αναπόφευκτα δημιουργείται η ανάγκη εντοπισμού, αλλά και ξεπερασμού των ορίων των δύο πεδίων. Φιλοσοφία και επιστήμες είναι ουσιαστικά στενά συνδεδεμένες.

			Πολλές από τις επιστημονικές διενέξεις που προκλήθηκαν η ίδια η πρόοδος της γνώσης είτε τις επιλύει (π.χ. μηχανισμός αισθητηριακών δεδομένων), είτε τις θέτει σε νέα βάση (η θεωρία εξέλιξης του Δαρβίνου κ.ά.).

			Η ιστορική αναδρομή αναδεικνύει ότι η επιστήμη και η φιλοσοφία δεν εξελίσσονται ευθύγραμμα, αλλά αυτό συμβαίνει μόνον όταν οι κοινωνικές και οικονομικές συνθήκες είναι ώριμες και το επιτρέπουν. Πολλά ερωτήματα εξάλλου παραμένουν ανοιχτά γύρω από τη φύση της επιστήμης και σχετικά με το πώς αυτή λειτουργεί. Τέτοια ερωτήματα συνήθως δεν ανακύπτουν κατά τη μελέτη μιας συγκεκριμένης επιστήμης, αλλά τα αντιμετωπίζει η φιλοσοφία, ή οι ίδιοι οι επιστήμονες όταν αισθανθούν την ανάγκη να φιλοσοφήσουν.

			Η απόλυτη αλήθεια δεν είναι δυνατό να επιτευχθεί ούτε από τη φιλοσοφία, ούτε από την επιστήμη, τουλάχιστον με τα σημερινά δεδομένα. Οι επιτυχίες, όμως, των επιστημών δείχνουν πολλές φορές αντιστοιχία γνώσης και αντικειμενικής πραγματικότητας.

			Από πολλούς αναγνωρίζεται η ανάγκη ύπαρξης διαλόγου μεταξύ των διάφορων ερευνητικών μεθόδων ώστε να ανασυγκροτηθεί το νόημα των επιστημονικών όρων προς μία κατεύθυνση ομογενοποίησής τους και να δημιουργηθούν οι προϋποθέσεις για βαθύτερη κατανόηση της επιστημονικής προόδου.

			1.3. Σκοποί επιστημονικής έρευνας

			Κατά τον Earl Babbie (2012) τρεις είναι οι συνηθέστεροι και χρησιμότεροι σκοποί μιας έρευνας η διερεύνηση, η περιγραφή και η ερμηνεία.

			1.3.1 Διερεύνηση

			Η διερευνητική προσέγγιση προκύπτει συνήθως όταν ο ερευνητής εξετάζει ένα νέο αντικείμενο. Η σχετική έρευνα διεξάγεται μέσω συνεντεύξεων, συζητήσεων, χρήσης ομάδων εστίασης ή καθοδηγούμενων συζητήσεων σε μικρές ομάδες κ.ά. Οι παραπάνω τεχνικές χρησιμοποιούνται συχνά σε έρευνες αγοράς. Πολλές φορές ο λόγος διεξαγωγής της έρευνας δεν είναι μόνο η επιθυμία του ερευνητή για την καλύτερη κατανόηση ενός θέματος, αλλά και ο εντοπισμός της ορθής μεθόδου για τη συγκέντρωση των κατάλληλων πληροφοριών για έρευνα. Για παράδειγμα, μπορεί να πραγματοποιηθεί διερευνητική έρευνα προκειμένου να ελεγχθεί η δυνατότητα διεξαγωγής μιας πιο εκτεταμένης μελέτης ή προκειμένου να διαμορφωθούν οι μέθοδοι που θα χρησιμοποιηθούν σε επόμενη μελέτη (ένας ερευνητής, π.χ. πάει σε μία περιοχή που μόλις σταμάτησαν οι εχθροπραξίες για να εξετάσει τις συνθήκες διαβίωσης, τη σύνθεση πληθυσμού, κ.λπ.).

			Συνοψίζοντας θα λέγαμε ότι οι διερευνητικές εμπειρικές μελέτες χρησιμοποιούνται κάθε φορά που ένας ερευνητής αντιμετωπίζει ένα καινούργιο θέμα. Το βασικό μειονέκτημα των διερευνητικών μελετών είναι ότι σπάνια προσφέρουν επιστημονικά τεκμηριωμένες απαντήσεις σε ερευνητικά ερωτήματα, αν και μπορούν να υποδείξουν πιθανές απαντήσεις και μπορούν να χρησιμοποιηθούν ώστε να επιλεγούν οι κατάλληλες ερευνητικές μέθοδοι, που θα ήταν σε θέση να προσφέρουν οριστικές απαντήσεις. Η κυριότερη αιτία που οι διερευνητικές μελέτες είναι σπάνια έγκυρες και αξιόπιστες είναι ότι η δειγματοληψία που χρησιμοποιείται συνήθως είναι ευκαιριακή.

			1.3.2 Περιγραφή

			Συχνά ο ερευνητής αρκείται στην περιγραφή των όσων παρατήρησε. Οι επιστημονικές περιγραφές βασίζονται σε ακριβή δεδομένα και είναι συνήθως πιο ακριβείς και έγκυρες από άλλα είδη ερευνών.

			Παράδειγμα περιγραφικής μελέτης είναι η απογραφή των κατοίκων της Ελλάδας, που πραγματοποιήθηκε από την Ελληνική Στατιστική Αρχή (ΕΛΣΤΑΤ) το 2011. Ξεκίνησε τον Φεβρουάριο και ολοκληρώθηκε τον Μάιο. Είχε ως σκοπό την απογραφή τόσο του πληθυσμού, όσο και των κάθε είδους κτηρίων της χώρας. Όπως σε όλες τις απογραφές εστίασε στην καταγραφή του «μόνιμου» πληθυσμού της Ελλάδας, και όχι του «πραγματικού». Καταχώρισε δηλαδή τους απογραφόμενους στον πίνακα της περιοχής, όπου δήλωσαν ότι ζουν μόνιμα το τελευταίο δωδεκάμηνο, όχι στο σημείο που βρίσκονταν την ημέρα της απογραφής.

			Το μειονέκτημα των περιγραφικών μελετών είναι ότι καταγράφουν και περιγράφουν προβλήματα, αλλά δεν εντοπίζουν, ούτε αναλύουν αιτιακές σχέσεις.

			1.3.3 Ερμηνεία και αναζήτηση αιτιότητας

			Οι ερμηνευτικές μελέτες αναζητούν την αιτία των αποτελεσμάτων. Σε αντίθεση με τα προηγούμενα είδη ερευνών αντικείμενό τους δεν είναι η καταγραφή, αλλά η έγκυρη και τεκμηριωμένη ερμηνεία γεγονότων. Για παράδειγμα, το ποσοστό πωλήσεων δύο αναψυκτικών είναι περιγραφική έρευνα, το γιατί υπερτερούν οι πωλήσεις του Α σε σχέση με αυτές του Β είναι ερμηνευτική.

			Θέματα ερμηνευτικών ερευνών μπορεί να είναι ενδεικτικά: 1) Η αναζήτηση των αιτίων που προκαλούν τις εκδηλώσεις βίας στα σχολεία. 2) Ποιοι είναι οι λόγοι επιτυχίας ενός ροκ συγκροτήματος; 3) Γιατί οι γυναίκες ψηφίζουν άντρες υποψηφίους κατά τις βουλευτικές εκλογές;

			Αιτιότητα

			Στις ερμηνευτικές μελέτες μας ενδιαφέρει να εξετάσουμε την αιτία διάφορων γεγονότων, των οποίων η αιτιακή σχέση εξηγείται είτε με τη νομοθετική εξήγηση (nomothetic explanation) είτε με την ιδιογραφική (idiographic explanation).

			Με τη νομοθετική εξήγηση προσπαθούμε να καταγράψουμε κάποιους από τους παράγοντες (ανεξάρτητες μεταβλητές) που ερμηνεύουν ορισμένες αιτίες ενός φαινομένου. Αντίθετα με το ιδιογραφικό μοντέλο αναζητούμε την πλήρη ερμηνεία των αιτίων ενός φαινομένου.

			Στη νομοθετική εξήγηση η αιτιότητα δεν είναι ούτε πλήρης, ούτε αποκλειστική. Για παράδειγμα, μπορεί να εξετάζεται η αιτία που προκάλεσε μια αρρώστια σε κάποιον ασθενή, π.χ. είναι γνωστό ότι το κάπνισμα συσχετίζεται με τον καρκίνο του πνεύμονα, αυτό δεν σημαίνει, ότι το κάπνισμα είναι η αποκλειστική αιτία της εμφάνισης αυτής της ασθένειας σε κάποιον άνθρωπο ή ότι όποιος καπνίζει θα παρουσιάσει καρκίνο στους πνεύμονες κάποια στιγμή.

			 Παράδειγμα ιδιογραφικής προσέγγισης έχουμε στην ακόλουθη περίπτωση: μια ομάδα ποδοσφαίρου, προκειμένου να αγωνιστεί σε ένα παιχνίδι στο εξωτερικό, μεταφέρεται αυθημερόν με αεροπλάνο στη χώρα διεξαγωγής του αγώνα. Κατά την πτήση, όμως, δημιουργούνται επικίνδυνα καιρικά φαινόμενα με αποτέλεσμα οι επιβάτες να φθάσουν στον προορισμό τους σε πολύ κακή ψυχολογική και σωματική κατάσταση. Η απόδοση της ομάδας στον αγώνα είναι ιδιαίτερα μειωμένη σε σχέση με άλλες φορές και η αιτία γι’ αυτό είναι προφανής και πλήρης ( η προηγηθείσα ταλαιπωρία), έτσι μπορούμε να πούμε ότι προσεγγίσαμε με ακρίβεια την ερμηνεία του αποτελέσματος χρησιμοποιώντας μια ιδιογραφική προσέγγιση. Παρατηρούμε ότι η αιτία προηγείται του αποτελέσματος. Αυτή η σχέση (αιτίας και αποτελέσματος) καλείται αιτιολογική. Ένα ακόμη παράδειγμα στο οποίο ακολουθείται η ίδια χρονική τάξη είναι η οπαδική προτίμηση των παιδιών. Είναι γνωστό ότι η ποδοσφαιρική ομάδα που επιλέγουν τα παιδιά συσχετίζεται με την αντίστοιχη προτίμηση του πατέρα. Προφανώς σε πολύ σπανιότερες περιπτώσεις μπορεί η επιλογή του πατέρα να επηρεαστεί από αυτήν του παιδιού!

			Σε μία αιτιολογική σχέση οι μεταβλητές σχετίζονται είτε ανάλογα είτε αντιστρόφως ανάλογα. Υπάρχει όμως και η περίπτωση η συσχέτιση να είναι απλά στατιστική και όχι αιτιολογική. Παράδειγμα το κάπνισμα εκτός από τον καρκίνο του πνεύμονα συνδέεται με κιτρινισμό των δοντιών από τη νικοτίνη. Εύκολα θα μπορεί να διαπιστώσει κάποιος στατιστική συσχέτιση του κιτρινισμού των δοντιών με τον καρκίνο του πνεύμονα. Η συσχέτιση αυτή όμως δεν είναι αιτιολογική κα ως εκ τούτου δεν είναι ενδιαφέρουσα επιστημονικά και συνήθως παραλείπεται.

			Συχνά προκύπτουν σφάλματα λόγω παρανόησης της αιτιότητας. Σύμφωνα με τη νομοθετική προσέγγιση «οι εξαιρέσεις δεν επιβεβαιώνουν τον κανόνα», για παράδειγμα, είναι γνωστό ότι οι μεγαλύτεροι ηλικίας άνθρωποι είναι πιο συχνά θρησκευόμενοι από τους νεότερους. Αυτό, όμως, δεν σημαίνει ότι δεν υπάρχουν άθεοι μεγάλης ηλικίας ή θρησκευόμενοι νέοι κ.λπ. Εάν χρησιμοποιηθεί ιδιογραφική εξήγηση σε αυτή την περίπτωση, η έρευνα δεν θα δώσει σωστά αποτελέσματα, αφού η αιτιότητα δεν είναι πλήρης. Ένα αντιπαράδειγμα πλήρους αιτιότητας είναι και το κάπνισμα, το οποίο, ως γνωστό, είναι αιτία καρκίνου του πνεύμονα, προφανώς όμως δεν είναι η μοναδική αιτία (πολλοί ασθενείς μπορεί να έχουν αυτή την πάθηση χωρίς να είναι καπνιστές!). Η συσχέτιση επίσης κάποιες φορές ισχύει στη μειοψηφία των περιπτώσεων! Κάποιος νέος οδηγός είναι πιθανότερο, π.χ. μέσα στο χρονικό διάστημα ενός μηνός να προκαλέσει ατύχημα παραβιάζοντας τον ΚΟΚ, από ένα πιο έμπειρο οδηγό, αυτό δεν σημαίνει όμως ότι η πλειοψηφία των νέων οδηγών υποπίπτει σε αντίστοιχες παραβάσεις.

			Συνθήκες εξαγωγής αποτελέσματος

			Αναγκαία καλούμε τη συνθήκη που πρέπει να υπάρχει απαραίτητα για να προκύψει ένα συγκεκριμένο αποτέλεσμα. Είναι, για παράδειγμα, αναγκαίο να παρακολουθήσει κάποιος μαθήματα αγγλικής γλώσσας για να μπορέσει να αποκτήσει έστω το πρώτο δίπλωμα. Η παρακολούθηση, όμως, απλά σχετικών μαθημάτων δεν αρκεί για την επίτευξη του σκοπού αυτού (χρειάζεται η επιτυχία σε κάποιες εξετάσεις κ.λπ). Ικανή αποκαλούμε μια συνθήκη όταν αυτή υποχρεωτικά μας οδηγεί στο επιθυμητό αποτέλεσμα, π.χ. για να στεφθεί πρωταθλήτρια μία ομάδα στο ποδόσφαιρο πρέπει να συμμετέχει στο σχετικό πρωτάθλημα (αναγκαία συνθήκη) αλλά και να συγκεντρώσει στο τέλος της χρονιάς τη μεγαλύτερη βαθμολογία από τις υπόλοιπες ομάδες (ικανή συνθήκη).

			Μια συνθήκη που θεωρείται ταυτόχρονα αναγκαία και ικανή αποτελεί φυσικά πολύ σημαντικό εύρημα σε μια έρευνα, όμως, σπάνια αυτό εντοπίζεται σε κοινωνικές έρευνες (αντίθετα συχνά απαντάται στα μαθηματικά και γενικότερα στις θετικές επιστήμες).

			1.4 Η Λογική της έρευνας (Παραγωγική - Επαγωγική)

			Οι δύο ερευνητικές προσεγγίσεις που αναδεικνύουν τη λογική μιας μελέτης και από τις οποίες ο ειδικός καλείται να επιλέξει είναι η παραγωγική και η επαγωγική (Κυριαζόπουλος & Σαμαντά, 2011).

			Ειδικότερα, η παραγωγική ερευνητική προσέγγιση δίνει τη δυνατότητα για μετάβαση από το «γενικό» στο «ειδικό», ενώ η επαγωγική ακολουθεί την αντίθετη κατεύθυνση, από το «ειδικό» προς το «γενικό». Στην πράξη αυτό σημαίνει ότι στις έρευνες που εφαρμόζεται η παραγωγική λογική αρχικά εξετάζεται η υπάρχουσα θεωρία και με βάση αυτήν αναπτύσσονται συγκεκριμένες ερευνητικές υποθέσεις προς έλεγχο. Ενώ στις επαγωγικές έρευνες γίνεται προσπάθεια τα εμπειρικά στοιχεία να ενταχθούν στα πλαίσια κάποιας θεωρίας.

			Παράδειγμα: έστω ότι θέλουμε να ερευνήσουμε αν ένα φροντιστήριο είναι καλό για την προετοιμασία μαθητών στις πανελλήνιες εξετάσεις. Χρησιμοποιούμε παραγωγική προσέγγιση, αν επιχειρήσουμε να διαπιστώσουμε ότι λειτουργεί με ολιγομελή τμήματα, με έμπειρους καθηγητές, αν υπάρχει κεντρικός συντονισμός, αν διεξάγονται διαγωνίσματα κ.λπ., και ανάλογα να προβλέψουμε το επίπεδο εκπαίδευσης που προσφέρεται και κατά συνέπεια την ποιότητά του. Επαγωγική προσέγγιση εφαρμόζουμε εάν εξετάσουμε τις επιδόσεις μαθητών που πηγαίνουν σε διάφορα φροντιστήρια, και στηριζόμενοι σε αυτό το στοιχείο καταλήξουμε στο συμπέρασμα ότι κάποιο φροντιστήριο είναι καλύτερο από άλλο αφού οι μαθητές που φοίτησαν σε αυτό πέτυχαν καλύτερες επιδόσεις στις εξετάσεις κ.ο.κ.

			1.5 Μονάδες Ανάλυσης

			Παρά το γεγονός ότι συνήθως είναι εύκολα αναγνωρίσιμη η μονάδα ανάλυσης, δηλαδή η μονάδα (συνήθως κάποιο άτομο) που δίνει την πληροφορία, υπάρχουν περιπτώσεις που αυτή δεν είναι εύκολα αναγνωρίσιμη και καμιά φορά προκύπτουν λάθη λόγω επιλογής εσφαλμένης μονάδας ανάλυσης. Εκτός από άτομα σε μια εμπειρική έρευνα μονάδες ανάλυσης μπορεί να είναι ομάδες (νοικοκυριά, κόμματα), οργανώσεις (επιχειρήσεις, νοσοκομεία), ανθρώπινα δημιουργήματα (βιβλία, πίνακες ζωγραφικής, τραγούδια, κ.λπ.). Παράδειγμα στην έρευνα για το επίπεδο φτώχειας ενός πληθυσμού έχει αποδειχτεί ότι «ένα νοικοκυριό» είναι καλύτερη μονάδα ανάλυσης από τυχόν εξέταση μεμονωμένων ατόμων.

			Η ανεπιτυχής επιλογή μονάδων ανάλυσης καλείται οικολογικό σφάλμα (ecological fallacy) και συνεπάγεται φυσικά και λανθασμένα συμπεράσματα. Για παράδειγμα, ας εξετάσουμε την περίπτωση συμμετοχής της Ελλάδας στο διαγωνισμό της Eurovision με ένα ελληνόφωνο τραγούδι!. Ας θεωρήσουμε ότι θέλοντας να τεκμηριώσουμε την άποψη ότι η ελληνόφωνη μουσική έχει μεγαλύτερη απήχηση στους δυτικοευρωπαίους σε σχέση με τους ανατολικοευρωπαίους βλέπουμε τις βαθμολογίες που έδωσαν οι χώρες της ανατολικής Ευρώπης (Ρωσία, Πολωνία, κ.λπ) και οι χώρες της δυτικής (Αγγλία, Γερμανία, κ.λπ). Στην Αγγλία, Γαλλία, Γερμανία ζει όμως μεγάλος αριθμός Ελλήνων μεταναστών και φοιτητών οι οποίοι υποστήριξαν το τραγούδι. Έτσι το καλό αποτέλεσμα σε αυτές τις χώρες δεν οφείλεται στις προτιμήσεις του ιθαγενούς πληθυσμού. Το λάθος σ’αυτή την περίπτωση προήλθε γιατί μονάδα ανάλυσης έπρεπε να είναι ο ψηφοφόρος και όχι οι χώρες που συμμετείχαν (έτσι ώστε να λαμβάνεται υπόψη η ιθαγένεια του ψηφοφόρου και όχι ο τόπος διαμονής του).

			Ο αναγωγισμός (reductionism) είναι μία μέθοδος που βοήθησε ιδιαίτερα την ανάπτυξη των επιστημών ( η προσέγγιση ενός θέματος μέσω της κατανόησης των μερών που το απαρτίζουν), αλλά όπως και άλλες μέθοδοι έχει συγκεκριμένα όρια απόδοσης, τα οποία όταν τα ξεπερνάμε, λέμε ότι διαπράττουμε αναγωγικό σφάλμα, το οποίο είναι σύνηθες όταν χρησιμοποιούνται ακατάλληλες μονάδες ανάλυσης. Σ’ αυτή την περίπτωση επιχειρούμε να εξαγάγουμε κάποιο αποτέλεσμα ερμηνεύοντάς το βάσει ενός παράγοντα, που τον θεωρούμε ως πιο σημαντικό, χωρίς να υπολογίζουμε ότι η πολυπλοκότητα του φαινομένου απαιτεί άλλη προσέγγιση.

			Αναγωγικό σφάλμα, π.χ. διαπράττουμε όταν αναλύοντας τη μακροβιότητα των κατοίκων μιας περιοχής της Κρήτης θεωρούμε ότι αυτή οφείλεται στη μεσογειακή διατροφή. Στην περίπτωση αυτή το συμπέρασμα μπορεί να είναι σωστό, εν μέρει, αλλά η ερμηνεία είναι ελλιπής: έχουμε απομονώσει έναν μόνο παράγοντα, γιατί η μακροβιότητα μπορεί να οφείλεται και σε πάρα πολλούς άλλους λόγους, όπως άθληση, καλή ιατρική περίθαλψη, έλλειψη άγχους, περιβαλλοντολογικές συνθήκες κ.ά.

			Άλλο παράδειγμα έχουμε αν προβλέψουμε ότι η Ρεάλ Μαδρίτης θα γίνει πρωταθλήτρια Ευρώπης την επόμενη χρονιά, απλά επειδή είναι η ομάδα με το μεγαλύτερο προϋπολογισμό στην Ευρώπη.

			1.6 Η χρονική διάσταση των ερευνών

			Σημαντικός παράγοντας στη διεξαγωγή μιας έρευνας είναι ο χρόνος. Όπως είδαμε και στη νομοθετική εξήγηση η χρονική αλληλουχία των γεγονότων και των καταστάσεων καθορίζει αιτίες και αποτελέσματα. Οι ερευνητές διαχωρίζουν το σχεδιασμό της έρευνάς τους σε συγχρονικές και διαχρονικές μελέτες.

			Συγχρονική είναι μια μελέτη που βασίζεται σε παρατηρήσεις που αντιπροσωπεύουν ένα συγκεκριμένο σημείο στο χρόνο και αφορούν σε μια συγκεκριμένη κατηγορία πληθυσμού. Παραδείγματα είναι όλες οι δημοσκοπήσεις που αφορούν στην πρόθεση ψήφου των κατοίκων μιας χώρας. Ακόμα συγχρονική μελέτη έχουμε όταν ένας ερευνητής θέλει να καταγράψει την αποδοχή ενός προϊόντος σε ένα πληθυσμό σε μια δεδομένη χρονική στιγμή κ.ο.κ.

			Οι διαχρονικές μελέτες περιλαμβάνουν δεδομένα που αντλήθηκαν σε διαφορετικά χρονικά διαστήματα. Τις διαχρονικές έρευνες τις χωρίζουμε σε τρεις κατηγορίες.

			
					Η μελέτη τάσης (trend study): καταγράφει ένα δεδομένο χαρακτηριστικό κάποιου πληθυσμού σε διάφορες χρονικές περιόδους. Παράδειγμα τέτοιας μελέτης είναι η μελέτη του ποσοστού των αναλφάβητων στην Ελλάδα το 1920, 1940, 1960 και 1980.

					Η μελέτη κοόρτης (cohort study) παρατηρεί τις μεταβολές αντιλήψεων, συνηθειών, κ.λπ σε ένα συγκεκριμένο υποπληθυσμό, σε διάφορες χρονικές στιγμές. Παράδειγμα είναι η μελέτη της γνώμης των γεννηθέντων το 1950 ως προς το πολιτικό σύστημα της χώρας τους (συνήθως σε τέτοιες έρευνες μελετάται αν αλλάζει ο προσανατολισμός των ψηφοφόρων ανάλογα με την ηλικία, αν είναι αριστερός, δεξιός, κ.λπ). Έτσι μπορούμε να μετράμε τον πολιτικό προσανατολισμό των γεννηθέντων το 1950 ανά δεκαετία μετά το 1970.

					Η μελέτη πάνελ (panel study) αντλεί τα δεδομένα της από το ίδιο σύνολο ατόμων ανά τακτά χρονικά διαστήματα. Για παράδειγμα, μελετάμε τη γνώμη για τη θρησκεία των ίδιων ατόμων ανά δεκαπέντε χρόνια. Είναι σαφές ότι τα πιο τεκμηριωμένα αποτελέσματα θα τα εξάγουμε από μελέτες πάνελ. Όμως το σύνολο των ερωτηθέντων (πάνελ) είναι δύσκολο να διατηρηθεί το ίδιο με την πάροδο του χρόνου. Συγκεκριμένα οι συνηθέστερες απώλειες προέρχονται από την άρνηση των συμμετεχόντων να συνεχίσουν την έρευνα, καμιά φορά όμως, οφείλονται στη φυσική απώλεια των μονάδων ανάλυσης, ή αλλαγή τόπου κατοικίας τους, κ.λπ.

			

			Οι ερευνητές μπορούν να εξαγάγουν κατά προσέγγιση συμπεράσματα για διαχρονικές διαδικασίες, ακόμα και όταν έχουν στη διάθεσή τους μόνο συγχρονικά δεδομένα. Πιο συγκεκριμένα υπονοούν διαδικασίες που εξελίσσονται με τη πάροδο του χρόνου, εξάγουν λογικά συμπεράσματα και ζητούν από τα άτομα να ανακαλέσουν παλαιότερες συμπεριφορές. Αυτές οι μελέτες μπορεί να χαρακτηριστούν ως «κατά προσέγγιση» διαχρονικές.

			1.7 Δειγματοληψία

			1.7.1 Βασικές έννοιες

			Σε σύγχρονες έρευνες συχνά χρησιμοποιούνται μετρήσεις αντιπροσωπευτικές του πληθυσμού.

			Ειδικά στις περιπτώσεις ερευνών όπου οι μονάδες ανάλυσης είναι άνθρωποι η απογραφή ή η μέτρηση των σχετικών παραμέτρων σε όλα τα άτομα του υπό μελέτη συνόλου (πληθυσμού), εφόσον αυτός είναι μεγάλος είναι κατά κανόνα αδύνατη ή πολύ δαπανηρή.

			Καταλήγουμε λοιπόν στη λήψη αντιπροσωπευτικού δείγματος, το οποίο αν επιλεγεί σωστά, σύμφωνα με τους κανόνες της δειγματοληψίας, μπορεί να χρησιμοποιηθεί για να γίνουν αναφορές στον πληθυσμό. Το θέμα γενικά είναι αρκετά σημαντικό. Οι μέθοδοι που ακολουθούνται ποικίλλουν ανάλογα με τα χαρακτηριστικά, την κατανομή του πληθυσμού και το μέγεθος του δείγματος.

			Μία από τις πρώτες εφαρμογές της δειγματοληψίας έγινε το 1786 από τον Pierre Simon Laplace, o oποίος υπολόγισε τον πληθυσμό της Γαλλίας βάσει ενός δείγματος, καθώς και τις πιθανολογικές εκτιμήσεις τυχόν λάθους. Αξίζει να αναφερθεί μία από τις πρώτες δημοσκοπήσεις για την πρόθεση ψήφου σε εκλογές, η οποία πραγματοποιήθηκε στις ΗΠΑ το 1936, και κατέληξε σε λάθος συμπέρασμα (2.400.000 ψηφοφόροι συμμετείχαν σε αυτή). Τα αποτελέσματα της έρευνας έδειξαν τότε μεγάλο προβάδισμα του ρεπουμπλικάνου υποψηφίου Alf Landon, αλλά μετά τη διεξαγωγή των εκλογών πρόεδρος των ΗΠΑ διαπιστώθηκε ότι εξελέγη με πολύ άνετη νίκη ο δημοκρατικός υποψήφιος Franklin Roosevelt (τα ποσοστά ήταν 60,7% έναντι 39,3%). Το λάθος αυτό οφείλεται στο ότι η έρευνα πραγματοποιήθηκε τηλεφωνικά, αν και η χρήση του συγκεκριμένου μέσου επικοινωνίας δεν ήταν ευρέως διαδεδομένη την εποχή αυτή. Κατά συνέπεια έλαβαν μέρος στη δημοσκόπηση σχετικά ευκατάστατοι ψηφοφόροι, οι οποίοι προτιμούσαν τον ρεπουμπλικάνο υποψήφιο, η μεγάλη πλειοψηφία των πολιτών, όμως, που είχε χαμηλά εισοδήματα ψήφισε τον Roosevelt.

			Από τη εποχή που στην στατιστική ανάλυση δεδομένων άρχισαν να χρησιμοποιούνται ηλεκτρονικοί υπολογιστές η δειγματοληψία αποτελεί απαραίτητο εργαλείο για ερευνητές όλων των επιστημών.

			Διάσημα εγχειρίδια δειγματοληψίας έχουν γράψει οι Snedecor και Cochran (1956), Seber (1973), Begon (1979), Krebs (1999), Govindarajulu (1999) κ.ά. (βλ. βιβλιογραφικές αναφορές).

			Ακολούθως θα ασχοληθούμε με τον καθορισμό του μεγέθους του δείγματος και με τα κυριότερα είδη δειγματοληψίας.

			Στατιστικός πληθυσμός

			Στατιστικός πληθυσμός ονομάζεται το σύνολο των μονάδων ανάλυσης, π.χ. άνθρωποι, ζώα, επιχειρήσεις κ.λπ., οι οποίες μελετώνται κατά την πραγματοποίηση της έρευνας. Το πλήθος των μονάδων ανάλυσης του δείγματος συμβολίζεται με n, ενώ του πληθυσμού με Ν. Ο πληθυσμός διακρίνεται σε άπειρο και πεπερασμένο ανάλογα με τη φύση της έρευνας.

			Ο καθορισμός του πληθυσμού δεν είναι πάντοτε σαφής. Αν θέλουμε, π.χ. να συλλέξουμε δεδομένα εισοδήματος για την οικονομική κατάσταση φοιτητών ΑΕΙ και η έρευνα διεξάγεται στον χώρο του πανεπιστημίου επιδιώκουμε σ’ αυτήν τη συμμετοχή ενεργών φοιτητών. Αν θέλουμε να μελετήσουμε δημογραφικά χαρακτηριστικά μακροχρόνια ανέργων, τότε πρέπει πρώτα από όλα να εξειδικεύσουμε τον όρο «μακροχρόνια άνεργος», εφόσον η χρήση του όρου σε αυτήν την περίπτωση ποικίλλει ανάλογα με τον πληθυσμό στον οποίο αναφέρεται. Ανάλογα, λοιπόν, με το σκοπό της έρευνας από τις μονάδες ανάλυσης του πληθυσμού, μέσω ενός δείγματος, επιλέγονται οι κατάλληλες προς μελέτη. Η όλη διαδικασία ονομάζεται δειγματοληψία. Για να επιλεγούν ορθά οι μονάδες ανάλυσης του δείγματος απαραίτητο είναι να κατανοηθεί η έννοια της μεταβλητής.

			Μεταβλητές

			Ο όρος μεταβλητή χρησιμοποιείται όταν θέλουμε να αποδώσουμε κάποιο χαρακτηριστικό ή ιδιότητα σε ένα πρόσωπο, αντικείμενο, κατάσταση, κ.λπ., το οποίο σκοπεύουμε να καταμετρήσουμε για την έρευνά μας. Για να μελετήσουμε καλύτερα τα αποτελέσματα ενός πειράματος τύχης, π.χ. αντιστοιχούμε σε κάθε απλό ενδεχόμενο έναν πραγματικό αριθμό. Για παράδειγμα, αν μελετούμε τα ενήλικα άτομα μιας πόλης ως προς το ύψος τους, τότε σε κάθε άτομο αντιστοιχούμε κάποιον αριθμό που δηλώνει το ύψος του. Με αυτό τον τρόπο έχουμε ορίσει τη μεταβλητή Χ= «ύψος ατόμου». Αν ερευνούμε 50 οικογένειες με τρία παιδιά μιας πόλης, ορίζουμε τη μεταβλητή Y= «οικογένεια με τρία παιδιά». Είναι εύκολα αντιληπτό ότι οι τιμές που παίρνουν οι μεταβλητές X, Y είναι διαφορετικού είδους. Πράγματι η μεταβλητή Χ παίρνει τιμές μεταξύ του συνόλου ={1.50,… 2.12 } ενώ η Y παίρνει τιμές μεταξύ του συνόλου ={0, 1,2,3,…,50}.
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			Εικόνα 1.1: Διαφορετικά είδη εννοιών που ποσοτικοποιούνται μέσω τυχαίων μεταβλητών

			Από τις παραπάνω μεταβλητές γίνεται φανερό ότι υπάρχουν διαφορετικά είδη μεταβλητών ανάλογα με τον δειγματοχώρο και έτσι έχουμε τις εξής κατηγορίες:

			
					Ποσοτικές (quantitative)Είναι οι μεταβλητές που μπορούν να μετρηθούν. Σ΄ αυτή την περίπτωση η συνάρτηση τυχαίας μεταβλητής δίνει ως αποτέλεσμα τη μέτρηση χωρίς τη μονάδα π.χ. 70 αντί για 70kg κ.ά., οπότε έχουμε δύο είδη μεταβλητών: αυτές που παίρνουν οποιαδήποτε τιμή σε ένα διάστημα πραγματικών αριθμών και ονομάζονται συνεχείς (ηλικία, βάρος, εισόδημα) και αυτές που παίρνουν συγκεκριμένες τιμές, συνήθως ακέραιες, και λέγονται διακριτές (αριθμός παιδιών οικογένειας κ.ά.).


					Ποιοτικές (qualitative, categorical)

			

			Είναι οι μεταβλητές που δεν μπορούν να μετρηθούν. Σε αυτή την περίπτωση η αντιστοίχιση τιμών του δειγματικού χώρου με τους πραγματικούς αριθμούς είναι θέμα ορισμού και δεν έχει αριθμητική υπόσταση. Παράδειγμα αν εξετάζουμε το φύλο ενός ασθενή, μπορεί να γίνει η αντιστοίχιση «1» στον άντρα και «0» στη γυναίκα ή το ανάποδο. Σε αυτή την περίπτωση διακρίνουμε πάλι δύο περιπτώσεις: τις μεταβλητές που εμπεριέχουν την έννοια της διάταξης στις τιμές που παίρνουν και ονομάζονται διατάξιμες (εξέλιξη νόσου, κάπνισμα) και στις μη διατάξιμες (φύλο, πάσχοντες ή μη από μια νόσο, κ.λπ.).
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			Εικόνα 1.2: Τα είδη των μεταβλητών

			1.7.2 Καθορισμός μεγέθους δείγματος

			Το πρώτο που ενδιαφέρει σε μία δειγματοληπτική έρευνα είναι το πλήθος των παρατηρήσεων, που πρέπει να έχει το δείγμα, ώστε τα αποτελέσματα να έχουν ένα συγκεκριμένο βαθμό αξιοπιστίας

			Είναι αυτονόητο ότι ο βαθμός εγκυρότητας του δείγματος μεγαλώνει με την αύξηση του δείγματος. Αν και το κυριότερο μέτρο εγκυρότητας δεν είναι το μέγεθος του δείγματος, αλλά η αντιπροσωπευτικότητά του που προκύπτει από τη σωστή επιλογή της μεθόδου.

			Για τον καθορισμό μεγέθους του δείγματος πρωταρχικό ρόλο παίζει η διασπορά των παρατηρήσεων του πληθυσμού. Αν θελήσουμε, π.χ. να εκτιμήσουμε το μέσο μισθό των δημοσίων υπαλλήλων της δευτεροβάθμιας εκπαίδευσης στην Ελλάδα, θα θεωρήσουμε ως πληθυσμό όλους τους καθηγητές δευτεροβάθμιας στα δημόσια σχολεία των οποίων οι μισθοί έχουν μια διακύμανση σ (όχι πολύ μεγάλη). Αν όμως το ζητούμενο είναι η εκτίμηση του μέσου μισθού των πτυχιούχων λογιστικής στην Ελλάδα, η διασπορά είναι πολύ μεγαλύτερη από πριν και κατά συνέπεια και το μέγεθος του δείγματος είναι πολύ μεγαλύτερο. Στην ακραία περίπτωση που η διασπορά είναι μηδέν αρκεί μία παρατήρηση, προκειμένου να εκτιμήσουμε το μέσο μισθό (π.χ. αν θέλουμε να εκτιμήσουμε το μέσο μισθό πρωτοετών στρατιωτικής σχολής).

			Παρακάτω παρατίθενται βασικοί τύποι περιγραφικών στατιστικών:

			Μέτρα θέσεως (περίπτωση πρωτογενών δεδομένων)

			α) Μέσος αριθμητικός ή μέσος όρος ή μέση τιμή

			Αν οι τιμές της μεταβλητής Χ είναι x1, x2, …. xn

			O μέσος αριθμητικός υπολογίζεται από τη σχέση:
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			Εξίσωση 1.1

			β) Διάμεσος

			Η διάμεσος δ n παρατηρήσεων, x1, x2, …. xn, της μεταβλητής Χ είναι η τιμή της παρατήρησης που βρίσκεται στο μέσο, όταν οι παρατηρήσεις διαταχθούν σε αύξουσα ή φθίνουσα σειρά. Διακρίνουμε δυο περιπτώσεις:

			
					Το πλήθος n των παρατηρήσεων είναι άρτιος αριθμός. Στην περίπτωση αυτή η διάμεσος είναι το ημιάθροισμα των δύο μεσαίων παρατηρήσεων.

					Το πλήθος n των παρατηρήσεων είναι περιττός αριθμός. Στην περίπτωση αυτή η διάμεσος είναι η μεσαία παρατήρηση.

			

			Παρατήρηση: Η διάμεσος δεν επηρεάζεται από παρατηρήσεις οι οποίες βρίσκονται πολύ μακριά από τον κύριο όγκο των δεδομένων (outliers). Το αντίθετο συμβαίνει με τον μέσο αριθμητικό του οποίου η τιμή είναι ευαίσθητη σε τέτοιες παρατηρήσεις.

			γ) Επικρατούσα τιμή

			Όπως προκύπτει και από την ονομασία είναι η παρατήρηση με τη μεγαλύτερη συχνότητα.

			δ) Πρώτο τεταρτημόριο Q1

			Το πρώτο τεταρτημόριο Q1 (Q1 quartile) διαιρεί τα δεδομένα σε δύο μέρη, έτσι ώστε, όταν τα δεδομένα είναι διατεταγμένα κατ’αύξουσα σειρά μεγέθους, το μέρος με τις μικρότερες παρατηρήσεις να αντιστοιχεί στο 25% των δεδομένων.

			ε) Τρίτο τεταρτημόριο Q3

			Το τρίτο τεταρτημόριο Q3 (Q3 quartile) διαιρεί τα δεδομένα σε δύο μέρη, έτσι ώστε, όταν τα δεδομένα είναι διατεταγμένα κατ’ αύξουσα σειρά μεγέθους, το μέρος με τις μεγαλύτερες παρατηρήσεις να αντιστοιχεί στο 25% των δεδομένων.

			Μέτρα Διασποράς (πρωτογενών δεδομένων)

			
					ΕύροςΤο εύρος R (Range) είναι το απλούστερο από όλα τα μέτρα διασποράς και ορίζεται ως η διαφορά μεταξύ της μέγιστης και της ελάχιστης τιμής ενός συνόλου στατιστικών παρατηρήσεων:
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Εξίσωση 1.2


					Ενδοτεταρτημοριακό εύροςΜέτρο διασποράς είναι και το ενδοτεταρτημοριακό εύρος IR που ορίζεται από τον τύπο:
IR = Q3 - Q1


					Διακύμανση και Τυπική απόκλισηΑν οι τιμές της μεταβλητής Χ είναι, x1, x2, …. xn, η διακύμανση (Variance) υπολογίζεται από τη σχέση:
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Εξίσωση 1.3
Η διακύμανση εκφράζεται σε μονάδες που αντιστοιχούν στο τετράγωνο των μονάδων της μεταβλητής. Η ανάγκη για ένα μέτρο διασποράς που να εκφράζεται στις ίδιες μονάδες με τις αρχικές (ούτως ώστε να μπορεί να συνεκτιμάται σε συνδυασμό και με τη μέση τιμή) οδήγησε στη χρησιμοποίηση της τετραγωνικής ρίζας της διακύμανσης, η οποία ονομάζεται τυπική απόκλιση:
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Εξίσωση 1.4


					Συντελεστής μεταβλητότητας (coefficient of variation)Ας θεωρήσουμε τους μηνιαίους μισθούς, σε ευρώ, πέντε υπαλλήλων δύο εταιρειών Α και Β. Για την Α έχουμε τους μισθούς 10.100, 10.050, 10.020, 10.000, 10.010 και για τη Β έχουμε τους μισθούς 1.100, 1.050, 1.020, 1.000, 1.010. Παρατηρούμε ότι και οι δύο εταιρείες έχουν ίδια μέτρα διασποράς (τυπική απόκλιση, εύρος, κ.λπ.). Παρόλα αυτά αν κάποιος υπάλληλος της πρώτης εταιρείας υποστεί μείωση μισθού 1.000 ευρώ, τότε αυτό θα έχει γι’ αυτόν πολύ μικρότερες συνέπειες από ό,τι μια αντίστοιχη μείωση στο μισθό ενός υπαλλήλου της εταιρείας Β.
Από το παραπάνω παράδειγμα φαίνεται η ανάγκη να οριστεί ένα καινούργιο μέτρο, το οποίο δεν θα αντικατοπτρίζει μόνο τη διασπορά των δεδομένων, αλλά και τις επιπτώσεις που έχει αυτή η διασπορά στην πειραματική μονάδα. Το μέτρο αυτό συμβολίζεται με CV, ονομάζεται συντελεστής μεταβλητότητας και δίνεται από το λόγο της τυπικής απόκλισης (s) και του αριθμητικού μέσου:
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Εξίσωση 1.5
Εάν ο μέσος όρος είναι κοντά στο μηδέν ή πολύ μεγάλος, τότε ο συντελεστής μεταβλητότητας καθίσταται αναξιόπιστος. Επίσης, θα πρέπει να ελεγχθεί προσεκτικά η αξιοπιστία του συντελεστή μεταβλητότητας, όταν μία κατανομή παρουσιάζει ασυμμετρία.
Ο συντελεστής μεταβλητότητας μπορεί επίσης να χρησιμοποιηθεί για την εκτίμηση της τυπικής απόκλισης μίας εμπειρικής κατανομής συχνοτήτων, αν η μέση τιμή και η τυπική απόκλιση s μεταβάλλονται με τέτοιο τρόπο, ώστε ο CV να παραμένει σταθερός. Η αξία αυτής της μεθόδου είναι μεγαλύτερη, αν τα δεδομένα είναι τέτοια που δεν διευκολύνουν τον υπολογισμό των:
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Κριτήριο καθορισμού μεγέθους δείγματος με βάση το τυπικό σφάλμα
Έστω τυχαία μεταβλητή Χ (π.χ. τα εισοδήματα καθηγητών δευτεροβάθμιας) προερχόμενη από πληθυσμό με μέση τιμή μ και διασπορά σ2. Αν πάρουμε ένα δείγμα μεγέθους n θα εκτιμήσουμε το μέσο εισόδημα του πληθυσμού από το δειγματικό μέσο:
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Εξίσωση 1.6
Η διακύμανση του δειγματικού μέσου ονομάζεται τυπικό σφάλμα και δίνεται από τον τύπο:
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Εξίσωση 1.7
Άρα για δεδομένο τυπικό σφάλμα και γνωστή διασπορά του πληθυσμού μπορούμε να εκτιμήσουμε το μέγεθος του δείγματος από τον τύπο:
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Εξίσωση 1.8
Εφόσον το τυπικό σφάλμα είναι ένα μέτρο διασποράς, είναι προφανές ότι όσο μικρότερες τιμές έχει, τόσο και πιο αντιπροσωπευτική είναι η τιμή της δειγματικής εκτίμησης.
Το πρόβλημα της εύρεσης της διασποράς σ2 του πληθυσμού συνήθως αντιμετωπίζεται με εκτίμηση της σ2 από μικρό στοιχειώδες δείγμα. Οπότε ο τύπος γίνεται:
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Εξίσωση 1.9
Ο τύπος αυτός δίνει το μέγεθος για προκαθορισμένο δείγμα και για προκαθορισμένο τυπικό σφάλμα, μειονεκτεί όμως στο ότι δε λαμβάνει υπόψη τη μέση τιμή της μεταβλητής, που θέλουμε να εκτιμήσουμε. Έτσι μπορεί να έχουμε ίδια προκαθορισμένη τιμή τυπικού σφάλματος, π.χ. σx = 1 για μία μεταβλητή με μέση τιμή μ = 1.000.000, και για μία με μέση τιμή μ = 1 κάτι που προφανώς δεν είναι σωστό.
Κριτήριο καθορισμού μεγέθους δείγματος με βάση τον συντελεστή παραλλακτικότητας
Με τον συντελεστή παραλλακτικότητας:
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Εξίσωση 1.10
Υπάρχει η δυνατότητα να αντιμετωπιστεί το μειονέκτημα του τυπικού σφάλματος, που προαναφέρθηκε, γιατί λαμβάνεται υπόψη στην τιμή του τυπικού σφάλματος και η μέση τιμή του πληθυσμού.
Οπότε για συγκεκριμένη τιμή του συντελεστή παραλλακτικότητας C έχουμε:
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Εξίσωση 1.11
Η μέση τιμή αλλά και η διακύμανση του πληθυσμού συνήθως δεν είναι γνωστές και εκτιμώνται από στοιχειώδες δείγμα. Σ’ αυτή την περίπτωση έχουμε τον τύπο:
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Εξίσωση 1.12
Κριτήριο καθορισμού μεγέθους δείγματος με βάση το διάστημα εμπιστοσύνης
Στην περίπτωση που θέλουμε να καθορίσουμε μέγεθος δείγματος για συγκεκριμένο διάστημα εμπιστοσύνης, π.χ. θέλουμε να εκτιμήσουμε το ποσοστό ενός κόμματος στις εκλογές, ενώ το εύρος του διαστήματος δεν θέλουμε να ξεπεράσει το 3%. Το διάστημα εμπιστοσύνης όταν είναι γνωστή η διασπορά του πληθυσμού είναι γνωστό ότι δίνεται από τον τύπο:
[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\1.13.wmf]
Εξίσωση 1.13
Άρα το μήκος του διαστήματος είναι (κατά το ήμισυ):
[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\1.14.wmf]
Εξίσωση 1.14
Από τη σχέση αυτή προκύπτει ότι ο τύπος για το μέγεθος του δείγματος είναι:
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Εξίσωση 1.15
Το πρόβλημα της εύρεσης της διακύμανσης σ2 του πληθυσμού συνήθως αντιμετωπίζεται με εκτίμηση της s2 από μικρό στοιχειώδες δείγμα. Οπότε ο τύπος γίνεται:
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Εξίσωση 1.16
Για μικρά δείγματα θα χρησιμοποιείται η κατανομή Student αντί για την κανονική άρα το μέγεθος του δείγματος είναι:
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Εξίσωση 1.17
Στην περίπτωση αυτή ο υπολογισμός είναι πιο σύνθετος, γιατί το μέγεθος του δείγματος περιέχεται και στην κατανομή. Αντί για σταθερό μήκος d μπορεί να δίνεται το διάστημα ως ποσοστό της παραμέτρου της μέσης τιμής, π.χ. 0,1μ ή γενικά kμ οπότε το μέγεθος του δείγματος είναι:
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Εξίσωση 1.18
Για άγνωστη διακύμανση πληθυσμού και μεγάλο δείγμα έχουμε:
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Εξίσωση 1.19
Και για μικρό δείγμα έχουμε:
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Εξίσωση 1.20
Παράδειγμα 1
Έστω ότι θέλουμε να υπολογίσουμε το μέγεθος του δείγματος με πιθανότητα 95% (α = 0,05) προκειμένου το διάστημα εμπιστοσύνης να περιέχει με ακρίβεια 10% το μέσο ετήσιο εισόδημα των εκπαιδευτικών πρωτοβάθμιας και δευτεροβάθμιας εκπαίδευσης στην Ελλάδα (δηλαδή με εύρος διαστήματος ±0,10μ και k = 0,10). Από μικρό δείγμα υπολογίστηκαν:
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και
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Να επαναληφθεί η διαδικασία προκειμένου να εκτιμηθεί το μέγεθος, αν θέλουμε το εύρος της εκτίμησης να μην ξεπερνά τα 200 ευρώ με πιθανότητα 95%.
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Πίνακας 1.1: Τιμές του n για τις παραμέτρους του παραδείγματος
Παρατηρούμε ότι με το κριτήριο του ποσοστού επί της μέσης τιμής το ζητούμενο δείγμα είναι 6 (όπου υπάρχει η μικρότερη απόσταση του αριθμού της πρώτης και της τέταρτης στήλης (6-6,232727), ενώ με το δεύτερο κριτήριο 5 (όπου η αντίστοιχη απόσταση είναι 5-5, 552). Παρατηρούμε ότι και στις δύο περιπτώσεις το μέγεθος δείγματος είναι μικρό γιατί η τυπική απόκλιση s=200 θεωρείται σχετικά μικρή σε σχέση με τη μέση τιμή, αλλά και τα κριτήρια δεν ήταν αυστηρά (ο συντελεστής k = 0,1 είναι μεγάλος, όπως και το εύρος d = 200).
Παράδειγμα 2
Καταγράφεται ο χρόνος επίλυσης ενός προβλήματος από ηλεκτρονικούς υπολογιστές με τα ίδια χαρακτηριστικά προκειμένου να βρεθεί ο χρόνος επίλυσης του προβλήματος. Εφαρμόζοντας το ίδιο πρόβλημα παίρνουμε πέντε προκαταρτικά δείγματα από έξι υπολογιστές. Να υπολογιστεί το μέγεθος των δειγμάτων που προκύπτει από τις παραπάνω μεθόδους και να σχολιαστούν τα αποτελέσματα.
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Πίνακας 1.2: Δεδομένα 2ου παραδείγματος
Για τις έρευνες αυτές προκύπτουν τα παρακάτω διαγράμματα:
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Εικόνα 1.3: Διαγράμματα με δεδομένα το χρόνο επίλυσης (Α και Β)
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Εικόνα 1.4: Διαγράμματα με δεδομένα το χρόνο επίλυσης (Γ και Δ)
[image: \\server-pc\Storage_Volume\_ΥΛΙΚΟ ΔΟΥΛΕΙΑΣ\Κάλλιπος Χαλικιάς\Images - Resized\1.5.png]
Εικόνα 1.5: Διάγραμμα με δεδομένα το χρόνο επίλυσης (Ε)
Καθώς και τα εξής:
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Πίνακας 1.3: Μέσες τιμές και τυπικές αποκλίσεις των δεδομένων
Θα θεωρήσουμε αρχικά την τιμή του τυπικού σφάλματος ως:
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Εξίσωση 1.21
Οπότε τα συγκεκριμένα πέντε ζητούμενα μεγέθη δείγματος βρίσκονται από τον τύπο:
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Εξίσωση 1.22
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Πίνακας 1.4: Πίνακας που έχουν καταγραφεί τα ζητούμενα μεγέθη του δείγματος
Στη συνέχεια θα υπολογίσουμε την τιμή του συντελεστή παραλλακτικότητας C = 0,01. Οπότε τα πέντε ζητούμενα μεγέθη δείγματος βρίσκονται από τον τύπο:
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Εξίσωση 1.23
και καταλήγουμε στον Πίνακα 1.5:
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Πίνακας 1.5: Πίνακας που έχουν καταγραφεί τα ζητούμενα μεγέθη του δείγματος
Ακολούθως θα δεχτούμε ως δεδομένο το μήκος του διαστήματος εμπιστοσύνης (d = 5), οπότε τα ζητούμενα μεγέθη δείγματος βρίσκονται από τον τύπο:
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Εξίσωση 1.24
και καταλήγουμε στον Πίνακα 1.6:
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Πίνακας 1.6: Πίνακας που έχουν καταγραφεί τα ζητούμενα μεγέθη του δείγματος
Τέλος θα πάρουμε ως δεδομένο και το μήκος του διαστήματος εμπιστοσύνης ( ٢٪ της μέσης τιμής, δηλαδή k = 0,02), οπότε τα ζητούμενα μεγέθη δείγματος βρίσκονται από τον τύπο:
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Εξίσωση 1.25
και καταλήγουμε στον Πίνακα 1.7:
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Πίνακας 1.7: Πίνακας που έχουν καταγραφεί τα ζητούμενα μεγέθη του δείγματος
Συνοψίζοντας καταλήγουμε στον Πίνακα 1.8:
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Πίνακας 1.8: Πίνακας που έχουν καταγραφεί τα ζητούμενα μεγέθη του δείγματος
1.7.3 Τα είδη δειγματοληψίας
1.7.3.1 Μη πιθανοτική δειγματοληψία
Όταν η εξαγωγή δείγματος βασίζεται σε τεχνικές κατά τις οποίες δε χρησιμοποιούνται οι νόμοι των πιθανοτήτων, τότε η όλη διαδικασία καλείται μη πιθανοτική δειγματοληψία. Συνήθως είναι ευκαιριακές διαδικασίες και εφαρμόζονται για πιλοτικές έρευνες και όχι για έρευνες επιστημονικού κύρους. Σ' αυτή την περίπτωση συνήθως εφαρμόζονται τρία δειγματοληπτικά σχέδια:
	Δειγματοληψία ευκαιρίας (convenience sampling): Είναι η συλλογή όσο το δυνατό μεγαλύτερου δείγματος, κατά τη διάρκειά της συγκεντρώνουμε όλες τις παρατηρήσεις στις οποίες έχουμε εύκολη πρόσβαση. Για παράδειγμα, έστω ότι ένας ερευνητής ενδιαφέρεται να συλλέξει πληροφορίες για την ικανοποίηση των πελατών από ένα κατάστημα. Εφαρμογή ευκαιριακής δειγματοληψίας θα έχουμε αν ο ερευνητής πάει μια μέρα στο κατάστημα και δίνει ερωτηματολόγια στους πελάτες που βρίσκονται στο κατάστημα. Άλλο παράδειγμα είναι τα ρεπορτάζ στην τηλεόραση που ασχολούνται με την άποψη του κόσμου για τις τιμές των προϊόντων στην οδό Ερμού, κ.λπ. Προφανώς ο συγκεκριμένος τρόπος συλλογής του δείγματος δεν αντιπροσωπεύει τον πληθυσμό και δεν έχει επιστημονική εγκυρότητα. Η χρήση του συγκεκριμένου σχεδίου γίνεται κυρίως για πιλοτικές έρευνες και όχι για εξαγωγή συμπερασμάτων. Πρέπει να τονιστεί ότι συχνά παρατηρείται λανθασμένη σύγχυση της ευκαιριακής δειγματοληψίας με την απλή τυχαία δειγματοληψία που θα εξετάσουμε στην παράγραφο 1.7.3.2.
	Δειγματοληψία κρίσεως ή σκόπιμη δειγματοληψία (judgement sampling): Η μέθοδος αυτή θυμίζει σε μεγάλο βαθμό την ευκαιριακή, με τη διαφορά ότι η συλλογή των μονάδων γίνεται με κάποια επιλογή του ερευνητή, έτσι ώστε το δείγμα να είναι κατά τη γνώμη του πιο αντιπροσωπευτικό. Αν κατά τη δειγματοληψία ευκαιρίας για την ικανοποίηση πελατών, που αναφέραμε στο προηγούμενο παράδειγμα, ο ερευνητής κάνει μία πρόχειρη επιλογή σε ποιους δίνει το ερωτηματολόγιο, τότε η μέθοδος πλέον καλείται δειγματοληψία κρίσεως. Ο συγκεκριμένος ερευνητής έχοντας δώσει τα τρία πρώτα ερωτηματολόγια σε γυναίκες, το τέταρτο το δίνει σε άντρα, γιατί πιστεύει έτσι ότι το δείγμα θα είναι πιο αντιπροσωπευτικό. Όπως σε όλα τα σχέδια δειγματοληψίας και το συγκεκριμένο στερείται επιστημονικής εγκυρότητας και δεν συναντάται σε επιστημονικές δημοσιεύσεις, αλλά σε πιλοτικές έρευνες.
	Δειγματοληψία της χιονοστιβάδας (snowball sampling): Είναι μία μέθοδος κατά την οποία ο ερωτώμενος καλείται να βρει και να υποδείξει άλλους συμμετέχοντες στην έρευνα. Παρά το ότι η διαδικασία αυτή φαίνεται αρκετά παράδοξη, εντούτοις χρησιμοποιείται και σε επιστημονικές έρευνες. Ο λόγος χρήσης της μεθόδου είναι ότι σε πολλές περιπτώσεις ο πληθυσμός είναι αδύνατο να καταγραφεί, έτσι ώστε να υπάρχει δειγματοληπτικό πλαίσιο και να πραγματοποιηθεί η επιθυμητή δειγματοληψία, επίσης είναι δύσκολη η ανεύρεση των μονάδων ανάλυσης. Παράδειγμα έστω ότι θέλουμε την πραγματοποίηση έρευνας για ζητήματα που αφορούν στους λαθρομετανάστες. Προφανώς η πρόσβαση σε αυτούς τους ανθρώπους είναι πολύ δύσκολη και τη διευκολύνει σε πολύ μεγάλο βαθμό η ύπαρξη ενός λαθρομετανάστη, ο οποίος θα θέλει να βοηθήσει στην έρευνα μιλώντας σε αυτούς που γνωρίζει και προτρέποντάς τους να συμμετάσχουν στην έρευνα.
	Ποσοτική δειγματοληψία (quota sampling): Γίνεται συχνά σύγχυση του σχεδίου έρευνας που εφαρμόζεται σ΄ αυτή τη μέθοδο με τα αντίστοιχα της πιθανοτικής δειγματοληψίας. Στο ποσοτικό δειγματοληπτικό σχέδιο η συλλογή δείγματος πραγματοποιείται εξασφαλίζοντας συγκεκριμένα ποσοστά σε κάποιες παραμέτρους που κατά την κρίση του ερευνητή είναι οι σημαντικότερες. Προφανώς τα ποσοστά αυτά αντιπροσωπεύουν τον πληθυσμό. Έστω ότι το ζητούμενο είναι η εύρεση ενός δείγματος από τους φοιτητές του τμήματος Διοίκησης Επιχειρήσεων του ΑΕΙ Πειραιά ΤΤ. Από τα στοιχεία της γραμματείας βρέθηκε ότι το ποσοστό των φοιτητριών είναι 65% και των φοιτητών 35%. Ακόμα από τα στοιχεία της γραμματείας προκύπτει ότι το 18% είναι πρωτοετείς, το 16% δευτεροετείς, το 15% τριτοετείς, 15% τεταρτοετείς, και το υπόλοιπο 36% είναι φοιτητές επί πτυχίω.
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			Πίνακας 1.9: Καταγραφή μεταβλητών με τα αντίστοιχα ποσοστά
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			Πίνακας 1.10: Ποσοστά ανά κατηγορία

			Έστω ότι το δείγμα αποτελείται από 1.000 φοιτητές-φοιτήτριες τότε θα πάρουμε τις παρακάτω παρατηρήσεις από κάθε κατηγορία:

			[image: ]

			Πίνακας 1.11: Συχνότητες ανα κατηγορία

			Η μέθοδος αυτή, αν και μπορεί σε πολλές περιπτώσεις να δώσει αντιπροσωπευτικά δείγματα, στερείται εγκυρότητας για το λόγο ότι η στάθμιση στηρίζεται σε περιορισμένο αριθμό παραγόντων (ενός, δύο ή τριών) που ο ερευνητής αυθαίρετα θεώρησε ότι είναι οι πιο σημαντικοί. Στην πράξη, όμως, ο ερευνητής δεν είναι σε θέση να προεξοφλήσει, αν κάποιος από τους παράγοντες είναι σημαντικός. Στο προηγούμενο παράδειγμα αν η έρευνα αφορά στο εισόδημα των φοιτητών, μπορεί οι παράγοντες φύλο και έτος να μην είναι σημαντικοί, αλλά να χρειάζεται να εξεταστούν άλλοι παράγοντες, όπως εάν οι φοιτητές προέρχονται από αστικό κέντρο, ή από επαρχία, αν παρακολουθούν τα μαθήματα ή όχι, κ.λπ.

			1.7.3.2 Πιθανοτική δειγματοληψία

			
					Απλή τυχαία δειγματοληψία (simple random sampling): Από ένα πληθυσμό πεπερασμένου πλήθους μονάδων ανάλυσης εκλέγεται τυχαία δείγμα χωρίς επανάθεση. Ο όρος τυχαία δεν σημαίνει ότι εκλέγουμε στην τύχη όποιους θέλουμε από τον πληθυσμό κάποιων ατόμων. Η τυχαιότητα εξασφαλίζεται με χρήση τυχαίων αριθμών κατά την επιλογή των ατόμων ή με χρήση κάλπης.Η επανάθεση εξασφαλίζει ότι οι πειραματικές μονάδες του δείγματος είναι διαφορετικές μεταξύ τους. Έτσι αν έχουμε ένα πληθυσμό Ν μελών και θέλουμε να υπολογίσουμε το πλήθος των δειγμάτων (n στοιχείων το καθένα), αυτό δίνεται από τον υπολογισμό Ν μελών ανά n στοιχείων το καθένα:
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Εξίσωση 1.26


					Συστηματική δειγματοληψία (systematic sampling): Κατά τη συστηματική δειγματοληψία πρώτα από όλα αριθμούνται όλα τα μέλη του πληθυσμού. Αν ο πληθυσμός είναι Ν μονάδων ανάλυσης και θέλουμε να εξάγουμε δείγμα n από αυτές, πρώτα από όλα υπολογίζουμε το πηλίκο:[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\1.27.wmf]
Εξίσωση 1.27
Παίρνουμε το ακέραιο μέρος του αριθμού αυτού: λ = [k].
Μετά τον υπολογισμό του λ επιλέγεται τυχαία αριθμός ρ μεταξύ του 1 και του λ. Τα n μέλη του δείγματος θα έχουνε τους εξής αύξοντες αριθμούς στο πλαίσιό τους ρ, ρ+λ, ρ+2λ, …, ρ+(n-1)λ.
Η διαδικασία αυτή είναι πολύ εύκολα εφαρμόσιμη στην περίπτωση που οι πειραματικές μονάδες είναι είδη αριθμημένες, π.χ. φάκελοι νοσοκομείου. Λάθος, που μπορεί να προκύψει από τη διαδικασία αυτή, είναι αν η αρίθμηση κρύβει και μία περιοδικότητα στα δεδομένα, π.χ. αν αναφερόμαστε σε εφημερίδες και το βήμα λ=30 θα προκύπτουν φύλλα εφημερίδων με ίδιες ημερομηνίες κάθε μήνα (π.χ. 20/6-20/7-19/8, κ.λπ).


			

			
					Στρωματοποιημένη δειγματοληψία (stratified sampling): Κατά τη στρωματοποιημένη δειγματοληψία ο πληθυσμός διαιρείται σε στρώματα (strata), από τα οποία, αφού καθοριστούν, εξάγονται δείγματα από το καθένα με τη μέθοδο της απλής τυχαίας δειγματοληψίας. Η μέθοδος έχει καλή εφαρμογή σε περιπτώσεις που ο πληθυσμός είναι ανομοιόμορφος. Ο καθορισμός των στρωμάτων γίνεται με κριτήριο τη διασπορά εντός των στρωμάτων. Συγκεκριμένα το επιδιωκόμενο είναι μέσα στα στρώματα να υπάρχει όσο το δυνατό μικρότερη διασπορά και ανάμεσα στα στρώματα όσο το δυνατό μεγαλύτερη. Ένα δείγμα που προκύπτει από στρωματοποιημένη δειγματοληψία μπορεί να είναι: είτε αναλογικό (ο αριθμός των μονάδων ανάλυσης που επιλέγονται να είναι ανάλογος του μεγέθους του δείγματος) είτε μη αναλογικό.

					Δειγματοληψία κατά συστάδες (cluster sampling): Στη δειγματοληψία κατά συστάδες ο πληθυσμός διαιρείται σε συστάδες (clusters), κάθε μία από αυτές θα αντιπροσωπεύει ένα νέο πληθυσμό. Οπότε η δειγματοληψία πραγματοποιείται σε δύο φάσεις: στην πρώτη με απλή τυχαία δειγματοληψία χωρίς επανάθεση επιλέγεται δείγμα από τις συστάδες και στη δεύτερη γίνεται απογραφή των συστάδων. Παρατηρούμε ότι η συγκεκριμένη μέθοδος μοιάζει αρκετά με την στρωματοποιημένη, παρόλα αυτά οι διαφορές στην εφαρμογή είναι αρκετά διακριτές. Συγκεκριμένα για τη μεγαλύτερη δυνατή αποτελεσματικότητα στη δειγματοληψία συστάδων πρέπει, σε αντίθεση με αυτό που συμβαίνει στη στρωματοποιημένη δειγματοληψία, μεταξύ των συστάδων να υπάρχει όσο το δυνατό μικρότερη διασπορά, ενώ μέσα στις συστάδες όσο το δυνατό μεγαλύτερη.

					Διπλή δειγματοληψία (double sampling): Κατά τη διαδικασία στατιστικού ελέγχου ποιότητας και αξιοπιστίας προϊόντων (quality control), κυρίως στον τομέα της βιομηχανικής παραγωγής, πολλές φορές έλεγχος ενός δείγματος σημαίνει και καταστροφή του προϊόντος. Παράδειγμα αν θέλουμε να ελέγξουμε την παραγωγή σοκολάτας, ως προς τη γεύση. Στην περίπτωση αυτή το δείγμα που εξάγεται είναι η πρώτη παρτίδα παραγόμενων προϊόντων. Οπότε με βάση τα αποτελέσματά της, βγάζουμε συμπεράσματα και για τα υπόλοιπα παραγόμενα προϊόντα.

			

			1.8 Τα είδη των ερευνών

			1.8.1 Έρευνα πεδίου

			Η έρευνα πεδίου είναι ένα είδος έρευνας που δίνει τη δυνατότητα στον ερευνητή να παρατηρεί το αντικείμενο έρευνας στο περιβάλλον που πραγματοποιείται. Συνήθως δεν περιλαμβάνει ποσοτική ανάλυση. Απλά καταγράφονται παρατηρήσεις και μια ολοκληρωμένη οπτική για το αντικείμενο που εξετάζεται. Ο σκοπός ανάλογων ερευνών είναι συχνά διερευνητικός, χωρίς να αποκλείεται να είναι περιγραφικός ή ερμηνευτικός.

			1.8.1.1 Παραδείγματα κατάλληλα για έρευνα πεδίου

			Η έρευνα πεδίου είναι κατάλληλη, όπως ήδη αναφέρθηκε, για ζητήματα που η μελέτη τους είναι επιτυχής όταν διεξάγεται στις συνθήκες που αυτά γεννιούνται και αναπτύσσονται, ώστε να παρακολουθεί κάποιος εύκολα τις διαφοροποιήσεις που παρατηρούνται σε αυτά με την πάροδο του χρόνου.

			Τέτοια ζητήματα είναι:

			
					Διερεύνηση των συνθηκών εργασίας που επικρατούν σε μια βιομηχανία, εργοστάσιο, κ.λπ., έστω για παράδειγμα η λειτουργία ενός ορυχείου χρυσού στη Ν. Αφρική. Παρά το γεγονός ότι πληροφορίες μπορεί να εξαχθούν με προσέγγιση των εργαζομένων με κάποια ερωτηματολόγια, είναι πολύ προτιμότερο ο ερευνητής να βρεθεί ο ίδιος επί τόπου και να παρακολουθήσει τις συνθήκες εργασίας, αλλά και τις πρακτικές της εταιρείας.

					Μελέτη της απήχησης στον κόσμο ενός νέου πολιτικού προσώπου. Ο ερευνητής παρακολουθεί τις κεντρικές ομιλίες του πολιτικού, καταγράφοντας τον παλμό, την απήχηση, τα συνθήματα και τα χαρακτηριστικά του κόσμου που συμμετέχουν.

					Δημοσιογραφική κάλυψη των επιπτώσεων ενός συμβάντος, π.χ. του τυφώνα Κατρίνα στις ΗΠΑ.

					Η παρατήρηση και καταγραφή των αντιδράσεων των πολιτών που στέκονται στην ουρά για κάποια δουλειά, π.χ. των ανέργων που περιμένουν για το σχετικό επίδομα του ΟΑΕΔ, κ.λπ.

					Η μελέτη της ζωής ανθρώπων πετυχημένων στη δουλειά τους, οι οποίοι έχουν μια πολύ καλή κοινωνική θέση και έχουν ξεκινήσει από χαμηλά. Κάποιοι από αυτούς ανέβηκαν με πολύ κόπο και κάποιοι απλά ήταν πολύ τυχεροί. Το θέμα μελέτης θα αφορούσε στις τυχόν αλλαγές στον χαρακτήρα τους και στη συμπεριφορά τους. Ο ερευνητής πρέπει να έρθει κοντά με τους ανθρώπους αυτούς και με ένα μικρό κύκλο ανθρώπων που τους γνωρίζουν από παλιά για να πάρει πληροφορίες και να βγάλει τα συμπεράσματά του.

					Μελέτη σχέσεων συνεργαζόμενων ατόμων, π.χ. των παικτών μιας αθλητικής ομάδας. Για να πραγματοποιηθεί τέτοιου είδους έρευνα πρέπει να υπάρχει παρατηρητής από μέσα, δηλαδή ο ερευνητής να μπει στην ομάδα, να ζήσει την ατμόσφαιρα στις προπονήσεις και το κλίμα στα αποδυτήρια.

			

			1.8.1.2 Οι διάφοροι ρόλοι του ερευνητή

			Οι ρόλοι είναι τρείς:

			
					Συμμετέχων: Σε αυτή την περίπτωση ο ερευνητής δρα ο ίδιος στο πεδίο που μελετά, με σκοπό να μην γίνει αντιληπτός από τα υποκείμενα μελέτης του. Φυσικά θα πρέπει να έχει ένα επίπεδο γνώσεων σχετικά με το θέμα που μελετά, γιατί αλλιώς κινδυνεύει να τον καταλάβουν. Βασικότερο μειονέκτημα της μεθόδου αυτής είναι ότι ο ερευνητής από τη στιγμή που συμμετέχει μπορεί να επηρεάσει το πεδίο μελέτης του εκφράζοντας κάποια άποψη. Είναι χαρακτηριστικό ότι εκτός από απόφαση που μπορεί να κληθεί να πάρει ο ερευνητής από το υπόλοιπο περιβάλλον για τις επόμενες δράσεις των ατόμων που συμμετέχουν, μπορεί και η απλή παρουσία του, η γνώμη του για διάφορα θέματα να επηρεάσει τη δράση της ομάδας. Άλλο μειονέκτημα είναι ότι μπορεί να επηρεαστεί και ο ίδιος από τα γεγονότα που παρακολουθεί χάνοντας την αντικειμενικότητά του. Σε κάθε περίπτωση γεννάται και σημαντικό θέμα δεοντολογίας, δεδομένου ότι για να υπάρχει εγκυρότητα και ο ερευνητής να έχει μία σωστή εικόνα δε θα πρέπει να γνωστοποιεί στο περιβάλλον που δρα την ιδιότητά του.

					Παρατηρητής: Είναι αυτός που απλά παρακολουθεί χωρίς να λαμβάνει μέρος σε καμία δραστηριότητα. Και εδώ υπάρχουν κίνδυνοι. Όπως στην περίπτωση διαδήλωσης με έντονα επεισόδια. Ο ερευνητής δεν μπορεί απλά να κάθεται σε μία άκρη με το μπλοκάκι του και να βλέπει τους διαδηλωτές (τα υποκείμενα της έρευνας) να πετάνε πέτρες στους αστυνομικούς, γιατί τότε θα γίνει αμέσως αντιληπτός και οι διαδηλωτές πιθανότατα να αλλάξουν συμπεριφορά απέναντί του και στη συγκεκριμένη περίπτωση μπορεί να διατρέξει και κάποιο κίνδυνο. Επίσης αν περιορίζεται μόνο στην απλή παρατήρηση, δεν θα είναι εύκολο ο ίδιος να αποκτήσει ολοκληρωμένη εικόνα για το αντικείμενο της μελέτης του.

					Συμμετέχων-Παρατηρητής: Αυτός ο ρόλος είναι μάλλον και ο πιο ορθός, γιατί επιτρέπει στον ερευνητή και να συμμετέχει και να παρατηρεί. Μπορεί να κατευθύνει τη μελέτη του, κατά την κρίση του, αλλά και να λαμβάνει υπόψη του γεγονότα, που τυχόν υποδεικνύουν κάποιες απρόβλεπτες διαστάσεις, που με τη σειρά τους τον οδηγούν σε διαφοροποιήσεις του αρχικού σχεδιασμού.

			

			Σχέσεις με το αντικείμενο μελέτης

			Υπάρχει κίνδυνος κατά τη συμμετοχή του σε μία έρευνα πεδίου ο ερευνητής να χάσει την αντικειμενικότητά του. Να βλέπει με συμπάθεια είτε τα φυσικά πρόσωπα μελέτης (π.χ. τους συμμετέχοντες σ’ ένα κόμμα), είτε το αντικείμενο μελέτης (π.χ. την ιδεολογία του κόμματος). Η οπτική γωνία του ερευνητή, που βλέπει τα γεγονότα αποστασιοποιημένα και αντικειμενικά, καλείται ημική.

			Πρέπει να τονιστεί ότι η αντικειμενική (ημική) οπτική δεν είναι πάντα το ζητούμενο! Σ’ ένα θέμα, π.χ. όπως τα αισθήματα των κατοίκων ενός απολυταρχικού καθεστώτος σε χώρα της Αφρικής, που ο ηγέτης τους θεωρείται ότι έχει θρησκευτικές υπερεξουσίες, ίσως η επιλογή Ευρωπαίου αντικειμενικού ερευνητή δεν είναι καλή. Αντίθετα κάποιος θρησκευόμενος πολίτης αυτής της χώρας μπορεί να δώσει καλύτερη εικόνα. Η οπτική γωνία που έχει ο ερευνητής που υιοθετεί τις απόψεις του αντικειμένου μελέτης του λέγεται ητική.

			1.8.1.3 Συνεντεύξεις

			 Όταν για τη βαθύτερη κατανόηση και ανάλυση κάποιου θέματος απαιτείται η γνώση της σκέψης, των κινήτρων, των συναισθημάτων, κ.λπ. των ερωτωμένων, τότε οι συνεντεύξεις είναι η πιο πρόσφορη μέθοδος για να αντληθούν οι απαραίτητες πληροφορίες.

			Παρά το ότι κάποιος σχεδιασμός έχει προηγηθεί, στόχος είναι η συζήτηση να διεξαχθεί κατά το δυνατόν αβίαστα. Η συνέντευξη για να είναι επιτυχής στηρίζεται στην αλληλεπίδραση συνεντευκτή και συνεντευξιαζόμενου. Σε πολλές περιπτώσεις μπορεί ένα μέρος της συνέντευξης να αναλωθεί σε κάτι που είναι εκτός σχεδιασμού, αν κριθεί ότι μπορεί να εξηγήσει στάσεις συμπεριφοράς, κ.λπ.

			Ένα λογικό μέτρο για τον χρόνο ομιλίας συνεντευκτή και συνεντευξιαζόμενου είναι οι απαντήσεις από τον ερωτώμενο να καλύπτουν τουλάχιστο το 95% του συνολικού χρόνου της συνέντευξης και οι ερωτήσεις-τοποθετήσεις του συνεντευκτή το πολύ το 5% του χρόνου.

			Συνοψίζοντας ο ερευνητής κατά τη διάρκεια της συνέντευξης θα πρέπει να προσέξει ότι:

			
					Ο τρόπος διατύπωσης μιας ερώτησης καθορίζει την απάντηση που θα αποσπάσει ο ερευνητής, ενώ από τις απαντήσεις σ’ αυτές διαμορφώνονται οι επόμενες ερωτήσεις.

					Ο ερευνητής κατά τη διάρκεια μιας συνέντευξης θα πρέπει να μπορεί να ακούει, να σκέφτεται και να μιλά σχεδόν ταυτόχρονα.

					Πρέπει να είναι καλός ακροατής, δηλαδή πρέπει να κοιτάει και να ακούει με ενδιαφέρον τον ερωτώμενο και να του αφήνει την πρωτοβουλία σε περιπτώσεις σύντομων παύσεων. Δεν πρέπει να είναι βέβαια παθητικός και να μην μιλά, αλλά, όπως ήδη αναφέρθηκε, η ομιλία του να μην ξεπερνά συνολικά το 5% της διάρκειας της συνέντευξης.

					Θα πρέπει να καθοδηγεί τη συζήτηση προς την κατεύθυνση που επιθυμεί έμμεσα.

					Αν διακόπτει τον ερωτώμενο, μεταφράζεται ως έλλειψη ενδιαφέροντος. Η ενθάρρυνση του ερευνητή ως προς τον ερωτώμενο, για περαιτέρω ανάπτυξη του θέματος, αντιθέτως, δηλώνει το γνήσιο ενδιαφέρον του ερευνητή.

					Θα πρέπει να έχει προκαθορίσει συγκεκριμένα τα βασικά ζητήματα για να πετύχει ομαλές και λογικές μεταβάσεις από το ένα ζήτημα στο άλλο (Rubin, H. & Rubin, R., 1995).

					Ο ερευνητής δεν πραγματοποιεί αυθόρμητη συζήτηση, αλλά επίσημη. Αυτό σημαίνει ότι η επιθυμία να εμφανιστεί ο ίδιος ως ενδιαφέρον άτομο είναι αντιπαραγωγική. Πρέπει να κάνει τον συνεντευξιαζόμενο να νιώθει αυτός ως ενδιαφέρον άτομο, ακούγοντάς τον περισσότερο παρά μιλώντας ο ίδιος.

			

			Τα στάδια της διαδικασίας συνέντευξης είναι:

			
					Θεματοποίηση: Καθορισμός σκοπού και στόχων της συνέντευξης.

					Σχεδιασμός: Διατύπωση διαδικασίας συνέντευξης.

					Συνέντευξη.

					Απομαγνητοφώνηση, δηλ. μεταγραφή σε κείμενο της συνέντευξης.

					Ανάλυση: Μελέτη των συλλεχθέντων πληροφοριών σύμφωνα με το σκοπό της έρευνας.

					Επαλήθευση: Έλεγχος αξιοπιστίας και της εγκυρότητας των συμπερασμάτων.

					Έκθεση: Δημοσίευση συμπερασμάτων έρευνας.

			

			1.8.1.4 Ομάδες εστίασης

			Οι έρευνες με ομάδες εστίασης είναι έρευνες με συχνή εφαρμογή στις επιστήμες Διοίκησης και Οικονομίας. Στις έρευνες αυτές ο ερευνητής είναι συντονιστής μιας συζήτησης που διεξάγεται με μία ομάδα εστίασης (focus group). H τεχνική αυτή είναι ίδια μ’ αυτή που χρησιμοποιεί ένας δημοσιογράφος που συντονίζει μια πολιτική εκπομπή με πολλούς καλεσμένους στην τηλεόραση.

			Χρησιμοποιείται τακτικά σε έρευνες αγοράς για την αξιολόγηση προϊόντων και ειδών εμπορεύματος. Βασίζεται σε δομημένες, ημιδομημένες ή μη δομημένες συνεντεύξεις.

			Συγκεντρώνονται 5-12 άτομα σε ιδιωτικό και άνετο περιβάλλον για να συζητήσουν ένα συγκεκριμένο ζήτημα. Για την επιλογή των ατόμων προηγείται δειγματοληψία, η οποία σπάνια είναι πιθανοτική (άλλωστε ο περιορισμένος αριθμός του δείγματος δεν διευκολύνει ώστε αυτό να είναι αντιπροσωπευτικό). Συχνά το δείγμα αποτελείται από άτομα που θεωρούνται κατάλληλα για την έρευνα, π.χ. είναι εν δυνάμει πελάτες ενός κινητού που θα βγει σε λίγο στην αγορά.

			Ο ερευνητής θα πρέπει να δίνει το λόγο σε όλη την ομάδα για το ίδιο ερώτημα. Ο χρόνος θα πρέπει να μοιράζεται εξίσου, ώστε να μην μονοπωλούν κάποιοι τη συζήτηση. Ο ίδιος έχει επίσης την ευθύνη για μια εποικοδομητική και πολιτισμένη συζήτηση.

			Παρακάτω παρατίθενται τα πλεονεκτήματα και τα μειονεκτήματα των ομάδων εστίασης σύμφωνα με τον Krueger (1988).

			Πλεονεκτήματα

			
					Είναι μια κοινωνικά προσανατολισμένη ερευνητική μέθοδος που συλλαμβάνει δεδομένα της πραγματικής ζωής σε ένα κοινωνικό περιβάλλον.

					Είναι ευέλικτη.

					Έχει υψηλή εγκυρότητα.

					Προσφέρει άμεσα αποτελέσματα.

					Έχει μικρό κόστος.

			

			Μειονεκτήματα

			
					Ο ερευνητής έχει μειωμένη ικανότητα ελέγχου σε σχέση με τις ατομικές συνεντεύξεις.

					Δυσκολότερη ανάλυση δεδομένων.

					Οι συντονιστές πρέπει να έχουν ειδικές δεξιότητες.

					Η αντιπαράθεση ερωτώμενων στην ομάδα εστίασης μπορεί να προκαλέσει προβλήματα.

					Δύσκολη συγκέντρωση ομάδων.

					Η συζήτηση πρέπει να διεξαχθεί σε πρόσφορο περιβάλλον.

			

			Ενδιαφέρουσα είναι η άποψη του Morgan (1993) που υποστηρίζει ότι η έρευνα σε ομάδες εστίασης μπορεί να είναι ο κατάλληλος τρόπος για να γίνει μία σωστή και πλήρης σύνταξη ερωτηματολογίου δειγματοληπτικής έρευνας.

			1.8.1.5 Δεοντολογία ποιοτικής έρευνας πεδίου

			
					Μία έρευνα πεδίου, για να έχει έγκυρο αποτέλεσμα, πρέπει να μην γίνεται αντιληπτή η παρουσία του ερευνητή, αυτό έχει, όμως, ως αποτέλεσμα ανυποψίαστοι άνθρωποι να γίνονται αντικείμενα μελέτης ερευνητικών σκοπών, ή ακόμα χειρότερα να καλλιεργούνται ανθρώπινες σχέσεις στρατηγικά σχεδιασμένες.

					Ελλοχεύει ο κίνδυνος, όπως και σε άλλες έρευνες, προσωπικά δεδομένα που εκμυστηρεύονται οι πληροφοριοδότες στον ερευνητή να βγουν στη δημοσιότητα.

			

			1.8.2 Δειγματοληπτική έρευνα

			Οι δειγματοληπτικές έρευνες διεξάγονται από ερευνητές για τη συλλογή δεδομένων με σκοπό είτε τη διερεύνηση, είτε την περιγραφή, είτε την ερμηνεία διαφόρων ζητημάτων. Πρέπει να σημειωθεί, όμως, ότι η δομή αυτών των ερευνών και τα τεχνικά στοιχεία θα αναφερθούν στο επόμενο κεφάλαιο. Το εργαλείο διεξαγωγής μιας έρευνας είναι το ερωτηματολόγιο. Τρόποι εξαγωγής των δεδομένων είναι: οι προσωπικές συνεντεύξεις μέσω ερωτηματολογίων και τηλεφώνου (με τη βοήθεια του υπολογιστή), και η ατομική συμ-πλήρωση ερωτηματολογίου που αποστέλλεται ταχυδρομικά ή διαδικτυακά. Θα γίνει αναλυτική αναφορά στη σύνταξη του ερωτηματολογίου με παραδείγματα λανθασμένης σύνταξης ερωτηματολογίου, αλλά και λανθασμένων ερωτήσεων στο δεύτερο κεφάλαιο. Ακόμα, σε δειγματοληπτικές έρευνες εφαρμόζεται δευτερογενής ανάλυση των δεδομένων, κατά την οποία κάποια δεδομένα που έχουν συλλεχθεί για μία έρευνα ξαναχρησιμοποιούνται σε κάποια άλλη μεταγενέστερη.

			1.8.2.1 Ερωτηματολόγια

			Αρχικά, τα ζητήματα που απασχολούν τους ερευνητές για τη διεξαγωγή δειγματοληπτικών ερευνών είναι πολλά και στη μεγάλη πλειοψηφία τους έχουν ως επίκεντρο τους ανθρώπους και τα ζητήματα που τους απασχολούν, επομένως, μονάδες ανάλυσης μιας δειγματοληπτικής έρευνας είναι συνήθως μεμονωμένα άτομα ή διάφορες ομάδες ατόμων.

			Μια δειγματοληπτική έρευνα είναι η πιο κατάλληλη μέθοδος για τη συγκέντρωση στοιχείων από ένα μεγάλο πληθυσμό. Ακόμα, οι έρευνες αυτές παρέχουν τη μέτρηση της αντίληψης των απόψεων και κατευθύνσεων ενός πληθυσμού. Χαρακτηριστικό παράδειγμα τέτοιων ερευνών αποτελούν οι δημοσκοπήσεις.

			1.8.2.2. Πλεονεκτήματα δειγματοληπτικών ερευνών

			Οι δειγματοληπτικές έρευνες έχουν τα εξής πλεονεκτήματα:

			
					Αφορούν σε ζητήματα μεγάλων πληθυσμών, τα οποία δύσκολα διερευνώνται με άλλες μεθόδους.

					Λόγω της καταχώρισης των απαντήσεων στις κλειστές ερωτήσεις η επεξεργασία και η συμπερασματολογία είναι διαδικασίες σχετικά απλές.

			

			1.8.2.3 Μειονεκτήματα δειγματοληπτικών ερευνών

			Οι δειγματοληπτικές έρευνες έχουν, όμως, και μειονεκτήματα, τα οποία είναι:

			
					Απώλεια πληροφορίας που οφείλεται στο «στρίμωγμα» δεδομένων σε γενικές κατηγορίες, για αυτό χαρακτηρίζονται και «άκαμπτες».

					Το θέμα που μελετάται μπορεί να μην είναι μετρήσιμο μέσω ερωτηματολογίων.

					Η ορθή διεξαγωγή τους απαιτεί πολύ χρόνο και χρήμα.

					Αν γίνει λάθος στον αρχικό σχεδιασμό, π.χ. σύνταξη ερωτηματολογίου δεν μπορεί να διορθωθεί.

			

			1.8.2.4 Δευτερογενής έρευνα

			Η συσσώρευση καταγεγραμμένων γνώσεων επιτρέπει συχνά σε πολλούς επιστήμονες να αντλήσουν από αυτές κατάλληλα στοιχεία για τα δικά τους ενδιαφέροντα. Υπάρχουν περιπτώσεις που τα δεδομένα μιας έρευνας επαναχρησιμοποιούνται σε μία άλλη με εντελώς διαφορετικό προσανατολισμό, σκοπό και στόχους. Για παράδειγμα, επαναχρησιμοποιούνται απαντήσεις σε ερωτηματολόγια, απογραφικά στοιχεία και μετρήσεις πειραμάτων, κ.λπ. Τα πρώτα χρόνια συλλογής δευτερογενών δεδομένων τα δεδομένα συλλέγονταν σε έντυπη μορφή σε βιβλιοθήκες. Τώρα πλέον προφανώς φυλάσσονται σε ηλεκτρονικές διευθύνσεις.

			Ακόμα υπάρχει πληθώρα ερευνητικών κέντρων που υπάρχει η δυνατότητα συλλογής στοιχείων όπως τα εξής:

			
					Η Ελληνική Τράπεζα Κοινωνικών Δεδομένων (ΕΤΚΔ),

					H Ειδική Τράπεζα Πληροφοριών (ΕΤΠ),

					Το Αρχείο Κοινωνικών Δεδομένων και Δεικτών (ΑΚΔΔ),

					Το Περιβάλλον Διαχείρισης Κοινωνικών Δεδομένων (ΠΔΚΔ),

					Ο Κόμβος Δευτερογενούς Επεξεργασίας (ΚΔΕ).

			

			Ενδεικτικά τέτοια κέντρα στις ΗΠΑ είναι:

			
					Το κέντρο Roper για την Έρευνα της κοινής γνώμης του Πανεπιστημίου του Κονέκτικατ,

					Το Εθνικό Κέντρο Έρευνας της κοινής γνώμης του Πανεπιστημίου του Σικάγο.

			

			Προφανές πλεονέκτημα της δευτερογενούς έρευνας είναι η οικονομία. Επίσης υπάρχει και η δυνατότητα της μετα-ανάλυσης όπου ο ερευνητής συγκεντρώνει πληροφορίες από παλαιότερες έρευνες για ένα συγκεκριμένο ζήτημα.

			Βασικό μειονέκτημα είναι η εγκυρότητα, εφόσον οι ερευνητές συλλέγουν τα δεδομένα για ένα συγκεκριμένο σκοπό, και δεν είναι εύκολο τα δεδομένα αυτά να είναι κατάλληλα για άλλα ερευνητικά ενδιαφέροντα.

			1.8.2.5 Δεοντολογία της δειγματοληπτικής έρευνας

			Η μέθοδος αυτή δεν παρουσιάζει πολλά δεοντολογικά ζητήματα, γιατί ο ρόλος του ερευνητή είναι ξεκάθαρος και δεν αποκρύβεται από τον ερωτώμενο. Δεοντολογικά ζητήματα μπορούν να προκύψουν με τη διαχείριση των προσωπικών δεδομένων. Είναι χαρακτηριστικό ότι συχνά πραγματοποιούνται δημοσκοπήσεις, κατά τις οποίες χρησιμοποιείται κάλπη, ώστε ο ερωτώμενος να αποφασίζει ανεπηρέαστος και μετά ο ερευνητής συνδέει την «ψήφο» με τις υπόλοιπες ερωτήσεις εν αγνοία του ερωτώμενου.

			1.8.3 Πειραματικοί σχεδιασμοί

			Ο όρος πείραμα για τους περισσότερους ανθρώπους είναι ταυτισμένος με τις επιστήμες της φυσικής, της χημείας, της ιατρικής, κ.λπ. (Κίτσος, 1994). Οι πειραματιστές, όμως, πέρα από τις ελεγχόμενες συνθήκες εργαστηρίου έχουν τη δυνατότητα να πραγματοποιήσουν πειράματα στην κοινωνία.

			1.8.3.1 Θέματα κατάλληλα για πειράματα

			Στους πειραματικούς σχεδιασμούς ο σκοπός της έρευνας είναι συνήθως ερμηνευτικός και όχι περιγραφικός, αφού ο στόχος της έρευνας είναι η άσκηση κάποιας επίδρασης σε μία υπάρχουσα κατάσταση και η εξέταση των αποτελεσμάτων αυτής, εξετάζεται δηλ. αν σημειώθηκαν κάποιες αλλαγές στη συγκεκριμένη κατάσταση μετά την εφαρμογή της όποιας επίδρασης. Τα πειράματα ταιριάζουν περισσότερο σε ερευνητικά προγράμματα που αφορούν σε περιορισμένες και σαφείς έννοιες και προτάσεις. Παράδειγμα: Ας υποθέσουμε ότι θέλουμε να μειώσουμε τον βαθμό προκατάληψης έναντι των γυναικών με διευθυντική θέση μέσα στις επιχειρήσεις. Πολλοί θεωρούν ότι οι γυναίκες δεν μπορούν να υποστηρίξουν μια θέση με τόσες ευθύνες και απαιτήσεις, επειδή δεν έχουν τα απαραίτητα προσόντα και (για πολλούς) την απαραίτητη νοημοσύνη! Εάν κάνουμε γνωστή τη συμβολή τους σε βάθος χρόνου στην ανάπτυξη πολλών επιχειρήσεων, υποθέτουμε ότι το στοιχείο αυτό θα επιτρέψει τη μείωση της σχετικής προκατάληψης. Επομένως αποφασίζουμε να ελέγξουμε τη συγκεκριμένη υπόθεση σε πειραματικό επίπεδο.

			Βήματα:

			
					Ελέγχουμε μια ομάδα υποκειμένων προκειμένου να καθορίσουμε το επίπεδο προκατάληψης (η μέτρηση της προκατάληψης μπορεί να γίνει π.χ. με συμπλήρωση ερωτηματολόγιου).

					Με διάφορα μέσα (π.χ. ντοκιμαντέρ) δίνουμε πληροφορίες σχετικά με το θέμα που εξετάζουμε, παρέχονται δηλαδή στοιχεία που αποδεικνύουν την επιτυχημένη επαγγελματική δράση γνωστών γυναικών.

					Μετά το ντοκιμαντέρ μετράμε εκ νέου το επίπεδο της σχετικής προκατάληψης ώστε να διαπιστώσουμε εάν το ντοκιμαντέρ συνέβαλε στη μείωση της προκατάληψης ή όχι.

			

			1.8.3.2 Η διαδικασία του πειράματος

			Η πειραματική διαδικασία έχει δύο στάδια τον προ-έλεγχο και το μετα-έλεγχο (μέτρηση πριν και μετά τη δράση των αποτελεσμάτων). Σ’ αυτήν παίρνουν μέρος οι πειραματικές ομάδες και οι ομάδες ελέγχου. Πειραματική ομάδα είναι η ομάδα μονάδων ανάλυσης που υφίσταται το πείραμα-τη δράση. Ομάδα ελέγχου είναι η ομάδα μονάδων ανάλυσης που χωρίς να υφίσταται κάποια δράση καταμετρώνται οι μονάδες ανάλυσης προκειμένου να πραγματοποιείται σύγκριση με την πειραματική ομάδα.

			Στο πείραμα θα χρησιμοποιηθούν δύο ειδών μεταβλητές: η εξαρτημένη, που μπορεί να είναι σύνολο ποσοτικών μεταβλητών και είναι το αποτέλεσμα του πειράματος και η ανεξάρτητη που είναι μία ποιοτική μεταβλητή δύο τιμών: α) «η μονάδα ανάλυσης έχει δεχθεί την επίδραση», β) «η μονάδα ανάλυσης δεν έχει δεχθεί την επίδραση». Στο παράδειγμα που προαναφέρθηκε η εξαρτημένη μεταβλητή είναι «η προκατάληψη κατά τις αποτελεσματικότητας των γυναικών σε διοικητικές θέσεις» (η οποία μπορεί να έχει μετρηθεί είτε με συνέντευξη είτε με τη συμπλήρωση ερωτηματολογίου). Ενώ η ανεξάρτητη είναι η μεταβλητή με τις τιμές: «η μονάδα ανάλυσης έχει δει το ντοκιμαντέρ», «η μονάδα ανάλυσης δεν έχει δει το ντοκιμαντέρ».

			Πρέπει όμως να πούμε πως η ανεξάρτητη μεταβλητή σε ένα πείραμα μπορεί να γίνει εξαρτημένη μεταβλητή σε ένα άλλο πείραμα. Για παράδειγμα, η προκατάληψη στο προηγούμενο παράδειγμα είναι η εξαρτημένη μεταβλητή, αλλά σ’ ένα άλλο πείραμα, που εξετάζει το αποτέλεσμα της προκατάληψης στην εκλογική συμπεριφορά, θα μπορούσε να είναι η ανεξάρτητη μεταβλητή.

			1.8.3.3 Προ-έλεγχος και μετα-έλεγχος

			Σε κάθε έρευνα το βασικό θέμα που ανακύπτει είναι η εγκυρότητάς της: το πρόβλημα αυτό επισημαίνεται κυρίως στο στάδιο του μετα-ελέγχου, γιατί στην πρώτη διεξαγωγή του ερωτηματολογίου οι ερωτώμενοι μπορεί (και πρέπει!) να αγνοούν το σκοπό του, ενώ στη δεύτερη διεξαγωγή είναι σχεδόν βέβαιο ότι θα αντιληφθούν το λόγο για τον οποίο διενεργείται η έρευνα και έτσι υπάρχει μεγάλη πιθανότητα να επηρεαστούν και να δώσουν άλλες απαντήσεις από αυτές που θα έδιναν αν ήταν ανεπηρέαστοι. Για παράδειγμα, κάποιος που συνειδητοποιεί ότι καταμετράται η προκατάληψή του κατά των γυναικών, το πιθανότερο είναι να δώσει απαντήσεις που να μην προδίδουν τέτοια προκατάληψη. Η μεροληψία στις απαντήσεις είναι το μεγάλο πρόβλημα που έχουν να αντιμετωπίσουν οι ερευνητές σε πειραματικούς σχεδιασμούς οικονομικών και κοινωνικών επιστημών. Αξιοσημείωτο είναι ότι μεροληψία προκύπτει ακόμα και σε θετικές επιστήμες (ιατρική, κ.λπ.) όπως θα αναφέρουμε πιο κάτω.

			1.8.3.4 Το κλασσικό πείραμα

			Το πρόβλημα της μεροληψίας των απαντήσεων αντιμετωπίστηκε από τους ερευνητές με τη χρησιμοποίηση δύο ομάδων. Το αποτέλεσμα της δράσης δεν θα μετράται από τα αποτελέσματα της πειραματικής ομάδας πριν και μετά τη επίδραση, όπως θα περίμενε κανείς, αλλά από τη σύγκριση μονάδων ανάλυσης που έχουν δεχτεί τη δράση (πειραματική ομάδα) και μονάδων ανάλυσης που δεν την έχουν δεχτεί (ομάδα ελέγχου). Το κλασσικό πείραμα παρουσιάζεται στο σχήμα που ακολουθεί.
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			Εικόνα 1.6: Το κλασσικό πείραμα

			Στην αρχή έχουμε δύο ομάδες ελέγχου, οι οποίες με κριτήρια πιθανοτικής δειγματοληψίας θα πρέπει να μοιάζουν μεταξύ τους. Πραγματοποιείται ο προ-έλεγχος, δηλ. καταμετρώνται ως προς την εξαρτημένη μεταβλητή (π.χ. την προκατάληψη κατά της «καταλληλότητας» των γυναικών για την ανάληψη διοικητικών καθηκόντων) οι μονάδες ανάλυσης της πειραματικής ομάδας και της ομάδας ελέγχου. Στην πειραματική ομάδα ασκείται η επιλεγείσα επίδραση και ξαναμετράται ως προς την εξαρτημένη μεταβλητή (μετα-έλεγχος), μετα-έλεγχος διενεργείται και στην ομάδα ελέγχου, παρά το γεγονός ότι αυτή δεν υποβάλλεται στη σχετική δοκιμασία. Το συμπέρασμα για το αν η δράση επηρεάζει το αποτέλεσμα, εξάγεται από τη σύγκριση των μετα-ελέγχων των δύο ομάδων. Με αυτό τον τρόπο δίνεται η δυνατότητα να υπολογίσουμε τη μεροληπτικότητα που προέρχεται από τις απαντήσεις που δίνει κάποιος ο οποίος συνειδητοποιεί ότι είναι «υποκείμενο πειράματος». Στο παράδειγμα της έρευνας, κάποιος που συνειδητοποιεί ότι η άποψή του για την «καταλληλότητα» των γυναικών-διευθυντών γίνεται αντικείμενο μελέτης, είναι λογικό να δώσει μεροληπτικές απαντήσεις στο μετα-έλεγχο για να μη δείχνει προκατειλημμένος. Έχοντας την ομάδα ελέγχου μπορούμε να εκτιμήσουμε το βαθμό της προκατάληψης και να συγκρίνουμε τα αποτελέσματα αυτά με το μετα-έλεγχο της πειραματικής ομάδας.

			Στο συγκεκριμένο πείραμα τα αναμενόμενα αποτελέσματα είναι: α) ότι το ντοκιμαντέρ δεν παίζει ρόλο και έτσι ο μετα-έλεγχος και για τις δύο ομάδες δίνει τον ίδιο βαθμό προκατάληψης και β) ότι το ντοκιμαντέρ παίζει ρόλο και η προκατάληψη στην πειραματική ομάδα είναι μικρότερη από αυτή της ομάδας ελέγχου.

			Το πόσο μεγάλο βαθμό παίζει η προκατάληψη φαίνεται από το «φαινόμενο Χόθορν»: Σε μία έρευνα στις αρχές του αιώνα οι ερευνητές ενδιαφέρονταν να μάθουν τους τρόπους με τους οποίους μπορούσε να αυξηθεί η παραγωγικότητα των εργαζομένων. Για αυτό το λόγο μελέτησαν τις συνθήκες εργασίας στο τηλεφωνικό κέντρο της εταιρείας στην περιοχή Χόθορν του Σικάγου. Τα αποτελέσματα της έρευνας ήταν ενθαρρυντικά, όταν βελτιώνονταν οι συνθήκες φωτισμού. Έτσι βγήκε το συμπέρασμα ότι οι συνθήκες φωτισμού βελτιώνουν την παραγωγικότητα. Για να είναι ασφαλές το συμπέρασμα επανέφεραν τις συνθήκες φωτισμού σταδιακά στις αρχικές συνθήκες, τότε με έκπληξη διαπίστωσαν ότι η παραγωγικότητα συνέχισε να βελτιώνεται! Έτσι το καταληκτικό συμπέρασμα είναι ότι η παραγωγικότητα βελτιωνόταν όχι λόγω φωτισμού, αλλά επειδή οι εργαζόμενοι ένοιωθαν πως τους έδιναν προσοχή οι ερευνητές.

			Ενδιαφέρον έχει το φαινόμενο της προκατάληψης του ερευνητή! Σε πολλές περιπτώσεις, κυρίως, όταν η μέτρηση είναι υποκειμενική, ο ερευνητής μπορεί να επηρεαστεί από τη γνώση ότι το υποκείμενο ανήκει στην πειραματική ομάδα. Λόγου χάρη ο γιατρός ερευνητής μπορεί να βλέπει βελτίωση στην κινητική κατάσταση ενός ασθενή, όταν πιστεύει ότι έχει πάρει ένα κατάλληλο φάρμακο. Για την περίπτωση αυτή εφαρμόζεται το «διπλά τυφλό πείραμα». Συγκεκριμένα στην περίπτωση δύο πειραματικών ομάδων, σύμφωνα με τις οποίες η μία λαμβάνει ψευδοφάρμακο, ενώ η άλλη λαμβάνει το πειραματικό φάρμακο, οι υπεύθυνοι ερευνητές δεν πρέπει να γνωρίζουν τί φάρμακο έχει χορηγηθεί στην κάθε ομάδα, ούτε όμως και οι ομάδες πρέπει να το γνωρίζουν αυτό, ούτως ώστε τα αποτελέσματα να είναι έγκυρα χωρίς μεροληψία. Ο τρόπος αυτός αποκαλείται «διπλά τυφλό πείραμα».

			1.8.3.5 «Ταίριασμα» και «Τυχαιοποίηση»

			Για να είναι σωστά εφαρμόσιμος ο κλασσικός σχεδιασμός, όπως αναφέρθηκε και πιο πάνω, θα πρέπει η ομάδα ελέγχου και η πειραματική ομάδα να μοιάζουν όσο το δυνατό περισσότερο σε κάποια χαρακτηριστικά. Αυτό επιτυγχάνεται ή με πιθανοτική δειγματοληψία ή με «ταίριασμα». Το συνηθέστερο παράδειγμα πιθανοτικής δειγματοληψίας είναι όταν και οι δύο ομάδες συλλέγονται με απλή δειγματοληψία από τον πληθυσμό. Σε τέτοια περίπτωση λαμβάνεται βεβαίως υπόψη και το μέγεθος του δείγματος που θα πρέπει να είναι ικανοποιητικό.

			Αν ο πληθυσμός είναι μικρός, συνήθως, ακολουθείται η διαδικασία «τυχαιοποίησης», δηλαδή χωρίζεται με τυχαίο τρόπο (κλήρωση) σε πειραματική ομάδα και ομάδα ελέγχου. Η «τυχαιοποίηση» είναι γενικά καλύτερος τρόπος από το «ταίριασμα», όταν δηλαδή για κάθε παρατήρηση από τη μία ομάδα, επιλέγουμε μία από την άλλη που της «ταιριάζει». Το κριτήριο για το «ταίριασμα» είναι η ομοιότητα σε περιορισμένο πλήθος παραγόντων, που ο ερευνητής κρίνει ως σημαντικότερους (π.χ. ηλικία, φύλο, οικογενειακή κατάσταση, κ.λπ.). Στην περίπτωση αυτή το μειονέκτημα της διαδικασίας είναι το ίδιο με την ποσοστική δειγματοληψία, οι παράγοντες που λαμβάνονται υπόψη είναι λίγοι και ο ερευνητής μπορεί να κάνει λάθος εκτίμηση για τους παράγοντες που επηρεάζουν την εξαρτημένη μεταβλητή που εξετάζεται. Το «ταίριασμα» πλεονεκτεί της «τυχαιοποίησης» και της πιθανοτικής δειγματοληψίας, μόνο όταν το πλήθος των μονάδων ανάλυσης είναι μικρό.

			1.8.3.6 Εγκυρότητα

			Υπάρχουν δύο ειδών παράγοντες οι οποίοι επηρεάζουν αρνητικά την πειραματική έρευνα, οι παράγοντες που αποτελούν πηγή έλλειψης εσωτερικής εγκυρότητας και οι παράγοντες που αποτελούν πηγή έλλειψης εξωτερικής εγκυρότητας.

			1.8.3.7 Πηγές έλλειψης εσωτερικής εγκυρότητας

			Οι Campbell και Stanley (1963) και οι Cook και Campbell (1979) εξέτασαν πηγές που επηρεάζουν την εσωτερική εγκυρότητα μιας έρευνας, όπως το ιστορικό της έρευνας, την ωρίμανση, την επίδραση του ελέγχου, την επίδραση των εργαλείων μέτρησης, την στατιστική παλινδρόμηση, τα σφάλματα μεροληπτικής επιλογής, την «πειραματική θνησιμότητα» και την αποθάρρυνση συμμετοχής στην έρευνα.

			
					Ένα γεγονός που γίνεται γνωστό κατά τη διάρκεια ενός πειράματος μπορεί να επηρεάσει το πείραμα. Για παράδειγμα, μία έρευνα η οποία εξέταζε την εμπιστοσύνη των πολιτών στην αμερικανική κυβέρνηση θα μπορούσε να επηρεαστεί από την αποκάλυψη του Snowden ότι οι αμερικανικές και βρετανικές κυβερνήσεις εφαρμόζουν πρόγραμμα μαζικής παρακολούθησης.

					Ανεξάρτητα με το αν το πείραμα είναι μακροχρόνιο ή όχι, το υποκείμενο επηρεάζεται από τον ψυχολογικό-ανθρώπινο παράγοντα. Αυτό σημαίνει ότι το υποκείμενο μπορεί να βαρεθεί, να πεινάσει/διψάσει, να κουραστεί, ή αν αναφερόμαστε σε μία μακροχρόνια περίοδο να έχει μία διαφορετική στάση απέναντι στο θέμα λόγω αλλαγής των αντιλήψεών του.

					Στην περίπτωση που το υποκείμενο γνωρίζει ότι ελέγχεται ίσως προσπαθήσει να δώσει τις απαντήσεις τις οποίες νομίζει ότι θέλουμε ή εκείνες που θα το κάνουν να φαίνεται καλύτερο.

					Στην περίπτωση που οι ομάδες που χρησιμοποιούνται στο πείραμα έχουν ακραίες παρατηρήσεις, τότε παρατηρείται στατιστική παλινδρόμηση. Ορισμένες φορές διεξάγουμε πειράματα σε υποκείμενα τα οποία ξεκινούν με ακραίες τιμές για την εξαρτημένη μεταβλητή. Σ’ αυτή την περίπτωση υπάρχει ο κίνδυνος οι αλλαγές που θα παρατηρηθούν να οφείλονται στο γεγονός ότι τα υποκείμενα εκκινούν από ακραία θέση και όχι λόγω επίδρασης του πειραματικού αποτελέσματος. Αν δοκιμάζουμε, π.χ. μία νέα μέθοδο προπόνησης σε μία ομάδα, η οποία είναι τελευταία στην κατάταξη του πρωταθλήματος, το γεγονός ότι ίσως βελτιώνεται δεν μπορεί να συνδεθεί με το πείραμα, αφού ακόμα και χωρίς πειραματικό ερέθισμα η βελτίωση είναι η μόνη αλλαγή που θα μπορούσε να συμβεί.

					Οι μονάδες ανάλυσης μπορεί να «πεθάνουν» κατά την έρευνα: Η κατηγορία αυτή δεν αναφέρεται στον βιολογικό θάνατο των υποκειμένων, αλλά στον θάνατο σε πειραματικό επίπεδο. Οποιοσδήποτε λόγος υποχρεώσει το υποκείμενο να εγκαταλείψει το πείραμα μετά τον προ-έλεγχο, ανήκει πλέον σε αυτήν την κατηγορία, αφού επηρεάζει τα τελικά αποτελέσματα.

			

			1.8.3.8 Πλεονεκτήματα και μειονεκτήματα

			Το βασικό πλεονέκτημα ενός ελεγχόμενου πειράματος έγκειται στην απομόνωση της επίδρασης της ανεξάρτητης μεταβλητής. Αυτό σημαίνει ότι η μεταβολή των στοιχείων από τον προ-έλεγχο στον μετα-έλεγχο οφείλεται στην επίδραση του πειράματος, αν οι μονάδες ανάλυσης δεν έχουν υποστεί μεταβολή με κάποιο άλλο τρόπο. Ακόμα το πείραμα δίνει τη δυνατότητα επανάληψης, γι’ αυτό είναι συνήθως πιο εύκολο από την επανάληψη δειγματοληπτικών ερευνών.

			 Μία δυσκολία του πειράματος (μειονέκτημα), που παρουσιάζεται, οφείλεται στο γεγονός ότι στην πραγματικότητα είναι δύσκολο να απομονώσουμε πλήρως τις συνθήκες πειράματος, όπως και να εξαλείψουμε την προκατάληψη των υποκειμένων του πειράματος, π.χ. στις απαντήσεις που δίνουν.

			1.8.3.9 Δεοντολογία και πειράματα

			Ζητήματα που προκύπτουν από τη διεξαγωγή ενός πειράματος είναι τα εξής: τα υποκείμενα, όπως και στην έρευνα πεδίου, δεν πρέπει να γνωρίζουν ότι μελετώνται, γιατί έτσι δημιουργούνται συνθήκες μεροληπτικότητας στη συμπεριφορά και στις απαντήσεις τους. Ακόμα ένα πείραμα μπορεί να δημιουργήσει τραύματα ψυχικά και σωματικά ή και προβλήματα υγείας (αν πρόκειται για ιατρικό πείραμα).

			1.8.4 Μη αντιδραστικές μέθοδοι ανάλυσης

			Μέχρι τώρα εξετάστηκαν μέθοδοι που, λίγο πολύ, προϋποθέτουν αλληλεπίδραση με τις μονάδες ανάλυσης, αφού κατά κανόνα η μονάδα ανάλυσης είναι άνθρωπος και για να δώσει την αναγκαία πληροφορία, χρειάζεται να υπάρχει αλληλεπίδραση μεταξύ αυτού και του ερευνητή. Ακολούθως θα γίνει αναφορά σε μεθόδους που δεν προϋποθέτουν αλληλεπίδραση με τις μονάδες ανάλυσης, γι’ αυτό λέγονται και μη αντιδραστικές μέθοδοι. Πολύ ωραίο παράδειγμα έχει ο Eugene Webb στο βιβλίο του Unobtrusive Research (1966) όπου παρουσιάζει παραδείγματα μη αντιδραστικών ερευνών. Ο Webb παραλληλίζει τη δουλειά που πρέπει να κάνει ο ερευνητής μ’ αυτή που κάνει ένας ντεντέκτιβ για να εξιχνιάσει μια υπόθεση. Ένα από τα πιο εντυπωσιακά παραδείγματα, που παρουσιάζει, είναι αυτό, κατά το οποίο ο ερευνητής προκειμένου να καταλήξει στο πιο ενδιαφέρον εύρημα ενός μουσείου, παρατηρεί τη φθορά του ξύλινου πατώματος μπροστά από κάθε εύρημα!

			Διακρίνουμε δύο τύπους μη αντιδραστικών μεθόδων: α) τις έρευνες περιεχομένου και β) τις έρευνες καταγεγραμμένων στατιστικών.

			 Έρευνες περιεχομένου είναι αυτές, που οι μονάδες ανάλυσης είναι καταγεγραμμένα αποτελέσματα ανθρώπινων δραστηριοτήτων ή επικοινωνιών (ιστοσελίδες, βιβλία κ.λπ.).

			Για μια έρευνα που αφορά στις συνθήκες εργαζομένων στο χρηματιστήριο της Νέας Υόρκης τη δεκαετία του 1970, π.χ. μπορεί να χρησιμοποιηθεί υλικό όπως φωτογραφίες, συλλογή άρθρων από τις εφημερίδες της εποχής, αγγελίες εφημερίδων για εργασία, δεδομένα με τιμές μετοχών της εποχής, κ.λπ.

			Άλλο παράδειγμα είναι η σύνδεση τηλεοπτικών διαφημίσεων με το περιεχόμενο των ταινιών που προβάλλονται. Παράδειγμα η σύνδεση των πολιτικών δημοσιογραφικών εκπομπών (talk show) με προϊόντα αντρικά ή γυναικεία προϊόντα. Το αποτέλεσμα αυτό θα επιβεβαιωθεί ή θα απορριφθεί με απλή καταγραφή των διαφημίσεων που παίχτηκαν τον τελευταίο μήνα σε όλα τα talk show της τηλεόρασης. Ακόμα πολύ ενδιαφέρον έχει, αν αλλάζει ο προσανατολισμός των διαφημίσεων σε μία συγκεκριμένη πολιτική εκπομπή, όπου γνωστός δημοσιογράφος καλεί κάθε φορά έναν πολιτικό (αν υπάρχει δηλαδή, διαφορά ανάλογα με τον πολιτικό προσανατολισμό του υποψηφίου (π.χ. αν είναι δεξιός, αριστερός κ.ο.κ.)

			Οι έρευνες καταγεγραμμένων στατιστικών είναι αυτές στις οποίες χρησιμοποιούνται καταγεγραμμένα στατιστικά είτε πρωτογενών δεδομένων είτε επεξεργασμένων, τα οποία μπορεί να παρέχονται από την Ελληνική Στατιστικής Αρχή, τη Eurostat, διαφόρους επιστημονικούς οργανισμούς, όπως το EKKE, τον Παγκόσμιο Οργανισμό Υγείας, συνδικαλιστικούς φορείς, όπως την ΑΔΕΔΥ, τη ΓΕΣΕΕ, κ.λπ. Ας δούμε μερικά παραδείγματα:

			
					Έστω ότι θέλουμε να συνδυάσουμε την εκλογική απήχηση των δύο κορυφαίων κομμάτων σε μία χώρα με την οικονομική κατάσταση των ψηφοφόρων. Μία έρευνα που θα είχε διαθέσιμα ποσοστά των κομμάτων και κατά κεφαλήν εισοδήματα, θα μπορούσε να δώσει τεκμηριωμένες απαντήσεις σε αυτό το ζήτημα.

					Έστω ότι θέλουμε να διερευνήσουμε την επίδραση της οικονομικής κατάστασης κρατών σε σχέση με το επίπεδο υγειονομικής περίθαλψης των κατοίκων. Θα χρησιμοποιηθούν υφιστάμενα στατιστικά που αφορούν στο ΑΕΠ των χωρών, στο προσδόκιμο ζωής των κατοίκων, στον αριθμό των γιατρών ανά 10.000 κατοίκους, στον αριθμό νοσοκομειακών κλινών ανά 1.000 κατοίκους κ.λπ.

			

			1.8.4.1 Πλεονεκτήματα και μειονεκτήματα

			Το μεγάλο πλεονέκτημα των μη αντιδραστικών μεθόδων είναι ότι είναι οικονομικές, ως επί το πλείστον πραγματοποιούνται από ένα ερευνητή, ο οποίος έχει να συλλέξει δεδομένα συνήθως με μικρό ή μηδενικό κόστος. Επίσης επιτρέπει τη διόρθωση των σφαλμάτων στο σχεδιασμό ή στην καταγραφή. Αντίθετα π.χ. με τις δειγματοληπτικές έρευνες, αν προκύψει κάποιο πρόβλημα, μπορεί να συλλεχθούν επιπλέον μονάδες ανάλυσης ή να μελετηθούν άλλα άτομα. Ακόμα σε αντίθεση με πειραματικούς σχεδιασμούς και δειγματοληπτικές μεθόδους, επειδή οι μονάδες ανάλυσης δεν είναι άνθρωποι, η πραγματοποίηση μιας έρευνας δεν δημιουργεί ψυχικές και σωματικές βλάβες σε ανθρώπους (ή πειραματόζωα). Ακόμα για την άρτια πραγματοποίησή τους δεν χρειάζεται να ειπωθούν ψέματα ώστε να αποκρυφτεί η ιδιότητα του ερευνητή (όπως στην έρευνα πεδίου).

			1.8.4.2 Δεοντολογία μη αντιδραστικών ερευνών

			Επειδή δεν γίνεται απόκρυψη του ρόλου του ερευνητή σ’ αυτού του είδους τις έρευνες, τα δεοντολογικά θέματα είναι από μικρά έως ανύπαρκτα. Το μόνο πρόβλημα που μπορεί να υπάρχει είναι ως προς τη δημοσιοποίηση προσωπικών δεδομένων σε μία έρευνα, π.χ. που κάνει χρήση αλληλογραφίας μέσω e-mails κ.λπ.
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			Κεφάλαιο 2

			Δειγματοληπτικές Έρευνες

			Σύνοψη

			Στο κεφάλαιο αυτό εξετάζονται τεχνικά ζητήματα δειγματοληπτικών ερευνών οι οποίες θεωρούνται ως η πιο διαδεδομένη ερευνητική μέθοδος στις κοινωνικές επιστήμες και στις επιστήμες διοίκησης και οικονομίας. Ελέγχεται η εγκυρότητα και η αξιοπιστία ερωτηματολογίου, η παρουσίαση και η ανάλυση αποτελεσμάτων και η σύγκριση των ευρημάτων µε άλλες μεθόδους έρευνας και τέλος καταγράφονται τα πλεονεκτήματα και μειονεκτήματα δειγματοληπτικών ερευνών. Πιο εκτεταμένη αναφορά γίνεται στις δημοσκοπήσεις που αποτελούν ειδική κατηγορία δειγματοληπτικών ερευνών.

			Προαπαιτούμενη γνώση

			Προαπαιτούμενη γνώση ουσιαστικά δεν υπάρχει. Καλύτερη κατανόηση του κεφαλαίου όμως θα είναι δυνατή αν ο αναγνώστης έχει γνώσεις δειγματοληψίας (που μπορούν να προκύψουν από τη σωστή μελέτη του προηγούμενου κεφαλαίου). Τα εγχειρίδια που παρουσιάζουν με πληρότητα τις δειγματοληπτικές μεθόδους έρευνας είναι πολλά, ενδεικτικά αναφέρονται τα βιβλία των E. Babbie, D. Morgan, και M. Grawitz (βλ. βιβλιογραφικές αναφορές) ακόμα αναφέρονται ενδεικτικά τα βιβλία των R. Alvarez et.al και G. Μichelat και J.P. Thomas για τον χώρο των δημοσκοπήσεων. Όπως έχω αναφέρει και στον πρόλογο σημαντική είναι η συμβολή των φοιτητών μου Γ. Φλουρή, Ι. Νταβή, Γ. Τσιτμηδέλη και Ε. Τριανταφύλλου.

			2.1. Εισαγωγή

			Το πιο διαδεδομένο είδος έρευνας στις επιστήμες διοίκησης και οικονομίας και στις κοινωνικές επιστήμες είναι οι δειγματοληπτικές έρευνες, οι οποίες εφαρμόζονται σε όλους τους σχετικούς ερευνητικούς τομείς και διακρίνονται τόσο για την ευκολία της ανάλυσης των δεδομένων που προκύπτουν, όσο και για την ευκολία εξαγωγής συμπερασμάτων.

			2.2.1 Ερωτηματολόγιο

			Το ερωτηματολόγιο αποτελεί το θεμελιώδες στοιχείο σε κάθε δειγματοληπτική έρευνα, αλλά και στα πειράματα, στις έρευνες πεδίου και σε άλλες δραστηριότητες που χρειάζονται για τη συγκέντρωση πληροφοριών, στοιχείων και δεδομένων. Έτσι η κατασκευή ενός ερωτηματολογίου είναι πολύ σημαντική, επειδή αυτό παρέχει ουσιαστικά τα δεδομένα της έρευνας, οπότε θα πρέπει να τηρούνται κάποιες αρχές για να είναι αξιοποιήσιμη η πληροφορία που προκύπτει.

			Η μορφή ενός ερωτηματολογίου είναι επίσης πολύ σημαντική για το είδος και τη διατύπωση των ερωτήσεων που αυτό περιλαμβάνει. Ένα ερωτηματολόγιο θα πρέπει να είναι οργανωμένο, σαφές, σύντομο, και να εμπεριέχει τις αναγκαίες οδηγίες και υποδείξεις.

			Για να επιτυγχάνονται τα προαναφερθέντα θα πρέπει να προηγείται ο κατάλληλος σχεδιασμός και έλεγχος. Αρχικά επιλέγεται η κατάλληλη μορφή ερωτήσεων. Οι ερωτήσεις μπορούν να είναι δύο ειδών: είτε κλειστού τύπου όπου ο ερωτώμενος καλείται να επιλέξει μεταξύ συγκεκριμένων απαντήσεων είτε ανοιχτού τύπου όπου ο ερωτώμενος απαντά στην ερώτηση συμπληρώνοντας το κενό περιθώριο που προβλέπεται για να καταχωρίσει την απάντησή του. Έτσι η επιλογή της μορφής των ερωτήσεων γίνεται με κριτήριο την αποτελεσματικότητα, την ευελιξία, το ενδιαφέρον, την ομοιογένεια και κυρίως την καταλληλότητα στην επεξεργασία των δεδομένων.

			Προφανώς οι κλειστές ερωτήσεις υπερτερούν στην ευκολία ανάλυσης των δεδομένων, ενώ οι ανοιχτές δίνουν επιπλέον δυνατότητα στον ερωτώμενο να ξεδιπλώσει τη σκέψη του.

			Σε γενικές γραμμές θα πρέπει να προηγούνται ανοιχτές ερωτήσεις με ανάλογο περιεχόμενο και κλειστές, που θα έπονται. Προϋποθέσεις για ένα σωστό ερωτηματολόγιο θεωρούνται:

			
					Η διατύπωση σαφών και μονοσήμαντων ερωτήσεων: Συχνά ο ερευνητής παρασυρόμενος από τη γνώση που έχει σε κάποιο θέμα θεωρεί αυτονόητα πράγματα που δεν είναι. Παράδειγμα: λάθος μπορεί να είναι η ερώτηση «Ποια είναι η γνώμη σας για το νέο νομοσχέδιο της παιδείας που αφορά στη μεταγραφή των φοιτητών;». Στο ερώτημα αυτό σίγουρα θα υπάρχουν και ερωτώμενοι που δεν γνωρίζουν σε τι αφορά το συγκεκριμένο νομοσχέδιο.

					Η αποφυγή διφορούμενων ερωτήσεων: Οι συντάκτες συνήθως επιθυμούν μια και μοναδική απάντηση σε ένα ερώτημα που μπορεί να περιέχει ποικίλες απαντήσεις, γι’ αυτό πρέπει οι δυνατές απαντήσεις να μην επικαλύπτονται. Παράδειγμα: στην ερώτηση «Η Ελλάδα πρέπει να σκληρύνει τη στάση της απέναντι στην Τουρκία στο θέμα των γκρίζων ζωνών του Αιγαίου»; Παρά το ότι κάποιοι θα απαντήσουν ξεκάθαρα ναι ή ξεκάθαρα όχι, σημαντικό ποσοστό των ερωτώμενων θα θέλει διευκρίνιση στο τί είναι σκλήρυνση της στάσης καθώς και το ποιες θεωρείται ότι θα είναι οι επιπτώσεις.

					Η αντίληψη της ικανότητας απάντησης των ερωτώμενων: Πολλές φορές οι ερωτώμενοι νομίζουν ότι ξέρουν να απαντήσουν, αλλά οι απαντήσεις που δίνουν δεν είναι σωστές. Παράδειγμα: στην ερώτηση «Το κυκλοφοριακό συγκοινωνιακό σύστημα στην Αθήνα έχει βελτιωθεί σε σχέση με τη δεκαετία του ενενήντα»; Είναι μία ερώτηση που ο ερωτώμενος θα πρέπει να ανακαλέσει στη μνήμη του την κατάσταση της συγκοινωνίας 25 χρόνια πριν. Σε τέτοια περίπτωση είναι δύσκολο να περιμένουμε αξιόπιστες απαντήσεις. Επειδή επίσης μόνιμα οι συντάκτες ερωτηματολογίου έχουν την αμφιβολία αν είναι αξιόπιστες οι απαντήσεις των ερωτώμενων, σε περιπτώσεις που οι απαντήσεις αφορούν σε προσωπικά βιώματα, καλό είναι να υπάρχουν ερωτήσεις ελέγχου αξιοπιστίας, π.χ. με μια ερώτηση διαπίστωσης ενός ιστορικού γεγονότος της εποχής που καλούμε τους ερωτώμενους να μας δώσουν πληροφορίες.

					Η απροθυμία των ερωτώμενων να απαντήσουν: Πολλές φορές οι ερωτώμενοι είναι απρόθυμοι και διστακτικοί να βοηθήσουν δίνοντας απάντηση σε ερωτήσεις που θίγουν πολιτικά, ηθικά ζητήματα κ.ά. και τίθενται από κάποιον που δεν γνωρίζουν. Χαρακτηριστικό είναι ότι σε απολυταρχικά καθεστώτα οι ερωτώμενοι διστάζουν να απαντήσουν ακόμα και σε ερωτήματα που αφορούν στη γνώση ενός προϊόντος κ.ο.κ. Γεγονός που πρέπει να λαμβάνεται υπόψη και κατά τη δημιουργία σχετικών ερωτήσεων. Οι ερωτήσεις που εμπεριέχονται σε ένα ερωτηματολόγιο θα πρέπει να είναι σχετικές με τους ερωτώμενους και κατανοητές από αυτούς, καθώς δεν πρέπει να τους ζητούν να σκεφθούν για θέματα που δεν τους έχουν απασχολήσει. Ωραίο παράδειγμα ελέγχου αξιοπιστίας σε ένα ερωτηματολόγιο αναγνωσιμότητας πολιτικών είναι αυτό που εμπεριέχει στο ερωτηματολόγιο ερωτήματα σχετικά με την ύπαρξη ενός πολιτικού που δεν υπάρχει κ.ο.κ.

					Η αποτύπωση σύντομων ερωτήσεων: Οι ερωτώμενοι κουράζονται από πολύπλοκα και μεγάλης έκτασης ερωτηματολόγια, οι σύντομες και σαφείς ερωτήσεις είναι ιδανικές.

					Η αποφυγή ερωτήσεων αρνητικού περιεχομένου: Πάντα ελλοχεύει ο κίνδυνος να παρανοήσουν οι ερωτώμενοι κάτι και λέξεις όπως το «δεν», «ναι ή όχι» συμβαίνει να δημιουργούν κάποια προκατάληψη στους ερωτώμενους. Οι περισσότεροι ερωτώμενοι συμπληρώνουν γρήγορα το ερωτηματολόγιο και είναι πιθανό να μην προσέξουν ότι η ερώτηση είναι αρνητική. Παράδειγμα λάθους ερώτησης: «Η Ελλάδα δεν πρέπει να είναι υπέρ της ένταξης της Τουρκίας στην Ευρωπαϊκή Ένωση;».

					Η παράλειψη προκατειλημμένων και μεροληπτικών ερωτήσεων και όρων: Επειδή τέτοιες λέξεις μπορεί να επηρεάσουν τον ερωτώμενο να απαντήσει σε μια συγκεκριμένη κατεύθυνση ή μπορεί να υπάρξει η ταύτιση κάποιου ατόμου με μια συγκεκριμένη κατεύθυνση (κάτι που οδηγεί σε έλλειψη εγκυρότητας). Παράδειγμα λάθους διατύπωσης: «Συμφωνείτε με την άποψη των δανειστών της Ελλάδας ότι οι Έλληνες δεν εργάζονται όσο οι άλλοι Ευρωπαίοι (!);».

					Η μορφή των ερωτήσεων: Η μορφή των ερωτήσεων ενός ερωτηματολογίου μπορεί να δίνει τη δυνατότητα στους ερωτώμενους να επιλέξουν την απάντηση από μια λίστα πιθανών απαντήσεων (μέσα σε κουτάκια ή με κωδικό αριθμό δίπλα σε αυτές από ένα πρόγραμμα επεξεργασίας του υπολογιστή). Επίσης, μπορεί να εμπεριέχονται ερωτήσεις συνάφειας, η σωστή χρήση τους μπορεί να κάνει πιο εύκολο το έργο των ερωτώμενων και τις απαντήσεις πιο σαφείς και αποτελεσματικές. Σε αυτή την περίπτωση θα πρέπει να περιλαμβάνονται οδηγίες στην επικεφαλίδα κάθε σελίδας όπου αναγράφεται η ερώτηση συνάφειας. Μια άλλη μορφή είναι οι ερωτήσεις πίνακα ή κλίμακας Likert που είναι ένας πίνακας που περιέχει ερωτήσεις με πέντε ή επτά πιθανές απαντήσεις (π.χ. πολύ δυσαρεστημένος/η, δυσαρεστημένος/η, ούτε δυσαρεστημένος/η, ούτε ικανοποιημένος/η, ικανοποιημένος/η, πολύ ικανοποιημένος/η). Τα πλεονεκτήματα αυτής της μορφής είναι ότι χρησιμοποιείται εποικοδομητικά και αποτελεσματικά ο χώρος, είναι πιο γρήγορη η συμπλήρωση του ερωτηματολογίου και έχουν τη δυνατότητα οι ερωτώμενοι να συγκρίνουν της απαντήσεις τους. Υπάρχουν, όμως, και κάποια μειονεκτήματα σε αυτή τη μορφή ερωτηματολογίου: δεν αποτυπώνεται από τη διάταξη των απαντήσεων η ιδιοσυγκρασία του κάθε ερωτώμενου, ακόμα λόγω της δομής των απαντήσεων πολλές φορές ο ερωτώμενος μπαίνει στον πειρασμό να απαντά με ταχύτητα, κάνοντας πρόχειρη ανάγνωση, επειδή θεωρεί ότι λίγο πολύ όλες οι απαντήσεις κινούνται στην ίδια κατεύθυνση.

					Η διάταξη των ερωτήσεων: Η σειρά των ερωτήσεων ενός ερωτηματολογίου είναι σημαντική καθώς μπορεί να επηρεάσει τις απαντήσεις των ερωτώμενων. Παράδειγμα: έστω ότι υπάρχει μια ανοιχτή ερώτηση «Ποιο είναι το σημαντικότερο πρόβλημα της Ελλάδας σήμερα;» και μετά από λίγες ερωτήσεις ακολουθεί η ερώτηση κλειστού τύπου «Συμφωνείτε με την άποψη ότι η ανεργία των νέων είναι σε δυσθεώρητα όρια;» με απαντήσεις τύπου Likert καθόλου, λίγο, αρκετά, πολύ, πάρα πολύ. Προφανώς αν η δεύτερη ερώτηση γίνει πριν από την πρώτη, τότε οι απαντήσεις στην πρώτη ερώτηση θα είναι τελείως διαφορετικές. Πολλές φορές οι ερευνητές-συντάκτες προβαίνουν σε μια τυχαία σειρά των στοιχείων του ερωτηματολογίου. Το καλύτερο είναι να γίνεται εκτίμηση των συνεπειών της σειράς των ερωτήσεων. Είναι διαφορετική η σειρά στα ατομικής συμπλήρωσης ερωτηματολόγια και στις συνεντεύξεις. Ακόμα, τα δημογραφικά στοιχεία θα πρέπει να τοποθετούνται στο τέλος ενός ερωτηματολογίου και όχι στην αρχή.

			

			Όπως αναφέρθηκε παραπάνω σε ένα ερωτηματολόγιο είναι αναγκαίο να περιέχονται ακριβείς οδηγίες και εισαγωγικά σχόλια για να διευκολύνεται ο ερωτώμενος ως προς την συμπλήρωσή του. Στις ερωτήσεις ανοικτού τύπου θα πρέπει να προσδιορίζεται το μέγεθος των απαντήσεων των ερωτώμενων σε κάθε ερώτηση από τους συντάκτες. Τα ερωτηματολόγια που περιέχουν ενότητες ή υποενότητες θα πρέπει να περιλαμβάνουν και μια εξήγηση από κάτω και κάποιες ερωτήσεις μπορεί να χρειάζονται ειδικές οδηγίες με σκοπό να απαντηθούν σωστά από τους ερωτώμενους.

			Τέλος, θα πρέπει οι συντάκτες να προβαίνουν σε ένα προέλεγχο του ερωτηματολογίου πριν την δημοσίευσή του. Ένας τρόπος είναι η ανάγνωσή του, δηλαδή να ζητηθεί από τους συντάκτες να διαβάσουν το ερωτηματολόγιο άλλοι άνθρωποι και να διατυπώσουν τις απόψεις τους για αυτό ή να πραγματοποιήσουν μιας μικρής έκτασης πιλοτική έρευνα.

			Συνοψίζοντας, θα πρέπει οι ερευνητές να διατυπώσουν το σκοπό της έρευνάς τους και να συντάξουν το ερωτηματολόγιο που θα εξυπηρετεί τον σκοπό αυτό λαμβάνοντας υπόψη όλα τα παραπάνω, στη συνέχεια θα δούμε παραδείγματα μελετών περίπτωσης σχεδιασμού ερωτηματολογίων.

			2.2.2 Δείγματα ερωτηματολογίων

			Κατωτέρω παρατίθενται κάποια ερωτηματολόγια που περιλαμβάνουν όλα τα στοιχεία που αναπτύξαμε παραπάνω λεπτομερώς. Τα συγκεκριμένα ερωτηματολόγια συντάχθηκαν από τις απόφοιτες του μεταπτυχιακού προγράμματος «Διεθνής Διοικητική των Επιχειρήσεων» Ιωάννα Νταβή και Γεωργία Τσιτμηδέλη στα πλαίσια των διπλωματικών τους εργασιών, επιβλέπων καθηγητής ήταν ο Μ. Χαλικιάς.

			Ερωτηματολόγιο 1

			Θέμα: «Η επίδραση της οικονομικής κρίσης στην ισορροπία εργασιακής και προσωπικής ζωής (work life balance). Μελέτη περίπτωσης: Η Εθνική Τράπεζα».

			Συντάκτης ερωτηματολογίου: Ιωάννα Νταβή

			1η Ενότητα: Ισορροπία Εργασίας-Οικογένειας

			(Κλίμακα Likert)

			[image: ]

			Πίνακας 2.1: Πίνακας ερωτηματολογίου 1 (πρώτη ενότητα)

			2η Ενότητα: Εργασιακή Ικανοποίηση

			(Κλίμακα Likert)

			[image: ]

			Πίνακας 2.2: Πίνακας ερωτηματολογίου 1(δεύτερη ενότητα)

			3η Ενότητα: Εργασιακή Πίεση

			(Κλίμακα Likert)
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			Πίνακας 2.3: Πίνακας ερωτηματολογίου 1 (τρίτη ενότητα)

			4η Ενότητα: Πρακτικές για τη συμφιλίωση εργασιακής και προσωπικής ζωής

			(Κλίμακα Likert)
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			Πίνακας 2.4: Πίνακας ερωτηματολογίου 1 (τέταρτη ενότητα)

			5η Ενότητα: Δημογραφικά Στοιχεία

			Παρακαλώ δηλώστε αν συμφωνείτε ή διαφωνείτε με την παρακάτω πρόταση

			1. Στις σημερινές οικονομικές συνθήκες, ο μισθός μου δεν είναι επαρκής για να τα βγάλω πέρα:
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			Πίνακας 2.5: Πίνακας ερωτηματολογίου 1 (ικανοποίηση από το μισθό)

			2. Φύλο:
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			Πίνακας 2.6: Πίνακας ερωτηματολογίου 1 (φύλο)

			3. Ηλικία:
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			Πίνακας 2.7: Πίνακας ερωτηματολογίου 1 (ηλικία)

			4. Οικογενειακή κατάσταση:
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			Πίνακας 2.8: Πίνακας ερωτηματολογίου 1 (οικογενειακή κατάσταση)

			5. Πόσα παιδιά και εξαρτώμενα άτομα έχετε στις πιο κάτω κατηγορίες; Παρακαλώ σημειώστε τον ακριβή αριθμό:

			[image: ]

			Πίνακας 2.9: Πίνακας ερωτηματολογίου 1 (αριθμός παιδιών)

			6. Επίπεδο εκπαίδευσης:
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			Πίνακας 2.10: Πίνακας ερωτηματολογίου 1 (επίπεδο εκπαίδευσης)

			7. Συμβόλαιο εργασίας:
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			Πίνακας 2.11: Πίνακας ερωτηματολογίου 1 (σχέση εργασίας)

			8. Πόσο χρονικό διάστημα εργάζεστε σε αυτή τη θέση;
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			Πίνακας 2.12: Πίνακας ερωτηματολογίου 1 (αριθμός ετών προυπηρεσίας)

			9. Απασχόληση:
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			Πίνακας 2.13: Πίνακας ερωτηματολογίου 1 (είδος απασχόλησης)

			10. Η εργασία σας είναι σχετική με τις σπουδές σας;
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			Πίνακας 2.14: Πίνακας ερωτηματολογίου 1 (συνάφεια με σπουδές)

			11. Μηνιαίο εισόδημα σε ευρώ:
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			Πίνακας 2.15: Πίνακας ερωτηματολογίου 1 (μηνιαίο εισόδημα)

			12. Ο/η σύζυγος/σύντροφός σας εργάζεται;
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			Πίνακας 2.16: Πίνακας ερωτηματολογίου1 (απασχόληση συζύγου)

			13.Υπό κανονικές συνθήκες, καθημερινά ποιος είναι ο συνολικός χρόνος για τη μετάβασή σας στην εργασία και την επιστροφή στο σπίτι:
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			Πίνακας 2.17: Πίνακας ερωτηματολογίου 1 (χρόνος μετάβασης στην εργασία)

			Ερωτηματολόγιο 2

			Θέμα: «Σχέση προϊστάμενου-υφιστάμενου και η επίδραση στην εργασιακή ικανοποίηση και απόδοση του υφισταμένου».

			Συντάκτης ερωτηματολογίου: Γεωργία Τσιτμηδέλη

			Ερωτηματολόγιο Υφισταμένων

			Αρχή Φόρμας

			1. Σε ποιο βαθμό επηρεάζεται η εργασιακή σας ικανοποίηση και απόδοση από τους παρακάτω παράγοντες;
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			Πίνακας 2.18: Πίνακας ερωτηματολογίου 2 (επιρροή εργασιακής ικανοποίησης και απόδοσης)

			2. Σε ποιον βαθμό τα παρακάτω στοιχεία της σχέσης μεταξύ προϊστάμενου και υφιστάμενου επιδρούν στην εργασιακή ικανοποίηση και απόδοσή σας;
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			Πίνακας 2.19: Πίνακας ερωτηματολογίου 2 (επιρροή σχέση προϊστάμενου-υφιστάμενου στην εργασιακή ικανοποίηση και απόδοση)

			3. Στο τμήμα που εργάζομαι ο προϊστάμενος μου για να είναι αποτελεσματικός θα πρέπει να:
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			Πίνακας 2.20: Πίνακας ερωτηματολογίου 2 (αποτελεσματικότητα προϊσταμένου)

			4. Σε ποιον βαθμό επηρεάζεται η απόδοσή σας στην εργασία από τα παρακάτω;
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			Πίνακας 2.21: Πίνακας ερωτηματολογίου 2 (επιρροή στην απόδοση)

			5. Πόσο σας εκφράζουν τα παρακάτω σχετικά με την «ισορροπημένη» σχέση μεταξύ του προϊστάμενου και του υφιστάμενου:
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			Πίνακας 2.22: Πίνακας ερωτηματολογίου 2 (στοιχεία ισορροπίας σχέσης προϊσταμένου-υφισταμένου)

			Στοιχεία Ερωτηθέντων

			1. Φύλο:
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			Πίνακας 2.23: Πίνακας ερωτηματολογίου 2 (φύλο)

			2. Σε ποιο ηλικιακό γκρουπ ανήκετε;
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			Πίνακας 2.24: Πίνακας ερωτηματολογίου 2 (ηλικία)

			3. Ποιο είναι το ανώτερο επίπεδο σπουδών που έχετε συμπληρώσει;
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			Πίνακας 2.25: Πίνακας ερωτηματολογίου 2 (εκπαιδευτικό επίπεδο)

			3. Σε ποιο μαιευτήριο εργάζεστε;
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			4. Ποιος είναι ο τίτλος της θέσης εργασίας σας;
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			5. Πόσο χρονικό διάστημα εργάζεστε στο μαιευτήριο;
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			Πίνακας 2.26: Πίνακας ερωτηματολογίου 2 (έτη προϋπηρεσίας)

			6. Πόσο χρονικό διάστημα συνεργάζεστε με τον προϊστάμενο σας;
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			Πίνακας 2.27: Πίνακας ερωτηματολογίου 2 (έτη συνεργασίας με τον συγκεκριμένο προϊστάμενο)

			7. Σχόλια

			Ερωτηματολόγιο Προϊσταμένων

			Αρχή Φόρμας:

			1. Ποια είναι η άποψή σας για τα παρακάτω;
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			Πίνακας 2.28: Πίνακας ερωτηματολογίου 2 (επιρροή της σχέσης προϊσταμένου-υφισταμένου στην εργασιακή απόδοση)

			2. Προσδιορίστε το βαθμό που σας αντιπροσωπεύουν τα παρακάτω:

			Στο τμήμα που ηγούμαι θα πρέπει να:
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			Πίνακας 2.29: Πίνακας ερωτηματολογίου 2 (ρόλος του προϊσταμένου)

			3. Προσδιορίστε σε ποιο βαθμό τα παρακάτω συντελούν στην προσωπική σας επιτυχία:
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			Πίνακας 2.30: Πίνακας ερωτηματολογίου 2 (παράγοντες επιτυχίας προϊσταμένου)

			4. Πόσο σας εκφράζουν τα παρακάτω σχετικά με την «ισορροπημένη» σχέση μεταξύ του προϊστάμενου και του υφιστάμενου.

			[image: ]

			Πίνακας 2.31: Πίνακας ερωτηματολογίου 2 (ισορροπία σχέσης προϊσταμένου-υφισταμένου)

			Στοιχεία Ερωτηθέντων

			1. Φύλο:
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			Πίνακας 2.32: Πίνακας ερωτηματολογίου 2 (φύλλο)

			2. Σε ποιο ηλικιακό γκρουπ ανήκετε;
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			Πίνακας 2.33: Πίνακας ερωτηματολογίου 2 (ηλικία)

			3. Ποιο είναι το ανώτερο επίπεδο σπουδών που έχετε συμπληρώσει;
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			Πίνακας 2.34: Πίνακας ερωτηματολογίου 2 (εκπαιδευτικό επίπεδο)

			3. Σε ποιο μαιευτήριο εργάζεστε;
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			4. Ποιος είναι ο τίτλος της θέσης εργασίας σας;
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			5. Πόσο χρονικό διάστημα εργάζεστε στο μαιευτήριο;
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			Πίνακας 2.35: Πίνακας ερωτηματολογίου 2 (έτη προϋπηρεσίας)

			6. Πόσο χρονικό διάστημα είστε προϊστάμενος;
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			Πίνακας 2.36: Πίνακας ερωτηματολογίου 2 (έτη προϋπηρεσία σε θέση προϊσταμένου)

			Στα παραπάνω ερωτηματολόγια παρατηρούμε ότι τα θέματα που αναλύονται (π.χ. επιρροή εργασίας στην οικογένεια, ικανοποίηση από τη δουλειά κ.ο.κ.) δεν καλύπτονται από μία ερώτηση, αλλά από σειρά ερωτήσεων που καλύπτουν το θέμα σφαιρικά. Συνήθως σε τέτοιες περιπτώσεις κατά τη στατιστική ανάλυση χρησιμοποιείται factor analysis, όπου από ένα σετ πολλών συσχετισμένων μεταβλητών προκύπτει ένα σετ λίγων και ασυσχέτιστων μεταβλητών που περιέχει σημαντικό μέρος της πληροφορίας του αρχικού σετ δεδομένων.

			2.2.3 Ερωτηματολόγια ατομικής συμπλήρωσης

			Οι βασικές μέθοδοι υποβολής ερωτηματολογίου σε ένα δείγμα είναι:

			
					Τα παραδοσιακά τυπωμένα ερωτηματολόγια ατομικής συμπλήρωσης που συμπληρώνονται είτε ταχυδρομικά είτε μέσω συνεντεύξεων,

					Οι έρευνες μέσω τηλεφώνου,

					Οι έρευνες μέσω διαδικτύου.

			

			Η πιο συχνή μορφή ερωτηματολογίου ατομικής συμπλήρωσης είναι η ταχυδρομική έρευνα. Η διαδικασία έχει ως εξής: ένας εργαζόμενος στην έρευνα παραδίδει το ερωτηματολόγιο στο σπίτι του ερωτώμενου και του εξηγεί σχετικά τα θέματα που θέτει η έρευνα. Έπειτα αφήνει το ερωτηματολόγιο προκειμένου να συμπληρωθεί και αργότερα περνά να το παραλάβει.

			Μπορεί, επίσης, να υπάρξει συνδυασμός τεχνικών, δηλ. της παράδοσης στο σπίτι και της ταχυδρόμησης του ερωτηματολογίου. Γενικά φαίνεται να είναι υψηλότερο το ποσοστό απαντήσεων σ’ αυτή την περίπτωση, απ’ όταν η έρευνα διεξάγεται απλά ταχυδρομικά.

			2.2.4 Ταχυδρόμηση και επιστροφή

			Στην έρευνα μέσω ταχυδρομείου, αποστέλλονται τα ερωτηματολόγια με σκοπό να συμπληρωθούν από τους ερωτώμενους και αναμένεται να ταχυδρομηθούν συμπληρωμένα. Στη μέθοδο αυτή υπάρχει ένα πρόβλημα: η μη επιστροφή του ερωτηματολογίου.

			Για να μειωθούν στο ελάχιστο οι περιπτώσεις αυτές καλό είναι τεχνικά ζητήματα όπως το μέγεθος του φακέλου, η ευκολία αποστολής του φακέλου (όπου πρέπει σίγουρα να αναγράφεται η διεύθυνση του ερευνητή και να προσφέρεται το γραμματόσημο), ο καθορισμός του τρόπου αποστολής (συστημένο ή απλό, αν το επιτρέπει ο προϋπολογισμός των οικονομικών της έρευνας προφανώς θα πρέπει να είναι συστημένο) να αντιμετωπίζονται έγκαιρα και να επιλύονται με τον καλύτερο τρόπο.

			2.2.5 Παρακολούθηση των επιστροφών

			Αποτελεί πάντα σημαντική πληροφορία πόσοι και ποιοι απαντούν στα ερωτηματολόγια, γιατί έτσι μπορούμε να αποφύγουμε κάποια μεροληπτικά αποτελέσματα. Παράδειγμα: αν σε μία ιατρική έρευνα δούμε ότι το μεγάλο ποσοστό των ερωτηματολογίων που δεν απαντήθηκαν ήταν τα ερωτηματολόγια που είχαν δοθεί σε βαριά ασθενείς, το γεγονός θα αξιολογηθεί διαφορετικά από την περίπτωση που οι ερωτώμενοι, που δεν απάντησαν, ανήκαν σε άλλες κοινωνικές ομάδες.

			2.2.6 Επαναληπτικές αποστολές

			Καλό είναι σε ερωτώμενους που δεν απάντησαν να γίνουν επαναληπτικές αποστολές. Ο απλούστερος τρόπος, είναι τους σταλεί το ερωτηματολόγιο ξανά. Άλλος τρόπος είναι η αποστολή επιστολής σε όσους δεν επέστρεψαν το ερωτηματολόγιο, σε αυτήν την περίπτωση καλύτερα είναι να επισυνάπτεται στην επιστολή αντίγραφο του ερωτηματολογίου. Ο δεύτερος τρόπος πρέπει να προσεχθεί ώστε να μη φέρει εκνευρισμό στον ερωτώμενο. Οι επαναληπτικές είναι αποτελεσματική μέθοδος, καθώς ανεβάζει το ποσοστό απόκρισης μιας ταχυδρομικής έρευνας.

			2.2.7 Ποσοστό απόκρισης

			Σημαντικό είναι να εξετάσουμε το ποσοστό των ατόμων του δείγματος που απάντησαν στο ερωτηματολόγιο. Προφανώς όσο μεγαλύτερο είναι το δείγμα και όσο μεγαλύτερο είναι το ποσοστό απόκρισης τόσο το καλύτερο. Αυτό όμως δεν σημαίνει ότι υπάρχει κάποιο ποσοστό το οποίο εξασφαλίζει αντιπροσωπευτικό δείγμα. Όπως είπαμε και πριν έχει σημασία ποιοι δεν απαντούν (2.2.5).

			Υψηλό ποσοστό απόκρισης σημαίνει μικρό ενδεχόμενο εμφάνισης μεροληψίας, ενώ υψηλό ποσοστό «μη απόκρισης», είναι ένα αρνητικό σημάδι. Συνήθως ποσοστό μεγαλύτερο του 70% εξασφαλίζει αντιπροσωπευτικά αποτελέσματα. Ενδιαφέρον έχει η παρουσία κινήτρων (π.χ. οικονομικών) που αποδεδειγμένα αυξάνουν το ποσοστό απόκρισης. Ακόμα όπως θα ειπωθεί και παρακάτω οι πρόσωπο με πρόσωπο συνεντεύξεις αυξάνουν το ποσοστό αυτό.

			2.2.8 Δειγματοληπτικές έρευνες με χρήση συνεντεύξεων

			Η συνέντευξη είναι μια εναλλακτική μέθοδος συλλογής δεδομένων δειγματοληπτικών ερευνών. Οι ερωτήσεις γίνονται προφορικά και οι απαντήσεις καταγράφονται από τους ερευνητές. Διεξάγονται συνήθως πρόσωπο με πρόσωπο ή μέσω τηλεφώνου. Σε έρευνες μεγάλου δείγματος τις περισσότερες φορές χρειάζεται πάνω από ένας συνεντευκτής.

			Πλεονεκτήματα: υψηλό ποσοστό απόκρισης, οι ερωτώμενοι είναι περισσότερο απρόθυμοι να απορρίψουν μια συνέντευξη, ενώ με ευκολία μπορούν να πετάξουν το ερωτηματολόγιο που τους ταχυδρομήθηκε στα σκουπίδια. Επίσης οι συνεντευκτές μπορούν να διαφυλάξουν την ομαλή ροή των απαντήσεων, όταν υπάρχουν ερωτήσεις που προκαλούν σύγχυση, αφού ο ερευνητής μπορεί να διευκρινίσει ό,τι θέλει ή και να διορθώσει τον ερωτώμενο όταν υπάρχει παρανόηση της ερώτησης.

			Στην περίπτωση πολλών συνεντευκτών θα πρέπει να διασφαλίζεται η ομοιομορφία των αποτελεσμάτων γι’ αυτό θα πρέπει να τους δίνονται οδηγίες και να υπάρχει συντονισμός.

			Η εμφάνιση του συνεντευκτή, ο τρόπος που απευθύνει τις ερωτήσεις και γενικά η συμπεριφορά του είναι απαραίτητο να μην επηρεάζουν την αντίληψη του ερωτώμενου για μια ερώτηση ή μια απάντηση. Για εξοικονόμηση χρόνου και χρήματος ο συνεντευκτής κάνει την έρευνα σε συγκεκριμένη γεωγραφική περιοχή. Η ουδετερότητα είναι πολύ σημαντική για τέτοια δείγματα, καθώς αν ο συνεντευκτής επηρεάσει με κάποιο τρόπο το δείγμα, τότε θα επηρεαστούν οι απαντήσεις.

			Καλό θα ήταν οι ερευνητές-συνεντευκτές να προσέχουν:

			
					την εμφάνισή τους, να είναι προσεκτική και όχι εξεζητημένη,

					να έχουν καλή γνώση του ερωτηματολογίου πριν ξεκινήσει η διαδικασία της συνέντευξης,

					την πιστή αναπαραγωγή των ερωτήσεων,

					την καταγραφή των απαντήσεων με ηλεκτρονικά μέσα,

			

			
					να δίνονται διευκρινίσεις όταν οι απαντήσεις δείχνουν ότι δεν υπάρχει κατανόηση της ερώτησης.

			

			2.2.9 Συντονισμός και έλεγχος

			 Όπως αναφέρθηκε για τον σωστό συντονισμό χρειάζεται εκπαίδευση των συνεντευκτών για τη διεξαγωγή της έρευνας. Αυτή ξεκινά βέβαια από τη συζήτηση περί γενικών κανόνων και μελέτη του ερωτηματολογίου, αλλά δεν αρκεί. Είναι πάντα καλό να υπάρχει μια προετοιμασία προδιαγραφών που θα συνδέονται με το κάθε ερωτηματολόγιο. Οι προδιαγραφές είναι επεξηγηματικά και διευκρινιστικά σχόλια για το πώς πρέπει να αντιμετωπίζονται οι δυσκολίες ή οι ασάφειες. Θα πρέπει να περιέχουν οδηγίες για τον χειρισμό τέτοιων καταστάσεων.

			Μετά, τη μελέτη του ερωτηματολογίου πρέπει να κατανοηθεί πώς θα λειτουργήσει η συνέντευξη, για αυτό το καλύτερο είναι να γίνει μια επίδειξη συνέντευξης χωρίς διακοπές, με διευκρινίσεις στο τέλος. Μετά τη συνέντευξη επίδειξης οι συνεντευκτές μπορούν να κάνουν εξάσκηση παίρνοντας συνέντευξη ο ένας στον άλλο.

			Χαρακτηριστικό είναι ότι στην απογραφή πληθυσμού οι συνεντευκτές παρακολουθούν σεμινάρια και ανά είκοσι άτομα είναι υπό την παρακολούθηση ενός υπευθύνου.

			Πολλές φορές πριν οι συνεντευκτές πάρουν τις πρώτες συνεντεύξεις συμμετέχουν σε πιλοτική έρευνα προκειμένου να αντιμετωπίσουν τα όποια προβλήματα σε κανονικές συνθήκες.

			2.2.10 Τηλεφωνικές έρευνες

			Πλεονεκτήματα

			
					Είναι πολύ πιο οικονομικές από τις ταχυδρομικές.

					Κερδίζεται πολύ χρόνος σε σχέση με τις ταχυδρομικές.

					Η διαδικασία απλής τυχαίας δειγματοληψίας γίνεται σχετικά εύκολα εφόσον είναι γενικά εύκολη η πρόσβαση σε καταλόγους σταθερών τηλεφώνων.

					Η επιρροή του συνεντευκτή στον ερωτώμενο είναι πολύ περιορισμένη.

					Ο συνεντευκτής δεν διατρέχει κανένα κίνδυνο εφόσον δεν έρχεται σε επαφή με κόσμο και δε χρειάζεται να επισκεφθεί ενδεχομένως επικίνδυνες περιοχές.

			

			Μειονεκτήματα

			
					Συνήθως προκύπτουν από καταλόγους σταθερών τηλεφώνων και έτσι αποκλείονται αυτοί που δεν έχουν τηλέφωνο ή χρησιμοποιούν μόνο κινητό.

					Στους καταλόγους σταθερών τηλεφώνων δεν περιλαμβάνονται συνήθως απόρρητοι αριθμοί.

					Υπάρχει μεγάλη πιθανότητα να κλείσει ο ερωτώμενος το τηλέφωνο πριν το τέλος της συνέντευξης.

					Υπάρχει μεγάλη προκατάληψη σε αυτούς που δέχονται τηλέφωνα λόγο των διαδεδομένων πωλήσεων μέσω τηλεφώνων.

			

			2.2.11 Ποσοστά απόκρισης σε έρευνες μέσω συνεντεύξεων

			Το ποσοστό απόκρισης δεν είναι σταθερό στην πορεία του χρόνου. Μέχρι το τέλος της δεκαετίας του ενενήντα που πρωτοεμφανίστηκαν μαζικά οι δημοσκοπήσεις στην Ελλάδα και πραγματοποιούνταν κυρίως με συνεντεύξεις πρόσωπο με πρόσωπο το ποσοστό αυτό ήταν γενικά πολύ υψηλό. Μετά όμως η παρουσία πολλών εταιριών έφερε έναν κορεσμό στον κόσμο που υπό διάφορες συνθήκες είχε πρόθεση να συμμετάσχει. Τα τελευταία χρόνια για λόγους οικονομίας στη μεγάλη πλειοψηφία πραγματοποιούνται τηλεφωνικές έρευνες. Το ποσοστό απόκρισης είναι πάρα πολύ μικρό, λόγω των τηλεπωλήσεων που έχουν παίξει έναν καθοριστικό ρόλο στο σοβαρό πρόβλημα που αντιμετωπίζουν οι παραδοσιακές τηλεφωνικές έρευνες. Επιπλέον οι τηλεφωνητές και τα φωνητικά μηνύματα έχουν συμβάλει στο σοβαρό πρόβλημα που έχει προκύψει. Έτσι το ποσοστό απόκρισης θα είναι ένα σημαντικό ζήτημα που θα εξακολουθεί να πλήττει τις δειγματοληπτικές έρευνες γνώμης.

			2.2.12 Διαδικτυακές έρευνες

			Η διάδοση του διαδικτύου είχε άμεσο αντίκτυπο στη δημιουργία των διαδικτυακών ερευνών. Είναι ένα είδος έρευνας το οποίο παρά τα προφανή προβλήματα κερδίζει έδαφος συνεχώς, ειδικά στις έρευνες αγοράς. Η ιδανική τους εφαρμογή γίνεται όταν ο πληθυσμός είναι οι επισκέπτες ενός ιστοτόπου (website).

			Σ΄ αυτή την περίπτωση ο ερευνητής και συντάκτης των ερωτήσεων καλό είναι να προσέξει τα ακόλουθα:

			
					Να περιορίσει κατά το δυνατό τον χρόνο της έρευνας.

					Αν χρειάζεται η χρήση κωδικού να αποφευχθεί η χρήση ενός «αριθμού» κ.λπ., καλύτερα να καταχωρείται το όνομα ή το e-mail σε κάποιο πεδίο.

					Να γνωστοποιηθεί ότι τα αποτελέσματα θα κοινοποιηθούν στους συμμετέχοντες στην έρευνα. Πολλές φορές αυτό το κίνητρο λειτουργεί ευεργετικά.

					Καλό είναι να υπάρχει σχεδιασμός στην ημερομηνία αποστολής των e-mail στους συμμετέχοντες, ανάλογα με το θέμα της έρευνας.

					To link της έρευνας πρέπει να είναι σε εμφανές σημείο και άμεσα προσβάσιμο.

					Πολύ ευεργετικά λειτουργεί ένα σύστημα ανταμοιβής των συμμετεχόντων με υλική επιβράβευση σε περίπτωση ανταπόκρισης.

			

			2.2.13 Δομή δειγματοληπτικής έρευνας

			
					Πρώτα από όλα καταγράφεται ο σκοπός της έρευνας.

					Με βάση τον σκοπό καταγράφονται οι επιμέρους στόχοι που μπορεί να αφορούν στη θεωρητική τεκμηρίωση του θέματος (θεωρητικοί στόχοι), ή στη μελέτη και τεκμηρίωση συμπερασμάτων και υποθέσεων από τα δεδομένα της δειγματοληπτικής μας έρευνας. Προφανώς κατά την εκπλήρωση των θεωρητικών στόχων θα πρέπει να γίνεται εννοιολόγηση των θεμάτων που θα απασχολήσουν τον ερευνητή και να έχουν συλλεχθεί παραπομπές της βιβλιογραφίας από σχετικές έρευνες. Η επισκόπηση της βιβλιογραφίας μπορεί να εμπλουτίσει τους ερευνητικούς στόχους που έχουμε θέσει εξαρχής, γι’ αυτό καλό είναι να προηγείται των ερευνητικών στόχων και υποθέσεων.

					Αφού τεθούν οι θεωρητικοί στόχοι θα πρέπει να αντιστοιχήσουμε ερωτήματα που πρέπει να απαντηθούν είτε δίνοντας ορισμούς (εννοιολόγηση) είτε από τη μελέτη άλλων εργασιών. Αντίστοιχα στους ερευνητικούς στόχους θα πρέπει να αντιστοιχήσουμε ερευνητικά ερωτήματα στη μελέτη καθώς και ερευνητικές προτάσεις (ερευνητικές υποθέσεις) που θα θέλουμε να δούμε αν ισχύουν ή όχι. Είναι χαρακτηριστικό ότι ερευνητικές υποθέσεις που έχουν εξεταστεί σε άλλες εργασίες καλό είναι να επανεξετάζονται. Πρέπει να σημειωθεί ότι η αιτιακή ανάλυση είναι σημαντική για τον έλεγχο των υποθέσεων. Θα πρέπει να οριστούν οι μεταβλητές που συνδέονται αιτιακά, καθώς και ο τρόπος μέτρησής τους. Επίσης, μπορεί να οριστεί ο βαθμός της σχέσης μεταξύ των δύο μεταβλητών. Είναι σημαντικός ο καθορισμός του ελέγχου, έτσι ώστε να αποδειχτεί ότι οι σχέσεις δεν είναι πλαστές.

					Έχοντας όλα τα παραπάνω κατά νου κατασκευάζουμε το ερωτηματολόγιο το οποίο εκτός των άλλων θα πρέπει να μας δώσει δεδομένα κατάλληλα για επεξεργασία. Σ’ αυτή τη φάση θα αποφασίσουμε για τα υποκείμενα της μελέτης και τη στατιστική ανάλυση.

					Σχεδιασμός πιθανοτικής δειγματοληψίας ώστε να διατεθεί το ερωτηματολόγιο. Θα πρέπει να ληφθούν όλες οι παράμετροι δειγματοληψίας που αναφέρθηκαν, να γίνει καθορισμός μεγέθους δείγματος, αλλά και να εκτιμηθεί σωστά η διαδικασία σε χρόνο και κόστος.

					Στατιστική Ανάλυση δεδομένων. Τα ερωτήματα και οι υποθέσεις θα πρέπει να απαντώνται με στατιστικούς ελέγχους και όχι περιγραφικά.

					Εξαγωγή συμπερασμάτων λαμβάνοντας υπόψη τις αδυναμίες του δείγματος (σχεδόν πάντα θα υπάρχουν!).

			

			Η παρακάτω μελέτη περίπτωσης προέρχεται από την απόφοιτη του μεταπτυχιακού προγράμματος «Διεθνής Διοικητική των Επιχειρήσεων» Ευαγγελία Τριανταφύλλου στα πλαίσια της διπλωματικής της εργασίας, επιβλέπων καθηγητής ήταν ο Μ. Χαλικιάς.

			2.3 Μελέτη περίπτωσης: Κατασκευή ερωτηματολογίου δειγματοληπτικής έρευνας

			Η Επίδραση της Οικονομικής Ύφεσης στα Συστήματα Αμοιβών και Ανταμοιβών σε Μεσαίες και Μεγάλες Επιχειρήσεις στην περιοχή Αττικής. Συντάκτης ερευνητικής πρότασης και ερωτηματολογίου: Τριανταφύλλου Ευαγγελία.

			2.3.1 Σκοπός και στόχοι μελέτης

			Η παρούσα ερευνητική εργασία έχει ως σκοπό τη μελέτη και διερεύνηση της δομής και της φιλοσοφίας των συστημάτων αμοιβών και ανταμοιβών εργαζομένων, όπως εφαρμόζονται από τις ελληνικές μεσαίες και μεγάλες επιχειρήσεις (με επικέντρωση στη γεωγραφική περιοχή της Αττικής) και την καταγραφή και διακρίβωση των συνεπειών της οικονομικής ύφεσης στις πολιτικές απασχόλησης και αμοιβών των παραπάνω επιχειρήσεων. Παράλληλα θα διερευνηθεί τόσο σε θεωρητικό, όσο και σε εμπειρικό επίπεδο, το φαινόμενο της ακαμψίας των μισθών και οι παράγοντες που οδηγούν σε αυτό, στο πλαίσιο των μεσαίων και μεγάλων επιχειρήσεων.

			Για την επίτευξη του παραπάνω σκοπού, η μελέτη θα εστιάσει στους ακόλουθους στόχους:

			Θεωρητικοί στόχοι

			Θ.1. Θεωρητική μελέτη και ανάλυση της έννοιας της αμοιβής και των συστημάτων αμοιβών και ανταμοιβών, ως βασική λειτουργία της Διαχείρισης Ανθρώπινων Πόρων.

			Θ.2. Μελέτη των βασικών θεωριών, που ερμηνεύουν το φαινόμενο και τα αίτια της ακαμψίας των αμοιβών, σε περίοδο οικονομικής ύφεσης.

			Ερευνητικοί στόχοι

			Ε.1. Να διερευνηθούν τα δομικά στοιχεία των συστημάτων αμοιβών, που εφαρμόζονται από τις μεσαίες και μεγάλες επιχειρήσεις και να εξεταστεί η συσχέτισή τους με τα «δημογραφικά» τους χαρακτηριστικά (έτη δραστηριότητας, μέγεθος, σύνθεση ανθρώπινου δυναμικού, κ.λπ.).

			Ε.2. Να διερευνηθούν οι επιπτώσεις της υφιστάμενης οικονομικής ύφεσης στα οικονομικά μεγέθη των προς εξέταση εταιρειών και να διακριβωθούν οι μεταβολές στις ακολουθούμενες από τις επιχειρήσεις πολιτικές εργασίας και αμοιβών.

			Ε.3. Να διερευνηθεί το φαινόμενο της ακαμψίας μισθών στις μεσαίες και μεγάλες επιχειρήσεις και να διακριβωθούν τα αίτια που οδηγούν σε αυτό.

			2.3.2 Διατύπωση ερευνητικών ερωτημάτων

			Μετά την παρουσίαση του σκοπού και των θεωρητικών και ερευνητικών στόχων της παρούσας μελέτης, ακολουθεί η διατύπωση των επιμέρους ερευνητικών ερωτημάτων, που ανακύπτουν από το θέμα.

			1ος Στόχος (Θεωρητικός)

			Θεωρητική μελέτη και ανάλυση της έννοιας της αμοιβής και των συστημάτων αμοιβών και ανταμοιβών, ως βασική λειτουργία της Διαχείρισης Ανθρώπινων Πόρων.

			Θ.1.1. Πώς ορίζεται η έννοια της αμοιβής;

			Θ.1.2. Πώς ορίζεται η έννοια του συστήματος αμοιβής και ανταμοιβής;

			Θ.1.3. Ποιος είναι ο στρατηγικός ρόλος του συστήματος αμοιβής και ανταμοιβής στα πλαίσια των οικονομικών οργανισμών;

			Θ.1.4. Ποια είναι τα συστατικά στοιχεία ενός συστήματος αμοιβής και ανταμοιβής;

			Θ.1.5. Ποιοι παράγοντες επηρεάζουν τον σχεδιασμό ενός συστήματος αμοιβής και ανταμοιβής;

			Θ.1.6. Σε ποια θεωρητικά μοντέλα βασίζεται ο σχεδιασμός ενός συστήματος αμοιβής και ανταμοιβής;

			2ος Στόχος (Θεωρητικός)

			Μελέτη των βασικών θεωριών, που ερμηνεύουν το φαινόμενο και τα αίτια της ακαμψίας των αμοιβών, σε περίοδο οικονομικής ύφεσης.

			Θ.2.1. Πώς ορίζεται η έννοια της ακαμψίας αμοιβών και γιατί είναι σημαντική για την επιχείρηση;

			Θ.2.2. Ποιες είναι οι θεωρητικές προσεγγίσεις που μελετούν το φαινόμενο της ακαμψίας;

			1ος Στόχος (Ερευνητικός)

			Διερεύνηση των δομικών στοιχείων των συστημάτων αμοιβών, που εφαρμόζονται από τις μεσαίες και μεγάλες επιχειρήσεις και της ενδεχόμενης συσχέτισής τους με τα «δημογραφικά» τους χαρακτηριστικά.

			Ε.1. Τα «δημογραφικά» χαρακτηριστικά μιας επιχείρησης διαφοροποιούν τη δομή των εφαρμοζόμενων συστημάτων αμοιβής;

			2ος Στόχος (Ερευνητικός)

			Διερεύνηση των επιπτώσεων της υφιστάμενης οικονομικής ύφεσης στις ακολουθούμενες από τις επιχειρήσεις πολιτικές εργασίας και αμοιβών.

			Ε.2.1. Έχουν μεταβάλλει οι επιχειρήσεις τις πολιτικές εργασίας και αμοιβών, κατά την περίοδο της οικονομικής κρίσης;

			Ε.2.2. Ποιοι παράγοντες επηρεάζουν τις πολιτικές εργασίας και αμοιβών;

			3ος Στόχος (Ερευνητικός)

			Διερεύνηση του φαινομένου της ακαμψίας αμοιβών στις μεσαίες και μεγάλες επιχειρήσεις και διακρίβωση των αιτίων που οδηγούν σε αυτό.

			Ε.3.1. Υπάρχει ακαμψία στους μισθούς των εργαζομένων στις ελληνικές μεσαίες και μεγάλες επιχειρήσεις, σε περίοδο οικονομικής ύφεσης;

			Ε.3.2. Ποιοι μηχανισμοί-αίτια οδηγούν στην εμφάνιση φαινομένων ακαμψίας αμοιβών στις επιχειρήσεις;

			Ε.3.3. Υπάρχει συσχέτιση των αιτίων που οδηγούν σε φαινόμενα ακαμψίας με τα χαρακτηριστικά της επιχείρησης (μέγεθος, σύνθεση ανθρώπινου δυναμικού);

			2.3.3 Διατύπωση ερευνητικών υποθέσεων

			Στην παρούσα ενότητα συνοψίζονται οι ερευνητικές υποθέσεις, όπως προέκυψαν από τη θεωρητική προσέγγιση, του υπό διερεύνηση προβλήματος, και αντιστοιχίζονται με τους ερευνητικούς στόχους της μελέτης (Πίνακας 37).

			[image: ]

			Πίνακας 2.37: Αντιστοίχιση Ερευνητικών Υποθέσεων και Ερευνητικών Στόχων

			Συμπεράσματα

			
					Πρακτική εφαρμογή αποτελεσμάτων (managerial implications),

					Συστάσεις για μελλοντική έρευνα,

					Περιορισμοί έρευνας.

			

			Ερωτηματολόγιο 3

			Θέμα: «Η επίδραση της οικονομικής ύφεσης στα συστήματα αμοιβών και ανταμοιβών σε μεσαίες και μεγάλες επιχειρήσεις, στην περιοχή της Αττικής».

			Πρώτη Θεματική Ενότητα

			1.1 Εκτός του μισθού, ποια από τα ακόλουθα στοιχεία περιλαμβάνει η επιχείρησή σας, στο σύστημα αμοιβής που εφαρμόζει;

			[image: ]

			Πίνακας 2.38: Πίνακας ερωτηματολογίου 3 (συστήματα αμοιβών)

			1.2 Η επιχείρησή σας παρέχει στους εργαζόμενους, κάποια από τα ακόλουθα προνόμια, πέραν των νόμιμων υποχρεώσεών της;

			[image: ]

			Πίνακας 2.39: Πίνακας ερωτηματολογίου 3 (προνόμια εργαζομένων)

			Δεύτερη Θεματική Ενότητα

			2.1 Την τελευταία πενταετία έχετε μειώσει τους μισθούς των εργαζομένων της επιχείρησης και αν ναι σε τι ποσοστό του προσωπικού;
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			Πίνακας 2.40: Πίνακας ερωτηματολογίου 3 (μειώσεις μισθών)

			2.2 Παρακαλώ δηλώστε κατά πόσο είναι αποτρεπτική, καθεμιά από τις παρακάτω προτάσεις στην απόφαση του οργανισμού σας, να μην μειώσει τους μισθούς του προσωπικού της.

			[image: ]

			Πίνακας 2.41: Πίνακας ερωτηματολογίου 3 (παράγοντες συγκράτησης των μισθών)

			2.3 Παρακαλώ δηλώστε, κατά πόσο είναι σχετική καθεμιά από τις παρακάτω προτάσεις ως στρατηγική αντιμετώπισης, μιας απρόσμενης μείωσης της ζήτησης των προϊόντων της επιχείρησής σας.
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			Πίνακας 2.42: Πίνακας ερωτηματολογίου 3 (στρατηγικές απρόσμενης ζήτησης)

			2.3.1 Παρακαλώ αξιολογήστε τη σημαντικότητα καθενός από τα ακόλουθα μέτρα για τη μείωση του κόστους της επιχείρησης.
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			Πίνακας 2.43: Πίνακας ερωτηματολογίου 3(παράγοντες μείωσης κόστους)

			2.3.2 Έχετε χρησιμοποιήσει κάποιο/κάποια από τα παραπάνω μέτρα, την τελευταία πενταετία;
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			Πίνακας 2.44: Πίνακας ερωτηματολογίου 3(μέτρα περικοπών που έχουν ληφθεί)

			2.4 Λαμβάνοντας υπόψη τις αλλαγές στο ευρύτερο οικονομικό περιβάλλον και ειδικότερα στην αγορά εργασίας, τα τελευταία πέντε έτη, πιστεύετε ότι έχει γίνει ευκολότερη η προσαρμογή των μισθών, προκειμένου να μειωθεί το εργατικό κόστος;
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			Πίνακας 2.45: Πίνακας ερωτηματολογίου 3(επιρροή οικονομικής κρίσης στην προσαρμογή μισθών)

			2.4.1 Αν απαντήσατε Ναι, παρακαλώ υποδείξτε το λόγο που θεωρείτε σημαντικότερο

			(επιλέξτε μόνο μια απάντηση)
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			Πίνακας 2.46: Πίνακας ερωτηματολογίου 3 (αιτίες προσαρμογής μισθών)

			Τρίτη Θεματική Ενότητα

			3.1 Ποιο είναι το έτος ίδρυσης της επιχείρησής σας;
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			3.2 Ποιος είναι ο κύριος τομέας δραστηριότητας της επιχείρησής σας;
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			Πίνακας 2.47: Πίνακας ερωτηματολογίου 3(τομείς της επιχείρησης)

			3.3 Η επιχείρησή σας είναι μέλος κάποιας εργοδοτικής οργάνωσης;
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			Πίνακας 2.48: Πίνακας ερωτηματολογίου 3 (εργοδοτική οργάνωση)

			3.4 Πόσα άτομα απασχολεί συνολικά η επιχείρησή σας, κατά την περίοδο διενέργειας της έρευνας;

			(εξαιρούνται οι εργαζόμενοι με συμβάσεις ανεξαρτήτων υπηρεσιών και γενικότερα οι εξωτερικοί συνεργάτες της επιχείρησης)

			Αριθμός εργαζομένων:
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			3.5 Πώς κατανέμεται, κατά προσέγγιση, το προσωπικό της επιχείρησής σας, στις ακόλουθες ομάδες απασχόλησης;
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			Πίνακας 2.49: Πίνακας ερωτηματολογίου 3(κατανομή προσωπικού)

			3.6 Σε τί ποσοστό του συνολικού προσωπικού της επιχείρησης, ο μισθός/ημερομίσθιο (ονομαστικός) είναι στα όρια των κατώτατων νομοθετημένων ορίων (Ε.Γ.Σ.Σ.Ε. ή άλλης κλαδικής ή ομοιοεπαγγελματικής σύμβασης εργασίας) ή πλησίον αυτών (+/- 10%);
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			3.7 Υπάρχει σωματείο εργαζομένων στην επιχείρησή σας;
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			Πίνακας 2.50: Πίνακας ερωτηματολογίου 3 (εργατικό σωματείο)

			3.7.1 Αν απαντήσατε ΝΑΙ, τί ποσοστό των εργαζομένων συμμετέχουν σε αυτό;

			Ποσοστό εργαζομένων στο σωματείο:
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			3.8 Συγκρίνοντας τον κύκλο εργασιών της επιχείρησής σας κατά το προηγούμενο οικονομικό έτος, θα λέγατε ότι σε σχέση με εκείνον του 2009 (αρχή κρίσης) είναι:
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			Πίνακας 2.51: Πίνακας ερωτηματολογίου 3(κύκλος εργασιών)

			Προαιρετικές Πληροφορίες

			Όνομα του ατόμου που απαντά στην έρευνα:
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			Θέση στην εταιρεία:
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			Ηλεκτρονική διεύθυνση επικοινωνίας:
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			Παρατήρηση

			Στο ερωτηματολόγιο θα πρέπει να δίνεται η δυνατότητα να απαντηθούν τα ερευνητικά ερωτήματα (πολλές φορές ερευνητικά ερωτήματα είναι και ερωτήσεις του ερωτηματολογίου). Ακόμα θα πρέπει να δίνεται η δυνατότητα απάντησης στις ερευνητικές υποθέσεις μέσω κατάλληλων στατιστικών ελέγχων. Ως εκ τούτου θα πρέπει να υπάρχουν οι ανάλογες ερωτήσεις που θα καταχωρηθούν ως μεταβλητές για την πραγματοποίηση του ελέγχου.

			2.4 Δημοσκοπήσεις

			2.4.1 Εισαγωγικά

			Το πιο διαδεδομένο είδος δειγματοληπτικών ερευνών στην Ελλάδα είναι οι δημοσκοπήσεις. Οι δημοσκοπήσεις ουσιαστικά αποτελούν μέρος του σημερινού πολιτικού συστήματος παγκοσμίως και η επίδρασή τους δεν περιορίζεται στην περιγραφή και στην καταγραφή του πολιτικού σκηνικού, αλλά σε μεγάλο βαθμό επιδρά στη διαμόρφωσή του.

			Είναι χαρακτηριστικό ότι επιλογή αποφάσεων υποψηφίων κ.ο.κ. εξαρτάται από αποτελέσματα δημοσκοπήσεων.

			Συχνά οι δημοσκοπήσεις έχουν πέσει έξω ειδικά τα τελευταία χρόνια όπου η ψήφος στις ελληνικές βουλευτικές εκλογές έχει γίνει ιδιαιτέρα ρευστή. Παρόλα αυτά η ισχύς της επιρροής τους παραμένει και αποτελέσματά τους χρησιμοποιούνται ως επιχειρήματα στον πολιτικό διάλογο. Οι δημοσκοπήσεις γίνονται εργαλεία χάραξης στρατηγικής είτε σε έρευνες αγοράς είτε σε στρατηγική πολιτικών στελεχών και πολιτικών κομμάτων.

			Υπάρχουν δύο μεγάλες κατηγορίες δημοσκοπήσεων: α) Οι δημοσκοπήσεις που παρουσιάζονται στα ΜΜΕ και β) Οι δημοσκοπήσεις που αφορούν ιδιώτες, κόμματα, επιχειρήσεις, διαφημιστικές εταιρίες κ.ο.κ. Η πρώτη κατηγορία δημοσκοπήσεων διαθέτει και το μεγαλύτερο τζίρο και εξασφαλίζει και δημοσιοποίηση των αποτελεσμάτων.

			Για τις δημοσκοπήσεις στην Ελλάδα έχει γίνει πολύ καλή αναφορά στο διαδικτυακό άρθρο του Χρ. Βερναρδάκη στο συλλογικό τόμο αφιέρωμα στη Λαμπίρη Δημάκη (Αφουξενίδης & Αλεξάκης 2006). Στην Ελλάδα οι δημοσκοπήσεις πραγματοποιούνται από το 1989 και μετά. Πριν βρουν έδαφος και εφαρμοστούν οι δημοσκοπήσεις στην Ευρώπη και στις ΗΠΑ είχε καλλιεργηθεί το κατάλληλο υπόβαθρο δεοντολογίας και αξιοπιστίας για τη διενέργειά τους. Η μεγάλη αυτή καθυστέρηση σε σχέση με τις υπόλοιπες ευρωπαϊκές χώρες, οφείλεται πρώτα στην αργή εξέλιξη των επιστημονικών εξελίξεων σε σχέση με τις ευρωπαϊκές χώρες αλλά και στην καχυποψία με την οποία αντιμετώπιζε ο κόσμος τις δημοσκοπήσεις λόγω της δικτατορίας και του εμφυλίου. Τεράστια ώθηση και προβολή έδωσαν τα exit polls που εμφανίστηκαν στις εκλογές του 1996. Η οικονομική ανάπτυξη τη δεκαετία του 90 στην Ελλάδα σε συνδυασμό με την άνθιση των ιδιωτικών καναλιών που ήταν οι βασικοί πυλώνες προβολής τους και χρηματοδότησής τους δημιούργησαν την ανάπτυξη των δημοσκοπήσεων και την εγκαθίδρυσή τους στα ελληνικά δρώμενα.

			Στην Ελλάδα οι δημοσκοπήσεις επηρεάζουν ποικιλοτρόπως τη διαμόρφωση της κοινής γνώμης, γιατί και οι δημοσιογράφοι προσαρμόζουν την άποψή τους και την τοποθέτηση που ακολουθούν με βάση τα αποτελέσματα δημοσκοπήσεων. Ακόμα η βαρύτητα των θεμάτων και η ατζέντα των συζητήσεων υιοθετούνται από δημοσκοπήσεις με στόχο πάντα το μεγαλύτερο ενδιαφέρον και τη μεγαλύτερη τηλεθέαση.

			Η βαρύτητα αυτή έχει ως αποτέλεσμα πολλές φορές την κατάχρηση, τη δόλια χρήση τους και την σκόπιμη παρερμήνευση των αποτελεσμάτων τους.

			Οι συγκεκριμένες έρευνες είναι συγχρονικές και αφορούν στη στιγμή που πραγματοποιούνται όπως όλες οι δειγματοληπτικές έρευνες. Όπως παρατηρεί και ο Grémy (1993), οι απαντήσεις, σε μεγάλο βαθμό, αποτελούν απόρροια της διατύπωσης της ερώτησης που πραγματοποιείται.

			Όπως αναφέρει ο Χρ. Βερναρδάκης υπάρχουν δύο βασικές φιλοσοφίες έρευνας για την κοινωνική έρευνα και κατ’ επέκταση, για τις δημοσκοπήσεις και τις δειγματοληπτικές έρευνες. Η πρώτη στηρίζεται στα ποσοστά των απαντήσεων και την επεξεργασία με ποσοτική μέθοδο, ενώ η δεύτερη αφορά την εκτίμηση της στάσης των ερωτώμενων με ποιοτική επεξεργασία αποτελεσμάτων, ώστε οι απαντήσεις να προσλαμβάνονται ως μια ολότητα (π.χ ο χαρακτηρισμός των απαντήσεων του ερωτώμενου ότι αποτελεί αριστερή στροφή σε σχέση με τις απόψεις που είχε πριν από ένα γεγονός κ.ο.κ.).

			Η πρώτη προσέγγιση είναι πιο διαδεδομένη και εύκολη στην επεξεργασία, τη δεύτερη την ανέδειξαν οι μελετητές κοινωνικής συμπεριφοράς (Michelat & Thomas, 1966· Michelat & Simon, 1977). Πρακτικά τα δύο όρια των προσεγγίσεων αυτών δεν είναι πάντοτε ξεκάθαρα και ο συνδυασμός τους είναι η ενδεδειγμένη διαδικασία (Rivière & Martelli-Banégas, 2002• Grunberg, 2002).

			2.4.2 Οι δημοσκοπήσεις σήμερα

			Ως δημοσκόπηση ορίζεται το αποτέλεσμα της δειγματοληπτικής έρευνας, που γίνεται σε ένα σύνολο ανθρώπων, με σκοπό να ακουστεί η γνώμη του πληθυσμού για ένα συγκεκριμένο ζήτημα.

			Εκτός της πρόθεσης ψήφου και των πολιτικών θεμάτων οι δημοσκοπήσεις, ασχολούνται κυρίως με τους τομείς των πωλήσεων, το μάρκετινγκ, έρευνες αγοράς, κ.λπ.

			Στην Ελλάδα υπάρχουν περίπου 30 ιδιωτικές εταιρείες δημοσκοπήσεων. Αξιοσημείωτο είναι ότι σε πρόσφατες αμερικανικές εκλογές, το κόστος ήταν έξι εκατομμύρια δολάρια ($6.000.000) για περίπου διακόσιες δημοσκοπήσεις που διενεργήθηκαν.

			Λόγω της σημασίας των δημοσκοπήσεων πολλές φορές έχει αμφισβητηθεί αν λένε την αλήθεια. Σε περίπτωση που τα λάθη δεν είναι επιτηδευμένα διακρίνουμε τρεις κατηγορίες αποτελεσμάτων που προϋποθέτουν και άλλη μορφή ανάλυσης.

			Η πρώτη είναι οι συνηθισμένες δημοσκοπήσεις όπου καταγράφεται προεκλογικά η πρόθεση ψήφου, η δεύτερη είναι τα exit-polls δηλαδή οι δημοσκοπήσεις που πραγματοποιούνται την ημέρα των εκλογών, έξω από εκλογικά τμήματα και η τρίτη οι εκτιμήσεις και οι προβλέψεις αποτελεσμάτων με βάση τα πρώτα δεδομένα (π.χ. τα πρώτα καταγεγραμμένα ψηφοδέλτια). Η εκτίμηση γίνεται με εφαρμογή στατιστικών μοντέλων. Η δεύτερη και η τρίτη, αφορούν αποκλειστικά την ημέρα των εκλογών, έτσι το αποτέλεσμά τους κρίνεται άμεσα από το κοινό και από το πολιτικό σύστημα. Είναι σχεδιασμένες έτσι ώστε να προσφέρουν πολύ μεγαλύτερη ακρίβεια μέτρησης σε σχέση με τις απλές δημοσκοπήσεις. Για τη δεύτερη κατηγορία καθοριστική είναι η σωστή δειγματοληψία, από εκεί και πέρα τα περιθώρια λάθους είναι ελάχιστα και έχουν να κάνουν με τη διατύπωση των ερωτήσεων. Στην τρίτη κατηγορία η εκτίμηση της πρόθεσης ψήφου αυτών που δεν συνεργάστηκαν με την έρευνα είναι ιδιαίτερα δύσκολη και απαιτεί χρήση στατιστικών μοντέλων.

			Η πρώτη περίπτωση δημοσκοπήσεων είναι δύσκολο να δώσει ακριβή αποτελέσματα. Ακόμα τα αποτελέσματα των δημοσκοπήσεων αυτών είναι πρακτικά αδύνατο να ελεγχθούν. Τα λάθη προέρχονται κυρίως από άρνηση συμμετοχής, κακή δειγματοληψία αλλά και λανθασμένη πρόβλεψη για το ποσοστό αναποφάσιστων.

			Είναι γεγονός ότι έχει δημιουργηθεί η αίσθηση ότι οι δημοσκοπήσεις, αντί να καταγράφουν τη στάση της κοινής γνώμης, στην πραγματικότητα τη διαμορφώνουν. Το φαινόμενο αυτό οφείλεται κυρίως στην αυξημένη προβλεπτική ικανότητα που αποδίδεται στις δημοσκοπήσεις σε σχέση με αυτήν που πραγματικά έχουν. Το προβάδισμα κάποιου κόμματος στις δημοσκοπήσεις μπορεί να δημιουργήσει το σύνδρομο του νικητή (bandwagon effect), το οποίο με τη σειρά του είναι ικανό να παρασύρει τους ταλαντευόμενους ψηφοφόρους και έτσι ο νικητής με βάση τις δημοσκοπήσεις ενισχύεται στην εκλογική διαδικασία. Ακόμα η επιρροή των δημοσκοπήσεων έχει να κάνει και με την επιλογή κομμάτων ή ατόμων που χρειάζεται να «ενισχυθούν», εφόσον σύμφωνα με τις δημοσκοπήσεις η πραγματική πρώτη προτίμηση του ψηφοφόρου έχει εξασφαλισμένο καλό ή κακό αποτέλεσμα.

			Αξιοσημείωτο είναι ότι στην Ελλάδα για κάποια χρόνια απαγορεύτηκε η δημοσιοποίηση δημοσκοπήσεων για ορισμένο χρονικό διάστημα πριν από τις εκλογές. Αυτό όμως δεν κρίθηκε χρήσιμο ή αποτελεσματικό, εφόσον δεν ήταν δυνατό να απαγορευτεί η δημοσιοποίηση σε άλλες χώρες ή μέσω internet κ.λπ.

			2.4.3 Σχετικές έρευνες

			Οι σύγχρονες έρευνες στοχεύουν κυρίως στην άμεση και γρήγορη πρόβλεψη μέσω internet. Κατά την έρευνα των Metaxas et al. (2011), εφάρμοσαν μοντέλα πρόβλεψης των μέσων κοινωνικής δικτύωσης για πολιτικές δημοσκοπήσεις κατά τις δύο τελευταίες εκλογές μελών του Κογκρέσου στις ΗΠΑ.

			Το μεγάλο πρόβλημα που εντοπίστηκε είναι ότι είναι εύκολο να δημιουργηθούν πολλοί ψεύτικοι λογαριασμοί και προφίλ χρηστών, ώστε να ενισχυθεί το μήνυμα υπέρ κάποιου υποψηφίου όπως έχουν επισημάνει οι (Mustafaraj et al., 2011).

			Είναι βέβαιο ότι δεδομένα μέσων κοινωνικής δικτύωσης αυξάνουν την προβλεψιμότητα των αποτελεσμάτων των εκλογών. Αλλά είναι δύσκολο να δημιουργηθεί μια μεθοδολογία λόγω της αλματώδους εξέλιξής τους (Livne et al., 2011).

			Οι O’Connor, B. et.al (2010) προσπάθησαν να χρησιμοποιήσουν δεδομένα ερωτηματολογίων που εξήχθησαν από μέσα κοινωνικής δικτύωσης, τα λεγόμενα στοιχεία της «αίσθησης» και του γενικότερου κλίματος που μετρώνται από τα κείμενα που περιέχονται στα tweets του Twitter.

			Οι Visser, P. S., Krosnick, J. A., Marquette, J., και Curtin, M. (1996), τονίζουν τη διαφορά στο βαθμό εγκυρότητας των δημοσκοπήσεων μέσω ταχυδρομείου που εφαρμόζονταν τη δεκαετία του 80 με τις σημερινές και με αυτό τον τρόπο θέλουν να τονίσουν ότι το μέλλον των δημοσκοπήσεων είναι μέσω internet.

			2.4.4 Τρόποι διεξαγωγής των δημοσκοπήσεων

			Οι τεχνικές πραγματοποίησης των δημοσκοπήσεων είναι αυτές που χρησιμοποιούνται στις δειγματοληπτικές έρευνες (μέσω τηλεφώνου, μέσω email, μέσω ταχυδρομείου). Όμως λόγω της φύσης των ερευνών μπορούν να πραγματοποιηθούν και με sms και βέβαια ξεχωριστή σημασία έχουν τα exit-polls.

			2.4.4.1 Exit-Polls

			Οι χρηματοδότες των exit-polls είναι κατά βάση τα ΜΜΕ. Η ακρίβειά τους είναι συνήθως πολύ μεγάλη και είναι χαρακτηριστικό ότι για αμφιλεγόμενου κύρους εκλογικές αναμετρήσεις έχουν χρησιμοποιηθεί προκειμένου να εντοπίσουν πιθανή νοθεία αποτελεσμάτων. Η κυριότερη διαφορά εκτός από τον χώρο και τον χρόνο που γίνονται είναι ότι ο ερωτώμενος καλείται να απαντήσει στο τί έχει πραγματικά ψηφίσει και όχι τι προτίθεται να κάνει.

			Ακόμα χρησιμοποιούνται για να συνδέσουν την ψήφο με κοινωνικά χαρακτηριστικά στα οποία καλείται να απαντήσει ο ερωτώμενος. Αυτή η πληροφορία μπορεί να προέλθει μόνο από τη διαδικασία της δημοσκόπησης των exit-polls, καθώς είναι γνωστό ότι η ψηφοφορία είναι μυστική και ανυπόγραφη. Αξιοσημείωτη αποτυχία των exit-polls σημειώθηκε το 1992 στη Μεγάλη Βρετανία και τις χρονιές 2012 και 2015 στις Ελληνικές εκλογές. Το λάθος στις Ελληνικές εκλογές αποδόθηκε, στο γεγονός ότι ψηφοφόροι συγκεκριμένων κομμάτων αρνήθηκαν να συμμετάσχουν στη διαδικασία. Τέτοιες περιπτώσεις, τα τελευταία χρόνια αποτελούν εξαίρεση, αφού τις πιο πολλές φορές τα exit-polls είναι πετυχημένα.

			Αξιοσημείωτο είναι το αποτέλεσμα του exit-poll στις προεδρικές εκλογές της Ουκρανίας το 2004 όπου αποκαλύφθηκε ότι υπήρχε νοθεία.

			Τα σφάλματα στα exit-polls μπορεί να προέλθουν από:

			
					Λάθη κατά τη δειγματοληψία. Μην ξεχνάμε ότι οι πληθυσμοί στις εκλογικές αναμετρήσεις είναι πολύ μεγάλοι, ενώ το δείγμα πρακτικά δύσκολα ξεπερνά τους 5.000 συμμετέχοντες. Το ιδανικό είναι να υπάρχει εκπροσώπηση από όλα τα εκλογικά κέντρα, αλλά πολλές φορές αυτό είναι αδύνατο.

					 Μερικοί άνθρωποι μπορεί να έχουν πραγματικά συμμετάσχει στη διαδικασία για το τί ψήφισαν, για ένα συγκεκριμένο υποψήφιο ή κόμμα, αλλά μπορεί εκούσια να δήλωσαν κάτι άλλο.

					Συνήθως η ανταπόκριση στα exit-polls εξαρτάται από το κόμμα που ψηφίστηκε. Οι υποστηρικτές κάποιων κομμάτων τείνουν να συμμετέχουν στη διαδικασία, ενώ κάποιων άλλων όχι.

			

			2.4.4.2 Δημοσκοπήσεις μέσω SMS

			Στην περίπτωση που οι ερωτήσεις είναι περιορισμένες (π.χ. η πρόθεση ψήφου) χρησιμοποιείται όλο και πιο συχνά η διαδικασία των sms. Με αποστολή και των ερωτήσεων και των απαντήσεων με sms.

			Τα πλεονεκτήματα είναι αρκετά καθώς σχεδόν όλοι είναι πλέον χρήστες κινητών τηλεφώνων, ενώ η μεγάλη πλειοψηφία έχει εξοικείωση με τα sms. Τα κυριότερα πλεονεκτήματα είναι:

			
					Ταχύτατη απάντηση και γρήγορη πρόσβαση στα αποτελέσματα, που συγκεντρώνονται πολύ εύκολα. Ο αναμενόμενος χρόνος απόκρισης δεν ξεπερνά τα δέκα λεπτά.

					Επιπλέον πληροφορίες. Μέσω των νέων τεχνολογιών, είναι πιο εύκολη η συλλογή περισσότερων πληροφοριών, όπως είναι η γεωγραφική θέση και η δραστηριότητα του κινητού, πάντα με τη συγκατάθεση του χρήστη, αλλιώς υφίσταται θέμα δεοντολογίας.

			

			Η παρουσία των sms είναι συνηθισμένη σε τηλεοπτικές εκπομπές, όπου ο θεατής καλείται να απαντήσει σε κάποιο ερώτημα στέλνοντας sms. Αυτού του είδους οι «δημοσκοπήσεις» στερούνται εντελώς εγκυρότητας.

			2.4.5 Αξιοπιστία εταιρειών δημοσκοπήσεων

			Λόγω του ρόλου των δημοσκοπήσεων στη διαμόρφωση της κοινής γνώμης και της επιρροής στο πολιτικό σκηνικό οι εταιρείες πρέπει να υπόκεινται σε ελέγχους αξιοπιστίας και εγκυρότητας των αποτελεσμάτων. Στην Ελλάδα οι εταιρείες έχουν συγκροτήσει σύλλογο τον ΣΕΔΕΑ (Σύλλογος Εταιρειών Δημοσκοπήσεων και Ερευνών Αγοράς) που αριθμεί αυτή τη στιγμή 23 εταιρείες. Ανάλογος διεθνής οργανισμός είναι η ESOMAR (European company of SOcial and MArket Research) που όμως δεν περιλαμβάνει εταιρείες, αλλά επιστήμονες που δραστηριοποιούνται στον χώρο των δημοσκοπήσεων και των ερευνών αγοράς. Οι εταιρείες μέλη του ΣΕΔΕΑ οφείλουν να τηρούν τους αντίστοιχους κώδικες δεοντολογίας και επαγγελματικής πρακτικής που η ESOMAR εκδίδει. Ανάλογος οργανισμός της ESOMAR είναι ο WAPOR (World Association for Public Opinion Research) Παγκόσμιος Οργανισμός Κοινής Γνώμης, του οποίου μέλη είναι επιστήμονες που δραστηριοποιούνται ερευνητικά και επαγγελματικά σε όλο τον κόσμο.
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			Κεφάλαιο 3

			Εισαγωγική Διαχείριση του IBM SPSS

			Σύνοψη

			Στο κεφάλαιο αυτό γίνεται αρχικά μία αναφορά στο περιβάλλον του SPSS και συγκεκριμένα στις επιλογές Run the Tutorial, Type in data, Run an existing query, Create new query using Database Wizard και αναλυτικά στα φύλλα Data View και Variable View. Γίνεται αναφορά στο Μενού File και συγκεκριμένα στις επιλογές Data, Syntax, Output και Script. Περιγράφεται η καταχώρηση δεδομένων στο IBM SPSS (χειρόγραφη καταγραφή δεδομένων και μεταφορά Δεδομένων από Αρχείο Excel) και η κωδικοποίηση δεδομένων ερωτηματολογίων. Από το μενού Edit View Data αναλύονται οι εντολές Sort Variables, Transpose, Select Cases, Merge Files (ενοποίηση δεδομένων από διαφορετικά αρχεία), Split File (διαχωρισμός των παρατηρήσεων του αρχείου σε μικρότερες εικονικές διαμερίσεις), Weight Cases ( στάθμιση σύμφωνα με τις τιμές μιας άλλης μεταβλητής), Restructure (αναδιοργάνωση του αρχείου μετατρέποντας τις μεταβλητές σε παρατηρήσεις και αντίστροφα), Recode (επανακωδικοποίηση εφαρμόζεται για τη δημιουργία νέας μεταβλητής), Compute (δημιουργία νέων μεταβλητών υπό την εφαρμογή μιας μαθηματικής (αριθμητικής) έκφρασης), Replace Missing Values (αντικατάσταση των ελλειπουσών τιμών).

			Προαπαιτούμενη γνώση

			Προαπαιτούμενη γνώση δεν υπάρχει. Καλύτερη κατανόηση του κεφαλαίου είναι δυνατή σε αναγνώστες που έχουν εξοικείωση με χρήση υπολογιστών. Τα εγχειρίδια που παρουσιάζουν με πληρότητα την ύλη του συγκεκριμένου κεφαλαίου καθώς και των υπόλοιπων που αφορούν στη χρήση SPSS αναφέρονται ενδεικτικά στα βιβλία των D. Howitt, και D. Cramer, Carver και Nash, Coakes και Steed, Field, Huber και Norousis.

			3.1 Το Περιβάλλον του SPSS

			Ξεκινώντας την εφαρμογή εμφανίζεται το παράθυρο διαλόγου βλ. Εικόνα ٣.١. Εάν επιθυμείτε να ανοίξετε ένα αρχείο δεδομένων «.sav» που υπάρχει ήδη διαθέσιμο τότε αφήνετε την αρχική επιλογή Open an existing data source και πατάμε το πλήκτρο αποδοχής OK.

			Εάν επιθυμείτε να ανοίξετε ένα αρχείο δεδομένων διαφορετικού τύπου που υπάρχει ήδη διαθέσιμο τότε επιλέγετε Open another type of file και πατάμε το πλήκτρο αποδοχής OK.

			Εάν επιθυμείτε να δημιουργήσετε ένα νέο αρχείο δεδομένων, δηλαδή θέλετε ένα νέο λογιστικό φύλλο εργασία, τότε ακυρώνετε το παράθυρο διαλόγου από το πλήκτρο ακύρωσης Cancel.
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			Εικόνα 3.1: Εισαγωγική Ενότητα του SPSS

			Η ενότητα διαθέτει ακόμα τις επιλογές:

			
					Run the Tutorial - Για να παρακολουθήσετε το πρόγραμμα εκμάθησης.

					Type in data - Για να εισάγετε δεδομένα πληκτρολογώντας.

					Run an existing query - Για να εκτελέσετε μια εντολή.

					Create new query using Database Wizard - Για να δημιουργήσετε μια εντολή χρησιμοποιώντας το πρόγραμμα Database Wizard.

			

			Επιλέγοντας Cancel εμφανίζεται η Εικόνα 3.2 δηλαδή ένας editor παρόμοιος με λογιστικού φύλλου Excel προκειμένου να πραγματοποιηθεί νέα καταγραφή δεδομένων.

			H ενότητα αυτή περιλαμβάνει τη γραμμή (menu) επιλογών, τη γραμμή συντομευμένων ενεργειών (εικονίδια) και δύο υποενότητες τη «Data View» και τη «Variable View» που θα αναλυθούν στη συνέχεια.

			Data View

			Η συγκεκριμένη υποενότητα αποτελείται από το λογιστικό φύλλο των δεδομένων, στο οποίο κατά την χειρόγραφη καταγραφή δεδομένων ο χρήστης εισάγει (πληκτρολογεί) απευθείας σε αυτό τις τιμές των παρατηρήσεων (περισσότερα βλ. στην παράγραφο «Καταχώρηση δεδομένων στο IBM SPSS»).
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			Εικόνα 3.2: Η ενότητα διαχείρισης του SPSS

			Variable View

			Η συγκεκριμένη υποενότητα περιλαμβάνει το σύνολο των μεταβλητών που περιέχονται στο Data View, και τα χαρακτηριστικά αυτών. Αναλυτικότερα, εάν η καταγραφή των δεδομένων γίνεται χειρόγραφα, τότε η εφαρμογή δίνει μια αρχική ονομασία στις μεταβλητές (π.χ. VAR٠٠٠٠١), όπως φαίνεται και από την Eικόνα ٣.٤. Καθώς οι ονομασίες αυτές δεν είναι βοηθητικές για τον αναλυτή, παρέχεται η δυνατότητα μετονομασίας στην υποενότητα Variable View.
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			Εικόνα.3.3: Ενότητα Variable View

			Τα χαρακτηριστικά που καταγράφονται για κάθε μεταβλητή είναι τα εξής:

			[image: ]

			Πίνακας ٣.١: Τα χαρακτηριστικά που καταγράφονται για κάθε μεταβλητή

			Οποιοδήποτε από τα παραπάνω στοιχεία είναι δυνατό να τροποποιηθούν από τον αναλυτή. Με δεξί κλικ στην στήλη αρίθμησης των μεταβλητών παρέχονται οι δυνατότητες Αντιγραφής, Copy, Επικόλλησης, Paste, Διαγραφής, Clear και Εισόδου Νέας Μεταβλητής, Insert New Variable. Ας δούμε όμως τώρα πιο διεξοδικά ορισμένες κεντρικές ομάδες (μενού), με τις σημαντικότερες δυνατότητές τους, που διαθέτει το περιβάλλον του SPSS.

			3.2 Μενού File

			Περιέχει εντολές για την διαχείριση του αρχείου, όπως δημιουργία νέου αρχείου, New, άνοιγμα υπάρχοντος αρχείου, Open και Open Database, αποθήκευση, Save και Save As, εκτύπωση, Print, εμφάνιση πληροφοριών για τους τύπους και τα ονόματα των μεταβλητών Display Data File Information, κ.ά.

			Από τις επιλογές αυτές αξίζει να επικεντρωθούμε στις επιλογές της δημιουργίας νέου αρχείου, New, μέσω του οποίου καθορίζεται το είδος του παραθύρου που θα ανοίξει, όπου:

			
					Data: Για τη δημιουργία ενός νέου λογιστικού φύλλου καταγραφής δεδομένων.

					Syntax: Για τη δημιουργία ενός νέου περιβάλλοντος καταγραφής εντολών. Ο τρόπος γραφής των εντολών προϋποθέτει βασικές προγραμματιστικές γνώσεις και δεδομένου ότι η παρούσα εργασία απευθύνεται σε πιο αρχάριους αναλυτές, δεν θα γίνει αναφορά σε αυτές. Να αναφέρουμε όμως ότι εάν κάποιος αναλυτής επιθυμεί να αρχίσει να μαθαίνει τον τρόπο που δέχεται το SPSS τις εντολές, μπορεί αντί να εκτελεί κάθε πλαίσιο διαλόγου από το πλήκτρο OK, να χρησιμοποιεί το πλήκτρο PASTE το οποίο ανοίγει αυτόματα το περιβάλλον Syntax, έχοντας ήδη καταγράψει τον αντίστοιχο κώδικα.

					Output: Για την εμφάνιση του περιβάλλοντος των αποτελεσμάτων της κάθε ενέργειάς μας. Οποιαδήποτε ενέργεια εκτελεί ένας αναλυτής στο αρχείο δεδομένων του, (από τη μετατροπή μιας μεταβλητής, μέχρι την οποιαδήποτε ανάλυση), καταγράφονται στο συγκεκριμένο περιβάλλον. Επίσης, το αρχείο αυτό αποθηκεύεται και μπορεί να ανοιχτεί από τον αναλυτή χωρίς να είναι απαραίτητη η ύπαρξη αρχείου δεδομένων γι’ αυτό.

					Script: Από το συγκεκριμένο περιβάλλον ο αναλυτής έχει τη δυνατότητα να συντάξει πλήρη προγράμματα σε γλώσσες προγραμματισμού, όπως η Basic ή η Python, και να έχει πρόσβαση στις λειτουργίες του SPSS.

			

			Στην επόμενη παράγραφο όμως θα ασχοληθούμε πιο συγκεκριμένα με την καταχώρηση δεδομένων στην εφαρμογή που είναι το προαπαιτούμενο κομμάτι για να ξεκινήσουμε την οποιαδήποτε ανάλυση.

			3.2.1 Καταχώριση δεδομένων στο IBM SPSS

			Για να προβούμε σε οποιαδήποτε στατιστική επεξεργασία στο SPSS, απαιτείται αρχικά η καταγραφή των δεδομένων στο πρόγραμμα.

			Η εισαγωγή των δεδομένων δύναται να πραγματοποιηθεί:

			
					είτε με χειρόγραφη καταγραφή αυτών,

					είτε με τη μεταφορά αυτών από κάποιο άλλο λογισμικό. Το πιο ευρέως διαδεδομένο λογισμικό στο οποίο πραγματοποιείται η αρχική καταγραφή των δεδομένων είναι το EXCEL.

			

			Χειρόγραφη Καταγραφή Δεδομένων

			Η χειρόγραφη καταγραφή των δεδομένων πραγματοποιείται γράφοντας τα δεδομένα απευθείας πάνω στο λογιστικό φύλλο του SPSS. Τονίζουμε ότι μια ορθή καταγραφή είναι κάθε στήλη να αντιστοιχεί σε μια μεταβλητή και κάθε γραμμή να αντιστοιχεί στα στοιχεία του κάθε ατόμου / αντικειμένου. Σημειώνουμε ότι σε περίπτωση που κάποιος καταχωρητής τα έχει καταγράψει ανάποδα, δηλ. τις μεταβλητές στις γραμμές και τα χαρακτηριστικά στις στήλες, τότε ο αναλυτής θα πρέπει μέσω της επιλογής Data > Transpose, να αντιστρέψει τον πίνακα των δεδομένων του αρχείου.
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			Εικόνα 3.4: Εισαγωγή Δεδομένων στο λογιστικό φύλλο του SPSS

			Επίσης, για την ορθή καταγραφή των δεδομένων μας θα πρέπει αρχικά να πραγματοποιηθεί μια προεργασία κωδικοποίησής τους.

			Για παράδειγμα, εάν στην κατοχή μας διαθέτουμε ένα πλήθος απαντημένων ερωτηματολογίων, για την επεξεργασία της στατιστικής ανάλυσης θα πρέπει οι απαντήσεις των ερωτώμενων να καταγραφούν στο SPSS. Έτσι, πριν την καταγραφή τους είναι σημαντικό να ορίσουμε εξαρχής μια κωδικοποίηση στα:

			
					Ερωτηματολόγια.

					Στις μεταβλητές.

					Στις απαντήσεις των ερωτήσεων πολλαπλής επιλογής, ή σε οποιαδήποτε μεταβλητή περιέχεται στην ανάλυση.

			

			Μεταφορά Δεδομένων από Αρχείο Excel

			Για να εισάγουμε τα δεδομένα επιλέγουμε από την γραμμή εντολών:

			File > Open > Data
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			Εικόνα 3.5: Άνοιγμα αρχείου δεδομένων

			Στη συνέχεια αναζητάμε τη θέση αποθήκευσης του αρχείου δεδομένων, φροντίζοντας την επιλογή του κατάλληλου τύπου αρχείου, π.χ. Excel για αρχεία με κατάληξη .xls, .xlsx.

			Η διαδικασία συνεχίζεται με την επιλογή Open, όπου στη συνέχεια επιλέγουμε το φύλλο Worksheet από το οποίο θα αντλήσουμε τα δεδομένα μας, καθώς στο αρχείο Excel δύναται να υπάρχουν δεδομένα σε περισσότερα από ένα λογιστικά φύλλα.

			[image: \\server-pc\Storage_Volume\_ΥΛΙΚΟ ΔΟΥΛΕΙΑΣ\Κάλλιπος Χαλικιάς\Images - Resized\3.6.png]

			Εικόνα 3.6: Αναζήτηση του αρχείου δεδομένων

			[image: ]

			Εικόνα 3.7: Επιλογή του λογιστικού φύλλου με τα δεδομένα

			Με την ολοκλήρωση, OK, πραγματοποιείται η εισαγωγή των δεδομένων στο λογιστικό φύλλο του SPSS.
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			Εικόνα 3.8: Η υποενότητα Data View

			File > Save As

			Είτε με την ολοκλήρωση της καταγραφής των δεδομένων είτε σε ενδιάμεσο στάδιο, αποθηκεύουμε το αρχείο μας από την επιλογή File > Save As, ορίζοντας την τοποθεσία αποθήκευσης. Ενδιάμεσες καταχωρήσεις των τροποποιήσεων του αρχείου θα πρέπει να πραγματοποιούνται για την αποφυγή της απώλειάς τους, από την επιλογή File > Save.

			3.2.2 Κωδικοποίηση Δεδομένων

			Ερωτηματολόγια

			Στην περίπτωση που τα δεδομένα μας προέρχονται από ερωτηματολόγια θα πρέπει να γίνεται μια κωδικοποίηση των ερωτηματολογίων, δηλώνοντας στο κάθε ερωτηματολόγιο έναν μοναδικό κωδικό, ώστε στο μέλλον να είμαστε σε θέση να γνωρίζουμε από ποιο ερωτηματολόγιο προέρχονται οι παρατηρήσεις των μεταβλητών μας. Η συγκεκριμένη κωδικοποίηση καταγράφεται σχεδόν πάντα στην πρώτη στήλη του λογιστικού φύλλου.

			Μεταβλητές

			Στις περιπτώσεις των ερωτηματολογίων, συναντάμε συνήθως πολυπληθείς ομάδες ερωτήσεων, για τις οποίες για την πιο γρήγορη και άμεση καταγραφή τους ορίζουμε μια σύντομη περιγραφή, όπως «Q٠٠١», «Q٠٠٢» κ.ο.κ.. Ωστόσο, η πλήρης περιγραφή καταγράφεται, όπως είδαμε, στο πεδίο Label της ενότητας Variable View.

			Παρατηρήσεις

			Όταν τα δεδομένα, οι παρατηρήσεις, οι τιμές των μεταβλητών μας, ή αλλιώς οι απαντήσεις των ερωτήσεων είναι περιγραφικές, όταν δηλαδή με άλλα λόγια διαχειριζόμαστε ποιοτικές μεταβλητές, τότε κωδικοποιούμε τις απαντήσεις μας, και στο λογιστικό φύλλο καταγράφουμε απευθείας τις κωδικοποιήσεις αυτών. Για παράδειγμα, για τη μεταβλητή «Φύλλο» μπορούμε να ορίσουμε «١ - Άνδρας» και «٢ - Γυναίκα». Έτσι στην καταγραφή των δεδομένων θα γραφτούν απευθείας οι τιμές «1» και «2», αντίστοιχα. Η συγκεκριμένη προσέγγιση εκτός από το γεγονός ότι εξυπηρετεί την πιο γρήγορη καταγραφή των δεδομένων, ενισχύει τη βέλτιστη ποιότητα δεδομένων, καθώς εάν χρησιμοποιούσαμε String / Text τιμές, υπάρχει κίνδυνος διαφορετικότητας μεταξύ ιδίων τιμών, αφού μια τιμή «άνδρας» (με μικρό άλφα) είναι διαφορετική από την τιμή «Άνδρας» (με κεφαλαίο άλφα).

			Καλό θα είναι πριν οποιαδήποτε καταγραφή των δεδομένων, να υπάρχει μια αρχική συνεννόηση του αναλυτή με τους καταχωρητές, προκειμένου να αποφεύγονται μελλοντικά προβλήματα, δυσκολίες και ταλαιπωρία του αναλυτή κατά τον «καθαρισμό» των δεδομένων.

			3.3 Μενού Edit

			Περιέχει εντολές διαδικασιών ανάκλησης, Undo, αντιγραφής, Copy, αποκοπής, Cut, επικόλλησης δεδομένων, Paste, καθώς και εισαγωγής μεταβλητών, Insert Variable. Οι εντολές αυτές δεν θα αναλυθούν περισσότερο καθώς η χρήση τους είναι γνωστή και κοινή στα περισσότερα προγράμματα, και θεωρούμε ότι ο χρήστης είναι εξοικειωμένος στη χρήση υπολογιστών γενικότερα.

			3.4 Μενού View

			Περιέχει εντολές ρύθμισης του πλαισίου Data Editor, δηλ. του πλαισίου εμφάνισης των δεδομένων των μεταβλητών που ανοίγει αυτόματα με την εκκίνηση του προγράμματος.

			Έτσι μέσω των επιλογών παρέχονται οι δυνατότητες απόκρυψης ή διαμόρφωσης της γραμμής εργαλείων Status Bar, απόκρυψης ή εμφάνισης του Data Editor, διαχείρισης της γραμματοσειράς της οθόνης Fonts, καθώς και εμφάνισης των τιμών ή της περιγραφής των τιμών των μεταβλητών Values Labels.

			Ομοίως, οι εντολές αυτές δεν θα αναλυθούν περισσότερο καθώς η χρήση τους είναι απλή και οι χρήστες θα μπορούσαν να πειραματιστούν σε αυτές. Επίσης αφορούν σε μορφολογικά τμήματα της εφαρμογής οπότε δεν κρίνεται αναγκαία η εκμάθησή τους από την παρούσα εργασία.

			3.5 Μενού Data

			Περιέχει εντολές διαχείρισης και τροποποίησης των δεδομένων, όπως επιλογή των δεδομένων που θα αναλυθούν Select Cases, ταξινόμηση δεδομένων Sort Cases, διαχωρισμού αρχείου Split File ή ενοποίησης αρχείων Merge Files. Στο συγκεκριμένο μενού επιλογών περιέχονται αρκετά σημαντικές δυνατότητες χειρισμού των μεταβλητών, εκ των οποίων αξίζει να παρουσιάσουμε τα εξής:

			3.5.1 Sort Cases

			Η δυνατότητα προσφέρεται από την επιλογή Data > Sort Cases, με σκοπό την ταξινόμηση των δεδομένων (γραμμών) με βάση μιας ή περισσότερων μεταβλητών.

			Στο παράθυρο διαλόγου που προκύπτει ο χρήστης καλείται να προσθέσει τη μεταβλητή ή τις μεταβλητές βάσει των οποίων θα πραγματοποιηθεί η ταξινόμηση, και στη συνέχεια να ορίσει εάν η ταξινόμηση θα είναι αύξουσα Ascending ή φθίνουσα Descending. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK.
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			Εικόνα 3.9: Η υποενότητα Sort Cases

			3.5.2 Sort Variables

			Η δυνατότητα προσφέρεται από την επιλογή Data > Sort Variables, με σκοπό την ταξινόμηση των δεδομένων με βάση κάποιο χαρακτηριστικό μιας ή περισσότερων μεταβλητών του αρχείου.

			Ορισμένες επιλογές ταξινόμησης που προσφέρονται από το παράθυρο διαλόγου είναι η ονομασία της μεταβλητής, ο τύπος, ο αριθμός των ψηφίων της κ.ά.

			[image: \\server-pc\Storage_Volume\_ΥΛΙΚΟ ΔΟΥΛΕΙΑΣ\Κάλλιπος Χαλικιάς\Images - Resized\3.10.png]

			Εικόνα 3.10: Η υποενότητα Sort Variables

			Ομοίως ο αναλυτής έχει τη δυνατότητα να ορίσει εάν η ταξινόμηση θα είναι αύξουσα Ascending ή φθίνουσα Descending. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK.

			3.5.3 Transpose

			Η δυνατότητα προσφέρεται από την επιλογή Data > Transpose, με σκοπό την αντιμετάθεση των γραμμών (χαρακτηριστικά ατόμων ή αντικειμένων) και των στηλών (μεταβλητών) του αρχείου. Έτσι δημιουργείται ένα νέο αρχείο το οποίο έχει τις στήλες ως γραμμές και τις γραμμές ως στήλες. Να αναφέρουμε ότι η συγκεκριμένη δυνατότητα εξυπηρετεί περιπτώσεις όπου οι καταχωρητές έχουν καταγράψει με «λανθασμένο» τρόπο τα δεδομένα, π.χ. σε κάποιο ενδιάμεσου τύπου αρχείο, όπως Excel. Και μιλάμε για λανθασμένο τρόπο καταχώρησης, διότι τα στατιστικά προγράμματα χειρίζονται τα δεδομένα έχοντας ως κοινό παρονομαστή ότι κάθε στήλη αντιστοιχεί σε κάποια μεταβλητή, ενώ κάθε γραμμή σε κάποια οντότητα (άτομο ή αντικείμενο).

			[image: \\server-pc\Storage_Volume\_ΥΛΙΚΟ ΔΟΥΛΕΙΑΣ\Κάλλιπος Χαλικιάς\Images - Resized\3.11.png]

			Εικόνα 3.11: Η υποενότητα Transpose

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK.

			3.5.4 Select Cases

			Υπάρχουν περιπτώσεις που επιθυμούμε να πραγματοποιήσουμε ανάλυση δεδομένων σε συγκεκριμένες παρατηρήσεις, οι οποίες ικανοποιούν ορισμένα κριτήρια. Σε αυτή την περίπτωση η προσθήκη φίλτρου στην επιλογή των παρατηρήσεων πραγματοποιείται από την ενότητα : Data > Select Cases.

			Από αυτή την ενότητα παρέχονται οι επιλογές:

			
					All Cases: Για την επιλογή όλων των παρατηρήσεων. Αυτή χρησιμοποιείται κυρίως για την παύση ενός φίλτρου που έχει ήδη εφαρμοστεί, ώστε η μελλοντική ανάλυση να γίνει και πάλι στο σύνολο των δεδομένων του αρχείου.

					If condition is satisfied: Για να ορίσουμε τις συνθήκες επιλογής των παρατηρήσεων. Η υποενότητα που εμφανίζεται είναι σχεδόν ίδια με αυτή της εντολής Transform > Compute όπου στο πλαίσιο πάνω δεξιά της ενότητας καταγράφεται η «μαθηματική» έκφραση, ενώ επίσης από το πλαίσιο Function Group παρέχονται διάφορες μαθηματικές, σχεσιακές ή λογικές συναρτήσεις. Εφαρμόζοντας το φίλτρο, εάν η συνθήκη που έχει καταγραφεί ισχύει, τότε η παρατήρηση επιλέγεται, αλλιώς όχι.
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			Εικόνα 3.12: Η υποενότητα Select Cases
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			Εικόνα 3.13: Menu Data > Select Cases > If condition is satisfied

			
					Random samples of cases: Για να γίνει μέσω τυχαίας δειγματοληψίας επιλογή τυχαίου υποσυνόλου παρατηρήσεων. Ο αναλυτής μπορεί να επιλέξει δείγμα κατά προσέγγιση (Approximately) μεγέθους ίσου με οριζόμενο ποσοστό, π.χ. ١٠٪ των συνολικών παρατηρήσεων, ή ακριβώς (Exactly) με το οριζόμενο πλήθος παρατηρήσεων.

			

			Σε περίπτωση που επιλεγεί η δεύτερη μέθοδος, ο αναλυτής μπορεί να ορίσει και το πλήθος των παρατηρήσεων του αρχικού αρχείου από το οποίο θα επιλεγεί το δείγμα, συνεπώς σ’ αυτή την περίπτωση το οριζόμενο πλήθος θα πρέπει να είναι μικρότερο ή ίσο από το πλήθος των παρατηρήσεων του αρχικού αρχείου.
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			Εικόνα 3.14: Η υποενότητα Random samples of cases

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK.

			Με την ολοκλήρωση των ενεργειών μας επιβεβαιώνουμε ότι έχουμε ολοκληρώσει ορθά τη διαδικασία, ελέγχοντας τα αποτελέσματα των ενεργειών μας:

			
					Στην υποενότητα Data View εμφανίζεται η διαγραφή των μη επιλεγμένων παρατηρήσεων. Οι παρατηρήσεις που έχουν την ένδειξη της διαγραφής, δεν θα ληφθούν υπόψη στην οποιαδήποτε ανάλυση πραγματοποιήσει ο αναλυτής.[image: \\server-pc\Storage_Volume\_ΥΛΙΚΟ ΔΟΥΛΕΙΑΣ\Κάλλιπος Χαλικιάς\Images - Resized\3.15.png]
Εικόνα 3.15: Εμφάνιση των διαγραμμένων παρατηρήσεων


					Στην υποενότητα Variable View έχει δημιουργηθεί η μεταβλητή φίλτρου η οποία φέρει την ονομασία filter_$, και στην περιγραφή της οποίας μπορούμε να δούμε λεπτομέρειες για το φίλτρο που εφαρμόστηκε.
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			Εικόνα 3.16: Δημιουργία της μεταβλητής φίλτρου

			Η πάυση του φίλτρου πραγματοποιείται είτε από την επιλογή Data > Select Cases > All Cases, είτε απλά διαγράφοντας τη μεταβλητή filter_$ από την επιλογή Clear στο περιβάλλον Variable View.

			3.5.5 Merge Files

			Η δυνατότητα προσφέρεται από την επιλογή Data > Merge με σκοπό την ενοποίηση δεδομένων από διαφορετικά αρχεία, και αυτό γιατί συμβαίνει συχνά η καταχώρηση των δεδομένων να γίνεται από περισσότερους του ενός καταχωρητές για εξοικονόμηση χρόνου. Έτσι στο τέλος προκύπτουν διαφορετικά αρχεία δεδομένων τα οποία θα πρέπει να ενοποιηθούν σε ένα.

			Από το σημείο αυτό παρέχονται δύο επιλογές:

			
					Merge > Add Cases - Με σκοπό τη δημιουργία ενός νέου αρχείου δεδομένων, όπου ο αναλυτής θα έχει απομονώσει ορισμένες μεταβλητές από ένα μεγαλύτερο αρχείο, και την επιλογή.

					Merge > Add Variables - Με σκοπό την δημιουργία ενός νέου συγκεντρωτικού αρχείου δεδομένων, όπου ο αναλυτής θα συγκεντρώσει σε ένα αρχείο μεταβλητές από διαφορετικά αρχεία.

			

			Merge > Add Cases

			Στο πρώτο πλαίσιο διαλόγου ο αναλυτής ορίζει το αρχείο από το οποίο θα αντλήσει δεδομένα. Αυτό μπορεί να είναι είτε κάποιο αρχείο που είναι ήδη ανοιγμένο An open dataset, είτε να ορίσει το μονοπάτι στο οποίο βρίσκεται αποθηκευμένο το αρχείο An external PASW Statistics data file.
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			Εικόνα 3.17: Η υποενότητα Merge > Add Cases > Step 1

			Στη συνέχεια στο δεύτερο πλαίσιο διαλόγου θα οριστούν στο σημείο Variables in New Active Dataset οι μεταβλητές που θα δημιουργήσουν το νέο αρχείο.
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			Εικόνα 3.18: Η υποενότητα Merge > Add Cases > Step 2

			Merge > Add Variables

			Ομοίως, στο πρώτο πλαίσιο διαλόγου ο αναλυτής ορίζει το αρχείο από το οποίο θα λάβει τις επιπρόσθετες μεταβλητές. Αυτό μπορεί να είναι είτε κάποιο αρχείο που είναι ήδη ανοιγμένο An open dataset είτε να ορίσει το μονοπάτι στο οποίο βρίσκεται αποθηκευμένο το αρχείο An external PASW Statistics data file.
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			Εικόνα 3.19: Η υποενότητα Merge > Add Variables > Step 1

			Στη συνέχεια στο δεύτερο πλαίσιο διαλόγου έχουμε:

			
					Excluded Variables: Σ’ αυτό το παράθυρο δηλώνονται οι μεταβλητές που δεν θα προστεθούν στο αρχείο.

					New Active Dataset: Εμφανίζονται οι μεταβλητές που περιέχονται στο επιλεγμένο αρχείο.

					Key Variables: Το συγκεκριμένο πλαίσιο ενεργοποιείται όταν επιλεγεί Match cases on key variables in sorted files με σκοπό να δηλωθεί η μεταβλητή - κλειδί (ID) σύμφωνα με την οποία θα γίνει η αναγνώριση των δεδομένων σε κάθε οντότητα (γραμμή του αρχείου).

			

			Για να επιτευχθεί μια σωστή αντιστοίχιση των παρατηρήσεων κάθε οντότητας (ατόμου ή αντικειμένου αναλόγως τί μελετάμε) θα πρέπει:

			
					η μεταβλητή κλειδί να περιέχεται και στα δύο αρχεία, και

					οι εγγραφές να έχουν ήδη ταξινομηθεί με βάση το κλειδί (βλ. εντολή Sort Cases).

			

			Η ίδια η εφαρμογή εμφανίζει μήνυμα διακοπής για την πρώτη περίπτωση και προειδοποιητικό μήνυμα για τη δεύτερη περίπτωση.
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			Εικόνα 3.20: Μήνυμα διακοπής ώστε το κλειδί να δηλωθεί και στα δύο προς ενοποίηση αρχεία
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			Εικόνα 3.21: Προειδοποιητικό μήνυμα ταξινόμησης των δεδομένων με βάση το κλειδί αντιστοίχισης
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			Εικόνα 3.22: Η υποενότητα Merge > Add Variables > Step 2

			Στο παραπάνω παράδειγμα έχουμε δύο αρχεία με κοινές τις μεταβλητές sex, age, education, οι οποίες επειδή υπάρχουν και στα δύο αρχεία, εξαιρούνται από την ενοποίηση για να μην έχουμε διπλοκαταχωρήσεις. Και στα δύο αρχεία περιέχεται η μεταβλητή ταυτοποίησης της κάθε γραμμής ID, η οποία και ορίζεται ως η μεταβλητή κλειδί.

			Με την ολοκλήρωση της διαδικασίας προκύπτει ένα αρχείο που περιέχει το σύνολο των μεταβλητών.
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			Εικόνα 3.23: Αποτέλεσμα μετά την ενοποίηση Merge

			3.5.6 Split File

			Η δυνατότητα προσφέρεται από την επιλογή Data > Split File, με σκοπό την αντίθετη διαδικασία από την επιλογή Merge, δηλ. τον διαχωρισμό των παρατηρήσεων του αρχείου σε μικρότερες εικονικές διαμερίσεις. Ο διαχωρισμός επιτυγχάνεται με βάση τις τιμές μιας ή περισσότερων μεταβλητών Compare Groups με σκοπό την εφαρμογή της επόμενης ανάλυσης στο επιλεγμένο υποσύνολο. Η διαμέριση πραγματοποιείται ιεραρχικά αρχίζοντας από την πρώτη μεταβλητή στο πλαίσιο Groups Based on, στη συνέχεια εσωτερικά στην κάθε κατηγορία αυτής με τις τιμές της δεύτερης, κ.ο.κ.
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			Εικόνα 3.24: Η υποενότητα Split File

			Διαπιστώνουμε ότι η συγκεκριμένη δυνατότητα διαφέρει κατά πολύ από την επιλογή Select Cases, και επιπρόσθετα θα πρέπει να λάβουμε υπόψη ότι για την εφαρμογή της διαμέρισης θα πρέπει οι παρατηρήσεις να έχουν ταξινομηθεί από την επιλογή Sort Cases.

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK.

			3.5.7 Weight Cases

			Η δυνατότητα προσφέρεται από την επιλογή Data > Weight Cases, με σκοπό οι παρατηρήσεις να σταθμιστούν σύμφωνα με τις τιμές μιας άλλης μεταβλητής. Οι τιμές της μεταβλητής που χρησιμοποιούνται για τη στάθμιση μιας άλλης μεταβλητής θεωρούνται ως το πλήθος των επαναλήψεων (replications) της κάθε παρατήρησης από την αστάθμητη μεταβλητή.

			Η μεταβλητή που χρησιμοποιείται για να σταθμίσει μια άλλη, ενδέχεται είτε να είναι μια αρχική μεταβλητή του αρχείου είτε μια μεταβλητή που έχει προκύψει από κάποια ανάλυση (π.χ. παλινδρόμηση).

			Επίσης, η χρήση αυτής της επιλογής γίνεται όταν η καταχώρηση δεδομένων έχει γίνει με ομαδοποίηση δεδομένων. Για παράδειγμα, έστω ότι έχουμε ένα δείγμα 100 παρατηρήσεων όπου κάποιος έχει μετρήσει το πλήθος των τιμών μιας μεταβλητής (έστω το πλήθος παιδιών σε μια οικογένεια), και αντί να λάβουμε αναλυτική γνώση όλων των παρατηρήσεων, λαμβάνουμε το πλήθος της κάθε παρατήρησης, δηλ. το πλήθος της τιμής «0 παιδιά», της τιμής «1 παιδί» κ.ο.κ. Για να μπορέσει ο ερευνητής να εξάγει περιγραφικούς δείκτες γι’αυτά τα δεδομένα θα πρέπει να χρησιμοποιήσει αυτή τη δυνατότητα καθώς στην πραγματικότητα η τιμή «1» εμφανίστηκε 22 φορές στο δείγμα.
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			Εικόνα 3.25: Πίνακας συχνοτήτων της μεταβλητής πλήθος παιδιών σε μια οικογένεια

			Στο πεδίο Frequency Variable καταγράφεται η μεταβλητή στάθμισης των δεδομένων.
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			Εικόνα 3.26: Η υποενότητα Weight Cases

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK.

			3.5.8 Restructure

			Η δυνατότητα προσφέρεται από την επιλογή Data > Restructure, με σκοπό την αναδιοργάνωση του αρχείου μετατρέποντας τις μεταβλητές σε παρατηρήσεις, και αντίστροφα. Η εντολή αυτή διαφέρει από την εντολή Τranspose, καθώς δεν αλλάζει απλά τη διάσταση του πίνακα εναλλάσσοντας γραμμές με στήλες, αλλά αναδιοργανώνει την δομή των μεταβλητών και των παρατηρήσεων σύμφωνα με κανόνες.

			Η αναδιοργάνωση συνήθως χρησιμοποιείται για την εξαγωγή στατιστικών αναλύσεων σε περιπτώσεις επαναλαμβανόμενων μετρήσεων, δηλ. μετρήσεων του ίδιου χαρακτηριστικού ενός άτομου που έχουν καταγραφεί σε διαφορετικές χρονικές στιγμές, και στο αρχείο έχουν καταγραφεί σε διαφορετικές στήλες.

			Έστω για παράδειγμα ότι έχουμε τις ακόλουθες τιμές, βλ. Εικόνα 3.27:
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			Εικόνα 3.27: Δεδομένα σε Wide Format

			Στόχος μας είναι το αρχείο να λάβει μια μορφή όπου τα δεδομένα των τριών μεταβλητών Time1, 2, 3 θα περιέχονται σε μία στήλη (μια μεταβλητή). Δύο είναι οι περιπτώσεις / μεθοδολογίες που θα συναντήσουμε:

			
					Data > Restructure > Restructure selected variables into cases.

			

			Με σκοπό την αναδιοργάνωση από Wide σε Long Format.

			
					Data > Restructure > Restructure selected cases into variables.

			

			Με σκοπό την αναδιοργάνωση από Long σε Wide Format. Η μέθοδος της αναδιοργάνωσης του αρχείου εξαρτάται από την ανάλυση που θα πραγματοποιηθεί, καθώς και από την πρωταρχική μορφή του αρχείου.

			Στο παράδειγμα, υπό την υπάρχουσα μορφή των δεδομένων ο αναλυτής μπορεί μόνο να διεξάγει:

			
					GLM Repeated Measures

					Paired Sample T- test

					2 Repeated Samples

					k - Repeated Samples

			

			Σε αυτές τις περιπτώσεις δεν υπάρχει η ανάγκη αναδιοργάνωσης.

			Όμως, αυτές δεν είναι παρά ορισμένες περιπτώσεις, και καθώς η πλειοψηφία των στατιστικών αναλύσεων απαιτούν μια μορφή όπου τα δεδομένα του αρχείου θα είναι σε εκτενή μορφή (long) με ομαδοποίηση παρατηρήσεων και όχι μεταβλητών, οπότε το αρχείο πρέπει να αναδιοργανωθεί.

			Στο σημείο αυτό να αναφέρουμε ξανά ότι είναι σημαντικό να γίνεται μια αρχική συνεννόηση του αναλυτή με τους καταχωρητές των δεδομένων για να αποφεύγονται μελλοντικές καθυστερήσεις επεξεργασίας και αναδιοργάνωσης του αρχείου δεδομένων. Βέβαια καθώς τα δεδομένα ενδέχεται να προέρχονται από οποιαδήποτε πηγή και σε οποιαδήποτε μορφή, πρέπει να γνωρίζουμε το είδος της ανάλυσης που θα πραγματοποιηθεί έτσι ώστε να διαμορφώσουμε κατάλληλα το αρχείο στην επιθυμητή μορφή. Αναλυτικότερα για την ολοκλήρωση της διαδικασίας ακολουθούμε 7 βήματα.

			Βήμα 1 από 7

			Επιλογή της μεθόδου ανάλογα με την αρχική μορφή των δεδομένων μας, και το είδος της ανάλυσης που θα πραγματοποιήσουμε. Στο παράδειγμα μας (βλ. παραπάνω) τα δεδομένα είναι σε Wide μορφή οπότε επιλέγουμε:

			Data > Restructure > Restructure selected variables into cases και στη συνέχεια το πλήκτρο Next.
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			Εικόνα 3.28: Επιλογή μεθόδου αναδιοργάνωσης. Βήμα 1 από 7

			Βήμα 2 από 7

			Επιλέγουμε το πλήθος των ομαδοποιημένων μεταβλητών που υπάρχουν στο αρχείο. Στο παράδειγμα (βλ. παραπάνω) οι τρείς μεταβλητές time1, time 2, time 3 αποτελούν μια ομάδα μεταβλητών καθώς αναφέρονται σε μετρήσεις του ίδιου χαρακτηριστικού που πραγματοποιήθηκαν σε διαφορετικές χρονικές στιγμές.

			Έτσι, επιλέγουμε την επιλογή One. Σε αντίθετη περίπτωση θα επιλέγαμε More than one και θα ορίζαμε το πλήθος των ομάδων μεταβλητών.
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			Εικόνα 3.29: Επιλογή πλήθους ομάδων μεταβλητών. Βήμα 2 από 7

			Βήμα 3 από 7

			Στο σημείο αυτό ορίζουμε τις μεταβλητές. Στο πλαίσιο Case Group Identification επιλέγουμε τη μεταβλητή εκείνη που ταυτοποιεί τις παρατηρήσεις. Στην προκειμένη περίπτωση θα δημιουργήσουμε τη μεταβλητή Subject, για την οποία καταγράφουμε το όνομά της στο πεδίο Label.

			Στο πεδίο Target Variable δηλώνουμε το όνομα της νέας μεταβλητής, και στη συνέχεια εντός του πλαισίου προσθέτουμε τις επαναλαμβανόμενες μεταβλητές, Time1, Time2, Time3.

			Τέλος στο πλαίσιο Fixed Variable(s) θα καταγραφούν εκείνες οι μεταβλητές που είναι σταθερές σε κάθε γραμμή, (όπως sex,age), δηλ. τα αμετάβλητα χαρακτηριστικά του ατόμου.
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			Εικόνα 3.30: Ορισμός των μεταβλητών. Βήμα 3 από 7

			Βήμα 4 από 7

			Σ’ αυτό το βήμα δηλώνουμε τη δημιουργία μεταβλητών-δεικτών (Indexes), οι οποίες μας βοηθούν να αναγνωρίσουμε της επαναλήψεις. Οι μεταβλητές αυτές απαιτούνται σε ορισμένες στατιστικές αναλύσεις (π.χ. Repeated Measurement Analysis) για την αναγνώριση των υποκειμένων. Η εφαρμογή παρουσιάζει ένδειξη για τη μορφή που θα λάβουν οι δείκτες, και ο αναλυτής στο σημείο αυτό καλείται να ορίσει το πλήθος τους.

			Εάν στο παράδειγμά μας είχαμε περισσότερες από μια ομάδες μεταβλητών, τότε θα ήταν αναγκαία η δημιουργία περισσότερων από μια μεταβλητών-δεικτών.
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			Εικόνα 3.31: Επιλογή πλήθους μεταβλητών-δεικτών. Βήμα 4 από 7

			Βήμα 5 από 7

			Σ’ αυτό το βήμα ορίζουμε τις τιμές, την ονομασία και την περιγραφή των μεταβλητών-δεικτών. Οι τιμές που δύναται να λάβουν είναι είτε διαδοχικοί αριθμοί sequential numbers είτε το όνομα της μεταβλητής από την οποία προέκυψαν variable name.

			Στο πλαίσιο Edit the Index Variable Name and Label καταγράφονται η ονομασία και η περιγραφή των μεταβλητών-δεικτών.

			Βήμα 6 από 7

			Σε αυτό δηλώνουμε ορισμένες παραμέτρους (Options) που αφορούν στη μορφή του αναδιοργανωμένου αρχείου ως προς τις μεταβλητές που δεν θα αναδιοργανωθούν Handling of Variables not Selected, τις ελλείπουσες παρατηρήσεις System Missing, και τη δημιουργία μιας νέας μεταβλητής Create Count Variable που θα μετρά το πλήθος των παρατηρήσεων που προκύπτουν για κάθε παρατήρηση του αρχικού αρχείου.
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			Εικόνα 3.32: Ορισμός στοιχείων της μεταβλητής-δείκτη. Βήμα 5 από 7
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			Εικόνα 3.33: Ορισμός λοιπών στοιχείων διαχείρισης. Βήμα 6 από 7

			Βήμα 7 από 7

			Στο τελευταίο βήμα ολοκληρώνεται η διαδικασία της αναδιοργάνωσης Finish. Ωστόσο, παρέχεται η δυνατότητα επανάκτησης της αρχικής μορφής των δεδομένων.
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			Εικόνα 3.34: Ολοκλήρωση της διαδικασίας. Βήμα 7 από 7
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			Εικόνα 3.35: Μήνυμα δυνατότητας επανάκτησης του αρχικού αρχείου
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			Εικόνα 3.36: Το αποτέλεσμα της αναδιοργάνωσης. Δεδομένα σε long format

			3.6 Μενού Transform

			Περιέχει εντολές για τη δημιουργία νέων μεταβλητών ή τον μετασχηματισμό υπαρχόντων, βασιζόμενες σε ορισμένες συνεχείς κατανομές ή σε μαθηματικές και λογικές σχέσεις υπαρχόντων δεδομένων. Από τις εντολές αυτές θα ασχοληθούμε εκτενέστερα με τις εξής:

			3.6.1 Recode

			Η δυνατότητα προσφέρεται από την επιλογή Transform > Recode, με σκοπό την επανακωδικοποίηση των τιμών μιας μεταβλητής.

			Η εντολή χωρίζεται σε δύο κατηγορίες:

			
					Transform > Recode > Into Same Variable - Για την εφαρμογή της επανακωδικοποίησης των τιμών μιας μεταβλητής εντός της ίδιας μεταβλητής.

					Transform > Recode > Into Different Variable - Για την εφαρμογή της επανακωδικοποίησης των τιμών μιας μεταβλητής σε μια νέα μεταβλητή, διατηρώντας την αρχική μεταβλητή αμετάβλητη.

			

			Transform > Recode > Into Same Variable

			Στο πρώτο πλαίσιο διαλόγου ο αναλυτής ορίζει στο πλαίσιο Numeric Variables τη μεταβλητή ή τις μεταβλητές που θα μετασχηματίσει, και στη συνέχεια στο πλαίσιο διαλόγου Old and New Values τις παλαιές και τις νέες τιμές.
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			Εικόνα 3.37: Η υποενότητα Recode Into Same Variables
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			Εικόνα 3.38: Η υποενότητα Old and New Values

			Έστω ότι ο ερευνητής θέλει να μετασχηματίσει μια ποσοτική μεταβλητή σε μια ποιοτική μεταβλητή, ομαδοποιώντας τα δεδομένα της συνεχούς μεταβλητής σε κλάσεις. Ο ορισμός των νέων τιμών πραγματοποιείται στο υποπλαίσιο διαλόγου Old & New Values, όπου αναλυτικά έχουμε:

			Old Values

			Στο σημείο αυτό δηλώνονται οι αρχικές τιμές, ή το εύρος τιμών, ή ακόμα και οι ελλείπουσες τιμές της υπάρχουσας μεταβλητής που θα επανακωδικοποιηθούν. Ο χειρισμός του εύρους μπορεί να οριστεί είτε για τα ανώτατα, είτε για κατώτατα άκρα.

			New Values

			Στο σημείο αυτό ορίζονται οι νέες τιμές της μεταβλητής που θα αντικαταστήσουν τις αρχικές για κάθε επιλογή.

			Με το πλήκτρο Add κάθε αντιστοίχιση μεταφέρεται στο υποπλαίσιο Old > New, ενώ από τα πλήκτρα Change και Remove παρέχεται η δυνατότητα τροποποίησης ή διαγραφής μιας αντιστοίχισης. Οι αντιστοιχήσεις εμφανίζονται ταξινομημένες σύμφωνα πάντα με τις αρχικές τιμές της μεταβλητής.

			Transform > Recode > Into Different Variable

			Με αυτή την επιλογή, η αρχική μεταβλητή παραμένει αναλλοίωτη και η επανακωδικοποίηση εφαρμόζεται για τη δημιουργία νέας μεταβλητής. Η διαδικασία είναι όμοια με την προηγούμενη επιλογή, με τη διαφορά ότι πλέον ο χρήστης θα πρέπει να ορίσει τη σύντομη και την πλήρη ονομασία της νέας μεταβλητής στο πλαίσιο Output Variable στα πεδία Name και Label, και επιπρόσθετα από το πλήκτρο Change να δηλώσει ποια μεταβλητή αντικαθιστά την επιλεγμένη υπάρχουσα.
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			Εικόνα 3.39: Η υποενότητα Recode into Different Variables

			Σε περιπτώσεις που η επανακωδικοποίηση είναι περισσότερο πολύπλοκη, ή για παράδειγμα πρέπει να εφαρμοστεί σε ένα υποσύνολο των αρχικών τιμών, τότε αυτό επιτυγχάνεται από το πλήκτρο If (optional case selection condition) υποπλαίσιο διαλόγου If cases. Το παράθυρο που εμφανίζεται είναι σχεδόν ίδιο με αυτό της επιλογής Compute παρέχοντας τη δυνατότητα μετασχηματισμού εφαρμόζοντας μαθηματικές πράξεις ή συναρτήσεις. Προκαθορισμένες συναρτήσεις περιέχονται στη λίστα Function Group.
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			Εικόνα 3.40: Η υποενότητα If cases

			Μια συνήθης περίπτωση επανακωδικοποίησης των τιμών μιας μεταβλητής είναι όταν ο αναλυτής έχει να διαχειριστεί διατάξιμες μεταβλητές από ερωτηματολόγιο κοινωνικοψυχολογικών μετρήσεων, και θέλει να κάνει αλλαγή στην κλίμακα μιας διατάξιμης μεταβλητής. Για παράδειγμα, οι τιμές 1 - 5 (κλίμακα Likert) να τροποποιηθούν σε «-1», «-0,5», «0», «+0,5», «+1», ώστε στη συνέχεια ο χρήστης να προβεί σε δημιουργία δείκτη που άμεσα θα λαμβάνει την ένδειξη εάν οι προτιμήσεις των ερωτώμενων είναι «θετικές» ή «αρνητικές».

			3.6.2 Compute

			Η δυνατότητα προσφέρεται από την επιλογή Transform > Compute, με σκοπό τη δημιουργία νέων μεταβλητών υπό την εφαρμογή μιας μαθηματικής (αριθμητικής) έκφρασης.

			Στο πεδίο Target Variable καταγράφεται η σύντομη ονομασία της νέας μεταβλητής, ενώ στο δεξιό μέρος Numeric Expression καταγράφεται η μαθηματική έκφραση (ο τύπος μετασχηματισμού) της μεταβλητής ή η μαθηματική έκφραση των μεταβλητών που θα οδηγήσουν στη δημιουργία της νέας μεταβλητής.

			Η χρήση της συγκεκριμένης επιλογής συνηθίζεται σε μετασχηματισμούς των μονάδων μέτρησης, π.χ. από GHz σε MHz, ή στη δημιουργία μεταβλητών υψωμένων σε δυνάμεις για τη μετέπειτα χρήση τους σε μοντέλα παλινδρόμησης. Αξίζει να σημειωθεί ότι κατά τη διαδικασία υπολογισμού της νέας μεταβλητής παρέχεται πληθώρα μαθηματικών και στατιστικών συναρτήσεων στο πλαίσιο Function Group.
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			Εικόνα 3.41: Η υποενότητα Compute

			Παράδειγμα

			Έστω ότι ο ερευνητής έχει καταγράψει μόνο το έτος γέννησης των ερωτώμενων και θέλει να υπολογίσει την ηλικία τους. Σ’ αυτή την περίπτωση η μαθηματική έκφραση που θα καταγραφεί στο πλαίσιο Numeric Expression είναι : «2015-brthyear», όπου brthyear η μεταβλητή «Έτος Γέννησης».

			3.6.3 Replace Missing Values

			Η δυνατότητα προσφέρεται από την επιλογή Transform > Replace Missing Values, με σκοπό την αντικατάσταση των ελλειπουσών τιμών, όταν αυτές υπάρχουν, καθώς δημιουργούν προβλήματα στις στατιστικές αναλύσεις. Το κυριότερο πρόβλημα είναι το ότι μειώνουν το πλήθος των προς επεξεργασία δεδομένων, με αποτέλεσμα να μην ισχύουν βασικές υποθέσεις της μεθοδολογίας. Στις περιπτώσεις που η εφαρμογή διαπιστώνει ότι οι υποθέσεις της κάθε μεθοδολογίας καταστρατηγούνται, τότε εμφανίζει προειδοποιητικό μήνυμα (Warning) στην αρχή των αποτελεσμάτων της ανάλυσης, για ενημέρωση του αναλυτή, ώστε αυτός στη συνέχεια να προβεί σε κάποια μέθοδο διαχείρισής τους.

			Σ’ αυτές τις περιπτώσεις η αντικατάσταση των ελλειπουσών τιμών κρίνεται αναγκαία και μπορεί να γίνει με την αντικατάσταση αυτών των μεταβλητών (των μεταβλητών που έχουν ελλείπουσες τιμές) από νέες μεταβλητές οι οποίες προκύπτουν από τις αρχικές έχοντας αντικαταστήσει της ελλείπουσες τιμές με κάποια τιμή. Η τιμή που θα καταγραφεί στην θέση της ελλείπουσας τιμής προκύπτει μέσω της επιλεγμένης μεθόδου.
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			Εικόνα 3.42: Η υποενότητα Replace Missing Values

			Οι νέες μεταβλητές που θα προκύψουν έχουν ως ονομασία την ονομασία της αρχικής μεταβλητής (τους έξι πρώτους χαρακτήρες) και αριθμημένη κατάληξη, διατηρώντας τα value labels της αρχικής (εφόσον υπάρχουν).

			Στο πλαίσιο New Variable ορίζονται οι μεταβλητές οι οποίες έχουν πρόβλημα ελλειπουσών τιμών και στο πεδίο Method επιλέγεται η μέθοδος διαχείρισής τους.

			Μέθοδοι Διαχείρισης Ελλειπουσών Τιμών

			Η εφαρμογή διαθέτει τις ακόλουθες μεθόδους:

			
					Mean: Ώστε οι ελλείπουσες τιμές να αντικατασταθούν από τον μέσο όρο των υπαρχόντων παρατηρήσεων της μεταβλητής.

					Mean or nearby points: Ώστε οι ελλείπουσες τιμές να αντικατασταθούν από τον μέσο όρο των παρατηρήσεων που βρίσκονται γύρω από την ελλείπουσα τιμή. Το πλήθος των παρατηρήσεων που θα ληφθούν υπόψη (πάνω και κάτω από την ελλείπουσα παρατήρηση) ορίζεται στο πεδίο span of nearby points. Η συγκεκριμένη δυνατότητα είναι σύνηθες να χρησιμοποιείται όταν η μεταβλητή είναι διατάξιμη και η τιμή της ελλείπουσας τιμής εξαρτάται από τη θέση της.

					Median or nearby points: Ώστε οι ελλείπουσες τιμές να αντικατασταθούν από τη διάμεσο των παρατηρήσεων που βρίσκονται γύρω από την ελλείπουσα τιμή. Το πλήθος των παρατηρήσεων που θα ληφθούν υπόψη (πάνω και κάτω από την ελλείπουσα παρατήρηση) ορίζεται στο πεδίο span of nearby points. Η συγκεκριμένη δυνατότητα είναι σύνηθες να χρησιμοποιείται όταν η μεταβλητή είναι διατάξιμη και η τιμή της ελλείπουσας τιμής εξαρτάται από τη θέση της.

					Linear Interpolation: Ώστε η αντικατάσταση να πραγματοποιηθεί με τη μέθοδο της γραμμικής παρεμβολής, χρησιμοποιώντας τις παρατηρήσεις πριν και μετά τη θέση της ελλείπουσας τιμής. Εάν οι παρατηρήσεις πριν και μετά είναι επίσης ελλείπουσες τιμές, τότε η μέθοδος δεν μπορεί να εφαρμοστεί.

					Linear Trend at point: Ώστε οι ελλείπουσες τιμές να αντικατασταθούν με τη χρήση υποδείγματος γραμμικής παλινδρόμησης. Δηλαδή έχουμε ως εξαρτημένη μεταβλητή την ίδια τη μεταβλητή και ως ανεξάρτητη τη θέση της κάθε τιμής της μεταβλητής στο αρχείο. Ομοίως η μέθοδος αυτή πρέπει να επιλέγεται εάν υπάρχει εκ των προτέρων γνώση ότι η τιμή της ελλείπουσας σχετίζεται με τη θέση στην οποία βρέθηκε.

			

			3.6.4 Random Number Generator

			Η δυνατότητα προσφέρεται από την επιλογή Transform > Random Number Generators, με σκοπό την παραγωγή τυχαίων αριθμών από προκαθορισμένους αλγορίθμους (γεννήτριες) τυχαίων αριθμών.

			Στην ενότητα Active Generator, επιλέγεται το είδος του αλγορίθμου και στην ενότητα Active Generator Initialization στο πεδίο Set Starting Point οι τιμές εκκίνησης του αλγορίθμου. O αναλυτής μπορεί να ορίσει μια σταθερή τιμή στο πεδίο Value της επιλογής Fixed Values έτσι ώστε σε κάθε στάδιο του αλγορίθμου να λαμβάνεται η συγκεκριμένη τιμή.
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			Εικόνα 3.43: Η υποενότητα Random Number Generators

			3.7 Μενού Analyze

			Αποτελεί τον βασικό κορμό και τον λόγο ύπαρξης αυτού του προγράμματος, καθώς περιέχει όλες τις εντολές στατιστικής ανάλυσης που προσφέρονται από το πρόγραμμα. Οι εντολές αυτές θα περιγραφούν αναλυτικότερα στα επόμενα κεφάλαια του κειμένου αυτού.
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			Κεφάλαιο 4

			Περιγραφική Στατιστική - Γραφήματα

			Σύνοψη

			Αρχικά περιέχονται βασικές έννοιες και ορισμοί για την περιγραφική στατιστική, τις έννοιες του πληθυσμού και του δείγματος και τα είδη των μεταβλητών. Γίνεται αναφορά στον υπολογισμό περιγραφικών στατιστικών στο SPSS μέσω των διαδρομών Descriptive Statistics > Frequencies, Descriptive Statistics > Descriptives, Descriptive Statistics > Explore, Descriptive Statistics > Crosstabs.

			Παράλληλα εξηγούνται οι στατιστικές έννοιες που χρειάζονται ενδεικτικά αναφέρουμε Trimmed Mean - Ξακρισμένη μέση τιμή και Confidence Interval for Mean - Διάστημα Εμπιστοσύνης για τον μέσο.

			Γίνεται αναφορά στην έννοια της συσχέτισης, στους συντελεστές συσχέτισης και στον τρόπο υπολογισμού τους (μέσω της επιλογής Correlate). Γίνεται αναλυτική περιγραφή της εντολής Multiple Response (Analyze > Multiple Response > Define Multiple Response Sets). Και τέλος γίνεται αναφορά στα διαγράμματα μέσω του μενού Graphs. Συγκεκριμένα περιγράφονται τα Ραβδογράμματα Bar Charts (Simple και Clustered), τα Γραμμικά Line (επιλογές Simple και Multiple) τα Γραφήματα Περιοχής Area, τα Κυκλικά Pie, Τα Υψηλών - Χαμηλών τιμών High - Low (επιλογές Simple και Clustered) τα Θηκογράμματα ή Πλαισίου Απολήξεων BoxPlots (επιλογές Simple και Clustered), τα Διασποράς Scatter/ Dot (επιλογές Simple και Matrix και Scatter) και τα Ιστογράμματα, Histogram.

			Προαπαιτούμενη γνώση

			Καλύτερη κατανόηση του κεφαλαίου προκύπτει αν ο αναγνώστης έχει γνώσεις περιγραφικής στατιστικής (ύλη που κατά βάση καλύπτεται στο πρώτο κεφάλαιο). Τα εγχειρίδια που παρουσιάζουν με πληρότητα την ύλη του συγκεκριμένου κεφαλαίου είναι αυτά που αναφέρθηκαν στο Κεφάλαιο 3.

			4.1 Βασικές Έννοιες και Ορισμοί

			Ως Στατιστική (Statistic) ορίζεται η επιστήμη που απασχολείται με τη συγκέντρωση (συλλογή), οργάνωση, παρουσίαση και ανάλυση δεδομένων.

			Δηλαδή ασχολείται με την:

			
					Συλλογή και Επιλογή ενός δείγματος από τον πληθυσμό και λήψη μετρήσεων από αυτό.

					Οργάνωση των δεδομένων με την χρήση των Η/Υ μέσω διαφόρων λογιστικών φύλλων (π.χ. Excel) ή στατιστικών πακέτων (π.χ. SPSS, STATA, SAS, R, SPlus, Minitab κ.α).

					Παρουσίαση περιγραφικών χαρακτηριστικών των δεδομένων με χρήση πινάκων συχνοτήτων, γραφημάτων και περιγραφικών μέτρων.

					Στατιστική συμπερασματολογία με χρήση μοντέλων [π.χ. γραμμική παλινδρόμηση (linear regression)].

			

			Η επιστήμη της Στατιστικής χωρίζεται σε δύο μεγάλους κλάδους, την Περιγραφική Στατιστική (Descriptive Statistics), η οποία θα αναλυθεί στο παρόν κεφάλαιο, και την Στατιστική Συμπερασματολογία (Inferential Statistics), η οποία θα αναλυθεί στα επόμενα κεφάλαια.

			Περιγραφική στατιστική (Descriptive Statistics)

			Σκοπός της Περιγραφικής Στατιστικής είναι η συνοπτική παρουσίαση των δεδομένων. Αποτελεί ένα στατιστικό εργαλείο με σκοπό τη συγκέντρωση ταξινόμηση και παρουσίαση πρωτογενών δεδομένων σε κατανοητή μορφή. Γίνεται με τη χρήση πινάκων (συχνοτήτων, διπλής εισόδου), γραφημάτων (ραβδογράμματα, θηκογράμματα, διασποράς κ.ά.), και στατιστικών μέτρων (μέτρα κεντρικής τάσης, μέτρα μεταβλητότητας και μέτρα αναφορικά με τη μορφή της κατανομής συχνότητας).

			Βασικές Στατιστικές Έννοιες

			Στατιστικός πληθυσμός (population)

			Με τον όρο αυτό καλούμε το σύνολο των ατόμων ή αντικειμένων στα οποία αναφέρονται οι παρατηρήσεις μας. Τα στοιχεία του συνόλου αυτού καλούνται στατιστικές μονάδες ή άτομα. Ο πληθυσμός μας μπορεί να είναι πεπερασμένος ή άπειρος, υπαρκτός ή ιδεατός. Τα άτομα αυτά διακρίνονται για κάποιο χαρακτηριστικό ή ιδιότητα.

			Στατιστική μεταβλητή (Variable)

			Η ιδιότητα ή το χαρακτηριστικό, ως προς το οποίο ερευνάται ένας πληθυσμός καλείται στατιστική μεταβλητή (variable). Κάθε πληθυσμός έχει διαφορετικά χαρακτηριστικά (ιδιότητες), όπως για παράδειγμα μια ομάδα ατόμων μπορούν να διαφέρουν ως προς την ηλικία, το φύλο, το βάρος κ.ά. Για να μετρήσουμε τα μεταβαλλόμενα χαρακτηριστικά χρειάζεται να χρησιμοποιήσουμε είτε κατάλληλα εργαλεία μέτρησης είτε κατάλληλες κωδικοποιήσεις με σκοπό τη διεξαγωγή μετρήσεων για κάθε χαρακτηριστικό (μεταβλητή). Τα αριθμητικά δεδομένα (δηλαδή το πεδίο τιμών των μεταβλητών) λέγονται παρατηρήσεις (observations) ή μετρήσεις. Οι μετρήσεις αυτές ονομάζονται τιμές των μεταβλητών. Είναι προφανές ότι οι τιμές διαφοροποιούνται μεταξύ των ατόμων ή μεταξύ των στατιστικών χαρακτηριστικών. Οι τιμές των μεταβλητών μπορεί να είναι πραγματικοί αριθμοί (π.χ. βάρος = 75kg) ή φράσεις (π.χ. φύλο = άνδρας).

			Είδη Μεταβλητών

			Η φύση των μεταβλητών καθορίζει το είδος των δεδομένων. Οι μεταβλητές διακρίνονται σε ποσοτικές (quantitative) και ποιοτικές (qualitative) ανάλογα με το εάν οι τιμές εκφράζουν αριθμητικά ή ονομαστικά δεδομένα.

			Οι ποσοτικές μεταβλητές διακρίνονται με τη σειρά τους σε συνεχείς (continues) και διακριτές (discrete) ανάλογα με το αν είναι συνεχείς ή διακριτές. Συνεχείς μπορούν να ονομαστούν οι μεταβλητές που δύναται να λάβουν μια οποιαδήποτε τιμή, έστω και θεωρητική, εντός ενός διαστήματος (π.χ. ύψος, βάρος). Από την άλλη μεριά, διακριτές μπορούν να οριστούν οι μεταβλητές οι οποίες λαμβάνουν ακέραιο αριθμό (π.χ. αριθμός παιδιών σε μία οικογένεια).

			Οι ποιοτικές μεταβλητές διακρίνονται σε μη διατάξιμες (nominal) και διατάξιμες (ordinal). Οι μεταβλητές, οι οποίες δίνουν τη δυνατότητα στον ερευνητή να διατάξει και να διαβαθμίσει τις κατηγορίες που προκύπτουν από τις τιμές ονομάζονται διατάξιμες [π.χ. επίπεδα εκπαίδευσης, γνώμη καταναλωτή (Καθόλου, Λίγο, Αρκετά, Πολύ, Πάρα Πολύ)]. Οι υπόλοιπες που δεν παρέχουν τη δυνατότητα διάταξης αλλά με βάση τα χαρακτηριστικά που εκφράζουν οι τιμές τους επιτρέπουν απλά και μόνο τη διάκριση ορισμένων κατηγοριών ονομάζονται μη διατάξιμες (π.χ. φύλο, οικογενειακή κατάσταση).

			Είναι σημαντικό η αναγνώριση του είδους της μεταβλητής να γίνει ορθά, καθώς σε αυτό βασίζεται η επιλογή των στατιστικών αναλύσεων που θα εφαρμοστούν.

			Πιο συγκεκριμένα:
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			Πίνακας 4.1: Αναγνώριση του είδους μιας μεταβλητής

			Οι ενότητες της εφαρμογής SPSS που θα αναλυθούν στο παρόν κεφάλαιο, και που αφορούν στον κλάδο της περιγραφικής στατιστικής, είναι οι:

			
					Descriptive Statistics > Frequencies,

					Descriptive Statistics > Descriptives,

					Descriptive Statistics > Explore,

					Descriptive Statistics > Crosstabs,

					Tables,

					Correlate,

					Multiple Response,

					Graphs.

			

			4.2 Frequencies

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Descriptive Statistics > Frequencies, με σκοπό την εξαγωγή πινάκων συχνοτήτων Ποιοτικών ή Ποσοτικών Διακριτών μεταβλητών. Η εντολή χρησιμοποιείται ως επί το πλείστον για ποιοτικές μεταβλητές, ωστόσο δύναται να χρησιμοποιηθεί και για την ανάλυση ποσοτικών μεταβλητών, όπως θα δούμε παρακάτω.

			Ποιοτικές μεταβλητές

			Η εντολή χρησιμοποιείται για την εξαγωγή πινάκων συχνοτήτων. Οι κατανομές συχνότητας (frequency distributions) αποτελούν μία από τις πιο γνωστές μεθόδους παρουσίασης ενός συνόλου δεδομένων. Στόχος είναι να δοθεί μία πλήρης εικόνα για την κατανομή των δεδομένων στην κλίμακα μέτρησής της.

			Τα ποιοτικά δεδομένα, είτε αυτά είναι τύπου κατηγορίας (nominal) ή τύπου διάταξης (ordinal), δεν επιδέχονται μαθηματικές πράξεις. Η μόνη δυνατότητα που έχουμε είναι να καταμετρήσουμε τις διάφορες τιμές της μεταβλητής – δηλ. να υπολογίσουμε τη συχνότητα εμφάνισης κάθε τιμής και να παρουσιάσουμε τα αποτελέσματά μας σε ένα πίνακα απλής εισόδου (one-way table). Για την εξαγωγή πινάκων διπλής εισόδου χρησιμοποιούμε την εντολή Analyze > Descriptive Statistics > Crosstabs, η οποία θα αναλυθεί στην ομώνυμη παράγραφο.

			Για την εξαγωγή των πινάκων συχνοτήτων θα πρέπει να είναι επιλεγμένη η παράμετρος εμφάνισης των πινάκων συχνοτήτων Display frequency tables, αλλιώς στην ανάλυση επιτρέπεται η χρήση ποσοτικών μεταβλητών και η εξαγωγή περιγραφικών μέτρων σε αυτές.

			Η πιο διαδεδομένη χρήση της συγκεκριμένης εντολής είναι για την περιγραφική ανάλυση ποιοτικών μεταβλητών, καθώς για τις ποσοτικές μεταβλητές μπορούμε να χρησιμοποιήσουμε και άλλες εντολές, όπως είναι η εντολή Descriptives, και η εντολή Explore.
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			Εικόνα 4.1: To menu Frequencies

			Στο πλαίσιο Variable(s) τοποθετούμε τις μεταβλητές για τις οποίες θα εξάγουμε πίνακες (κατανομές) συχνοτήτων. Επίσης από την υποενότητα Charts μπορούμε να δημιουργήσουμε κυκλικά διαγράμματα Pie Chart ή ραβδογράμματα Bar Chart. Περισσότερα για τα χαρακτηριστικά των διαγραμμάτων βλ. στην ομώνυμη παράγραφο. Στο σημείο Chart Values ορίζουμε εάν στο διάγραμμα θα εμφανίζονται οι απόλυτες Frequencies ή οι σχετικές συχνότητες Percentages της μεταβλητής.

			Για παράδειγμα, στους πίνακες συχνοτήτων που προκύπτουν για τις δύο ποιοτικές μη διατάξιμες μεταβλητές «Ηλικιακή Ομάδα» και «Καπνιστική Συνήθεια» λαμβάνουμε:
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			Εικόνα 4.2: Πίνακες συχνοτήτων για την ηλικιακή ομάδα και την καπνιστική συνήθεια

			Στη πρώτη στήλη εμφανίζονται οι περιγραφές (ονομασίες) των τιμών της ποιοτικής μεταβλητής.

			Στην δεύτερη στήλη εμφανίζεται η (απόλυτη) Συχνότητα (Frequency) των τιμών της κάθε τιμής, δηλ. το πλήθος εμφάνισης της κάθε παρατήρησης xi.

			Στην τρίτη στήλη εμφανίζεται η Σχετική Συχνότητα (Relative Frequency) fi της τιμής xi, η οποία προκύπτει αν από τη συχνότητα διαιρέσουμε το μέγεθος n του δείγματος. H σχετική συχνότητα πολλές φορές καταγράφεται ως ποσοστό  Percent επί τοις εκατό (fi%).

			Στην τέταρτη στήλη εμφανίζεται η σχετική συχνότητα αφού έχουν αφαιρεθεί από το σύνολο των παρατηρήσεων οι ελλείπουσες τιμές. Συνεπώς πλέον το μέγεθος n του δείγματος είναι μικρότερο και το εμφανιζόμενο ποσοστό αντιστοιχεί στην πραγματική σχετική συχνότητα με βάση το  έγκυρο (valid) πλήθος των παρατηρήσεων. Εύλογα διαπιστώνει κανείς ότι όταν δεν υπάρχουν ελλείπουσες τιμές οι δύο στήλες μας παρέχουν την ίδια πληροφορία.

			Στην πέμπτη στήλη εμφανίζεται η Αθροιστική Συχνότητα (cumulative percent), δηλ. το πλήθος των παρατηρήσεων που είναι μικρότερες ή ίσες της τιμής xi εκφρασμένο ως ποσοστό. Για παράδειγμα, η αθροιστική συχνότητα στη μεταβλητή «Ηλικιακή Ομάδα» συνεπάγεται ότι το 11,1% των ατόμων είναι ηλικίας έως 44 ετών, το 22,2% ηλικίας έως 59 ετών, …, το 77,8% ηλικίας έως 74 ετών, κ.ο.κ.

			Συνεχείς μεταβλητές

			Προαναφέραμε ότι μπορούμε να χρησιμοποιήσουμε την ίδια εντολή Analyze > Descriptive Statistics > Frequencies, με σκοπό την ανάλυση ποσοτικών μεταβλητών. Αυτό επιτυγχάνεται μόνο εάν ΔΕΝ είναι επιλεγμένη η παράμετρος εμφάνισης των πινάκων συχνοτήτων Display frequency tables.
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			Εικόνα 4.3: To menu Frequencies με συνεχή μεταβλητή

			Σ’ αυτή την περίπτωση μέσω της υποενότητας Statistics επιλέγουμε τους περιγραφικούς δείκτες, ενώ από την υποενότητα Charts επιλέγουμε τη δημιουργία Ιστογράμματος Histograms με ή χωρίς την εμφάνιση της καμπύλης της κανονικής κατανομής With normal curve για οπτικό έλεγχο της κανονικότητας των δεδομένων της μεταβλητής.
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			Εικόνα 4.4: To menu Frequencies - Statistics

			Αναλυτικά από την υποενότητας Statistics παρέχονται τα ακόλουθα περιγραφικά μέτρα:

			Percentile Values

			Αποτελείται από μέτρα με σκοπό τον εντοπισμό της θέσης της κατανομής κατά μήκος του άξονα των τιμών της μεταβλητής. Αυτά ονομάζονται μέτρα θέσης (location measures) και τα πιο γνωστά είναι τα τεταρτημόρια και τα εκατοστημόρια.

			Quartiles - Τεταρτημόρια

			
					Τα Τεταρτημόρια υποδιαιρούν το σύνολο των διατεταγμένων κατά αύξουσα σειρά παρατηρήσεων σε τέσσερις ισοπληθείς ομάδες, κάθε μια από τις οποίες περιέχει το ٢٥٪ των παρατηρήσεων. Συγκεκριμένα:

					Το πρώτο τεταρτημόριο (first quartile), που συμβολίζεται με Q1, είναι η τιμή της παρατήρησης μέχρι την οποία περιλαμβάνεται το 25% των διατεταγμένων παρατηρήσεων του δείγματος.

					Το δεύτερο τεταρτημόριο (second quartile), που συμβολίζεται με Q2, είναι η τιμή της παρατήρησης μέχρι την οποία περιλαμβάνεται το 50% των διατεταγμένων παρατηρήσεων του δείγματος. Δηλαδή, το δεύτερο τεταρτημόριο των παρατηρήσεων είναι η Διάμεσος.

					Το τρίτο τεταρτημόριο (third quartile), που συμβολίζεται με Q3, είναι η τιμή της παρατήρησης μέχρι την οποία περιλαμβάνεται το 75% των διατεταγμένων παρατηρήσεων του δείγματος.

			

			H θέση των τεταρτημορίων υπολογίζεται από τους ακόλουθους μαθηματικούς τύπους, όπου n το μέγεθος του δείγματος.
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			Εξίσωση 4.1
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			Εξίσωση 4.2

			[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\4.3.wmf]

			Εξίσωση 4.3

			Percentiles - Ποσοστημόρια

			Τα εκατοστημόρια είναι τα σημεία που υποδιαιρούν το σύνολο των διατεταγμένων κατά αύξουσα σειρά παρατηρήσεων σε 100 ισοπληθείς ομάδες. Έτσι έχουμε ότι το 25ο εκατοστημόριο θα έχει από τα αριστερά του το 25% των παρατηρήσεων και από δεξιά του το υπόλοιπο 75%, το 50ο εκατοστημόριο θα διαιρέσει τις παρατηρήσεις στη μέση άρα ισούται με τη Διάμεσο, κ.ο.κ. Εάν τώρα γενικεύσουμε αυτό το ποσοστό τότε το k- οστό εκατοστημόριο θα έχει από τα αριστερά του το k% των παρατηρήσεων και από τα δεξιά του το (100 - k)%. Η εφαρμογή, εκτός από τα τεταρτημόρια, παρέχει στον αναλυτή τη δυνατότητα να ορίσει εκείνος το σημείο τομής των παρατηρήσεων σε οποιονδήποτε αριθμό ομάδων ίδιου μεγέθους μέσω του πεδίου Cut points for n equal groups. Προφανώς για n = 4 λαμβάνουμε τα τεταρτημόρια.

			Τέλος, από την επιλογή Percentile(s) μπορούν να υπολογιστούν συγκεκριμένα εκατοστημόρια (π.χ το 5ο, 10ο κ.ο.κ.) επιλέγοντας στο αντίστοιχο πεδίο το ποσοστό που χαρακτηρίζει το εκατοστημόριο και καταχωρώντας το με το πλήκτρο Add.

			Central Tendency

			Τα δεδομένα εμφανίζουν μια τάση να περιστρέφονται γύρω από μια κεντρική τιμή που εκφράζει την τυπική ή μέση τιμή τους. Αυτά ονομάζονται μέτρα κεντρικής τάσης (central tendency measures) και τα πιο γνωστά είναι ο αριθμητικός, ο αρμονικός και ο γεωμετρικός μέσος όρος. Από την εφαρμογή SPSS παρέχεται ο αριθμητικός μέσος.

			Mean - Αριθμητικός μέσος ή Μέση τιμή

			Η μέση τιμή ενός συνόλου n παρατηρήσεων ορίζεται ως το άθροισμα των παρατηρήσεων διά του πλήθους των παρατηρήσεων:
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			Εξίσωση 4.4

			Στο σημείο αυτό παρέχονται και μέτρα θέσης όπως:

			Median - Διάμεσος

			Διάμεσος ενός δείγματος n παρατηρήσεων οι οποίες έχουν διαταχθεί σε αύξουσα σειρά ορίζεται ως η μεσαία παρατήρηση, όταν το n είναι περιττός αριθμός, ή ο μέσος όρος (ημιάθροισμα) των δύο μεσαίων παρατηρήσεων όταν το n είναι άρτιος αριθμός.

			Mode - Eπικρατούσα τιμή

			Είναι η παρατήρηση με τη μεγαλύτερη συχνότητα.

			Sum - Άθροισμα

			Το άθροισμα όλων των παρατηρήσεων.

			Dispersion

			Αποτελείται από μέτρα ποσοτικής αξιολόγησης της συγκέντρωσης των τιμών μιας μεταβλητής γύρω από την κεντρική τιμή τους. Αυτά ονομάζονται μέτρα διασποράς (measures of variability) και τα πιο γνωστά είναι η διακύμανση, η τυπική απόκλιση, και το εύρος).

			Std. Deviation - Τυπική απόκλιση

			Τυπική απόκλιση ορίζεται ως η τετραγωνική ρίζα της διακύμανσης.
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			Εξίσωση 4.5

			Variance - Διακύμανση

			Διακύμανση ορίζεται ως ο αριθμητικός μέσος των τετραγώνων των αποκλίσεων των τιμών της μεταβλητής από τον αριθμητικό μέσο
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			Εξίσωση 4.6

			Range - Έυρος

			Εύρος ορίζεται ως η διαφορά της ελάχιστης Minimum παρατήρησης από τη μέγιστη Maximum παρατήρηση, δηλαδή:
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			Εξίσωση 4.7

			S.E. Mean - Τυπικό σφάλμα

			Ορίζεται ως η τυπική απόκλιση του μέσου όρου ενός δείγματος.
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			Εξίσωση 4.8

			Distribution

			Αποτελείται από μέτρα που περιγράφουν την μορφή της κατανομής συχνότητας, δηλ. μέτρα λοξότητας (measures of skewness) και μέτρα κύρτωσης (kurtosis measures). Η ασυμμετρία αναφέρεται στην απόκλιση του διαγράμματος της κατανομής συχνοτήτων από το διάγραμμα της κανονικής κατανομής, ενώ η κυρτότητα αναφέρεται στο πόσο πεπλατυσμένο είναι το διάγραμμα την κατανομής συχνοτήτων.

			Skewness - Συντελεστής Ασυμμετρίας

			Δίνεται από τη σχέση:
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			Εξίσωση 4.9

			Όπου:
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			Εξίσωση 4.10

			Η οποία καλείται τυποποιημένη μορφή των παρατηρήσεων.

			Για:

			
					β1 = 0, έχουμε συμμετρία,

					β1 < 0, έχουμε αρνητική ή αριστερή ασυμμετρία,

					β1 > 0, έχουμε θετική ή δεξιά ασυμμετρία.
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			Εικόνα 4.5: Μορφή καμπύλης συχνότητας με Θετική και Αρνητική ασυμμετρία

			Kurtosis - Συντελεστής Κύρτωσης

			Χαρακτηρίζει το ύψος της κορυφής της κατανομής και δίνει πληροφορίες για την αιχμηρότητα της καμπύλης. Οι κατανομές διακρίνονται σε λεπτόκυρτες, μεσόκυρτες και πλατύκυρτες.
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			Εξίσωση 4.11

			
					β2 = 3, έχουμε μεσόκυρτη κατανομή,

					β2 < ٣, έχουμε πλατύκυρτη κατανομή,

					β2 > 3, έχουμε λεπτόκυρτη κατανομή.
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			Εικόνα 4.6: Μορφή καμπύλης συχνότητας για διάφορες τιμές του συντελεστή κύρτωσης

			Στα αποτελέσματα μαζί με τις τιμές των συντελεστών ασυμμετρίας και κύρτωσης, εμφανίζονται και τα τυπικά τους σφάλματα.

			H παράμετρος Values are group midpoints επιλέγεται όταν οι τιμές της μεταβλητής είναι τα κεντρικά σημεία ομαδοποιημένων δεδομένων (για παράδειγμα στην μεταβλητή Age στον πίνακα συχνοτήτων στην Εικόνα 4.2, για την ηλικιακή ομάδα 40-44 στο αρχείο των δεδομένων θα είχαμε καταγράψει μόνο την τιμή 42,5 (κεντρική τιμή του διαστήματος), κ.ο.κ.]. Τότε, ενεργοποιώντας την παράμετρο η διάμεσος και τα εκατοστημόρια εκτιμώνται με τη μέθοδο της παρεμβολής (interpolation).
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			Εικόνα 4.7: Αποτελέσματα από την εντολή Frequencies

			4.3 Descriptives

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Descriptive Statistics > Descriptives, με σκοπό την εξαγωγή περιγραφικών μέτρων σε ποσοτικές μεταβλητές. Η εντολή είναι ένα υποσύνολο των δυνατών αποτελεσμάτων της εντολής Explore η οποία αναλύεται στην επόμενη ενότητα.
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			Εικόνα 4.8: To menu Descriptives

			Οι ποσοτικές μεταβλητές για τις οποίες θα λάβουμε τα περιγραφικά μέτρα εισάγονται στο πλαίσιο Variable(s). Με την επιλογή της παραμέτρου Save standardized values as variables δημιουργούνται και αποθηκεύονται ως μεταβλητές στο αρχείο δεδομένων, οι τυποποιημένες τιμές των παρατηρήσεων των μεταβλητών, οι οποίες προκύπτουν από τη σχέση:
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			Εξίσωση 4.12

			Οι τυποποιημένες τιμές μιας μεταβλητής που ακολουθεί κανονική κατανομή, έχουν την ιδιότητα να ακολουθούν την κανονική κατανομή με μηδενική μέση τιμή και μοναδιαία διασπορά. Η κατανομή αυτή συμβολίζεται ως Ν(0,1) και ονομάζεται τυπική κανονική κατανομή. Επίσης, οι τιμές αυτές είναι καθαροί αριθμοί, καθώς έχει γίνει εξάλειψη των μονάδων μέτρησης των παρατηρήσεων, και μπορούν να χρησιμοποιηθούν για τη σύγκριση μεταβλητών διαφορετικών μονάδων μέτρησης.

			Από το πλήκτρο Options προσφέρεται η επιλογή των περιγραφικών μέτρων τα οποία έχουν ήδη παρουσιαστεί στην προηγούμενη ενότητα, όπως ο μέσος, η διασπορά, η τυπική απόκλιση, το εύρος και οι συντελεστές ασυμμετρίας και κύρτωσης.

			Επιπρόσθετα, ο αναλυτής από την παρούσα ενότητα έχει τη δυνατότητα να διαμορφώσει την ταξινόμηση των μεταβλητών Display Order στην εμφάνιση των αποτελεσμάτων είτε με  βάση τη λίστα των μεταβλητών σύμφωνα με τη σειρά που έχουν προστεθεί στο πλαίσιο Variable(s), είτε αλφαβητικά Alphabetic, είτε κατά αύξοντα αριθμό μέσης τιμής Ascending Means, είτε κατά φθίνοντα αριθμό μέσης τιμής Descending Means.
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			Εικόνα 4.9: To menu Descriptives - Options

			Η διαφορά από την εντολή Frequencies είναι ότι η συγκεκριμένη εντολή λειτουργεί αποκλειστικά για ποσοτικές μεταβλητές, και τα αποτελέσματά της εμφανίζονται σε συγκεντρωτικό πίνακα που επιτρέπει πιο εύκολα τη σύγκριση των αποτελεσμάτων μεταξύ των ποσοτικών μεταβλητών.
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			Εικόνα 4.10: Αποτελέσματα από την εντολή Descriptives

			4.4 Explore

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Descriptive Statistics > Explore, με σκοπό την εξαγωγή περιγραφικών μέτρων σε ποσοτικές μεταβλητές. Η συγκεκριμένη εντολή διαφέρει κατά πολύ από την εντολή Descriptives, διότι παρέχει πολλές επιπρόσθετες δυνατότητες, όπως η εξαγωγή διαστημάτων εμπιστοσύνης, η ανίχνευση ακραίων τιμών, ο έλεγχος κανονικότητας των τιμών της μεταβλητής μέσω των στατιστικών Shapiro-Wilks και Kolmogorov-Smirnov, η εξαγωγή περιγραφικών μέτρων σε υποομάδες ποιοτικών μεταβλητών (Factors), και η δημιουργία διαγραμμάτων Box - Plot, Ιστογραμμάτων και Stem & Leaf plots.

			Αναλυτικότερα:
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			Εικόνα 4.11: To menu Explore

			Στο πλαίσιο Dependent List ορίζονται οι ποσοτικές μεταβλητές, ενώ στο πλαίσιο Factor List δηλώνουμε την (ή τις) ποιοτική μεταβλητή που θα χωρίσει το δείγμα σε υποομάδες με σκοπό την εξαγωγή των περιγραφικών μέτρων σ’ αυτή. Δηλαδή, για κάθε υποομάδα θα λάβουμε ξεχωριστά περιγραφικά μέτρα.

			Στο σημείο Display επιλέγουμε εάν στο Output θα εμφανιστούν μόνο τα περιγραφικά μέτρα Statistics, μόνο τα διαγράμματα Plots ή και τα δύο Both.

			Από το πλήκτρο Statistics επιλέγουμε την εξαγωγή των βασικών περιγραφικών μέτρων Descriptives με διαστήματα εμπιστοσύνης Confidence Interval for Mean ορίζοντας το επιθυμητό ποσοστό.
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			Εικόνα 4.12: To menu Explore - Statistics

			Τα περιγραφικά μέτρα που εξάγονται από την επιλογή αυτή είναι:

			
					η μέση τιμή και το 95% δ.ε. της μέσης τιμής,

			

			
					η «Ξακρισμένη» μέση τιμή,

					η διάμεσος,

					η τυπική απόκλιση,

					η μέγιστη και η ελάχιστη παρατήρηση,

					το ενδοτεταρτημοριακό εύρος που ορίζεται ως η διαφορά του πρώτου τεταρτημορίου από το τρίτο τεταρτημόριο,

					οι συντελεστές κύρτωσης και ασυμμετρίας.

			

			Trimmed Mean - Ξακρισμένη μέση τιμή

			Ορίζεται ως η μέση τιμή που προκύπτει εάν από το σύνολο των δεδομένων αφαιρεθούν το 5% των ελάχιστων και το 5% των μέγιστων παρατηρήσεων. Η μέση τιμή που προκύπτει από το υπόλοιπο 90% του δείγματος καλείται «ξακρισμένη» (trimmed) μέση τιμή, και εξυπηρετεί την ανάγκη εξάλειψης πιθανόν αλλοιώσεων από την ύπαρξη ακραίων τιμών (outliers). Ως ακραία τιμή ορίζεται μια παρατήρηση πολύ μικρότερη ή πολύ μεγαλύτερη από τις υπόλοιπες.

			Confidence Interval for Mean - Διάστημα Εμπιστοσύνης για τον μέσο

			Το (1-a)% δ.ε. της μέσης τιμής προκύπτει από τη σχέση:
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			Εξίσωση 4.13

			Για a = 5% λαμβάνουμε το 95% διάστημα εμπιστοσύνης της μέσης τιμής, το οποίο εκφράζει την πιθανότητα η εκτιμώμενη παράμετρος (μέση τιμή) να περιέχεται εντός του διαστήματος.

			Επιπρόσθετα, από αυτή την ενότητα, μπορούμε να λάβουμε τις ٥ μικρότερες και ٥ μεγαλύτερες (ακραίες) τιμές Outliers, καθώς και τα ποσοστημόρια Percentiles, τα οποία έχουμε ήδη αναλύσει στην προηγούμενη παράγραφο.

			Από το πλήκτρο Plots μπορούμε να επιλέξουμε τη δημιουργία θηκογραμμάτων για έλεγχο ακραίων τιμών Box - Plot, περιγραφικών όπως τα Stem - and - leaf Stem - and - leaf και τα Ιστογράμματα Histogram και Q - Q Plots ελέγχου κανονικότητας Normality plots with tests (Περισσότερα για τα χαρακτηριστικά των διαγραμμάτων, βλ. στην ομώνυμη παράγραφο).

			Επίσης με την επιλογή της παραμέτρου Normality plots with tests λαμβάνουμε και τα αποτελέσματα των ελέγχων κανονικότητας Shapiro-Wilks και Kolmogorov-Smirnov, οι οποίοι θα αναλυθούν σε επόμενο κεφάλαιο.
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			Εικόνα 4.13: To menu Explore - Plots

			Από το πλήκτρο Options γίνεται η διαχείριση των ελλειπουσών τιμών, όπου:

			
					Exclude cases listwise, οι παρατηρήσεις που έχουν την ελλείπουσα τιμή είτε σε κάποια ποσοτική μεταβλητή (πλαίσιο dependents), είτε σε κάποιον παράγοντα (πλαίσιο Factors) και εξαιρούνται από τις αναλύσεις. Η συγκεκριμένη επιλογή είναι προκαθορισμένη και συχνά δεν γίνεται αντιληπτό ότι άν π.χ. έχουμε δηλώσει τρείς ποσοτικές μεταβλητές και κάποια εξ αυτών έχει ελλείπουσες τιμές, τότε ολόκληρη η σειρά θα εξαιρεθεί από την ανάλυση και τα περιγραφικά μέτρα θα προκύψουν στο ίδιο μέγεθος δείγματος και για τις τρεις μεταβλητές.

					Exclude cases pairwise, αν μια ποσοτική μεταβλητή έχει ελλείπουσα τιμή σε όλες τις ομάδες της ποιοτικής οπότε εξαιρείται από την ανάλυση, αλλιώς όχι.

					Report values, οι παρατηρήσεις με ελλείπουσες τιμές αναλύονται ως ξεχωριστή κατηγορία.
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			Εικόνα 4.14: To menu Explore - Options

			Αποτελέσματα από την εντολή Explore.
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			Εικόνα 4.15: Αποτελέσματα - Ποσοστημόρια - από την εντολή Explore.
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			Εικόνα 4.16: Αποτελέσματα - Έλεγχοι Κανονικότητας - από την εντολή Explore
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			Εικόνα 4.17: Αποτελέσματα - Περιγραφικά Μέτρα - από την εντολή Explore
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			Εικόνα 4.18: Αποτελέσματα - Ακραίες Παρατηρήσεις - από την εντολή Explore

			4.5 Crosstabs

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Descriptive Statistics > Crosstabs, με σκοπό τη δημιουργία δισδιάστατων περιγραφικών πινάκων συνάφειας μεταξύ ποιοτικών ή ποσοτικών διακριτών μεταβλητών.

			Επιπρόσθετα, η συγκεκριμένη εντολή χρησιμοποιείται για τη σύγκριση και τον έλεγχο συσχέτισης μεταξύ των ποιοτικών ή ποσοτικών διακριτών μεταβλητών, σημεία τα οποία θα αναλυθούν σε επόμενο κεφάλαιο στα πλαίσια των ελέγχων υποθέσεων. Στο παρόν κεφάλαιο θα αναλυθούν τα σημεία εκείνα τα οποία αφορούν στην εξαγωγή περιγραφικών στοιχείων.
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			Εικόνα 4.19: To menu Crosstabs

			Επιλέγοντας την παράμετρο Display clustered bar charts εμφανίζονται ομαδοποιημένα ραβδογράμματα για τη γραφική απεικόνιση των συχνοτήτων των τιμών των μεταβλητών, ενώ με την παράμετρο Suppress tables δεν θα εμφανιστούν οι πίνακες συχνοτήτων. Προφανώς για τους σκοπούς του παρόντος κεφαλαίου δεν θα επιλέξουμε ποτέ αυτή την παράμετρο!

			Στα πλαίσια Row(s) και Column(s) ορίζουμε τις μεταβλητές, οι τιμές των οποίων θα εμφανίζονται στις γραμμές και στις στήλες του πίνακα, αντίστοιχα. Για να είναι ο πίνακας πιο εμφανίσιμος συνηθίζουμε να ορίζουμε τη μεταβλητή με τις περισσότερες τιμές στη θέση των γραμμών.
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			Εικόνα 4.20: To menu Crosstabs  - Cell Display

			Από το πλήκτρο Cells επιλέγουμε την προβολή πρόσθετων στοιχείων σε κάθε κελί του πίνακα π.χ. σχετικών συχνοτήτων, ή την εμφάνιση υπολοίπων. Συγκεκριμένα:

			Count

			
					Observed: Επιλέγεται ώστε σε κάθε κελί του πίνακα να εμφανίζονται οι παρατηρούμενες συχνότητες.

					Expected: Επιλέγεται ώστε σε κάθε κελί του πίνακα να εμφανίζονται οι αναμενόμενες συχνότητες.

			

			Percentages

			
					Row: Επιλέγεται ώστε να εμφανίζονται οι σχετικές συχνότητες % επί των γραμμών.

					Column: Επιλέγεται ώστε να εμφανίζονται οι σχετικές συχνότητες % επί των στηλών.

					Total: Επιλέγεται ώστε να εμφανίζονται οι σχετικές συχνότητες % επί του συνόλου των παρατηρήσεων.

			

			Residuals

			
					Unstandardized: Επιλέγεται για να εμφανιστούν τα μη τυποποιημένα υπόλοιπα από τη διαφορά παρατηρούμενων και αναμενόμενων συχνοτήτων.

					Standardized: Επιλέγεται για να εμφανιστούν τα τυποποιημένα υπόλοιπα από τη διαφορά παρατηρούμενων και αναμενόμενων συχνοτήτων.

			

			
					Adjusted standardized: Επιλέγεται για να εμφανιστούν τα αναπροσαρμοσμένα υπόλοιπα. Υπό τη μηδενική υπόθεση ότι οι 2 μεταβλητές είναι ανεξάρτητες, τα αναπροσαρμοσμένα υπόλοιπα θα ακολουθούν την τυπική κανονική κατανομή, δηλαδή έχουν μέση τιμή 0 και τυπική απόκλιση 1. Έτσι ένα προσαρμοσμένο υπόλειμμα που είναι πάνω από 1,96 (κατά συνθήκη χρησιμοποιείται 2,0) δείχνει ότι ο αριθμός των παρατηρήσεων στο εν λόγω κελί είναι σημαντικά μεγαλύτερος από ό, τι θα αναμενόταν εάν η μηδενική υπόθεση ήταν αληθής, με επίπεδο σημαντικότητας 0,05. Ένα αναπροσαρμοσμένο υπόλοιπο μικρότερο από -2,0 υποδεικνύει ότι ο αριθμός των παρατηρήσεων στο εν λόγω κελί είναι σημαντικά μικρότερος απ’ ότι θα αναμενόταν εάν η μηδενική υπόθεση ήταν αληθής. Έτσι ανάλογα με το πρόσημο του αναπροσαρμοσμένου υπολοίπου, διαπιστώνουμε εάν σε κάθε κελί υπάρχουν λιγότερες ή περισσότερες παρατηρήσεις απ’ ότι θα περίμενε κανείς αν οι 2 μεταβλητές ήταν ανεξάρτητες. Εάν ο πίνακας συνάφειας είναι 2x2, τότε όλα τα προσαρμοσμένα κατάλοιπα θα έχουν την ίδια απόλυτη τιμή, με ακριβώς 2 από αυτά να είναι αρνητικά.

					Noninteger Weights: Χρησιμοποιείται για να περικόψουμε ή να στρογγυλοποιήσουμε τις δεκαδικές τιμές από τις τιμές των παρατηρήσεων σε κάθε κελί. Γενικά, οι τιμές σε κάθε κελί είναι ακέραιες τιμές, δεδομένου ότι αντιπροσωπεύουν το πλήθος των περιπτώσεων σε κάθε συνδυασμό τιμών. Αν όμως στο αρχείο μας οι τιμές αυτές είναι σταθμισμένες σε σχέση με μια άλλη μεταβλητή βαρύτητας με δεκαδικές τιμές (για παράδειγμα 1,25), τότε οι παρατηρήσεις σε κάθε κελί μπορεί επίσης να είναι δεκαδικές.

			

			Από το πλήκτρο Statistics γίνεται η επιλογή των ελέγχων υποθέσεων και δεικτών συνάφειας μεταξύ των ποιοτικών ή ποσοτικών διακριτών μεταβλητών. Οι συγκεκριμένες δυνατότητες θα αναλυθούν στο επόμενο κεφάλαιο.

			 Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε:
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			Εικόνα 4.21: Αποτελέσματα από την επιλογή Crosstabs

			Από τον πίνακα ελέγχουμε οπτικά και συγκρίνουμε τις σχετικές συχνότητες επί των γραμμών ή των στηλών, ή για το σύνολο του δείγματος. Είμαστε επίσης ιδιαίτερα προσεκτικοί ως προς τα ποσοστά που συγκρίνουμε καθώς οι σχετικές συχνότητες επί των γραμμών αθροίζουν στο 100% οριζοντίως, οι σχετικές συχνότητες επί των στηλών αθροίζουν στο 100% καθέτως, ενώ οι σχετικές συχνότητες επί του συνολικού δείγματος αθροίζουν στο 100% μόνο στο τελευταίο κελί.

			4.6 Correlate

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Correlate > Bivariate, με σκοπό τον έλεγχο ύπαρξης γραμμικής σχέσης μεταξύ συνεχών μεταβλητών. Ο έλεγχος γίνεται με τον υπολογισμό των συντελεστών συνάφειας (r) των Pearson (παραμετρικό) και Spearman (μη παραμετρικό).

			Οι συντελεστές συσχέτισης είναι καθαροί αριθμοί (χωρίς μονάδες), που μας δείχνουν το μέγεθος και την κατεύθυνση της γραμμικής συσχέτισης μεταξύ δύο ποσοτικών μεταβλητών Χ και Υ, και λαμβάνουν τιμές στο διάστημα -1, 1, όπου:

			
					p = 1=> Ισχυρή θετική συσχέτιση,

					p = -1=> Ισχυρή αρνητική συσχέτιση,

					p = 0=> Απουσία συσχέτισης.

			

			Γραφικά η διερεύνηση της κατεύθυνσης της συσχέτισης (θετική, αρνητική ή απουσία συσχέτισης) πραγματοποιείται από τα διαγράμματα Scatter plots, βλ. ομώνυμη παράγραφο.

			Στο πλαίσιο Variables ορίζουμε τις μεταβλητές για τις οποίες θα υπολογιστεί ο πίνακας των (ανά δύο) συντελεστών συσχέτισης.
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			Εικόνα 4.22: Το menu Bivariate Correlations

			Correlation Coefficients

			
					r - Pearson - Προϋπόθεση για την εφαρμογή του είναι οι μεταβλητές να κατανέμονται κανονικά. Ο συντελεστής δίνεται από τη σχέση:
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			Εξίσωση 4.14

			Όπου:
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			Εξίσωση 4.15

			Για την εκτίμηση του συντελεστή συσχέτισης χρησιμοποιούμε το δειγματικό συντελεστή συσχέτισης, ο οποίος δίνεται από τον σχέση:
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			Εξίσωση 4.16

			
					r - Spearman - Χρησιμοποιείται όταν οι μεταβλητές δεν κατανέμονται κανονικά. Είναι ίδιος με τον παραμετρικό συντελεστή του Pearson, με τη διαφορά ότι αντί να χρησιμοποιηθούν οι δειγματικές παρατηρήσεις xi και yi των μεταβλητών Χ και Υ αντίστοιχα, χρησιμοποιούνται οι θέσεις (ranks - βαθμοί) αυτών, όπως έχουν κατανεμηθεί στο δείγμα. Ο συντελεστής δίνεται από τη σχέση:
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			Εξίσωση 4.17

			Ή ισοδύναμα:
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			Εξίσωση 4.18

			Όπου, di είναι η διαφορά των σχετικών θέσεων (ranks - βαθμών) των τιμών των xi και yi.

			Test of Significance

			Παραμετρικός έλεγχος

			Εφόσον ο πληθυσμιακός συντελεστής συσχέτισης p εκτιμάται από τον δειγματικό συντελεστή r, πρέπει να αξιολογηθεί, και καθώς έχουμε υποθέσει ότι οι μεταβλητές Χ και Υ κατανέμονται κανονικά, η υπόθεση που ελέγχεται είναι η:
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			Εξίσωση 4.19

			Υπό το κριτήριο:
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			Εξίσωση 4.20

			Όπου:
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			Εξίσωση 4.21

			Η υπόθεση απορρίπτεται για τιμές:
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			Εξίσωση 4.22

			Μη Παραμετρικός έλεγχος

			Ο έλεγχος για τον μη παραμετρικό συντελεστή συσχέτισης, είναι παρόμοιος. Η υπόθεση που ελέγχεται είναι η:
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			Εξίσωση 4.23

			Υπό το κριτήριο:
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			Εξίσωση 4.24

			Όπου:
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			Εξίσωση 4.25

			Η υπόθεση απορρίπτεται για τιμές:
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			Εξίσωση 4.26

			Στο συγκεκριμένο σημείο επιλέγουμε εάν ο έλεγχος που θα πραγματοποιηθεί είναι δίπλευρος Two -  tailed ή μονόπλευρος One - tailed. Περισσότερα αναφορικά με τους ελέγχους υποθέσεων θα παρουσιαστούν σε επόμενο κεφάλαιο, παρόλα αυτά σε αυτό το σημείο παραθέτουμε τα παραπάνω στοιχεία καθώς αφορούν στον συντελεστή συσχέτισης, και δεν θα επανέλθουμε σ’αυτό σε άλλο σημείο του παρόντος συγγράμματος.

			Flag significant correlations, με την επιλογή της παραμέτρου, όσοι συντελεστές συσχέτισης είναι στατιστικά σημαντικοί σε επίπεδο σ.σ. α = 5%, απεικονίζονται με έναν αστερίσκο, ενώ όσοι είναι στατιστικά σημαντικοί σε επίπεδο σ.σ. α = 1% απεικονίζονται με δύο αστερίσκους, προκειμένου να είναι άμεσα αντιληπτοί από τον αναλυτή.
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			Εικόνα 4.23: Το menu Bivariate Correlations - Options

			Από το πλήκτρο Options επιλέγουμε στο πλαίσιο Statistics τη μια ή και τις δύο από τις ακόλουθες παραμέτρους για τον συντελεστή Pearson:

			
					Means and standard deviations - Για να εμφανιστούν ο μέσος και η τυπική απόκλιση για κάθε μεταβλητή καθώς και το πλήθος των έγκυρων (μη ελλειπουσών τιμών) παρατηρήσεων. Η διαχείριση των ελλειπουσών τιμών πραγματοποιείται μέσω των κάτωθι παραμέτρων.

					Cross-product deviations and covariances - Ώστε να εμφανιστούν για κάθε ζεύγος μεταβλητών. Η «cross-product» τυπική απόκλιση ισούται με το άθροισμα των γινομένων των διαφορών των παρατηρήσεων από τη μέση τιμή τους (διορθωμένες παρατηρήσεις - mean corrected), δηλ. ο αριθμητής του συντελεστή συσχέτισης r. Η συνδιακύμανση είναι ένα μη τυποποιημένο μέτρο της σχέσης μεταξύ δύο μεταβλητών και ισούται με το «cross-product» διαιρούμενο με N-1.

			

			Από το πλαίσιο Missing Values γίνεται η διαχείριση των ελλειπουσών τιμών επιλέγοντας μιας εκ των δύο παραμέτρων.

			
					Exclude cases pairwise - Μ’ αυτή την επιλογή εξαιρούνται από τον υπολογισμό του συντελεστή συσχέτισης οι περιπτώσεις με ελλείπουσες τιμές για ένα ή και για τα δύο ζεύγη μεταβλητών.

					Exclude cases listwise - Μ’ αυτή την επιλογή από τον υπολογισμό των συντελεστών συσχέτισης εξαιρούνται όλες οι περιπτώσεις που υπάρχει μια ελλείπουσα τιμή σε οποιαδήποτε από τις μεταβλητές.

			

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK, όπου και λαμβάνουμε τον περιγραφικό πίνακα με τον μέσο, την τυπική απόκλιση και το πλήθος των μεταβλητών, και τον πίνακα με το συντελεστή συσχέτισης. Αναλυτικά στον πίνακα (Εικόνα 24) λαμβάνουμε τους συντελεστές συσχέτισης για όλους τους ανά δύο συνδυασμούς των μεταβλητών που έχουν δηλωθεί στο πλαίσιο Variables. Η διαγώνιος του πίνακα φέρει πάντα την τιμή «1», καθώς η συσχέτιση της μεταβλητής με τον εαυτό της είναι πάντα «1».

			Σε κάθε κελί εμφανίζονται τρείς τιμές, όπου η πρώτη είναι ο συντελεστής συσχέτισης (r = 0,413), στη δεύτερη το p-value από τον έλεγχο (μηδενική υπόθεση) ισότητας του συντελεστή με το μηδέν (p-value = 0,126 - άρα η υπόθεση δεν απορρίπτεται), και στην τρίτη το πλήθος των κοινών παρατηρήσεων μεταξύ των μεταβλητών. Εάν μια από τις δύο μεταβλητές έχει ελλείπουσα τιμή, τότε δεν θα χρησιμοποιηθεί ούτε η αντίστοιχη τιμή της άλλης μεταβλητής. Η ερμηνεία είναι κοινή και για τους δύο τύπους συντελεστών συσχέτισης.
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			Εικόνα 4.24: Αποτελέσματα από την επιλογή Correlate

			4.7 Multiple Response

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Multiple Response, με σκοπό τη διαχείριση ερωτήσεων πολλαπλής επιλογής στις οποίες ο ερωτώμενος έχει τη δυνατότητα να επιλέξει περισσότερες από μία απαντήσεις.

			Σε αυτή την περίπτωση κάθε δυνατή απάντηση θα οριστεί ως μια ξεχωριστή μεταβλητή την οποία ο ερωτώμενος είτε επέλεξε είτε όχι. Συνεπώς θα δημιουργηθούν μεταβλητές-δείκτες για την κάθε δυνατή απάντηση, με τιμές «1» εάν ο ερωτώμενος επέλεξε την απάντηση και «0» εάν όχι.

			Έχουμε για παράδειγμα την ερώτηση «Τί μέσα χρησιμοποιείτε για την παράδοση του μαθήματος σας;», με πιθανές απαντήσεις:

			
					Μαυροπίνακας,

					Η/Υ και projector,

					Σημειώσεις,

					Ομαδικές εργασίες.

			

			Η καταχώρηση των απαντήσεων, όπως φαίνεται και από την εικόνα, πραγματοποιείται με το να διαχειριζόμαστε την κάθε απάντηση ως ξεχωριστή μεταβλητή, που είτε επιλέχτηκε είτε όχι.
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			Εικόνα 4.25: Δεδομένα της ερώτησης πολλαπλών απαντήσεων «Τι μέσα χρησιμοποιείτε για την παράδοση του μαθήματος σας;»

			Οπότε, για την εξαγωγή συχνοτήτων σε αυτή την περίπτωση επιλέγουμε την εντολή Multiple Responses.

			4.7.1 Analyze > Multiple Response > Define Multiple Response Sets

			Αρχικά ορίζουμε το σύνολο των μεταβλητών που συνθέτουν την ερώτηση. Στο πλαίσιο Variables in Set δηλώνουμε όλες τις (δείκτριες) μεταβλητές που αποτελούν τις απαντήσεις της ερώτησης.

			Στο πλαίσιο Variables are coded επιλέγουμε εάν οι μεταβλητές είναι δίτιμες Dichotomies και ορίζουμε την τιμή που θα λαμβάνεται ως επιλογή (1 - Ναι). Εάν οι τιμές που έχουν δοθεί σε κάθε μεταβλητή είναι περισσότερες από δύο (δεν είναι δίτιμη) τότε θα πρέπει να ορίσουμε ποιες τιμές θα ανήκουν σε κάθε κατηγορία. Αυτό γίνεται στα πεδία Categories και στο Range.

			Στη συνέχεια μεταφέρουμε το σετ των μεταβλητών στο πλαίσιο Multiple Response Sets, το οποίο όπως διαπιστώνουμε λαμβάνει την ονομασία που έχουμε καταγράψει στο πεδίο Name.
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			Εικόνα 4.26: To menu Multiple Response> Define Multiple Response Sets

			4.7.2 Analyze > Multiple Response > Frequencies

			Έχοντας ήδη δημιουργήσει την ομάδα των μεταβλητών που συνθέτουν την ερώτηση, μπορούμε να δημιουργήσουμε την κατανομή πολλαπλών απαντήσεων για την ερώτηση. Αυτό επιτυγχάνεται από την εντολή Analyze > Multiple Response > Frequencies, όπου ορίζουμε το σετ που δημιουργήσαμε στο πλαίσιο Table(s) for.
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			Εικόνα 4.27: To menu Multiple Response > Frequencies

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK, και λαμβάνουμε τις απόλυτες και σχετικές συχνότητες της κάθε μεταβλητής-απάντησης. Όπως βλέπουμε συνολικά δόθηκαν 67 θετικές απαντήσεις. Η τρίτη στήλη μας παρέχει τα ποσοστά (σχετική συχνότητα) της κάθε μεταβλητής ξεχωριστά, έτσι για την απάντηση «Σημειώσεις» το 100% του δείγματος δήλωσε ότι χορηγεί σημειώσεις. Για την απάντηση «Μαυροπίνακας» το 50% του δείγματος (15/30) δήλωσε ότι κάνει χρήση αυτού, ενώ επί του συνόλου των θετικών απαντήσεων (15/67) αυτό το ποσοστό ανέρχεται σε 22,4%.
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			Εικόνα 4.28: Αποτελέσματα από την εντολή Multiple Response > Frequencies

			4.7.3 Analyze > Multiple Response > Crosstabs

			Επιπλέον, από την εντολή Analyze > Multiple Response > Crosstabs μπορούμε να λάβουμε πίνακες συνάφειας με τις κατανομές συχνοτήτων σε συνδυασμό και με άλλες ποιοτικές ή ποσοτικές διακριτές μεταβλητές.

			Στο πλαίσιο Row(s) τοποθετούμε τη μεταβλητή που θα εμφανίζεται στις γραμμές του πίνακα συνάφειας, ενώ στο πλαίσιο Column(s) τοποθετούμε τη μεταβλητή που θα εμφανίζεται στις στήλες του πίνακα.

			Για την επιλεγμένη ποιοτική ή ποσοτική διακριτή μεταβλητή εμφανίζονται δύο λατινικά ερωτηματικά, τα οποία είναι οι θέσεις που θα πρέπει να δηλώσουμε το εύρος των τιμών της μεταβλητής. Αυτό γίνεται από το πλήκτρο Define Ranges, όπου καταγράφουμε την ελάχιστη Minimum και την μέγιστη τιμή Maximum που λαμβάνει η μεταβλητή.

			Από την υποενότητα Options έχουμε τη δυνατότητα να δηλώσουμε εάν στον πίνακα συνάφειας θα εμφανίζονται οι σχετικές συχνότητες Cell Percentages, ανά γραμμή Row, ανά στήλη Column, ή σύνολο Total. Προσοχή θα πρέπει να δοθεί στην επιλογή Percentages Based On, όπου δηλώνουμε άν τα ποσοστά θα υπολογιστούν επί των ερωτώμενων Cases, ή επί των απαντήσεών τους Responses.
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			Εικόνα 4.29: To menu Multiple Response Crosstabs

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK. Η ερμηνεία του πίνακα είναι όπως και προηγουμένως.
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			Εικόνα 4.30: Αποτελέσματα από την εντολή Multiple Response > Crosstabs

			4.8 Graphs

			Περιέχει τη δυνατότητα γραφικής απεικόνισης των δεδομένων μέσω προκαθορισμένων τύπων διαγραμμάτων. Γράφημα (plot) ονομάζεται μια γραφική αναπαράσταση μιας ή περισσότερων μεταβλητών. Τα γραφήματα είναι χρήσιμα διότι μας παρέχουν άμεση πληροφόρηση για το σχήμα και τη μορφή της κατανομής των μεταβλητών, ή την από κοινού σχέση τους.

			Βασικά χαρακτηριστικά για τη δημιουργία ενός γραφήματος είναι:

			
					Να ξεκαθαρίσουμε τους στόχους και τη ζητούμενη πληροφορία που επιθυμούμε να αντλήσουμε.

					Να επιλέξουμε το κατάλληλο είδος γραφήματος.

					Να δημιουργήσουμε ένα ξεκάθαρο και κατανοητό γράφημα σύμφωνο με το αρχικό ερώτημα.

			

			Η επιλογή Legacy Dialogs διαφέρει από την εντολή Chart Builder στο ότι μας επιτρέπει να δημιουργήσουμε βασικά γραφήματα επιλέγοντας εκ των προτέρων το είδος του γραφήματος που θα δημιουργήσουμε.

			Το Chart Builder, ωστόσο, είναι μια πραγματική μηχανή γραφικών που δημιουργήθηκε με την προσαρμογή του προγράμματος στην εξέλιξη της τεχνολογίας για να προσφέρει στους χρήστες μεγαλύτερη  ευελιξία στη γραφική απεικόνιση, οδηγώντας τον χρήστη καθώς του παρέχει τη δυνατότητα να βλέπει πώς θα διαμορφωθεί το γράφημα με κάθε επιλογή του.

			Καθώς αυτή η επιλογή μοιάζει πολύ με τον τρόπο δημιουργίας του Excel, θα παρουσιάσουμε τις δυνατές επιλογές του Legacy Dialogs κάνοντας μια αναφορά στο είδος του κάθε γραφήματος. Όλα τα διαγράμματα μπορούν να μεταφερθούν σε άλλο πρόγραμμα π.χ. Word, Powerpoint με τη διαδικασία αντιγραφής Copy, επικόλλησης Paste.

			Οι τύποι των διαγραμμάτων που προσφέρονται είναι:
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			Εικόνα 4.31: Τύποι γραφημάτων που παρέχονται από το menu Graphs > Legacy Dialogs

			4.9 Ραβδογράμματα - Bar Charts

			Η δυνατότητα προσφέρεται από την επιλογή Graphs > Legacy Dialogs > Bar, για τη δημιουργία ραβδογράμματος. Τα ραβδογράμματα χρησιμοποιούνται για τη γραφική απεικόνιση των συχνοτήτων (απόλυτων και σχετικών) ποιοτικών μεταβλητών. Αποτελούνται από οριζόντιες στήλες που οι βάσεις τους βρίσκονται στον οριζόντιο (πιο σπάνια στον κάθετο) άξονα. Σε κάθε τιμή της μεταβλητής Χ αντιστοιχεί μια ορθογώνια στήλη της οποίας το ύψος είναι ίσο με την αντίστοιχη συχνότητα ή σχετική συχνότητα, (ή ακόμα και με τις τιμές κάποιας άλλης μεταβλητής, π.χ. μέσος). Έτσι έχουμε αντίστοιχα ραβδογράμματα συχνοτήτων και ραβδογράμματα σχετικών συχνοτήτων. Τόσο η απόσταση μεταξύ των στηλών, όσο και το πλάτος αυτών καθορίζονται αυθαίρετα από τον δημιουργό.

			Τα ραβδογράμματα μπορούν να είναι απλά Simple, όταν αφορούν μια μεταβλητή, ομαδοποιημένα Clustered ή Stacked, όταν αφορούν σε περισσότερες από μια μεταβλητές.
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			Εικόνα 4.32: Το αρχικό menu Bar Chart

			
					Data in Chart Are - Ορίζουμε το είδος των δεδομένων που είναι στη λίστα μεταβλητών.

					Summaries for groups of cases - Είναι η επιλογή που χρησιμοποιούμε καθώς μας δείχνει το πλήθος των περιπτώσεων που περιέχονται σε κάθε τιμή της μεταβλητής.

					Summaries of separate variables - Μ’ αυτή την επιλογή μπορούμε να λάβουμε αποτελέσματα έχοντας σε κάθε ράβδο π.χ. το μέσο άλλων μεταβλητών.

					Values of individual cases.

			

			Συνεχίζουμε στην επόμενη ενότητα με το πλήκτρο Define. Θα παρουσιάσουμε και τις δύο δυνατές επιλογές Simple και Clustered καθώς εξυπηρετούν τις πιο συνήθεις ανάγκες απεικόνισης των μεταβλητών μας.

			Simple

			Στο Bars Represent επιλέγουμε σε τί θα αναφέρονται οι ράβδοι του γραφήματος. Οι δυνατές επιλογές είναι :

			
					N of cases: Το πλήθος των παρατηρήσεων (συχνότητα).

					% of cases: Το ποσοστό των παρατηρήσεων (σχετική συχνότητα).

					Cum N: Η αθροιστική συχνότητα.

					Cum %: Η αθροιστική σχετική συχνότητα.

					Other statistic (π.χ. mean): Κάποιο άλλο στατιστικό όπως η μέση τιμή μιας μεταβλητής που θα οριστεί στο πεδίο Variable.

			

			Στο πεδίο Category Axis δηλώνουμε την ποιοτική μεταβλητή για την οποία θα δημιουργήσουμε το γράφημα.
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			Εικόνα 4.33: Η κεντρική ενότητα της επιλογής Bar Chart > Simple

			Από το πλήκτρο Titles δηλώνουμε τους τίτλους του γραφήματος, ενώ από το πλήκτρο Options μπορούμε να επιλέξουμε την εμφάνιση διαστημάτων σφάλματος (π.χ. συν ή πλην μια τυπική απόκλιση) για τη μέση τιμή σε κάθε ράβδο.
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			Εικόνα 4.34: To menu Bar Chart > Simple >Options

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε το γράφημα:
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			Εικόνα 4.35: Αποτελέσματα από την εντολή Bar Chart > Simple

			Clustered
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			Εικόνα 4.36: Η κεντρική ενότητα της επιλογής Bar Chart > Clustered

			Για τα ομαδοποιημένα ραβδογράμματα ορίζουμε επιπρόσθετα στο πεδίο Define Clusters by τη δεύτερη ποιοτική ή ποσοτική διακριτή μεταβλητή που θα διαμορφώσει τις ομάδες. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε το γράφημα:
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			Εικόνα 4.37: Αποτελέσματα από την εντολή Bar Chart > Clustered

			4.10 Γραμμικά - Line

			Η δυνατότητα προσφέρεται από την επιλογή Graphs > Legacy Dialogs > Line, για τη δημιουργία διαγράμματος γραμμής, το οποίο χρησιμοποιείται για την απεικόνιση των τιμών μιας μεταβλητής συνήθως σε σχέση με τον χρόνο. Τα διαγράμματα αυτά χρησιμοποιούνται για την απεικόνιση ποσοτικών μεταβλητών, διαφορών στους μέσους διαχρονικά ή υπό συνθήκες, ή μεταξύ ομάδων. Έτσι στον άξονα x τοποθετούμε τη χρονική (διατάξιμη) μεταβλητή (time) και στον y άξονα τοποθετούμε την ποσοτική μεταβλητή (ή τις τιμές των μέσων κ.λπ).

			Τα γραμμικά διαγράμματα μπορούν να είναι απλά Simple, όταν αφορούν μια μεταβλητή, ή ομαδοποιημένα Multiple, όταν αφορούν σε περισσότερες από μια μεταβλητές.

			Data in Chart Are, ορίζουμε το είδος των δεδομένων που είναι στη λίστα μεταβλητών.

			
					Summaries for groups of cases - Είναι η επιλογή που χρησιμοποιούμε καθώς μας δείχνει το πλήθος των περιπτώσεων που περιέχονται σε κάθε κατηγορία.

					Summaries of separate variables - Μ’ αυτή την επιλογή μπορούμε να λάβουμε αποτελέσματα έχοντας σε κάθε ράβδο π.χ. τον μέσο άλλων μεταβλητών.

					Values of individual cases.

			

			Συνεχίζουμε στην επόμενη ενότητα με το πλήκτρο Define.
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			Εικόνα 4.38: Το αρχικό menu Line Charts

			Θα παρουσιάσουμε και τις δύο δυνατές επιλογές Simple και Multiple καθώς εξυπηρετούν τις πιο σύνηθες ανάγκες απεικόνισης των μεταβλητών μας.

			Simple

			Στο Line Represents επιλέγουμε σε τί θα αναφέρονται οι γραμμές του γραφήματος. Οι δυνατές επιλογές είναι:

			
					N of cases: Το πλήθος των παρατηρήσεων (συχνότητα).

					% of cases: Το ποσοστό των παρατηρήσεων (σχετική συχνότητα).

					Cum N: Η αθροιστική συχνότητα.

					Cum %: Η αθροιστική σχετική συχνότητα.

					Other statistic (π.χ. mean): Κάποιο άλλο στατιστικό όπως η μέση τιμή μιας μεταβλητής που θα οριστεί στο πεδίο Variable.

			

			Στο πεδίο Category Axis δηλώνουμε τη χρονική (διατάξιμη) μεταβλητή. Από το πλήκτρο Titles δηλώνουμε τους τίτλους του γραφήματος, από το πλήκτρο Options μπορούμε να επιλέξουμε την εμφάνιση διαστημάτων σφάλματος (π.χ. συν ή πλην μια τυπική απόκλιση).
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			Εικόνα 4.39: Η κεντρική ενότητα της επιλογής Line Charts > Simple

			 Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε το γράφημα της Εικόνας ٤.٤٠.
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			Εικόνα 4.40: Αποτελέσματα από την εντολή Line Chart > Simple

			Multiple
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			Εικόνα 4.41: Η κεντρική ενότητα της επιλογής Line Charts > Multiple

			Για τις πολλαπλές γραμμές ορίζουμε επιπρόσθετα στο πεδίο Define Lines by την ποιοτική (ή ποσοτική διακριτή) μεταβλητή που θα διαμορφώσει την κάθε γραμμή. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε το γράφημα της Εικόνας 4.42.
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			Εικόνα 4.42: Αποτελέσματα από την εντολή Line Chart > Multiple

			4.11 Γράφημα Περιοχής - Area

			Η δυνατότητα προσφέρεται από την επιλογή Graphs > Legacy Dialogs > Area, για τη δημιουργία γραφήματος περιοχής. Ένα γράφημα περιοχής αφορά ποσοτικά δεδομένα και η δημιουργία του βασίζεται στο γράφημα γραμμής που είδαμε παραπάνω, όπου η περιοχή μεταξύ του άξονα και της δημιουργημένης γραμμής (line chart) γεμίζει με κάποιο χρώμα. Το γράφημα αυτό χρησιμοποιείται κυρίως για να συγκρίνει κανείς με μια περιοχή γραφήματος δύο ή περισσότερες ποσότητες.

			Τα διαγράμματα περιοχής μπορούν να είναι απλά Simple, όταν αφορούν μια μεταβλητή, ή στοιβαγμένα Stacked, όταν αφορούν περισσότερες από μια μεταβλητές.

			[image: \\server-pc\Storage_Volume\_ΥΛΙΚΟ ΔΟΥΛΕΙΑΣ\Κάλλιπος Χαλικιάς\Images - Resized\4.43.png]

			Εικόνα 4.43: Το αρχικό menu Area Charts

			
					Data in Chart Are - Ορίζουμε το είδος των δεδομένων που είναι στη λίστα μεταβλητών.

					Summaries for groups of cases - Είναι η επιλογή που χρησιμοποιούμε καθώς μας δείχνει το πλήθος των περιπτώσεων που περιέχονται σε κάθε κατηγορία.

					Summaries of separate variables- Με αυτή την επιλογή μπορούμε να λάβουμε αποτελέσματα έχοντας σε κάθε ράβδο π.χ. τον μέσο άλλων μεταβλητών.

					Values of individual cases.

			

			Συνεχίζουμε στην επόμενη ενότητα με το πλήκτρο Define.

			Simple

			Στο Area Represents επιλέγουμε σε τί θα αναφέρονται οι περιοχές του γραφήματος. Οι δυνατές επιλογές είναι:

			
					N of cases - Το πλήθος των παρατηρήσεων (συχνότητα).

					% of cases - Το ποσοστό των παρατηρήσεων (σχετική συχνότητα).

					Cum N - Η αθροιστική συχνότητα.

					Cum % - Η αθροιστική σχετική συχνότητα.

					Other statistic (e.g. mean) - Κάποιο άλλο στατιστικό όπως η μέση τιμή μιας μεταβλητής που θα οριστεί στο πεδίο Variable.

			

			Στο πεδίο Category Axis δηλώνουμε τη χρονική (διατάξιμη) μεταβλητή. Από το πλήκτρο Titles δηλώνουμε τους τίτλους του γραφήματος, από το πλήκτρο Options μπορούμε να επιλέξουμε την εμφάνιση διαστημάτων σφάλματος (π.χ. συν ή πλην μια τυπική απόκλιση).

			[image: \\server-pc\Storage_Volume\_ΥΛΙΚΟ ΔΟΥΛΕΙΑΣ\Κάλλιπος Χαλικιάς\Images - Resized\4.44.png]

			Εικόνα 4.44: Η κεντρική ενότητα της επιλογής Area Charts > Simple

			 Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε το γράφημα της Εικόνας 4.45.
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			Εικόνα 4.45: Αποτελέσματα από την εντολή Area Chart > Simple

			Για τη σύγκριση περισσότερων από μιας ποσότητας ορίζουμε επιπρόσθετα στο πεδίο Define Areas by την ποιοτική (ή ποσοτική διακριτή) μεταβλητή που θα διαμορφώσει την κάθε περιοχή.
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			Εικόνα 4.46: Η κεντρική ενότητα της επιλογής Area Charts > Stacked

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε το γράφημα της Εικόνας 4.47.
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			Εικόνα 4.47: Αποτελέσματα από την εντολή Area Chart > Stacked

			4. 12 Κυκλικά (πιτογράμματα) - Pie

			Η δυνατότητα προσφέρεται από την επιλογή Graphs > Legacy Dialogs >Pie, για τη δημιουργία κυκλικού διαγράμματος.

			Το κυκλικό διάγραμμα χρησιμοποιείται για τη γραφική απεικόνιση των ποιοτικών μεταβλητών. Είναι ένας κυκλικός δίσκος χωρισμένος σε κυκλικούς τομείς, τα εμβαδά των οποίων (ή ισοδύναμα τα τόξα) είναι ανάλογα προς τις αντίστοιχες απόλυτες ή σχετικές συχνότητες των τιμών της μεταβλητής.
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			Εικόνα 4.48: Το αρχικό menu Pie Charts

			
					Data in Chart Are - Ορίζουμε το είδος των δεδομένων που είναι στη λίστα μεταβλητών.

					Summaries for groups of cases - Είναι η επιλογή που χρησιμοποιούμε καθώς μας δείχνει το πλήθος των περιπτώσεων που περιέχονται σε κάθε κατηγορία.

					Summaries of separate variables - Με αυτή την επιλογή μπορούμε να λάβουμε αποτελέσματα έχοντας σε κάθε ράβδο π.χ. τον μέσο άλλων μεταβλητών.

					Values of individual cases.

			

			Συνεχίζουμε στην επόμενη ενότητα με το πλήκτρο Define.

			[image: \\server-pc\Storage_Volume\_ΥΛΙΚΟ ΔΟΥΛΕΙΑΣ\Κάλλιπος Χαλικιάς\Images - Resized\4.49.png]

			Εικόνα 4.49: Η κεντρική ενότητα της επιλογής Pie Chart

			Στο Slices Represent επιλέγουμε σε τι θα αναφέρονται οι κυκλικοί δίσκοι του γραφήματος. Οι δυνατές επιλογές είναι:

			
					N of cases - Το πλήθος των παρατηρήσεων (συχνότητα).

					% of cases - Το ποσοστό των παρατηρήσεων (σχετική συχνότητα).

					Cum N - Η αθροιστική συχνότητα.

					Cum % - Η αθροιστική σχετική συχνότητα.

					Other statistic (e.g. mean) - Κάποιο άλλο στατιστικό όπως η μέση τιμή μιας μεταβλητής που θα οριστεί στο πεδίο Variable.

			

			Στο πεδίο Defined Slices by δηλώνουμε την ποιοτική μεταβλητή για την οποία θα δημιουργήσουμε το γράφημα. Από το πλήκτρο Titles δηλώνουμε τους τίτλους του γραφήματος. Μπορούμε να επιλέξουμε και άλλες προσαρμοσμένες επιλογές, όπως να διαχωρίσουμε τα δεδομένα σε γραμμές και στήλες, τα οποία όμως δεν είναι υποχρεωτικά για τη δημιουργία ενός βασικού κυκλικού γραφήματος. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK, όπου και λαμβάνουμε το γράφημα. Με διπλό κλικ στο γράφημα μπορούμε να προβούμε σε μορφολογική επεξεργασία του.
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			Εικόνα 4.50: Αποτελέσματα από την εντολή Pie Chart

			4.13 High - Low

			Η δυνατότητα προσφέρεται από την επιλογή Graphs > Legacy Dialogs > High - Low, για τη δημιουργία  διαγράμματος Υψηλών - Χαμηλών τιμών. Το συγκεκριμένο είναι ένας τύπος γραφήματος που χρησιμοποιείται για να δείξει την εξέλιξη της τιμής του χρηματοπιστωτικού μέσου με την πάροδο του χρόνου.

			Κάθε κάθετη γραμμή στο διάγραμμα δείχνει το εύρος τιμών (υψηλότερες, χαμηλότερες και τιμές κλεισίματος μιας μετοχής) σε σχέση με τη μονάδα του χρόνου. Θα μπορούσαν να δοθούν διάφορες αποχρώσεις ανάλογα με το αν οι τιμές αυξήθηκαν ή μειώθηκαν κατά την περίοδο που εξετάζονται.

			Τα διαγράμματα Υψηλών - Χαμηλών τιμών μπορούν να είναι απλά Simple, όταν αφορούν σε μια μεταβλητή, ή ομαδοποιημένα Clustered όταν αφορούν σε περισσότερες από μια μεταβλητές. Θα παρουσιάσουμε τις επιλογές Simple και Clustered που είναι οι πιο συνήθεις.
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			Εικόνα 4.51: Το αρχικό menu High - Low Charts

			
					Data in Chart Are - Ορίζουμε το είδος των δεδομένων που είναι στη λίστα μεταβλητών.

					Summaries for groups of cases - Είναι η επιλογή που χρησιμοποιούμε καθώς μας δείχνει το πλήθος των περιπτώσεων που περιέχονται σε κάθε κατηγορία.

					Summaries of separate variables - Με αυτή την επιλογή μπορούμε να λάβουμε αποτελέσματα έχοντας σε κάθε ράβδο π.χ. τον μέσο άλλων μεταβλητών.

					Values of individual cases.

			

			Συνεχίζουμε στην επόμενη ενότητα με το πλήκτρο Define.

			Simple

			Στα πεδία High-Low-Close και Close ορίζουμε την μεταβλητή που μας δίνει την υψηλότερη, την χαμηλότερη και την τιμή κλεισίματος, π.χ. της μετοχής. Στο πεδίο Category Axis δηλώνουμε τη χρονική (διατάξιμη) μεταβλητή. Από το πλήκτρο Titles δηλώνουμε τους τίτλους του γραφήματος.
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			Εικόνα 4.52: Η κεντρική ενότητα της επιλογής High - Low Charts > Simple

			Από το πλήκτρο Statistic επιλέγουμε το περιγραφικό μέτρο που θα απεικονίζεται στο γράφημα. Η πιο συνήθης τιμή που λαμβάνεται και προκαθορισμένη από την εφαρμογή είναι ο μέσος.
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			Εικόνα 4.53: To menu από την εντολή High - Low Chart > Simple > Statistic

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK, όπου και λαμβάνουμε το γράφημα της Εικόνας 4.54.
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			Εικόνα 4.54: Αποτελέσματα από την εντολή High - Low Chart > Simple

			Clustered

			Για την απεικόνιση των τιμών περισσότερων από μιας «μετοχής» ορίζουμε τις τιμές τους στα αντίστοιχα πεδία με την αρχική «μετοχή». Τα πεδία εμφανίζονται με το πλήκτρο Next.
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			Εικόνα 4.55: Η κεντρική ενότητα της επιλογής High - Low Charts > Clustered

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK, όπου και λαμβάνουμε το γράφημα της Εικόνας 4.56.
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			Εικόνα 4.56: Αποτελέσματα από την εντολή High - Low Chart > Clustered

			4.14 Θηκογράμματα ή Πλαισίου-Απολήξεων BoxPlots

			Η δυνατότητα προσφέρεται από την επιλογή Graphs > Legacy Dialogs >Box Plot, για τη δημιουργία διαγράμματος πλαισίου-απολήξεων. Τα διαγράμματα πλαισίου - απολήξεων (ή αλλιώς θηκογράμματα) απεικονίζουν την κατανομή των ποσοτικών μεταβλητών και παρέχουν τη δυνατότητα διερεύνησης της ύπαρξης ακραίων τιμών σε μια μεταβλητή. Ο κορμός του διαγράμματος αποτελείται από ένα ορθογώνιο παραλληλόγραμμο του οποίου η κάτω πλευρά (βάση) απεικονίζει το πρώτο τεταρτημόριο Q1, ενώ η πάνω πλευρά (κορυφή) το τρίτο τεταρτημόριο Q3. Η γραμμή εντός του παραλληλογράμμου απεικονίζει τη διάμεσο των παρατηρήσεων. Η μέγιστη τιμή του διαγράμματος (ανώτερο φράγμα) δίνεται από τη σχέση Q3+1.5(Q3 - Q1) και η ελάχιστη (κατώτερο φράγμα) από την σχέση Q1-1.5(Q3-Q1).

			Τα θηκογράμματα μπορούν να είναι απλά Simple, όταν αφορούν σε μια μεταβλητή είτε ομαδοποιημένα Clustered, όταν αφορούν σε περισσότερες από μια μεταβλητές.

			
					Data in Chart Are: Ορίζουμε το είδος των δεδομένων που είναι στη λίστα μεταβλητών.

					Summaries for groups of cases: Είναι η επιλογή που χρησιμοποιούμε καθώς μας δείχνει το πλήθος των περιπτώσεων που περιέχονται σε κάθε κατηγορία.

					Summaries of separate variables: Μ’ αυτή την επιλογή μπορούμε να λάβουμε αποτελέσματα έχοντας σε κάθε πλαίσιο π.χ. τον μέσο άλλων μεταβλητών.

			

			Συνεχίζουμε στην επόμενη ενότητα με το πλήκτρο Define.
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			Εικόνα 4.57: Το αρχικό menu Boxplot

			Simple
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			Εικόνα 4.58: Η κεντρική ενότητα της επιλογής Boxplot > Simple

			Στο πεδίο Variable επιλέγουμε την ποσοτική μεταβλητή για την οποία θα δημιουργηθεί το γράφημα. Στο πεδίο Category Axis μπορούμε να δηλώσουμε μια ποιοτική μεταβλητή για να δημιουργήσουμε ξεχωριστό θηκόγραμμα για την κάθε κατηγορία της. Στο πεδίο Label Cases by δηλώνουμε τη μεταβλητή η οποία ονοματίζει τις παρατηρήσεις μας, συνήθως είναι η μεταβλητή Subject ή ID. Από το πλήκτρο Titles δηλώνουμε τους τίτλους του γραφήματος.

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε το γράφημα.
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			Εικόνα 4.59: Αποτελέσματα από την εντολή Boxplot > Simple

			Clustered

			Για τη δημιουργία γραφήματος με την απεικόνιση και δεύτερης ποιοτικής (ή ποσοτικής διακριτής) μεταβλητής, ορίζουμε στο πεδίο Define Clusters by τη δεύτερη ποιοτική (ή ποσοτική διακριτή) μεταβλητή.
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			Εικόνα 4.60: Η κεντρική ενότητα της επιλογής Boxplot > Clustered

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε το γράφημα:
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			Εικόνα 4.61: Αποτελέσματα από την εντολή Boxplot > Clustered

			4.15 Διασποράς - Scatter/ Dot

			Η δυνατότητα προσφέρεται από την επιλογή Graphs > Legacy Dialogs > Scatter / Dot, για την δημιουργία διαγράμματος σημείων ή διασποράς.

			Το διάγραμμα σημείων ονομάζεται και διάγραμμα διασποράς και αποτελεί μια γραφική απεικόνιση του τρόπου συσχέτισης μεταξύ ποσοτικών μεταβλητών, περιγράφοντας τη δυσδιάστατη κατανομή τους. Κάθε σημείο απεικονίζει ένα ζεύγος παρατηρήσεων των δύο μεταβλητών. Με το διάγραμμα διασποράς εντοπίζονται εύκολα συσχετίσεις και ακραίες τιμές. Η απλή συσχέτιση ασχολείται με τον βαθμό με τον οποίο τα σημεία συγκεντρώνονται γύρω από μια ευθεία χωρίς να προσδιορίζεται ποια είναι ακριβώς αυτή η γραμμή που διέρχεται μέσα από το νέφος των σημείων. Γραμμική συσχέτιση εμφανίζεται όταν τα σημεία όλων των παρατηρήσεων τείνουν να συγκεντρωθούν γύρω από μια ευθεία και μη γραμμική όταν τα σημεία τείνουν να συγκεντρωθούν γύρω από μια καμπύλη. Θετική συσχέτιση όταν δύο μεταβλητές τείνουν να μεταβάλλονται προς την ίδια κατεύθυνση (σχήμα α, Εικόνα 4.62), σε αυτή την περίπτωση οι τιμές αυξομειώνονται ταυτόχρονα. Αρνητική συσχέτιση όταν οι δύο μεταβλητές τείνουν να μεταβάλλονται προς την αντίθετη κατεύθυνση (σχήμα β, Εικόνα 4.62), και μηδενική συσχέτιση όταν οι μεταβολές των τιμών της μιας ποσοτικής μεταβλητής δεν σχετίζονται με τις τιμές της άλλης ποσοτικής μεταβλητής. Σε αυτή την περίπτωση τα σημεία του διαγράμματος είναι διασκορπισμένα σε όλο το μήκος του διαγράμματος (σχήμα γ, Εικόνα 4.62). Μη γραμμική συσχέτιση έχουμε όταν οι μεταβολές των τιμών της μιας μεταβλητής συνδέονται με τις μεταβολές της άλλης με μη γραμμική μορφή. Τα σημεία του νέφους τείνουν να συγκεντρωθούν γύρω από μια καμπύλη (σχήμα δ - Εικόνα 4.62).
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			Εικόνα 4.62: Γενικές μορφές διαγραμμάτων διασποράς

			Οι μορφές διαγραμμάτων διασποράς που προσφέρονται από την εφαρμογή είναι:

			
					Simple Scatter: Για τη δημιουργία απλού διαγράμματος διασποράς μεταξύ δύο ποσοτικών μεταβλητών.

					Matrix Scatter: Όταν έχουμε περισσότερες από δύο μεταβλητές, οπότε δημιουργούμε τα ανά δύο διαγράμματα διασποράς τους.

					Simple Dot: Μοιάζει με το ιστόγραμμα και χρησιμοποιείται για την απεικόνιση της κατανομής μιας ποσοτικής μεταβλητής. Τα δεδομένα είναι ομαδοποιημένα, αλλά αντί για μια τιμή σε κάθε κλάση όλες οι παρατηρήσεις της κάθε κλάσης εμφανίζονται στοιβαγμένες. Τα διαγράμματα αυτά ονομάζονται και διαγράμματα πυκνότητας.

					Overlay Scatter.

					3-D Scatter: Για τη δημιουργία τρισδιάστατου γραφήματος.
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			Εικόνα 4.63: Το αρχικό menu Scatter / Dot

			Συνεχίζουμε στην επόμενη ενότητα με το πλήκτρο Define.

			Simple

			Στα πεδία Y Axis και X Axis ορίζουμε τις δύο ποσοτικές μεταβλητές.
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			Εικόνα 4.64: Η κεντρική ενότητα της επιλογής Scatter / Dot > Simple

			Δεν είναι υποχρεωτικό, αλλά στο πεδίο Label Cases by μπορούμε να δηλώσουμε τη μεταβλητή που ονοματίζει τις παρατηρήσεις μας. Αν δεν δηλώσουμε κάποια μεταβλητή τότε οι ακραίες παρατηρήσεις μπορούν να εμφανιστούν με την αριθμητική τιμή τους.

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε το γράφημα.
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			Εικόνα 4.65: Αποτελέσματα από την εντολή Scatterplot > Simple

			Matrix Scatter

			Στο πλαίσιο Matrix Variables ορίζουμε τις ποσοτικές μεταβλητές για τις οποίες θα δημιουργηθούν ανά δύο τα διαγράμματα διασποράς.

			[image: \\server-pc\Storage_Volume\_ΥΛΙΚΟ ΔΟΥΛΕΙΑΣ\Κάλλιπος Χαλικιάς\Images - Resized\4.66.png]

			Εικόνα 4.66: Η κεντρική ενότητα της επιλογής Scatterplot > Matrix Scatter

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε το γράφημα.
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			Εικόνα 4.67: Αποτελέσματα από την εντολή Scatterplot > Matrix Scatter

			4.16 Ιστογράμματα - Histogram

			Η δυνατότητα προσφέρεται από την επιλογή Graphs > Legacy Dialogs >Histogram, για τη δημιουργία ιστογράμματος. Το ιστόγραμμα απεικονίζει την κατανομή μιας ποσοτικής μεταβλητής με τη βοήθεια ράβδων. Κάθε ράβδος αντιστοιχεί σε ένα διάστημα τιμών και το ύψος είναι ανάλογο της συχνότητας των παρατηρήσεων που περιέχονται σ’αυτό. Συχνά απεικονίζουμε και τη γραμμή της κανονικής κατανομής για να συγκρίνουμε εάν η κατανομή της ποσοτικής μας μεταβλητής είναι κανονική ή όχι. Αντίθετα με το ραβδόγραμμα στο οποίο ο x άξονας παριστάνει κατηγορίες, ο οριζόντιος άξονας ενός ιστογράμματος είναι μια αριθμητική κλίμακα. Κατασκευάζεται βασιζόμενο στον πίνακα συχνοτήτων ομαδοποιημένων παρατηρήσεων.

			Στο πεδίο Variable ορίζουμε την ποσοτική μεταβλητή, και επιλέγοντας την παράμετρο Display normal curve δηλώνουμε την εμφάνιση της καμπύλης της κανονικής κατανομής.
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			Εικόνα 4.68: Η κεντρική ενότητα της επιλογής Histogram

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε το γράφημα.
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			Εικόνα 4.69: Αποτελέσματα από την εντολή Histogram
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			Κεφάλαιο 5

			Βασικές έννοιες ελέγχων υποθέσεων και έλεγχοι κανονικότητας

			Σύνοψη

			Βασικές έννοιες και ορισμοί του ελέγχου υποθέσεων, γραφικοί έλεγχοι κανονικότητας μέσω των ιστογραμμάτων (διαδρομές Analyze > Descriptive Statistics > Frequencies > Charts, επιλέγοντας την παράμετρο Show normal curve on Histogram, Analyze Descriptive Statistics > Explore > Plots, επιλέγοντας την παράμετρο Histogram, Graphs > Legacy Dialogs > Histogram), των P-P plots (διαδρομές Analyze > Descriptive Statistics > P-P Plots, Analyze > Descriptive Statistics > Explore > Plots, επιλέγοντας την παράμετρο Normality plots with tests), των Q-Q Plots (διαδρομές Analyze > Descriptive Statistics > Q-Q Plots, Analyze > Descriptive Statistics > Explore > Plots). Στατιστικοί έλεγχοι κανονικότητας α) One-Sample Kolmogorov-Smirnov (K-S) Test (μέσω των διαδρομών Analyze > Descriptive Statistics > Explore > Plots επιλέγοντας την παράμετρο Normality plots with tests και Analyze > Nonparametric tests > Legacy Dialogs > 1 sample K-S), β) Shapiro-Wilk Τest μέσω της διαδρομής Analyze > Descriptive Statistics > Explore > Plots επιλέγοντας την παράμετρο Normality plots with tests).

			Προαπαιτούμενη γνώση

			Καλύτερη κατανόηση του κεφαλαίου προκύπτει αν ο αναγνώστης έχει καλή θεωρητική γνώση της κανονικής κατανομής. Τα εγχειρίδια που παρουσιάζουν με πληρότητα την ύλη του συγκεκριμένου κεφαλαίου είναι αυτά που αναφέρθηκαν στο κεφάλαιο 3.

			5.1 Εισαγωγή

			Στατιστική Συμπερασματολογία είναι ο κλάδος της Στατιστικής που έχει ως σκοπό τη εξαγωγή νόμων, κανόνων και συμπερασμάτων τα οποία ξεπερνούν το επίπεδο των παρατηρήσεων, και γενικεύονται στο σύνολο του πληθυσμού.

			Γενίκευση κάνουμε όταν ξεκινώντας από την πληροφορία που δίνει ένα ή περισσότερα αντιπροσωπευτικά δείγματα από κάποιον πληθυσμό, διατυπώνουμε μια πρόταση-υπόθεση (στατιστική υπόθεση) για τον πληθυσμό. Έτσι στο παρόν κεφάλαιο, αφήνουμε κατά μέρος την περιγραφική στατιστική ανάλυση και μπαίνουμε στον χώρο της συμπερασματολογίας (επαγωγής).

			Προσοχή: Για να ισχύει η γενίκευση θα πρέπει το δείγμα στο οποίο θα βασιστούμε για την εξαγωγή συμπερασμάτων, να είναι όσο το δυνατόν πιο αντιπροσωπευτικό του πληθυσμού που μελετάμε και φυσικά να ισχύουν οι προϋποθέσεις εφαρμογής της εκάστοτε μεθοδολογίας.

			5.2 Βασικές Έννοιες και Ορισμοί

			Η στατιστική υπόθεση (statistical hypothesis) μπορεί να είναι μια οποιαδήποτε «στατιστική» πρόταση (για περιγραφικά μέτρα, κατανομές πληθυσμών, στοχαστικές διαδικασίες, κ.λπ.) την ορθότητα ή μη της οποίας θέλουμε να εξετάσουμε με βάση τις παρατηρήσεις που διαθέτουμε.

			Έστω ότι μελετάμε μια παράμετρο θ για την οποία υποθέτουμε ότι μπορεί να λάβει μια συγκεκριμένη τιμή. Αυτή την υπόθεση την ονομάζουμε μηδενική υπόθεση (null hypothesis) και τη συμβολίζουμε με H0.

			Έτσι στο παράδειγμά μας η μηδενική υπόθεση διαμορφώνεται ως H0:θ = θ0. Σε περίπτωση που η H0 απορριφθεί τότε θεωρούμε ότι ισχύει η εναλλακτική υπόθεση (alternative hypothesis), η οποία συμβολίζεται ως H1 και η οποία δύναται να λάβει μια από τις ακόλουθες μορφές: H1 : θ ≠ θ0, η παράμετρος να είναι διάφορη από την τιμή θ0 (δίπλευρος έλεγχος).

			Η1:θ < θ0, η παράμετρος να είναι μικρότερη από την τιμή θ0 (μονόπλευρος έλεγχος).

			Η1:θ > θ0, η παράμετρος να είναι μεγαλύτερη από την τιμή θ0 (μονόπλευρος έλεγχος).

			Η επιλογή μονόπλευρου ή δίπλευρου ελέγχου εξαρτάται από το αντικείμενο που μελετάμε.

			Τιμές της παραμέτρου θ «κοντά» στη θ0 υποστηρίζουν την ορθότητα της H0, ενώ τιμές της παραμέτρου θ «μακριά» από τη θ0 δεν την υποστηρίζουν. Έτσι, χωρίζουμε τις δυνατές τιμές της παραμέτρου θ σε αυτές για τις οποίες η H0 απορρίπτεται, και αυτές για τις οποίες δεν μπορούμε να απορρίψουμε την H0. Η περιοχή όπου η H0 απορρίπτεται ονομάζεται περιοχή απόρριψης (rejection region) και συμβολίζεται με R.

			Η απόφαση για την απόρριψη ή μη της H0 γίνεται βάση πιθανοτήτων γι’αυτόν τον λόγο ορίζουμε επίπεδο εμπιστοσύνης (١-α) για την απόφαση ελέγχου. Το α λέγεται επίπεδο σημαντικότητας (significance level) και καθορίζει τη διαχωριστική γραμμή μεταξύ των περιοχών απόρριψης ή μη. Όταν το α μικραίνει, μικραίνει και η περιοχή απόρριψης R. Η πιο συνήθης τιμή για το α είναι α = ٥٪. Το επίπεδο σημαντικότητας που υπολογίζεται από τα δεδομένα μας και το οποίο συγκρίνουμε με το οριζόμενο επίπεδο σημαντικότητας α ονομάζεται p-value.
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			Εικόνα 5.1: Έλεγχοι Υποθέσεων για τη μέση τιμή ενός πληθυσμού. Δεξιά και αριστερά είναι οι μονόπλευροι έλεγχοι

			Με βάση την H0 προσδιορίζουμε τη «στατιστική ελέγχου» (test statistic) της εκάστοτε υπόθεσης μας. Οι στατιστικοί έλεγχοι διακρίνονται σε δύο κατηγορίες: τους παραμετρικούς, που βασίζονται σε ελεγχοσυναρτήσεις με γνωστή κατανομή, και τους μη παραμετρικούς που βασίζονται σε άλλες ιδιότητες της παραμέτρου.

			Προσοχή: Οι παραμετρικοί έλεγχοι υποθέσεων βασίζονται σε γνωστές κατανομές, οι οποίες φέρουν τις ιδιότητες της κανονικής κατανομής, συνεπώς για να αποφανθούμε εάν θα χρησιμοποιηθεί παραμετρικός ή μη παραμετρικός έλεγχος, αρχικά εξετάζουμε αν οι παρατηρήσεις μας ακολουθούν κανονική κατανομή.

			Συνοπτικά τα στάδια ενός στατιστικού ελέγχου είναι:

			
					Ορίζεται η μηδενική υπόθεση H0.

					Ορίζεται η εναλλακτική υπόθεση H1.

					Ορίζεται το επίπεδο σημαντικότητας α.

					Επιλέγεται η κατάλληλη ελεγχοσυνάρτηση.

					Ορίζεται η περιοχή απόρριψης R της H0.

			

			Σε έναν έλεγχο υπόθεσης υπάρχει περίπτωση να γίνουν δύο ειδών σφάλματα.

			
					Ως Σφάλμα Τύπου Ι ορίζεται η πιθανότητα απόρριψης της μηδενικής υπόθεσης H0, ενώ αυτή είναι σωστή. Η πιθανότητα του σφάλματος Τύπου Ι συμβολίζεται με α.α = P [απόρριψη της H0 | H0 είναι σωστή]
Εξίσωση 5.1


					Ως Σφάλμα Τύπου ΙΙ ορίζεται η πιθανότητα αποδοχής της μηδενικής υπόθεσης H0, ενώ αυτή είναι λανθασμένη. Η πιθανότητα του σφάλματος Τύπου ΙΙ συμβολίζεται με β.

			

			β = P [αποδοχή της H0 | H0 είναι λάθος]

			Εξίσωση 5.2

			Ισχύς (power) ενός στατιστικού ελέγχου ονομάζεται η πιθανότητα απόρριψης της H0, ενώ είναι πράγματι ψευδής, δηλ. είναι η πιθανότητα να αποφύγουμε ένα σφάλμα Τύπου ΙΙ.

			γ = 1 - β = P[απόρριψη της H0 | H0 είναι λάθος]

			Εξίσωση 5.3

			Επίπεδο σημαντικότητας ενός ελέγχου ονομάζεται η πιθανότητα να παρατηρηθεί μια τιμή του στατιστικού μεγαλύτερη από αυτήν που έδωσε το δείγμα των παρατηρήσεων.

			p-value = P[T(Y) πιο ακραία από την T(Yobs) | θ, H0]

			Εξίσωση 5.4

			5.3 Γραφικοί Έλεγχοι Κανονικότητας

			Για να αποφασιστεί εάν θα χρησιμοποιηθεί παραμετρικός ή μη παραμετρικός έλεγχος, αρχικά εξετάζουμε αν οι παρατηρήσεις μας ακολουθούν κανονική κατανομή. Ο έλεγχος κανονικότητας δύναται να πραγματοποιηθεί είτε γραφικά είτε μέσω στατιστικών ελέγχων.

			Η υπόθεση που εξετάζεται είναι εάν η κατανομή των δεδομένων είναι η κανονική κατανομή, ή όχι:
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			Εξισώσεις 5.5

			Γραφικά, ο έλεγχος κανονικότητας πραγματοποιείται με τη χρήση ιστογράμματος, ή διαγραμμάτων P-P και Q-Q plots. Αναλυτικότερα:

			5.3.1 Ιστογράμματα

			Η παραγωγή ιστογραμμάτων έχει ήδη αναλυθεί σε προηγούμενες παραγράφους, μέσω των επιλογών:

			
					Analyze > Descriptive Statistics > Frequencies > Charts, επιλέγοντας την παράμετρο Show normal curve on Histogram.

					Analyze > Descriptive Statistics > Explore > Plots, επιλέγοντας την παράμετρο Histogram.

					Graphs > Legacy Dialogs > Histogram.

			

			5.3.2 P-P Plots

			Η δυνατότητα προσφέρεται από τις επιλογές:

			
					Analyze > Descriptive Statistics > P-P Plots.

					Analyze > Descriptive Statistics > Explore > Plots, επιλέγοντας την παράμετρο Normality plots with tests με σκοπό τον έλεγχο κανονικότητας μιας ποσοτικής μεταβλητής.

			

			Το P-P plot (probability-probability plot or percent-percent plot) είναι ένα γράφημα πιθανότητας για την αξιολόγηση του πόσο στενά συμφωνούν δύο σύνολα δεδομένων, βασιζόμενες στις αθροιστικές τους συναρτήσεις κατανομής.

			Από το γράφημα εξετάζουμε εάν τα δεδομένα μας συμπίπτουν ή τείνουν στην ευθεία γραμμή του γραφήματος. Εάν τα σημεία τείνουν προς την ευθεία γραμμή συνεπάγεται ότι τα δεδομένα ακολουθούν την κατανομή που έχει οριστεί στο Test Distribution.

			Στο πλαίσιο Variables επιλέγουμε τις μεταβλητές που θα εξεταστούν ως προς την κανονικότητά τους, επιλέγοντας στο πεδίο Test Distribution την κανονική (Normal) κατανομή.

			Η επιλογή της κανονικής κατανομής είναι η προκαθορισμένη επιλογή της εφαρμογής, ωστόσο παρέχονται και πολλές άλλες γνωστές κατανομές όπως: οι Student, Pareto, Weibull, Uniform κ.ά.
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			Εικόνα 5.2: To menu P-P plot

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε ένα γράφημα για κάθε μεταβλητή.
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			Εικόνα 5.3: Αποτελέσματα από την εντολή P-P plot

			5.3.3 Q-Q Plots

			Η δυνατότητα προσφέρεται από τις επιλογές:

			
					Analyze > Descriptive Statistics > Q-Q Plots.

					Analyze > Descriptive Statistics > Explore > Plots, επιλέγοντας την παράμετρο Normality plots with tests με σκοπό τον έλεγχο κανονικότητας μιας ποσοτικής μεταβλητής.

			

			Ένα Q-Q plot (το «Q» προέρχεται από την λέξη quantile) είναι ένα γράφημα πιθανότητας για τη γραφική σύγκριση δύο κατανομών πιθανότητας, απεικονίζοντας τα ποσοστημόρια της μιας σε σχέση με την άλλη.

			Το γράφημα Q-Q χρησιμοποιείται για να συγκρίνουμε τα σχήματα των συναρτήσεων κατανομής, παρέχοντας μια γραφική άποψη για το πώς ιδιότητες, όπως η θέση, η κλίμακα και η ασυμμετρία είναι παρόμοιες ή διαφορετικές στις δύο κατανομές. Επίσης, χρησιμοποιείται για να συγκρίνει τις συλλογές δεδομένων ή θεωρητικές κατανομές. Η χρήση του γραφήματος για τη σύγκριση δύο δειγμάτων δεδομένων μπορεί να θεωρηθεί ως μια μη-παραμετρική προσέγγιση για τη σύγκριση των κατανομών τους. Γενικότερα η χρήση γραφημάτων Q-Q είναι μια πιο ισχυρή προσέγγιση από την κοινή τεχνική της σύγκρισης των ιστογραμμάτων των δύο δειγμάτων.

			Εάν οι δύο κατανομές είναι ίσες, τότε τα σημεία του Q-Q plot θα βρίσκονται στην ευθεία y = x. Εάν οι κατανομές έχουν γραμμική σχέση, τα σημεία του γραφήματος θα βρίσκονται περίπου σε μια γραμμή, αλλά όχι κατ’ ανάγκη στην ευθεία y = x. Γενικότερα τα γραφήματα Q-Q είναι συχνά τοξοειδούς ή «S» μορφής, υποδεικνύοντας ότι η μία από τις κατανομές είναι πιο ασύμμετρη από την άλλη.
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			Εικόνα 5.4: To menu Q-Q plot

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε ένα γράφημα για κάθε μεταβλητή.
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			Εικόνα 5.5: Αποτελέσματα από την εντολή Q-Q plot

			5.4 Στατιστικοί Έλεγχοι Κανονικότητας

			Για να αποφασιστεί αν θα χρησιμοποιηθεί παραμετρικός ή μη παραμετρικός έλεγχος, αρχικά εξετάζουμε την κανονικότητα των παρατηρήσεών μας.

			Οι στατιστικοί έλεγχοι που παρέχονται για τον έλεγχο της κανονικότητας είναι αυτοί των Kolmogorov-Smirnov και των Shapiro-Wilk.

			Η υπόθεση που εξετάζεται είναι αν η κατανομή των δεδομένων είναι η κανονική κατανομή, ή όχι.

			5.4.1 One-Sample Kolmogorov-Smirnov (K-S) Test

			Η δυνατότητα προσφέρεται από τις επιλογές :

			
					Analyze > Descriptive Statistics > Explore > Plots, επιλέγοντας την παράμετρο Normality plots with tests.

			

			
					Analyze > Nonparametric tests > Legacy Dialogs > 1 sample K-S, με σκοπό τον έλεγχο κανονικότητας μιας ποσοτικής μεταβλητής.

			

			To κριτήριο Κ-S είναι ένας μη παραμετρικός έλεγχος που χρησιμοποιείται για να εξετάσει την καλή προσαρμογή ενός τυχαίου δείγματος σε μία δεδομένη κατανομή, και βασίζεται στη διαφορά της εμπειρικής συνάρτησης κατανομής που προέρχεται από το δείγμα, και της αναμενόμενης συνάρτησης κατανομής υπό την υπόθεση της κανονικότητας, ή της οποιαδήποτε μηδενικής υπόθεσης Η0 η οποία μπορεί να είναι Κανονική, Ομοιόμορφη, Poisson ή Εxponential.

			Υποθέσεις του κριτηρίου:

			Το κριτήριο Kolmogorov-Smirnov υποθέτει ότι οι παράμετροι της υπό έλεγχο κατανομής προσδιορίζονται εκ των προτέρων. Αυτή η προσέγγιση υπολογίζει τις παραμέτρους από το δείγμα. Για κάθε κατανομή οι παράμετροι που εκτιμώνται είναι:
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			Πίνακας 5.1: Πίνακας που δείχνει τη σχέση κατανομής-παραμέτρου
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			Εικόνα 5.6: To menu One-Sample Kolmogorov-Smirnov Test

			Στο πλαίσιο Test Variables List ορίζονται οι μεταβλητές για τις οποίες θα υπολογιστεί το κριτήριο κανονικότητας. Το κριτήριο υπολογίζεται ξεχωριστά για κάθε μεταβλητή.

			Στο πλαίσιο Test Distribution επιλέγεται η κατανομή σύγκρισης. Οι δυνατές επιλογές είναι:

			
					Normal,

					Poisson,

					Uniform,

					Exponential.

			

			Από το πλήκτρο Exact επιλέγοντας την παράμετρο Monte Carlo ζητάμε από την εφαρμογή να χρησιμοποιήσει την τεχνική της προσομοίωσης για τον έλεγχο της κανονικότητας, όπου διεξάγει ١٠.٠٠٠ (προκαθορισμένη τιμή) ελέγχους κανονικότητας και για κάθε έναν υπολογίζει το p-value. Στο τέλος εμφανίζει τον μέσο όρο αυτών των 10.000 p-values και ένα 99% δ.ε. γι’ αυτόν. Ωστόσο, η συνήθης επιλογή είναι η προκαθορισμένη Asymptotic only.
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			Εικόνα 5.7: To menu One-Sample Kolmogorov-Smirnov Tes -Options

			Από το πλήκτρο Options παρέχεται η δυνατότητα εξαγωγής περιγραφικών μέτρων, τα ποσοστημόρια της κάθε μεταβλητής, και η διαχείριση των ελλειπουσών τιμών. Τα περιγραφικά μέτρα που παράγονται είναι η μέση τιμή, η τυπική απόκλιση, η ελάχιστη και η μέγιστη παρατήρηση και το πλήθος των έγκυρων παρατηρήσεων. Από τα ποσοστημόρια απεικονίζονται το ٢٥ο, το 50ο, και το 75ο ποσοστημόριο, δηλ. το ١ο, 2ο (διάμεσος) και ٣ο τεταρτημόριο.
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			Εικόνα 5.8: To menu One-Sample Kolmogorov-Smirnov Test-Options

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε τους ακόλουθους πίνακες.
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			Εικόνα 5.9: Περιγραφικά μέτρα από την εντολή One-Sample Kolmogorov-Smirnov Test
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			Εικόνα 5.10: Αποτελέσματα από την εντολή One-Sample Kolmogorov-Smirnov Test

			Από τα αποτελέσματά μας διαπιστώνουμε ότι η μηδενική υπόθεση απορρίπτεται σε επίπεδο σημαντικότητας ٥٪, συνεπώς η μεταβλητή δεν ακολουθεί κανονική κατανομή.

			5.4.2 Shapiro-Wilk Τest

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Descriptive Statistics > Explore > Plots επιλέγοντας την παράμετρο Normality plots with tests, με σκοπό τον έλεγχο κανονικότητας μιας ποσοτικής μεταβλητής.

			Το κριτήριο Shapiro-Wilk είναι ένας ακόμα πολύ γνωστός μη παραμετρικός έλεγχος για το αν οι παρατηρήσεις μίας μεταβλητής προέρχεται από κανονική κατανομή.

			Επιλέγοντας την παράμετρο Normality plots with tests, όταν οι τιμές της μεταβλητής είναι σταθμισμένες και οι τιμές των σταθμίσεων είναι μη ακέραιες, τότε το κριτήριο των Shapiro-Wilk υπολογίζεται όταν το σταθμισμένο (weighted) μέγεθος του δείγματος είναι μεταξύ 3-50. Εάν οι τιμές της μεταβλητής δεν είναι σταθμισμένες ή οι σταθμίσεις είναι ακέραιες τιμές, τότε το κριτήριο υπολογίζεται για μέγεθος δείγματος μεταξύ 3 και 5.000.

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε τον ακόλουθο πίνακα:
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			Εικόνα 5.11: Αποτελέσματα από την εντολή Explore-Normality plots with tests

			Από τα αποτελέσματα διαπιστώνουμε, ομοίως με τον προηγούμενο έλεγχο, ότι η μηδενική υπόθεση απορρίπτεται σε επίπεδο σημαντικότητας 5%, συνεπώς η μεταβλητή δεν ακολουθεί κανονική κατανομή.
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			Κεφάλαιο 6

			Παραμετρικοί και μη παραμετρικοί έλεγχοι υποθέσεων

			Σύνοψη

			Το κεφάλαιο αυτό παρουσιάζει τους γνωστότερους παραμετρικούς και μη παραμετρικούς ελέγχους θεωρητικά και στο πρόγραμμα. Συγκεκριμένα του ελέγχους: T-Test για τον έλεγχο Μέσης Τιμής Πληθυσμού, T-test για τον έλεγχο της διαφοράς δύο μέσων από ανεξάρτητα δείγματα, Mann-Whitney U, T-test για τον έλεγχο της διαφοράς δύο μέσων από συσχετιζόμενα δείγματα, Wilcoxon, Means, One-Way ANOVA για ανεξάρτητα δείγματα, Kruskall-Wallis, Two-Way ANOVA for Independent samples Friedman, Χ2 test, Mc Nemar test.

			Σημειώνεται ότι τα δεδομένα των εφαρμογών είναι κατά πλειοψηφία δεδομένα που χρησιμοποιήθηκαν κατά τις παραδόσεις των αντίστοιχων μαθημάτων του ΠΜΣ «Βιοστατιστικής» των πανεπιστημίων Αθηνών και Ιωαννίνων. Για τις εφαρμογές των 6.2, 6.6. και 6.11 χρησιμοποιήθηκαν δεδομένα από την αντίστοιχη σελίδα του πανεπιστημίου του Princeton (βλ. βιβλιογραφικές αναφορές). Πολύτιμες πληροφορίες για τη συγκεκριμένη ύλη υπάρχουν στον αντίστοιχο ιστότοπο του προγράμματος (βλ. βιβλιογραφικές αναφορές). Τέλος για την παράγραφο 6.14 αξιόλογη πηγή ήταν η διπλωματική εργασία του Γ. Κουτσοχέρα (βλ. βιβλιογραφικές αναφορές).

			Προαπαιτούμενη γνώση

			Απαιτείται πολύ καλή γνώση του προηγούμενου κεφαλαίου καθώς και θεωρητική γνώση των κατανομών κατανομής και Χ2, και εξοικείωση με τη διαδικασία ελέγχου υποθέσεων (έννοιες της ελεγχοσυνάρτησης και της περιοχής απόρριψης της μηδενικής υπόθεσης).

			6.1 T-Test για τον έλεγχο Μέσης Τιμής Πληθυσμού

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Compare Means > One-Sample T-test, με σκοπό τον έλεγχο της ισότητας της μέσης τιμής ενός πληθυσμού με μια συγκεκριμένη τιμή μ0. Δηλαδή οι υποθέσεις που εξετάζονται είναι:
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			Εξίσωση 6.1

			Η στατιστική συνάρτηση του ελέγχου διαμορφώνεται ανάλογα με το εάν το δείγμα μας προέρχεται από κανονικό πληθυσμό ή όχι, με γνωστή ή άγνωστη διασπορά. Η υπόθεση απορρίπτεται όταν η τιμή του κριτηρίου είναι κατά απόλυτη τιμή μεγαλύτερη από την τιμή που θα λάμβανε εάν ίσχυε η μηδενική υπόθεση και δίνεται από τους αντίστοιχους πίνακες της κανονικής, ή της t-student κατανομής.
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			Εικόνα 6.1: Περιοχές απόρριψης σε δίπλευρο έλεγχο

			Μορφές της ελεγχοσυνάρτησης

			1η Περίπτωση. Διασπορά γνωστή:
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			Εξίσωση 6.2

			Απορρίπτουμε την H0 εάν η περιοχή απόρριψης είναι:
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			Εξίσωση 6.3

			2η Περίπτωση. Διασπορά άγνωστη, n ≥ 30:
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			Εξίσωση 6.4

			Απορρίπτουμε την H0 εάν η περιοχή απόρριψης είναι:
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			Εξίσωση 6.5

			3η Περίπτωση. Διασπορά άγνωστη, n < 30
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			Εξίσωση 6.6

			Απορρίπτουμε την H0 εάν η περιοχή απόρριψης είναι:
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			Εξίσωση 6.7

			Στο περιβάλλον του SPSS, στο πεδίο Test Variable(s) εισάγουμε την ή τις συνεχείς μεταβλητές που θα εξεταστούν και στο πεδίο Test Value εισάγουμε την υπό εξέταση τιμή μ0.
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			Εικόνα 6.2: To menu One-Sample T-test

			Από το πλήκτρο Options ορίζουμε το επίπεδο σημαντικότητας για τη δημιουργία των διαστημάτων εμπιστοσύνης της διαφοράς των δύο μέσων (της μέσης τιμής και της υπό εξέτασης τιμής).

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε:
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			Εικόνα 6.3: Περιγραφικά μέτρα της μεταβλητής και αποτελέσματα ελέγχου της ισότητας της μέσης τιμής με την τιμή 1000

			Στον πρώτο πίνακα παρουσιάζονται το πλήθος παρατηρήσεων, η μέση τιμή, η τυπική απόκλιση και το τυπικό σφάλμα μέσης τιμής. Διαπιστώνεται ότι η μέση τιμή 24.372,2 διαφέρει από την υπό εξέταση τιμή μ0 = 1.000. Η διαφορά αυτή είναι στατιστικά σημαντική σε επίπεδο σημαντικότητας 5%, όπως επιβεβαιώνεται από τα αποτελέσματα του ελέγχου (p-value = 0,005 < 0,05).

			6.2 T-test για τον έλεγχο της διαφοράς δύο μέσων από ανεξάρτητα δείγματα

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Compare Means > Independent-Samples T-test, με σκοπό τον έλεγχο της συσχέτισης μιας συνεχούς μεταβλητής με μια δίτιμη κατηγορική μεταβλητή, στην οποία οι κατηγορίες αφορούν μετρήσεις που γίνονται σε διαφορετικά άτομα. Για παράδειγμα, εξετάζουμε το πλήθος θανάτων σε σχέση με το φύλο. Η μεταβλητή «Φύλο» είναι δίτιμη και οι μετρήσεις διενεργούνται σε διαφορετικά άτομα: άνδρες / γυναίκες.

			Στην πραγματικότητα η υπόθεση που εξετάζεται είναι η ισότητα των μέσων των δύο ανεξάρτητων ομάδων.
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			Εξίσωση 6.8

			Εάν η υπόθεση της ισότητας δεν απορριφθεί τότε θα συνεπάγεται ότι οι δύο μέσοι είναι ίδιοι στις δύο ομάδες, συνεπώς η κατηγοριοποίηση δεν οδηγεί σε διαφορετικά αποτελέσματα, ή με άλλα λόγια η κατηγορική μεταβλητή δεν σχετίζεται με τη συνεχή μεταβλητή.
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			Εικόνα 6.4: To menu Independent-Samples T-test

			Στο πεδίο Test Variable(s) εισάγουμε την ή τις συνεχείς μεταβλητές που θα εξεταστούν, ενώ στο πεδίο Grouping Variable εισάγουμε την κατηγορική μεταβλητή. Καθώς ενδέχεται η κατηγορική που θα επιλεγεί να έχει περισσότερες από δύο κατηγορίες. Μέσω του πλήκτρου Define Groups ορίζουμε τους κωδικούς των δύο κατηγοριών που θα χρησιμοποιηθούν για την εφαρμογή του T-test.

			Από το πλήκτρο Options ορίζουμε το επίπεδο σημαντικότητας για τη δημιουργία των διαστημάτων εμπιστοσύνης της διαφοράς των δύο μέσων μ1-μ2.
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			Εικόνα 6.5: To menu Independent-Samples T-test > Options

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε δύο πίνακες.

			Στον πρώτο πίνακα παρουσιάζονται τα περιγραφικά μέτρα (στο συγκεκριμένο παράδειγμα του πλήθους θανάτων) στις δύο ομάδες. Απ’ αυτά φαίνεται ότι οι άνδρες έχουν κατά μέσο όρο μεγαλύτερο πλήθος θανάτων σε σχέση με τις γυναίκες.
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			Εικόνα 6.6: Περιγραφικά μέτρα του πλήθους θανάτων στις δύο ομάδες
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			Εικόνα 6.7:Αποτελέσματα του T-test για ανεξάρτητα δείγματα

			Στον δεύτερο πίνακα λαμβάνουμε τα αποτελέσματα του ελέγχου. Στον πίνακα αυτόν εμφανίζονται δύο εγγραφές για τον έλεγχο T-test της ισότητας των δύο μέσων. Αυτό οφείλεται στο ότι για τον υπολογισμό χρησιμοποιούνται διαφορετικοί τύποι, αναλόγως εάν ισχύει ή όχι η ισότητα των διασπορών στις δύο ομάδες. Συνεπώς για να αποφανθούμε ποια αποτελέσματα θα χρησιμοποιήσουμε, ελέγχουμε αρχικά τον έλεγχο Levene για την ισότητα των διασπορών. Ο έλεγχος υποδεικνύει ότι η υπόθεση της ισότητας δεν μπορεί να απορριφθεί σε επίπεδο 5% (p-value = 0,094>0,05), συνεπώς θα χρησιμοποιηθούν τα αποτελέσματα του ελέγχου T-test από την πρώτη γραμμή, από όπου και διαπιστώνουμε ότι η υπόθεση της ισότητας δεν απορρίπτεται (p-value = 0,769 > 0,05), άρα το μέσο πλήθος θανάτων μεταξύ ανδρών και γυναικών είναι σχεδόν το ίδιο.

			6.3 Mann-Whitney U

			Πρόκειται για τον αντίστοιχο μη παραμετρικό έλεγχο της ισότητας δύο μέσων μεταξύ ανεξάρτητων δειγμάτων, τα οποία όμως δεν ακολουθούν κανονική κατανομή. Η δυνατότητα προσφέρεται από την επιλογή Analyze > Non Parametric Tests > Independent-Samples.

			Το κριτήριο Mann-Whitney είναι ένας βαθμολογικός έλεγχος που εξετάζει την υπόθεση ότι το άθροισμα των βαθμών των θέσεων των παρατηρήσεων του ενός δείγματος είναι ίσο με το άθροισμα των βαθμών των θέσεων των παρατηρήσεων του άλλου δείγματος.
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			Εξίσωση 6.9

			Εάν η υπόθεση ότι τα αθροίσματα είναι ίσα δεν απορριφθεί, τότε συνεπάγεται ότι η κατανομή των παρατηρήσεων της μιας ομάδας είναι σχεδόν ίδια με την κατανομή της άλλης και ότι οι παρατηρήσεις εμφανίζονται με τυχαίο τρόπο τόσο στη μια όσο και στην άλλη ομάδα. Συνεπώς, η διαφοροποίηση λόγω της κατηγορικής μεταβλητής δεν σχετίζεται με τη συνεχή μεταβλητή.

			Η ελεγχοσυνάρτηση βασίζεται στη σχέση:
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			Εξίσωση 6.10

			Όπου:
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			Εξίσωση 6.11

			Έστω ότι έχουμε δύο ομάδες ποντικιών (ίδιας ηλικίας και φύλου) στα οποία μετά από τυχαιοποίηση χορηγήθηκε ένα πρόγραμμα διατροφής υψηλής (ομάδα Α) και χαμηλής (ομάδα Β) περιεκτικότητας πρωτεϊνών. Στο τέλος του προγράμματος μετρήθηκε το βάρος των ποντικιών ώστε να εξεταστεί ποιο είδος διατροφής επιδρά στο βάρος των ποντικιών.
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			Εικόνα 6.8: To menu Nonparametric Tests: Two or More Independent-Samples
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			Εικόνα 6.9: To menu Nonparametric Tests: Two or More Independent-Samples > Fields

			Στο πεδίο Test Fields ορίζουμε τη συνεχή μεταβλητή, και στο πεδίο Groups την κατηγορική μεταβλητή.
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			Εικόνα 6.10: To menu Nonparametric Tests: Two or More Independent-Samples > Settings

			Στη συνέχεια στην ενότητα Settings επιλέγουμε το κριτήριο σύγκρισης των δύο ομάδων Mann- Whitney U (2 samples).

			Η διαδικασία ολοκληρώνεται με το πλήκτρο RUN όπου και λαμβάνουμε:
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			Εικόνα 6.11: Περιγραφικά μέτρα των βαθμών των θέσεων των παρατηρήσεων

			Το SPSS μας δίνει το μέσο της ιεράρχησης ή το μέσο της κατάταξης (Mean Rank) και όχι περιγραφικά μέτρα για τις δύο μεταβλητές ή για τις μετρήσεις της ίδιας μεταβλητής. Στις περιπτώσεις που η κανονικότητα παραβιάζεται συνηθίζουμε να δίνουμε τη διάμεσο ή το εύρος. Καθώς αυτά τα περιγραφικά δεν παρέχονται αυτόματα από το SPSS τα εξάγουμε από την εντολή Means, βλ. ομώνυμη ενότητα.
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			Εικόνα 6.12: Αποτελέσματα του ελέγχου Mann-Whitney U

			Ο έλεγχος υποδεικνύει ότι η υπόθεση της ισότητας δεν μπορεί να απορριφθεί σε επίπεδο 5% (p-value = 0,132 > 0,05), άρα δεν μπορούμε να ισχυριστούμε ότι οι δύο μέσοι διαφέρουν.

			6.4 T-test για τον έλεγχο της διαφοράς δύο μέσων από συσχετιζόμενα δείγματα

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Compare Means > Paired-Samples T-test, με σκοπό τον έλεγχο της συσχέτισης μιας συνεχούς μεταβλητής με μια δίτιμη κατηγορική μεταβλητή, στην οποία οι κατηγορίες αφορούν μετρήσεις που γίνονται στα ίδια άτομα πριν και μετά από τη μεσολάβηση ενός γεγονότος (π.χ. χορήγηση φαρμάκου). Για παράδειγμα, εξετάζουμε εάν οι άνθρωποι χάνουν βάρος εάν υποβληθούν σε μια δίαιτα υψηλή σε υδατάνθρακες και χαμηλά λιπαρά. Τα δύο δείγματα καλούνται εξαρτημένα (correlated) και οι παρατηρήσεις ζευγαρωτές παρατηρήσεις.

			Καθώς οι μετρήσεις εφαρμόζονται στο ίδιο άτομο, το δείγμα που προκύπτει προέρχεται από τη διαφορά των δύο μετρήσεων (πριν και μετά το γεγονός). Η υπόθεση που εξετάζεται είναι εάν ο μέσος όρος αυτών των διαφορών ισούται με το μηδέν ή όχι.
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			Εξίσωση 6.12

			Η ελεγχοσυνάρτηση είναι η:
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			Εξίσωση 6.13

			Όπου:

			[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\6.14.wmf]

			Εξίσωση 6.14

			και
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			Εξίσωση 6.15

			Η υπόθεση απορρίπτεται όταν t > t N-1.

			Συνεπώς, εάν η υπόθεση της ισότητας δεν απορριφθεί τότε θα συνεπάγεται ότι οι διαφορές είναι κατά μέσο όρο ίσες με το μηδέν, δηλ. ότι το γεγονός δεν επηρέασε την αρχική κατάσταση.

			Στο πεδίο Paired Variables στις θέσεις Variable1 & Variable2 εισάγουμε τις δύο μεταβλητές που αντιπροσωπεύουν τις μετρήσεις πριν και μετά το γεγονός.

			Προσοχή! Διαπιστώνουμε ότι η μορφή των δεδομένων για να πραγματοποιηθεί η ανάλυση είναι Wide Format. Εάν τα δεδομένα μας δεν είναι σε αυτή την μορφή, τότε βλ. ενότητα Restructure για τον μετασχηματισμό.

			Από το πλήκτρο Options ορίζουμε το επίπεδο σημαντικότητας για τη δημιουργία των διαστημάτων εμπιστοσύνης.
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			Εικόνα 6.13: To menu Paired-Samples T-test

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε δύο πίνακες.

			Στον πρώτο πίνακα παρουσιάζονται τα περιγραφικά μέτρα στις δύο ομάδες. Απ’ αυτά φαίνεται ότι υπάρχει μια μείωση της μέσης τιμής πριν και μετά.

			[image: 6]

			Εικόνα 6.14: Περιγραφικά μέτρα των δύο ομάδων
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			Εικόνα 6.15:Αποτελέσματα του T-test για εξαρτημένα δείγματα

			Ο δεύτερος πίνακας παρουσιάζει τα αποτελέσματα του ελέγχου από όπου διαπιστώνουμε ότι η διαφορά είναι σε επίπεδο 5% (p-value < 0,001), συνεπώς η διαφορά (μείωση) είναι στατιστικά σημαντική και το γεγονός (δίαιτα) συνετέλεσε στη μείωση της μέσης τιμής (σε μείωση του βάρους).

			6.5 Wilcoxon

			Ο έλεγχος αυτός είναι ο μη παραμετρικός ισοδύναμος του T-test για εξαρτημένα δείγματα. Η δυνατότητα προσφέρεται από την επιλογή Analyze > Nonparametric Tests > Related Samples.

			Το κριτήριο Wilcoxon είναι ένας βαθμολογικός έλεγχος που εξετάζει την υπόθεση ότι το άθροισμα των βαθμών των αρνητικών διαφορών είναι ίσο με το άθροισμα των βαθμών των θετικών διαφορών που προκύπτουν από τη διαφορά των τιμών των δύο δειγμάτων.

			Η ελεγχοσυνάρτηση βασίζεται στη σχέση:
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			Εξίσωση 6.16

			Όπου:

			Τ+: το άθροισμα των βαθμών των θετικών διαφορών και

			Τ-: το άθροισμα των βαθμών των αρνητικών διαφορών μεταξύ των δύο ομάδων (πριν και μετά).
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			Εικόνα 6.16: To menu Nonparametric Tests: Two or More Related-Samples
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			Εικόνα 6.17: To menu Nonparametric Tests: Two or More Independent-Samples > Fields

			Στο πεδίο Test Fields ορίζουμε τις δύο μεταβλητές που αντιπροσωπεύουν τις μετρήσεις πριν και μετά το γεγονός.

			Στη συνέχεια στην ενότητα Settings επιλέγουμε το κριτήριο σύγκρισης των δύο ομάδων Wilcoxon matched-pair signed-rank (2 samples).
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			Εικόνα 6.18: To menu Nonparametric Tests: Two or More Independent-Samples > Settings

			Η διαδικασία ολοκληρώνεται με το πλήκτρο RUN όπου και λαμβάνουμε:
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			Εικόνα 6.19: Περιγραφικά μέτρα των βαθμών των θέσεων των παρατηρήσεων
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			Εικόνα 6.20: Αποτελέσματα του ελέγχου Wilcoxon

			Το SPSS μας δίνει το μέσο της ιεράρχησης ή το μέσο της κατάταξης (Mean Rank) και όχι περιγραφικά μέτρα για τις δύο μεταβλητές ή για τις μετρήσεις της ίδιας μεταβλητής. Στις περιπτώσεις που η κανονικότητα παραβιάζεται συνηθίζουμε να δίνουμε τη διάμεσο ή το εύρος. Καθώς αυτά τα περιγραφικά δεν παρέχονται αυτόματα από το SPSS τα εξάγουμε από την εντολή Means, βλ. ομώνυμη ενότητα.

			Ο δεύτερος πίνακας παρουσιάζει τα αποτελέσματα του ελέγχου απ’ όπου διαπιστώνουμε ότι σε επίπεδο 5% (p-value < 0,001) απορρίπτεται η Η0, συνεπώς η διαφορά (μείωση) είναι στατιστικά σημαντική και το γεγονός (δίαιτα) συνετέλεσε στη μείωση της μέσης τιμής (σε μείωση του βάρους).

			6.6 Means

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Compare Means > Means, με σκοπό την εξαγωγή περιγραφικών μέτρων σε ομάδες δεδομένων.

			 Στο πεδίο Dependent List εισάγουμε τη συνεχή μεταβλητή για την οποία θα εξαχθούν τα περιγραφικά μέτρα και στο πεδίο Independent List την κατηγορική μεταβλητή ομαδοποίησης των δεδομένων.

			[image: 6]

			Εικόνα 6.21: To menu Means

			Από το πλήκτρο Options επιλέγουμε τα στατιστικά που επιθυμούμε να εξαχθούν εισάγοντάς τα στο πεδίο Cell Statistics.
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			Εικόνα 6.22: To menu Means > Options

			Η διαδικασία ολοκληρώνεται με το πλήκτρο OK όπου και λαμβάνουμε:
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			Εικόνα 6.23: Αποτελέσματα εντολής Means

			Ο πίνακας παρουσιάζει τα περιγραφικά μέτρα τόσο για την κάθε ομάδα, όσο και για το σύνολο του δείγματος.

			6.7 One-Way ANOVA για ανεξάρτητα δείγματα

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Compare Means > One- Way ANOVA, με σκοπό τον έλεγχο συσχέτισης μεταξύ μιας συνεχούς μεταβλητής με μια κατηγορική η οποία έχει περισσότερες από δύο κατηγορίες. Ανάλογα με τις κατηγορίες- «επίπεδα» της κατηγορικής μεταβλητής η μέθοδος προσπαθεί να εξηγήσει τη μεταβλητότητα που οφείλεται στα διαφορετικά επίπεδα της συνεχούς μεταβλητής. Ακόμα ερευνάται η μεταβλητότητα που υπάρχει εντός της κάθε κατηγορίας «επίπεδο» αποδίδοντας σε αυτήν το ανάλογο «ποσοστό».

			Υποθέσεις

			Για την εφαρμογή της μεθόδου υποθέτουμε ότι:

			
					Οι πληθυσμοί / επίπεδα από τους οποίους προέρχονται οι μετρήσεις έχουν την ίδια διασπορά:
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			Εξίσωση 6.17

			
					Οι πληθυσμοί κατανέμονται κανονικά.

					Οι μετρήσεις σε κάθε δείγμα (επίπεδο) είναι ανεξάρτητες και κατανέμονται κανονικά.

			

			Εφόσον ισχύουν οι παραπάνω υποθέσεις, αναρωτιόμαστε γιατί να μην γίνει εφαρμογή του ελέγχου T-test λαμβάνοντας ανά δύο τα ζεύγη των επιπέδων της κατηγορικής μεταβλητής, ώστε να συγκριθούν οι ομάδες που διαφέρουν μεταξύ τους. Αυτό δεν μπορεί να εφαρμοστεί, γιατί θα έπρεπε να εφαρμοστούν:
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			Εξίσωση 6.18

			Έλεγχοι για τα k ανεξάρτητα δείγματα, γιατί εάν το κάθε T-test απαιτούσε ένα επίπεδο στατιστικής σημαντικότητας α (σφάλμα Τύπου Ι), τότε το επίπεδο στατιστικής σημαντικότητας για την συνολική ανάλυση θα ήταν kα. Αυτό οδηγεί στο ότι το επίπεδο σημαντικότητας της κάθε μηδενικής υπόθεσης θα έπρεπε να περιοριστεί σε: α = 5% / k.

			Με αυτόν τον τρόπο η περιοχή απόρριψης της μηδενικής υπόθεσης περιορίζεται πολύ. Ως εκ τούτου αντί των πολλαπλών T-test εφαρμόζουμε ένα F-test.

			Ανάλυση της μεθόδου

			Η συνολική μεταβλητότητα των δεδομένων που εκφράζεται μέσω τετραγωνικών αποκλίσεων δίνεται από τη σχέση:
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			Εξίσωση 6.19

			Όπου:
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			Εξίσωση 6.20

			Η διακύμανση όλων των παρατηρήσεων γύρω από τον κοινό δειγματικό μέσο.
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			Εξίσωση 6.21

			Ο ολικός δειγματικός μέσος όπου:
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			Εξίσωση 6.22
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			Εξίσωση 6.23

			Η διακύμανση των παρατηρήσεων γύρω από τον μέσο κάθε δείγματος, δηλ. «μεταβλητότητα» μέσα στο κάθε δείγμα (within groups).
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			Εξίσωση 6.24

			Η διακύμανση των δειγματικών μέσων γύρω από τον ολικό μέσο, δηλαδή «μεταβλητότητα» μεταξύ των δειγμάτων (between groups).

			Η ανάλυση διακύμανσης ερευνά αν οι διαφορές ανάμεσα στους μέσους των διαφόρων «επιπέδων» της τυχαίας μεταβλητής Χ οφείλονται σε «τυχαίους» παράγοντες:
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			Εξίσωση 6.25: Μέτρο μεταβλητότητας στο κάθε δείγμα

			ή σε συστηματική διαφορά λόγω των διαφόρων επιπέδων της τυχαίας μεταβλητής Χ:
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			Εξίσωση 6.26: Μέτρο μεταβλητότητας μεταξύ των δειγμάτων
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			Εικόνα 6.24: One-way ANOVA Table

			Η υπόθεση που εξετάζεται είναι εάν οι μέσοι όλων των ομάδων είναι ίσοι μεταξύ τους, ή υπάρχει τουλάχιστον ένας μέσος που διαφέρει.
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			Εξίσωση 6.27

			Η ελεγχοσυνάρτηση δίνεται από τη σχέση:
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			Εξίσωση 6.28

			Όπου:

			MSSbg, η μέση μεταβλητότητα μεταξύ των ομάδων, και MSSwg, η μέση μεταβλητότητα εντός των ομάδων.

			Η υπόθεση απορρίπτεται όταν F>Fk-1,k;a. Τα αποτελέσματα του ελέγχου παρουσιάζονται στην Εικόνα 6.24.

			Έστω ότι έχουμε έναν πληθυσμό από 20 ποντίκια σε καθεστώς άγχους χωρισμένα σε 4 ισοπληθείς ομάδες, στα οποία χορηγείται ενδοφλεβίως ένα φάρμακο σε διαφορετικές δόσεις. Εξετάζουμε εάν η δοσολογία του φαρμάκου επιδρά στη μείωση των ποσοστών ταραχής.

			Στο πεδίο Dependent List εισάγουμε την/ις υπό εξέταση συνεχή/είς μεταβλητή/ές (π.χ. τη μεταβλητή «ποσοστό άγχους») και στο πεδίο Factor την κατηγορική μεταβλητή. Στο παράδειγμά μας είναι η μεταβλητή που καθορίζει σε ποια ομάδα δοσολογίας ανήκε το κάθε ποντίκι.
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			Εικόνα 6.25: To menu One-way ANOVA

			Από το πλήκτρο Options ορίζουμε την εμφάνιση πρόσθετων πληροφοριών και ελέγχων, όπως:

			
					Descriptive, για την εμφάνιση περιγραφικών μέτρων (μέση τιμή, τυπική απόκλιση, τυπικό σφάλμα, 95% Δ.Ε. του μέσου, ελάχιστη και μέγιστη παρατήρηση) της κάθε κατηγορίας.

					Fixed and Random Effects, για την εκτίμηση της επίδρασης της κατηγορικής μεταβλητής στη συνεχή μεταβλητή μέσω ενός υποδείγματος σταθερών επιδράσεων και μέσω ενός υποδείγματος τυχαίων επιδράσεων.

					Homogeneity of variance test, για τον έλεγχο της ισότητας των διασπορών μεταξύ των ομάδων. Ο έλεγχος που υπολογίζεται είναι αυτός του Levene. Εάν ο έλεγχος απορριφθεί τότε η χρήση της μεθόδου δεν συνιστάται δεδομένου ότι παραβιάζεται η υπόθεση εφαρμογής της μεθόδου. Σε αυτή την περίπτωση θα πρέπει να γίνει χρήση της μη παραμετρικής μεθόδου Kruskal-Wallis, ή των ελέγχων Brown-Forsythe και Welch.

					Means Plot, για την εμφάνιση διαγράμματος των μέσων της κάθε κατηγορίας.

					Missing Values, για τον χειρισμό των ελλειπουσών τιμών.
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			Εικόνα 6.26: To menu One-way ANOVA > Options

			Σε περίπτωση που ο έλεγχος One-way ANOVA απορριφθεί, δεν είναι σε θέση να μας δώσει ποιος ήταν ο μέσος που διέφερε σε σχέση με τους υπόλοιπους. Για να προσδιοριστούν οι μέσοι που διαφέρουν μεταξύ τους, θα πρέπει να γίνουν πολλαπλές συγκρίσεις μεταξύ των ομάδων (ανά δύο). Επειδή όπως προαναφέραμε θα πρέπει να ληφθεί υπόψη η μείωση στο επίπεδο σημαντικότητας λόγω των πολλαπλών συγκρίσεων, έχουν διαμορφωθεί ορισμένες μέθοδοι, όπως:

			
					Έλεγχοι που βασίζονται σε προσεγγίσεις pairwise multiple comparisons tests ή range tests (Tukey, Hochberg’s GT2, Gabriel, Scheffe),

					Έλεγχοι που κάνουν μόνο πολλαπλές συγκρίσεις των μέσων τιμών ανά δύο (Bonferroni, Sidak, Dunnett C, LSD-Least Significant Difference).

			

			Η πιο ευρέως διαδεδομένη είναι ο έλεγχος του Tukey.
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			Εικόνα 6.27: Οι δυνατές επιλογές για Post-Hoc Multiple Comparisons

			Tukey Test

			Είναι μια διαδικασία πολλαπλών συγκρίσεων που χρησιμοποιείται κυρίως όταν τα μεγέθη των k δειγμάτων είναι ίσα, και εξετάζει την υπόθεση:

			[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\6.29.wmf]

			Εξίσωση 6.29

			Ο έλεγχος βασίζεται στον υπολογισμό της στατιστικής συνάρτησης Q η οποία ορίζεται ως:
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			Εξίσωση 6.30

			Όπου:
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			Ο μέγιστος δειγματικός μέσος
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			Ο ελάχιστος δειγματικός μέσος
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			Το πλήθος των μετρήσεων σε κάθε δείγμα.

			Όλοι οι μέσοι συγκρίνονται ανά δύο και απορρίπτουμε τη μηδενική υπόθεση όταν Q > Qα, όπου η στατιστική συνάρτηση Q ~ κατανομή (k, dfwg).

			Σημείωση

			Αν τα δείγματα έχουν διαφορετικό μέγεθος, τότε το Np/s,υπολογίζεται από τον αρμονικό μέσο των μεγεθών των δειγμάτων:
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			Εξίσωση 6.31

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε:
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			Εικόνα 6.28: Περιγραφικά μέτρα των ομάδων
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			Εικόνα 6.29: ANOVA Table με τα αποτελέσματα του F-test

			Στα αποτελέσματα λαμβάνουμε τον πίνακα με τα περιγραφικά μέτρα των μέσων των ομάδων, και τον πίνακα ANOVA με τα αποτελέσματα του F-test, από τον οποίο διαπιστώνουμε ότι η μηδενική υπόθεση απορρίπτεται (p-value = 0,005), συνεπώς υπάρχει τουλάχιστον ένας μέσος που διαφέρει σημαντικά από τους υπόλοιπους. Αναφορικά με το παράδειγμά μας μπορεί να θεωρηθεί ότι υπάρχουν σημαντικές διαφορές στους μέσους των τεσσάρων ομάδων, επομένως η αύξηση της δοσολογίας που χορηγήθηκε στα ποντίκια μειώνει τα επίπεδα στρες.

			Για το λόγο αυτό θα πρέπει να ληφθεί υπόψη και ο πίνακας πολλαπλών συγκρίσεων μέσω κάποιας από τις μεθόδους της ενότητας Post Hoc Multiple Comparisons.
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			Εικόνα 6.30: Γραφική απεικόνιση των μέσων τιμών των ομάδων
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			Εικόνα 6.31: Πίνακας Πολλαπλών συγκρίσεων μέσω της μεθόδου Tukey

			Ο πίνακας Multiple Comparisons παρουσιάζει τις διαφορές των μέσων τιμών μεταξύ των ομάδων ανά δύο, σημειώνοντας με αστερίσκο τις στατιστικά σημαντικές διαφορές.

			Από την εφαρμογή του Tukey test έχουμε:
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			Εξίσωση 6.32

			Qα=٠.٠٥ = 4,05 και Qα=٠.٠١ = 5,2 ποσοστιαία σημεία της Q.

			Οπότε η διαφορά των μέσων των ομάδων 1 & 2:
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			Εξίσωση 6.33

			Άρα η H0 δεν απορρίπτεται.

			Η διαφορά των μέσων των ομάδων 1 & 3:
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			Εξίσωση 6.34

			Άρα η H0 απορρίπτεται κ.ο.κ. Επιπρόσθετα στα αποτελέσματα εμφανίζεται ο ακόλουθος πίνακας Homogeneous Subsets στον οποίο παρουσιάζονται τα ομοιογενή υποσύνολα που δύναται να δημιουργηθούν από τις υφιστάμενες ομάδες. Στο παράδειγμά μας διαπιστώνουμε ότι μπορούν να δημιουργηθούν δύο υποσύνολα στα οποία είτε το πρώτο θα περιέχει τις ομάδες 4,3 και 2 και το δεύτερο την ομάδα 1 μόνη της, είτε το πρώτο θα περιέχει τις ομάδες 4 και 3 και το δεύτερο τις ομάδες 2 και 1.
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			Εικόνα 6.32: Έλεγχος ομοιογένειας των ομάδων με σκοπό την ομαδοποίηση τους

			6.8 Kruskall-Wallis H

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Non parametric Tests > Legacy Dialogs > k Independent Samples, με σκοπό τον έλεγχο συσχέτισης μεταξύ μιας συνεχούς μεταβλητής με μια κατηγορική η οποία έχει περισσότερες από δύο κατηγορίες με ίσο ή διαφορετικό πλήθος ατόμων ανά κατηγορία. Η μέθοδος χρησιμοποιείται όταν δεν ισχύουν οι υποθέσεις εφαρμογής της One-Way ANOVA, δηλ. όταν οι κατανομές δεν είναι κανονικές και οι διασπορές δεν είναι ίσες, ή όταν η μεταβλητή είναι διατεταγμένη.

			Η μέθοδος βασίζεται στην ίδια λογική των ελέγχων εξετάζοντας αν ένα σύνολο k ανεξάρτητων ομάδων προέρχονται από τον ίδιο πληθυσμό. Σε αντίθεση με τον έλεγχο One-way ANOVA που εξετάζει την ισότητα των μέσων, εδώ χρησιμοποιείται το άθροισμα των βαθμών των θέσεων των παρατηρήσεων. Η μέθοδος είναι μια επέκταση του κριτηρίου Mann-Whitney U για k ανεξάρτητες ομάδες. Κατ’ επέκταση η υπόθεση που εξετάζεται είναι αν οι ομάδες έχουν ίσο μέσο βαθμών (δηλ. τυχαία διάταξη) ή κάποια ομάδα διαφοροποιεί τη διάταξη των παρατηρήσεων.

			Για την εφαρμογή της μεθόδου οι παρατηρήσεις διατάσσονται κατά αύξουσα σειρά και σε κάθε παρατήρηση προσδιορίζεται η σχετική της θέση (rank). Στη συνέχεια υπολογίζονται οι ποσότητες:
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			Εξίσωση 6.35

			Όπου:
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			Εξίσωση 6.36

			Το άθροισμα των θέσεων της κάθε j-ομάδας, το οποίο είναι το αντίστοιχο «άθροισμα τετραγώνων των θέσεων μεταξύ των ομάδων»:
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			Εξίσωση 6.37

			Το «συνολικό άθροισμα τετραγώνων των θέσεων των παρατηρήσεων όλων των ομάδων».

			Η ελεγχοσυνάρτηση προκύπτει από τη σχέση:

			[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\6.38.wmf]

			Εξίσωση 6.38

			Η υπόθεση απορρίπτεται όταν: H > X2k-1;a
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			Εικόνα 6.33: Το menu εκτέλεσης Κruskal-Wallis H

			Στο πεδίο Test Variable List εισάγουμε την/ις υπό εξέταση συνεχη/είς μεταβλητή/ές (π.χ. την μεταβλητή «ποσοστό άγχους») και στο πεδίο Grouping Variable την κατηγορική μεταβλητή. Στη συνέχεια από το πλήκτρο Define Range ορίζουμε το εύρος των κωδικών των επιπέδων της κατηγορικής μεταβλητής (ελάχιστο και μέγιστο κωδικό) που θα χρησιμοποιηθούν στην ανάλυσή μας.

			Σ’ αυτή την ενότητα παρέχονται επιπρόσθετα οι έλεγχοι Median και Jonckheere-Terpstra:

			
					Median Test, η οποία είναι μια μη παραμετρική διαδικασία που βασίζεται στον έλεγχο της συνάφειας μεταξύ των ομάδων και του πλήθους των παρατηρήσεων που είναι μικρότερες ή μεγαλύτερες από τη διάμεσο.

					Jonckheere-Terpstra που χρησιμοποιείται αντί του Κruskal-Wallis όταν μεταξύ των επιπέδων των ομάδων υπάρχει σχετική διάταξη, ώστε να εξεταστεί το ενδεχόμενο της ύπαρξης γραμμικής σχέσης, μεταξύ της διάταξης και της εξαρτημένης μεταβλητής.

			

			Από το πλήκτρο Options επιλέγουμε την εμφάνιση των περιγραφικών μέτρων (Descriptive) και των τεταρτημορίων (Quartiles) για την εξαρτημένη μεταβλητή.
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			Εικόνα 6.34: Το menu εκτέλεσης Κruska -Wallis H > Options

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε:
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			Εικόνα 6.35: Περιγραφικά μέτρα των ομάδων
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			Εικόνα 6.36: Οι μέσοι των βαθμών των ομάδων. Ο έλεγχος εξετάζει την ισότητά τους
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			Εικόνα 6.37: Αποτελέσματα του ελέγχου Kruskal-Wallis

			Από τα αποτελέσματα του ελέγχου Κruskal-Wallis διαπιστώνουμε ότι η υπόθεση απορρίπτεται (p-value = 0,026).

			Σε περίπτωση που ο έλεγχος Kruskall-Wallis απορριφθεί, δεν είναι σε θέση να μας δώσει ποιος ήταν ο μέσος που διέφερε σε σχέση με τους υπόλοιπους. Για να προσδιοριστούν οι μέσοι που διαφέρουν μεταξύ τους, θα πρέπει να γίνουν πολλαπλές συγκρίσεις μεταξύ των ομάδων (ανά δύο).

			Σε αυτή την περίπτωση ο ερευνητής μπορεί χειροκίνητα να προβεί σε επί μέρους εφαρμογή του Mann-Whitney U test για όλους τους ανά δύο πιθανούς συνδυασμούς, διορθώνοντας το επίπεδο σημαντικότητας διαιρώντας το με το πλήθος των συγκρίσεων (μέθοδος Bonferroni).

			6.9 Two-Way ANOVA for Independent Samples

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > General Linear Model > Univariate, με σκοπό τον έλεγχο συσχέτισης μεταξύ μιας συνεχούς μεταβλητής με δύο κατηγορικές μεταβλητές. Σε περίπτωση που θέλουμε να εξετάσουμε τη συσχέτιση με περισσότερες από δύο κατηγορικές, τότε εφαρμόζεται μια three way ANOVA, κ.ο.κ.

			Ανάλυση της μεθόδου

			Στην ανάλυση διακύμανσης ανά δύο παράγοντες έχουμε δύο κατηγορικές μεταβλητές X1 (παράγοντας Α) και X2 ( παράγοντας Β), και μια εξαρτημένη ποσοτική μεταβλητή Y. Έτσι, οι υποθέσεις που ελέγχουμε είναι εάν:

			
					Τα διαφορετικά επίπεδα τιμών της X1 επηρεάζουν τις τιμές της Y.

					Τα διαφορετικά επίπεδα τιμών της X2 επηρεάζουν τις τιμές της Y.

					Υπάρχει αλληλεπίδραση (interaction) μεταξύ των μεταβλητών X1 και X2.

			

			Έλλειψη αλληλεπίδρασης σημαίνει ότι η επίδραση της μεταβλητής X1 στην Y είναι ίδια για κάθε επίπεδο της μεταβλητής X2 και αντίστροφα.

			Για να εξεταστούν οι παραπάνω υποθέσεις, θα καταλήξουμε σε τρια F-test.

			Υποθέσεις

			Έστω ότι η μεταβλητή X1 έχει r επίπεδα και η μεταβλητή X2 έχει c επίπεδα. Οι παρατηρήσεις συμβολίζονται ως Yijk.

			Όπου:

			i = 1, …, r: τα επίπεδα της μεταβλητής X1,

			j = 1, …, c: τα επίπεδα της μεταβλητής X2,

			k = 1, …, NT: το σύνολο των μετρήσεων.

			Οι παρατηρήσεις εκφράζονται από τη σχέση:
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			Εξίσωση 6.39

			Όπου:
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			Εξίσωση 6.40

			Για την εφαρμογή της ανάλυσης ως προς δύο παράγοντες θα πρέπει να ισχύουν:

			
					Οι πληθυσμοί από τους οποίους προέρχονται οι παρατηρήσεις να κατανέμονται κανονικά:
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			Εξίσωση 6.41

			
					Οι πληθυσμοί από τους οποίους προέρχονται οι παρατηρήσεις να έχουν ίσες διασπορές:

			

			[image: Z:\_ΥΛΙΚΟ ΔΟΥΛΕΙΑΣ\Κάλλιπος Χαλικιάς\Equations\6.42.png]

			Εξίσωση 6.42

			Παράδειγμα

			Θέλουμε να εξετάσουμε την επίδραση και την αλληλεπίδραση δύο τύπων ναρκωτικών Α και Β, στη φυσιολογική διέγερση. Έχουμε 40 εργαστηριακά ποντίκια που χωρίζονται σε τέσσερις ομάδες των δέκα ατόμων. Κάθε ομάδα έλαβε μια συγκεκριμένη δοσοληψία από τα ναρκωτικά Α και Β (0 μονάδες και 1 μονάδα). Η τυχαία μεταβλητή Y είναι η φυσιολογική διέγερση.

			Στόχος μας είναι να κατασκευάσουμε τον ANOVA-Τable οπότε εργαζόμαστε ως εξής:

			1ον: Υπολογίζουμε τους μέσους όρους των ομάδων.

			2ον: Υπολογίζουμε τα τετραγωνικά αθροίσματα για την κάθε ομάδα, όπου:
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			Εξισώσεις 6.43

			Δηλαδή η μεταβλητότητα μεταξύ των ομάδων αναλύεται στη μεταβλητότητα μεταξύ των επιπέδων r, των επιπέδων c και στην αλληλεπίδραση.

			3ον: Υπολογίζουμε τους βαθμούς ελευθερίας:
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			Εξισώσεις 6.44

			4ον: Υπολογίζουμε τα:
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			Εξισώσεις 6.45

			5ον: Υπολογίζονται τα F-tests:

			
					F-test για τον έλεγχο της επίδρασης των επιπέδων της X1 στις τιμές της Y. Η υπόθεση που εξετάζεται είναι:

			

			H0: Δεν υπάρχει στατιστικά σημαντική διαφορά στους μέσους μεταξύ των δύο γραμμών.

			H1: Υπάρχει στατιστικά σημαντική διαφορά στους μέσους μεταξύ των δύο γραμμών.
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			Εξίσωση 6.46

			Απορρίπτουμε την H0 όταν:
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			Εξίσωση 6.47

			
					F-test για τον έλεγχο της επίδρασης των επιπέδων της X2 στις τιμές της Υ. Η υπόθεση που εξετάζεται είναι:H0: Δεν υπάρχει στατιστικά σημαντική διαφορά στους μέσους μεταξύ των δύο στηλών.
H1: Υπάρχει στατιστικά σημαντική διαφορά στους μέσους μεταξύ των δύο στηλών.
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Εξίσωση 6.48
Απορρίπτουμε την H0 όταν:
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Εξίσωση 6.49


					F-test για τον έλεγχο ύπαρξης αλληλεπίδρασης των επιπέδων της X1 στις τιμές της X2 Η υπόθεση που εξετάζεται είναι:

			

			H0: Δεν υπάρχει αλληλεπίδραση μεταξύ γραμμών και στηλών.

			H1: Υπάρχει αλληλεπίδραση μεταξύ γραμμών και στηλών.
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			Εξίσωση 6.50

			Απορρίπτουμε την H0 όταν:
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			Εξίσωση 6.51

			Από την επιλογή Analyze > General Linear Model > Univariate ορίζουμε στο πεδίο Dependent Variable την εξαρτημένη μεταβλητή και στο πεδίο Fixed Factor(s) τις κατηγορικές μεταβλητές.
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			Εικόνα 6.38: Το menu Univariate

			Από το πλήκτρο Save ο χρήστης έχει τη δυνατότητα να αποθηκεύσει διάφορες τιμές που προβλέπονται από το μοντέλο, σφάλματα (residuals) ή συναφή μέτρα αξιολόγησης της ανάλυσης, τα οποία αποθηκεύονται ως νέες μεταβλητές στο φύλλο δεδομένων. Αναλυτικότερα:

			
					Predicted Values: Περιέχει επιλογές με σκοπό τον υπολογισμό τιμών που προκύπτουν από προβλέψεις του μοντέλου.

					Unstandardized: Η τιμή πρόβλεψης για την εξαρτημένη μεταβλητή.

					Weighted: Οι σταθμισμένες μη τυποποιημένες προβλεπόμενες τιμές. Η δυνατότητα προσφέρεται μόνο αν η μεταβλητή έχει προηγουμένως δηλωθεί ως σταθμισμένη.

					Standard error: Μια εκτίμηση της τυπικής απόκλισης του μέσου όρου της εξαρτημένης μεταβλητής για τις περιπτώσεις που έχει τις ίδιες τιμές των ανεξάρτητων μεταβλητών.

					Diagnostics: Μας παρέχει μέτρα για τον εντοπισμό ασυνήθιστων περιπτώσεων. Π.χ. ακραίων παρατηρήσεων ή παρατηρήσεων επίδρασης στο μοντέλο.

					Cook’s distance: Είναι ένα μέτρο για τον εντοπισμό ακραίων παρατηρήσεων.

					Leverage values: Είναι ένα μέτρο για τον εντοπισμό παρατηρήσεων με μεγάλη επίδραση (μόχλευση) στο μοντέλο.
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			Εικόνα 6.39: To menu Univariate > Save

			Residuals: Περιέχει τις επιλογές αποθήκευσης διαφόρων μορφών σφαλμάτων του μοντέλου, όπου σφάλμα νοείται ως η διαφορά μεταξύ της προβλεπόμενης τιμής και της πραγματικής παρατήρησης.

			Unstandardized: Μη τυποποιημένα κατάλοιπα.

			Weighted: Σταθμισμένα μη τυποποιημένα σφάλματα. Η δυνατότητα προσφέρεται μόνο αν η μεταβλητή έχει προηγουμένως δηλωθεί ως σταθμισμένη.

			Standardized: Τυποποιημένα σφάλματα. Εάν ισχύει η υπόθεση της κανονικότητας, τότε τα τυποποιημένα σφάλματα έχουν μέση τιμή μηδέν και τυπική απόκλιση 1.

			Studentized: Τα σφάλματα διαιρούνται με την εκτιμήτρια της τυπικής απόκλισης η οποία διαφέρει ανάλογα με την κάθε περίσταση και εξαρτάται από την απόσταση της κάθε παρατηρούμενης τιμής των ανεξάρτητων μεταβλητών από τη μέση τιμή της ανεξάρτητης μεταβλητής.

			Deleted: Τα σφάλματα που προκύπτουν όταν η συγκεκριμένη παρατήρηση εξαιρείται από τον υπολογισμό του συντελεστή παλινδρόμησης. Είναι η διαφορά μεταξύ της τιμής της εξαρτημένης μεταβλητής και της προσαρμοσμένης προβλεπόμενης τιμής.

			Coefficient Statistics: Δημιουργεί έναν πίνακα διακυμάνσεων - συνδιακυμάνσεων των εκτιμώμενων παραμέτρων του μοντέλου είτε σε μια νέα βάση δεδομένων στην τρέχουσα ενότητα είτε σε νέο εξωτερικό αρχείο. Επίσης για κάθε εξαρτημένη μεταβλητή, θα υπάρξει μια σειρά εκτιμώμενων παραμέτρων, μια σειρά στατιστικά σημαντικών τιμών από ελέγχους T-test των εκτιμήσεων των συντελεστών του μοντέλου και μια σειρά από τους βαθμούς ελευθερίας των σφαλμάτων. Για ένα πολυπαραγοντικό μοντέλο υπάρχουν παρόμοιες σειρές για κάθε εξαρτημένη μεταβλητή. Αυτό το αρχείο δύναται να χρησιμοποιηθεί από άλλες διαδικασίες που έχουν τη δυνατότητα να διαβάζουν αρχεία πινάκων (μήτρας).
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			Εικόνα 6.40: Το menu Univariate > Options

			Από το πλήκτρο Options λαμβάνουμε (προαιρετικά) διάφορα στατιστικά στοιχεία τα οποία υπολογίζονται βάσει ενός μοντέλου σταθερών επιδράσεων (fixed effects). Αναλυτικά:

			
					Estimated Marginal Means: Σ’ αυτή την ενότητα επιλέγουμε τους παράγοντες και τις αλληλεπιδράσεις για τους οποίους θα υπολογιστούν οι εκτιμώμενοι μέσοι των πληθυσμών των κατηγοριών των παραγόντων. Οι μέσοι αυτοί είναι προσαρμοσμένοι σε σχέση με τις συμμεταβλητές, αν υπάρχουν. Οι αλληλεπιδράσεις είναι διαθέσιμες μόνο αν έχουν οριστεί αλληλεπιδράσεις στο προσαρμοσμένο (custom) μοντέλο.

					Compare main effects: Παρέχει μη διορθωμένες κατά ζεύγη συγκρίσεις μεταξύ των εκτιμώμενων μέσων για κάθε κύρια επίδραση του μοντέλου, τόσο για συγκρίσεις μεταξύ των ομάδων όσο και εντός των ομάδων. Η δυνατότητα προσφέρεται μόνο αν έχουν δηλωθεί κύριες επιδράσεις στην ενότητα Display Means For.

					Confidence interval adjustment: Επιλέγουμε τη μέθοδο προσαρμογής του επιπέδου στατιστικής σημαντικότητας για τις πολλαπλές συγκρίσεις. Μπορούμε να επιλέξουμε μεταξύ των μεθόδων LSD, Bonferroni, ή Sidak. Η δυνατότητα προσφέρεται μόνο αν έχει επιλεγεί η παράμετρος Compare main effects.

			

			 Η επιλογή Display Εμφανίζει πίνακες στατιστικών στοιχείων, όπως:

			
					Descriptive statistics: Παρέχει έναν πίνακα με περιγραφικά μέτρα όπως μέσο, τυπική απόκλιση και μέγεθος δείγματος για όλες τις εξαρτημένες μεταβλητές.

					Estimates of effect size: Παρέχει την εκτιμήτρια η2 για κάθε επίδραση και κάθε εκτιμώμενη παράμετρο. Η εκτιμήτρια η2 περιγράφει την αναλογία της συνολικής μεταβλητότητας που αναλογεί σε κάθε παράγοντα.

					Observed power: Παρέχει την ισχύ του ελέγχου όταν η εναλλακτική υπόθεση βασίζεται στην παρατηρούμενη τιμή.

					Parameter estimates: Παρέχει τον πίνακα με τους εκτιμώμενους συντελεστές του μοντέλου, τις τυπικές τους αποκλίσεις, τα t tests, τα διαστήματα εμπιστοσύνης και την ισχύ (p-values) των ελέγχων.

					Homogeneity tests: Παρέχει τον έλεγχο του Levene για τον έλεγχο της ομοιογένειας (ισότητας) της διασποράς της εξαρτημένης μεταβλητής σε όλα τα επίπεδα συνδυασμών των ομάδων που προκύπτουν από τις κατηγορικές μεταβλητές. Επίσης, περιλαμβάνονται οι έλεγχοι Box’s M test της ομοιογένειας του πίνακα συνδιασποράς της εξαρτημένης μεταβλητής.

					Spread-versus-level: Χρησιμοποιείται για τον έλεγχο των υποθέσεων του μοντέλου, και εμφανίζεται όταν δεν υπάρχουν παράγοντες.

					Residual plots: Χρησιμοποιείται για τον έλεγχο των υποθέσεων του μοντέλου, π.χ. με τη δημιουργία ενός γραφήματος διασποράς των προβλεπόμενων παρατηρήσεων σε σχέση με τα τυποποιημένα σφάλματα της εξαρτημένης μεταβλητής, ώστε να εξεταστούν οι υποθέσεις κανονικότητας, ομοσκεδαστικότητας και ανεξαρτησίας.

					Lack of fit: Για τον έλεγχο της περίπτωσης που η σχέση μεταξύ της εξαρτημένης και των ανεξάρτητων μεταβλητών μπορεί να περιγραφεί επακριβώς από το μοντέλο.

					General estimable function: Μας επιτρέπει την κατασκευή ειδικών (custom) υποθέσεων βασιζόμενες σε μετασχηματισμούς γενικών συναρτήσεων.

					Significance level: Ορίζεται το επίπεδο στατιστικής σημαντικότητας που θα χρησιμοποιείται από τις αναλύσεις (π.χ. post hoc tests, ή διαστήματα εμπιστοσύνης). Η τιμή αυτή χρησιμοποιείται επίσης για τον υπολογισμό της παρατηρούμενης ισχύος του ελέγχου (p-value).

			

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε:
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			Εικόνα 6.41: Περιγραφικά μέτρα των ομάδων
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			Εικόνα 6.42: Έλεγχος της ισότητας των διασπορών
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			Εικόνα 6.43: ANOVA Table
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			Εικόνα 6.44: Ο πίνακας των συντελεστών (b) του γραμμικού μοντέλου

			Από τον πίνακα διαπιστώνουμε ότι δεν υπάρχει αλληλεπίδραση (p-value = 0,936 > 0,005), ενώ οι δύο πρώτες υποθέσεις απορρίπτονται στα επίπεδα στατιστικής σημαντικότητας α = 0,05 και α = 0,01. Συνεπώς οι διαφορές μεταξύ των μέσων των δύο στηλών και των δύο γραμμών είναι στατιστικά σημαντικές που σημαίνει ότι 1 μονάδα του ναρκωτικού Α παράγει μεγαλύτερη διέγερση από 0 μονάδες του ναρκωτικού και παρόμοια 1 μονάδα του ναρκωτικού Β παράγει μεγαλύτερη διέγερση από 0 μονάδες του ίδιου ναρκωτικού. Οπότε 1 μονάδα από τα ναρκωτικά Α και Β γενικά αυξάνει τη σωματική διέγερση χωρίς ταυτόχρονα να υπάρχει αλληλεπίδραση μεταξύ των δύο ναρκωτικών.

			6.10 Friedman

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Non parametric Tests > Legacy Dialogs > Related Samples, με σκοπό τον έλεγχο συσχέτισης επαναλαμβανόμενων μετρήσεων μιας συνεχούς μεταβλητής. Η μέθοδος χρησιμοποιείται όταν δεν ισχύουν οι υποθέσεις εφαρμογής της Repeated Measures ANOVA, δηλ. όταν οι κατανομές δεν είναι κανονικές και οι διασπορές δεν είναι ίσες. Η μέθοδος είναι μια επέκταση του κριτηρίου sign test για k συσχετιζόμενα δείγματα.

			Για την εφαρμογή της μεθόδου οι παρατηρήσεις διατάσσονται κατά αύξουσα σειρά και σε κάθε παρατήρηση προσδιορίζεται η σχετική της θέση (rank) και στη συνέχεια υπολογίζεται το άθροισμα των σχετικών θέσεων.

			Η ελεγχοσυνάρτηση προκύπτει από τη σχέση:
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			Εξίσωση 6.52

			Όπου:
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			Εξίσωση 6.53

			Το άθροισμα των θέσεων της κάθε j -ομάδας.

			Η υπόθεση απορρίπτεται όταν:
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			Εξίσωση 6.54
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			Εικόνα 6.45: Το menu Non parametric Tests: Two or More Related Samples > Step 1 Objective
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			Εικόνα 6.46: Το menu Non parametric Tests: Two or More Related Samples > Step 2 Fields

			Στο πεδίο Test Fields εισάγουμε την ή τις επαναλαμβανόμενες μετρήσεις:
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			Εικόνα 6.47: Το menu Non parametric Tests: Two or More Related Samples > Step 3 Settings

			Στην ενότητα Settings επιλέγουμε τον έλεγχο Friedman’s Two-way ANOVA by ranks (k samples) για τη σύγκριση των κατανομών των επαναλαμβανόμενων μετρήσεων.

			Σε αυτή την ενότητα παρέχονται επιπρόσθετα οι έλεγχοι:

			
					Mc Nemar Test (2 samples): Βλ. επίσης ομώνυμη ενότητα.

					Cohran’s Q (k samples): Είναι μια μη παραμετρική διαδικασία η οποία ελέγχει κατά πόσο k δοκιμές (π.χ. θεραπείες) δίτιμων μεταβλητών έχουν ταυτόσημα αποτελέσματα. Ο έλεγχος είναι ισοδύναμος του Mc Nemar Test.

			

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε:
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			Εικόνα 6.48: Περιγραφικά μέτρα των μέσων
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			Εικόνα 6.49: Οι μέσοι των βαθμών των ομάδων
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			Εικόνα 6.50: Αποτελέσματα του ελέγχου Friedman

			Από τα αποτελέσματα του ελέγχου διαπιστώνουμε ότι η υπόθεση της ισότητας των μέσων απορρίπτεται, συνεπώς υπάρχει διαφορά μεταξύ των επαναλαμβανόμενων μετρήσεων.

			6.11 X2-test

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Descriptive Statistics > Crosstabs, με σκοπό τον έλεγχο για την ύπαρξη σχέσης μεταξύ δύο ποιοτικών μεταβλητών.

			Έχουμε ήδη αναφέρει ότι περιγραφικά οι από κοινού κατανομές συχνότητας δύο ποιοτικών μεταβλητών απεικονίζονται σε έναν πίνακα συνάφειας (contingency table) διπλής εισόδου.

			Οι υποθέσεις που εξετάζονται είναι:

			H0: Δεν υπάρχει συσχέτιση μεταξύ των μεταβλητών Α & Β, ή αλλιώς οι παρατηρηθείσες συχνότητες είναι ίσες με τις αναμενόμενες.

			H1: Υπάρχει συσχέτιση μεταξύ των μεταβλητών Α & Β, ή αλλιώς οι παρατηρηθείσες συχνότητες δεν είναι ίσες με τις αναμενόμενες.

			Η στατιστική συνάρτηση δίνεται από τη σχέση:

			[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\6.55.wmf]

			Εξίσωση 6.55

			Όπου:

			Oij: Οι παρατηρούμενες τιμές από κάθε κελί και eij: οι αναμενόμενες τιμές κάθε κελιού, οι οποίες υπολογίζονται από το πηλίκο του γινομένου του οριζόντιου και του κάθετου αθροίσματος του κάθε κελιού, προς το γενικό σύνολο.

			Υποθέσεις του ελέγχου:

			
					Όλες οι αναμενόμενες τιμές είναι μεγαλύτερες του ένα

					Περισσότερες από το 80% των αναμενώμενων τιμών ξεπερνά το 5

			

			Όταν οι υποθέσεις εφαρμογής του Χ2 τεστ δεν ισχύουν, τότε το SPSS εμφανίζει σημείωση που το αναφέρει και τότε λαμβάνουμε υπόψη το Fisher’s Εxact Τest.

			Έστω, ότι έχουμε τις μεταβλητές Φύλο και Συνήθεια Καπνίσματος και θέλουμε να εξετάσουμε την πιθανή συσχέτισή τους από τα αποτελέσματα των μετρήσεων σε μια ομάδα θεραπείας. Συνεπώς:

			Οι δύο μεταβλητές εισάγονται στα πεδία Row(s) και Column(s). Συνηθίζουμε να εισάγουμε στις γραμμές τη μεταβλητή με τις περισσότερες κατηγορίες για λόγους ομοιομορφίας του πίνακα συνάφειας που θα δημιουργηθεί.
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			Εικόνα 6.51: Το menu Crosstabs

			Από το πλήκτρο Cell αν επιθυμούμε επιλέγουμε επιπρόσθετα Expected για να εμφανιστούν οι αναμενόμενες συχνότητες. Περισσότερα για τις επιλογές του πλήκτρου Cell βλ. Παράρτημα «Crosstabs > Cell».

			Από το πλήκτρο Statistics επιλέγουμε Chi-square για να υπολογιστεί το στατιστικό κριτήριο. Περισσότερα για τις επιλογές του πλήκτρου Statistics βλ. Παράρτημα «Crosstabs > Statistics».
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			Εικόνα 6.52: Το menu Crosstabs > Cell
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			Εικόνα 6.53: Το menu Crosstabs > Statistics

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε:
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			Εικόνα 6.54: Πίνακας συνάφειας του Φύλου με την Καπνιστική Συνήθεια

			Ο πίνακας συνάφειας εμφανίζει τις παρατηρηθείσες και τις αναμενόμενες συχνότητες. Παράδειγμα, για το πρώτο κελί η αναμενόμενη τιμή δίνεται από τη σχέση (19·9) / 36.
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			Εικόνα 6.55: Αποτελέσματα του Χ2 τεστ

			Από τον πίνακα διαπιστώνουμε ότι η μηδενική υπόθεση δεν μπορεί να απορριφθεί (p-value = 0,548 > 0,05) συνεπώς δεν υπάρχει στατιστικά σημαντική συσχέτιση μεταξύ του φύλου και τις καπνιστικής συνήθειας.

			Παρακάτω παραθέτουμε μια περίπτωση δεδομένων στα οποία οι υποθέσεις εφαρμογής του Χ2 τεστ δεν ισχύουν, οπότε το SPSS εμφανίζει σχετική σημείωση που το αναφέρει, και σε αυτή την περίπτωση λαμβάνουμε υπόψη το Fisher’s Εxact Τest.
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			Εικόνα 6.56: Αποτελέσματα του Fisher Exact τεστ στο παράδειγμα Διακοπής Σχολείου με Διακοπή Θεραπευτικής Αγωγής

			Μέσω του Χ2 τεστ ελέγχουμε ανά δύο την ύπαρξη συσχετίσεων (μονοπαραγοντική ανάλυση). Ο έλεγχος αυτός είναι ένα μέτρο που μας δείχνει αν οι μεταβλητές συσχετίζονται ή όχι, δηλαδή δεν μας λέει το πόσο συσχετίζονται, παρά μόνο την ύπαρξη ή όχι κάποιας συσχέτισης.

			Λόγος Συμπληρωματικών Πιθανοτήτων

			Συνεπώς, για να εξεταστεί ο βαθμός συσχέτισης, στις περιπτώσεις 2x2 πινάκων συνάφειας, όπου ο έλεγχος προκύψει στατιστικά σημαντικός, υπολογίζουμε τα μέτρα κινδύνου π.χ. το OR (Odds Ratio).
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			Εικόνα 6.57: Εκτίμηση μέτρων του βαθμού κινδύνου, στο παράδειγμα Διακοπής Σχολείου με Διακοπή Θεραπευτικής Αγωγής

			Έστω ότι έχουμε τον ακόλουθο γενικό πίνακα, στον οποίο παρουσιάζονται οι συχνότητες ατόμων που εκτέθηκαν σε έναν παράγοντα και εμφάνισαν ή όχι μια ασθένεια. Εάν προκύψει ότι ο παράγοντας σχετίζεται με την ασθένεια θα πρέπει να διερευνηθεί ο βαθμός αυτής της συσχέτισης.
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			Εικόνα 6.58: 2x2 πίνακας συνάφειας Ασθένειας και Παράγοντα

			Το OR είναι ο λόγος των συμπληρωματικών πιθανοτήτων, δηλαδή του λόγου πιθανότητας εμφάνισης της ασθένειας στα άτομα που εκτέθηκαν στον παράγοντα, προς τον λόγο πιθανότητας εμφάνισης της ασθένειας στα άτομα που δεν εκτέθηκαν στον παράγοντα, και δίνεται από τη σχέση:
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			Εξίσωση 6.56

			Ερμηνεία

			
					Όταν OR = 1 τότε δεν υπάρχει συσχέτιση μεταξύ της ασθένειας και της έκθεσης στον παράγοντα.

					Όταν OR = α > 1 τότε η έκθεση είναι επιβαρυντική για την ασθένεια, δηλαδή η πιθανότητα εμφάνισης της ασθένειας είναι α φορές μεγαλύτερη από την πιθανότητα μη εμφάνισης της ασθένειας. Δηλαδή υπάρχει μεγαλύτερη πιθανότητα, τόσες φορές όσες είναι το OR ασθένειας αν υπάρχει έκθεση στον παράγοντα, σε σχέση με την πιθανότητα ασθένειας αν δεν υπάρχει έκθεση στον παράγοντα.

					Όταν OR = α < 1 τότε η έκθεση στον παράγοντα είναι προστατευτική, δηλαδή εάν εκτεθείς στον παράγοντα έχεις 1-α φορές λιγότερη πιθανότητα να ασθενήσεις.

			

			Στο παράδειγμα Διακοπής Σχολείου με Διακοπή Θεραπευτικής Αγωγής, έχουμε ΟR = 1,143 δηλαδή οι ασθενείς που δεν διακόπτουν τη θεραπευτική αγωγή έχουν 1,143 φορές περισσότερη πιθανότητα να μη διακόψουν το σχολείο σε σχέση με αυτούς που διέκοψαν τη θεραπευτική αγωγή.

			6.12 Mc Nemar test

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > Descriptive Statistics > Crosstabs, επιλέγοντας Mc Nemar από το πλήκτρο Statistics.

			Σκοπός είναι να εξεταστεί η συμφωνία δύο κατηγορικών μεταβλητών, όταν οι παρατηρήσεις εμφανίζουν αντιστοιχία κατά ζεύγη. Ο έλεγχος αυτός είναι ο μη παραμετρικός ισοδύναμος του T-test για εξαρτημένα δείγματα. Σ’ αυτή την περίπτωση τα δεδομένα παρουσιάζονται σε έναν πίνακα συνάφειας της μορφής:
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			Εικόνα 6.59: 2x2 Πίνακας συνάφειας κατά ζεύγη δεδομένων κατηγορικών μεταβλητών

			Η υπόθεση που εξετάζεται είναι:

			H0: Δεν υπάρχει διαφορά μεταξύ των απαντήσεων μεταβλητών Α και Β

			H1: Υπάρχει διαφορά μεταξύ των απαντήσεων μεταβλητών Α και Β

			H ελεγχοσυνάρτηση δίνεται από τη σχέση:
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			Εξίσωση 6.57

			Ελεγχοσυνάρτηση με διόρθωση κατά Yates:
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			Εξίσωση 6.58

			Η υπόθεση απορρίπτεται όταν:
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			Εξίσωση 6.59
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			Εικόνα 6.60: Το menu Crosstabs

			Από το πλήκτρο Statistics επιλέγουμε Mc Nemar για να υπολογιστεί το στατιστικό κριτήριο. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε:
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			Εικόνα 6.61: Πίνακας συνάφειας των ατόμων που κρυολόγησαν τους μήνες Σεπτέμβριο και Νοέμβριο

			Τον πίνακα συνάφειας των συχνοτήτων των παρατηρήσεων για τους συνδυασμούς των κατηγορικών μεταβλητών.
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			Εικόνα 6.62: Αποτελέσματα του ελέγχου

			Η υπόθεση που εξετάζεται είναι εάν υπάρχει διαφορά στην πιθανότητα νόσησης μεταξύ των μηνών Σεπτεμβρίου και Νοεμβρίου. Από τα αποτελέσματα του ελέγχου διαπιστώνουμε ότι η μηδενική υπόθεση απορρίπτεται (p-value = 0,041 < 0,05), συνεπώς δεν υπάρχει διαφορά στην πιθανότητα νόσησης μεταξύ των δύο μηνών.

			Σημείωση: Στην περίπτωση που τα δεδομένα έχουν γραφεί σε Wide Format, τότε θα πρέπει να σταθμιστούν μέσω της εντολής Weight Cases (βλ. ομώνυμη ενότητα).
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			Εικόνα 6.63: Στάθμιση δεδομένων που έχουν καταγραφεί σε Wide Format

			6.13 Παράρτημα: Crosstabs > Cell
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			Εικόνα 6.64: Το menu Crosstabs > Cell

			Συχνότητες (Counts)

			
					Observed: Επιλέγεται για να εμφανιστούν οι παρατηρούμενες συχνότητες των συνδυασμών των κατηγοριών της /των ποιοτικής/ών μεταβλητής/των.

					Expected: Επιλέγεται για να εμφανιστούν οι αναμενόμενες συχνότητες των συνδυασμών των κατηγοριών της /των ποιοτικής/ών μεταβλητής/των.

			

			Ποσοστά (Percentages)

			
					Row: Επιλέγεται για να εμφανιστούν οι σχετικές συχνότητες (%) ως προς τα αθροίσματα στις γραμμές του πίνακα.

					Column: Επιλέγεται για να εμφανιστούν οι σχετικές συχνότητες (%) ως προς τα αθροίσματα στις στήλες του πίνακα.

					Total: Επιλέγεται για να εμφανιστούν οι σχετικές συχνότητες (%) ως προς το σύνολο των παρατηρήσεων.

			

			Υπόλοιπα (Residuals)

			
					Unstandardized: Επιλέγεται για να εμφανιστούν τα μη τυποποιημένα υπόλοιπα από τη διαφορά παρατηρούμενων και αναμενόμενων συχνοτήτων.

					Standardized: Επιλέγεται για να εμφανιστούν τα τυποποιημένα υπόλοιπα από τη διαφορά παρατηρούμενων και αναμενόμενων συχνοτήτων.

					Adjusted standardized: Επιλέγεται για να εμφανιστούν τα αναπροσαρμοσμένα υπόλοιπα. Ισχύει ότι με τη μηδενική υπόθεση ότι οι 2 μεταβλητές είναι ανεξάρτητες, τα αναπροσαρμοσμένα υπόλοιπα θα ακολουθούν την τυπική κανονική κατανομή, δηλαδή έχουν μέση τιμή 0 και τυπική απόκλιση 1. Έτσι, ένα προσαρμοσμένο υπόλοιπο που είναι πάνω από 1,96 (κατά συνθήκη χρησιμοποιείται 2,0) δείχνει ότι ο αριθμός των παρατηρήσεων στο εν λόγω κελί είναι σημαντικά μεγαλύτερος από ό,τι θα αναμενόταν εάν η μηδενική υπόθεση ήταν αληθής, με επίπεδο σημαντικότητας 0,05. Ένα αναπροσαρμοσμένο υπόλοιπο μικρότερο από -2,0 υποδεικνύει ότι ο αριθμός των παρατηρήσεων στο εν λόγω κελί είναι σημαντικά μικρότερος από ό, τι θα αναμενόταν εάν η μηδενική υπόθεση ήταν αληθής. Έτσι, ανάλογα με το πρόσημο του αναπροσαρμοσμένου υπολοίπου, διαπιστώνουμε αν σε κάθε κελί υπάρχουν λιγότερες ή περισσότερες παρατηρήσεις από ό,τι θα περίμενε κανείς αν οι δύο μεταβλητές ήταν ανεξάρτητες. Αν ο πίνακας συνάφειας είναι 2x2, τότε όλα τα προσαρμοσμένα σφάλματα θα έχουν την ίδια απόλυτη τιμή, με ακριβώς 2 από αυτά να είναι αρνητικά.

					Noninteger Weights: Συνήθως κάθε κελί περιέχει ακέραιους αριθμούς, δεδομένου ότι αποτυπώνουν τις συχνότητες εμφάνισης. Ωστόσο, στις περιπτώσεις που τα δεδομένα σταθμίζονται από μεταβλητή με βαρύτητα κλασματικών τιμών (π.χ. 1,25), τότε επίσης ενδέχεται ο αριθμός που θα προκύψει σε κάθε κελί να είναι κλασματικός. Σε αυτές τις περιπτώσεις, υπάρχουν επιλογές με σκοπό την περικοπή ή στρογγυλοποίηση πριν ή μετά τον υπολογισμό των συχνοτήτων σε κάθε κελί.

			

			Οι επιλογές που παρέχονται είναι:

			
					Round Cell Counts: Επιλέγεται έτσι ώστε οι σταθμισμένες συχνότητες των κελιών να χρησιμοποιηθούν όπως είναι, αλλά οι αθροιστικές σταθμισμένες τιμές στρογγυλοποιούνται πριν από τον υπολογισμό των στατιστικών μέτρων.

					Truncate Cell Counts: Επιλέγεται έτσι ώστε οι σταθμισμένες συχνότητες των κελιών να χρησιμοποιηθούν όπως είναι, αλλά οι αθροιστικές σταθμισμένες τιμές να περικοπούν πριν από τον υπολογισμό των στατιστικών μέτρων. Σ’ αυτή την περίπτωση δεν γίνεται στρογγυλοποίηση στις τιμές αλλά αποκοπή από ένα σημείο και μετά. Για παράδειγμα, οι αριθμοί 1,4142 και 1,4987 περικόπτονται και οι δύο στον αριθμό 1,4.

					Round Case Weights: Επιλέγεται έτσι ώστε κάθε στάθμιση να στρογγυλοποιείται πριν τη χρήση της.

					Truncate Case Weights: Επιλέγεται έτσι ώστε κάθε στάθμιση να περικόπτεται πριν τη χρήση της.

					No adjustments: Επιλέγεται έτσι ώστε να μην απαιτούνται προσαρμογές. Οι σταθμίσεις χρησιμοποιούνται όπως είναι, το ίδιο και οι κλασματικές συχνότητες των κελιών. Ωστόσο, όταν πρέπει να υπολογιστούν ακριβή στατιστικά μέτρα (τα οποία είναι διαθέσιμα μόνο μέσω της επιλογής Exact tests), τότε οι αθροιστικές σταθμίσεις των κελιών είτε θα στρογγυλοποιηθούν είτε θα περικοπούν πριν τη χρήση τους στον υπολογισμό των στατιστικών μέτρων.

			

			6.14 Παράρτημα: Crosstabs > Statistics

			Από το πλήκτρο Statistics γίνεται η επιλογή των ελέγχων υποθέσεων και δεικτών συνάφειας μεταξύ των κατηγορικών μεταβλητών.
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			Εικόνα 6.65: Το menu Crosstabs > Statistics

			
					Chi-square: Επιλέγεται για τον υπολογισμό των ελέγχων Pearson Χ2 τεστ, likelihood-ratio Χ2 τεστ, Fisher Χ2 exact test, και Χ2 τεστ κατά Yates (διόρθωση συνέχειας) σε πίνακες 2x2. Το Fisher Χ2 exact test υπολογίζεται για πίνακες 2x2 όταν δεν ισχύουν οι υποθέσεις του Χ2 test, δηλ. όταν υπάρχει αναμενόμενη τιμή μικρότερη του ένα, ή όταν περισσότερες από το 80% των αναμενόμενων είναι μικρότερες του 5. Για πίνακες ανεξαρτήτων πλήθους γραμμών και στηλών υπολογίζονται τα Pearson Χ2 τεστ και likelihood-ratio Χ2 τεστ, ενώ όταν και οι δύο μεταβλητές είναι ποσοτικές τότε προσφέρεται και ο έλεγχος γραμμικής τάσης (the linear-by-linear association test).

					Correlations: Επιλέγεται για τον υπολογισμό του πίνακα συσχετίσεων, για πίνακες στους οποίους οι γραμμές και οι στήλες περιέχουν διατεταγμένες τιμές. Οι συσχετίσεις αποδίδονται από τον συντελεστή συσχέτισης του Spearman, r (μόνο για αριθμητικά δεδομένα). Περισσότερα για τον συντελεστή συσχέτισης r του Spearman βλ. παράγραφο Correlations.

					Nominal: Περιέχει επιλογές με σκοπό τον υπολογισμό στατιστικών μέτρων συνάφειας για ονομαστικά δεδομένα (κατηγορικά). Σε αυτή την υποενότητα μπορούμε να επιλέξουμε:

					Contingency coefficient: Ο συντελεστής συνάφειας είναι ένα μέτρο της σύνδεσης συσχέτισης των μεταβλητών. Οι τιμές του κυμαίνονται μεταξύ 0 και 1, με τιμή 0 να μην υποδεικνύει συσχέτιση μεταξύ των γραμμών και των στηλών (δηλ. συσχέτισης των μεταβλητών) και τιμές κοντά στο 1 να υποδεικνύουν υψηλό βαθμό συσχέτισης μεταξύ των μεταβλητών. Η μέγιστη δυνατή τιμή εξαρτάται από τον αριθμό των σειρών και των στηλών σε έναν πίνακα.

					Phi and Cramer’s V: O συντελεστής συνάφειας φ (Yule, 1912) είναι ένα μέτρο που βασίζεται στο Χ2 του Pearson και προκύπτει από τη ρίζα του πηλίκου του Χ2 με το μέγεθος δείγματος.
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			Εξίσωση 6.60

			Στη βιβλιογραφία ο συντελεστής αναφέρεται και ως συντελεστής μέσης τετραγωνικής συνάφειας του Pearson (Pearson’s coefficient of mean square contigency). Για πίνακες 2x2 ο συντελεστής φ λαμβάνει τιμές στο διάστημα -1, 1 χωρίς ωστόσο αυτό να είναι απόλυτο.

			Ο συντελεστής V ( Crammer, 1946) είναι μια επέκταση του συντελεστή φ για IxJ πίνακες συνάφειας με I, J > 2 και προκύπτει από τη σχέση:
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			Εξίσωση 6.61

			Όπου:
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			Εξίσωση 6.62

			Εκφράζοντας τη συνάφεια μεταξύ δύο μεταβλητών ως ποσοστό της μέγιστης δυνατής μεταβλητότητάς τους. Ο συντελεστής V λαμβάνει τιμές στο διάστημα [0,1] με V = 1 όταν οι δύο μεταβλητές έχουν ίσα περιθώρια αθροίσματα. Καθώς τα περιθώρια αθροίσματα διαφέρουν όλο και περισσότερο η τιμή του V πλησιάζει το 0.

			
					Lambda: Ο συντελεστής συνάφειας λ (Goodman & Kruskal, 1954) ανήκει στα μέτρα προγνωστικής συνάφειας, και αποτελεί ένα μέτρο της αναλογικής μείωσης του σφάλματος, όταν οι τιμές της ανεξάρτητης μεταβλητής χρησιμοποιούνται για να προβλέψουν τις τιμές της εξαρτημένης μεταβλητής. Ο συντελεστής λ λαμβάνει τιμές στο διάστημα [0,1], με λ = 0, όταν οι μεταβλητές είναι ανεξάρτητες, και λ = 1, όταν με βάση τη μια μεταβλητή μπορεί να γίνει τέλεια προγνώστη των τιμών της άλλης.

					Uncertainty coefficient: Ο συντελεστής αβεβαιότητας U (Theil’s uncertainty coefficient, 1972) ανήκει και αυτός στα μέτρα προγνωστικής συνάφειας και επίσης, είναι γνωστός και ως συντελεστής εντροπίας (entropy coefficient). Διαφοροποιείται από τον συντελεστή λ με την έννοια ότι λαμβάνει υπόψη του ολόκληρη την κατανομή της εξαρτημένης μεταβλητής και όχι μόνο την πιο συχνή κατηγορία της (όπως συμβαίνει στον συντελεστή λ). Λαμβάνει τιμές στο διάστημα [0,1], με U = 0 όταν οι μεταβλητές είναι ανεξάρτητες, και U = 1, όταν με βάση τη μια μεταβλητή μπορεί να γίνει τέλεια προγνώστη των τιμών της άλλης. Για παράδειγμα, U = 0,83 συνεπάγεται ότι η γνώση της μιας μεταβλητής, μειώνει το σφάλμα πρόβλεψης των τιμών της άλλης κατά 83%. Το πρόγραμμα υπολογίζει και τις συμμετρικές και τις μη συμμετρικές εκδοχές του συντελεστή αβεβαιότητας.

					Ordinal: Περιέχει επιλογές με σκοπό τον υπολογισμό στατιστικών μέτρων συνάφειας για διατάξιμα δεδομένα. Σ’ αυτή την υποενότητα μπορούμε να επιλέξουμε:

					Gamma: Ο συντελεστής γ (Goodman & Kruskal, 1954) είναι ένα μέτρο διατακτικής συνάφειας, που βασίζεται στη διαφορά «συμφωνιών» (concordant) και «ασυμφωνιών» (discordant). Λαμβάνει τιμές στο διάστημα [-1, 1], με γ = 1 ή γ = -1 να υποδεικνύει ισχυρή θετική ή αρνητική συσχέτιση, ενώ για γ = 0 μικρή ή καμία συσχέτιση.

					Somers’ d: Ο συντελεστής D (Somers, 1962) είναι ένα μέτρο για την πρόβλεψη της εξαρτημένης μεταβλητής γνωρίζοντας την ανεξάρτητη. Είναι παραλλαγή του μέτρου Gamma, λαμβάνοντας υπόψη τυχόν ισοβαθμίες (ties) των ζευγών των παρατηρήσεων. Λαμβάνει τιμές στο διάστημα [-1, 1], με D = 1 όταν δεν υπάρχουν «ασύμφωνα» ζεύγη μεταξύ των μεταβλητών Χ και Υ, και η διάταξη των Χ είναι σε πλήρη συμφωνία με τη διάταξη των τιμών της Υ (ισχυρή συσχέτιση μεταξύ των δύο μεταβλητών), ενώ D = -1 όταν δεν υπάρχουν «σύμφωνα» ζεύγη μεταξύ των μεταβλητών Χ και Υ, και η διάταξη των τιμών της Χ είναι σε πλήρη ασυμφωνία με τη διάταξη των τιμών της Υ.

					Kendall’s tau-b: Ο συντελεστής τ (Kendall, 1938) είναι ένα διατακτικό μέτρο συνάφειας, το οποίο έχει τρεις παραλλαγές. Ο συντελεστής τb λαμβάνει υπόψη τις περιπτώσεις ισοβαθμιών (ties). Λαμβάνει τιμές στο διάστημα [-1, 1], με το πρόσημο να καθορίζει την κατεύθυνση της σχέσης, όπως και στα προηγούμενα μέτρα.

					Kendall’s tau-c: Ο συντελεστής τ (Kendall, 1938) είναι ένα διατακτικό μέτρο συνάφειας, το οποίο έχει τρεις παραλλαγές. Ο συντελεστής τc, σε αντίθεση με τον προηγούμενο δείκτη, αγνοεί τις περιπτώσεις ισοβαθμιών (ties). Λαμβάνει και αυτός τιμές στο διάστημα [-1, 1], με το πρόσημο ομοίως, να καθορίζει την κατεύθυνση της σχέσης.

					Nominal by Interval: Περιέχει επιλογές με σκοπό τον υπολογισμό στατιστικών μέτρων συνάφειας μεταξύ μιας (κωδικοποιημένης) κατηγορικής και μιας ποσοστικής μεταβλητής.

					Eta: Ο συντελεστής η είναι ένα μέτρο συσχέτισης μεταξύ δύο μεταβλητών. Λαμβάνει τιμές στο διάστημα [0, 1], με η = 0 όταν δεν υπάρχει συσχέτιση μεταξύ των μεταβλητών και η = 1 ή κοντά στο 1, όταν υπάρχει υψηλός βαθμός συσχέτισης. ο συντελεστής είναι κατάλληλος όταν η μια εξαρτημένη μεταβλητή μετράται σε κλίμακα (π.χ. το εισόδημα) και η άλλη ανεξάρτητη μεταβλητή είναι κατηγορική, με περιορισμένο αριθμό κατηγοριών (π.χ. το φύλο).

					Kappa: Ο συντελεστής k Cohen είναι ένα στατιστικό μέτρο της συμφωνίας μεταξύ των αξιολογήσεων δύο βαθμολογητών όταν και οι δύο βαθμολογούν το ίδιο αντικείμενο. Λαμβάνει τιμές στο διάστημα [0, 1], με την τιμή 1 να δηλώνει τέλεια συμφωνία. Για να γίνει ο υπολογισμός του συντελεστή θα πρέπει και οι δύο μεταβλητές να έχουν ίδιο τύπο δεδομένων (string ή numeric) και το ίδιο καθορισμένο μήκος.

					Risk: Ο συντελεστής κινδύνου, υπολογίζεται για πίνακες 2x2 και είναι ένα μέτρο του βαθμού συσχέτισης δύο παραγόντων. Ορίζεται ως ο λόγος της επίπτωσης (αναλογία πιθανοτήτων) δύο ομάδων με διαφορετική έκθεση σε έναν παράγοντα. Αν το διάστημα εμπιστοσύνης του συντελεστή κινδύνου περιέχει την τιμή 1, τότε δεν είμαστε σε θέση να υποθέσουμε ότι κάποιος παράγοντας συνδέεται με το αποτέλεσμα/συμβάν. Η αναλογία πιθανοτήτων μπορεί να χρησιμοποιηθεί ως μια εκτίμηση του σχετικού κινδύνου ή όταν η εμφάνιση του παράγοντα είναι σπάνια.

					McNemar: Πρόκειται για μία μη παραμετρική στατιστική δοκιμασία για τον έλεγχο της συμφωνίας δύο κατηγορικών μεταβλητών, όταν οι παρατηρήσεις εμφανίζουν αντιστοιχία κατά ζεύγη. Ο έλεγχος αυτός είναι ο μη παραμετρικός ισοδύναμος του T-test για εξαρτημένα δείγματα, βλ. ομώνυμη ενότητα.

					Cochran’s and Mantel-Haenszel statistics: Μ’ αυτή την επιλογή λαμβάνονται οι στατιστικές Cochran και Mantel-Haenszel για τον έλεγχο της ανεξαρτησίας μεταξύ μιας δίτιμης μεταβλητής παράγοντα και μιας δίτιμης μεταβλητής απόκρισης, που εξαρτάται από μια μεταβλητή που ορίζει ένα ή περισσότερα στρώματα (ελέγχου). Θα πρέπει να ληφθεί υπόψη ότι ενώ άλλα στατιστικά μέτρα υπολογίζονται ξεχωριστά για κάθε στρώμα, οι στατιστικές Cochran και Mantel-Haenszel υπολογίζονται μία φορά για όλες τις στρώσεις.
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			Κεφάλαιο 7

			Γραμμική και λογιστική παλινδρόμηση

			Σύνοψη

			Στο κεφάλαιο αυτό γίνεται ανάλυση της μεθοδολογίας της απλής και πολλαπλής γραμμικής παλινδρόμησης, και αναφορά στη μεθοδολογία της λογιστικής παλινδρόμησης. Γίνεται αρκετά λεπτομερής θεωρητική αναφορά σε κάθε μεθοδολογία καθώς και επεξήγηση των επιλογών και των παραμέτρων που παρέχονται από το πρόγραμμα. Σε κάθε περίπτωση υπάρχουν εφαρμογές σε δειγματικά αρχεία δεδομένων και επεξήγηση των αποτελεσμάτων. Σημειώνεται ότι χρησιμοποιήθηκαν δύο αρχεία δεδομένων (solar.sav και carcrash.sav) τα οποία χρησιμοποιούνται στο μάθημα Στατιστικά Πρότυπα του ΔΠΜΣ, Μαθηματική προτυποποίηση σε σύγχρονες τεχνολογίες και στην οικονομία του ΕΜΠ (υπεύθυνη μαθήματος Χ. Καρώνη).

			Προαπαιτούμενη γνώση

			Για την καλύτερη κατανόηση του κεφαλαίου αυτού οι αναγνώστες θα πρέπει να έχουν παρακολουθήσει το μάθημα των γενικευμένων γραμμικών μοντέλων σε προχωρημένο επίπεδο, καθώς μέσω των επιλογών του προγράμματος γίνεται εκτενής αναφορά σε πληθώρα κριτηρίων και ελέγχων. Ακόμα ως προαπαιτούμενη είναι η βασική γνώση των στατιστικών ελέγχων, της εκτιμητικής (κυρίως η έννοια των διαστημάτων εμπιστοσύνης), των κατανομών Student, X2 και κανονικής, των πράξεων μεταξύ πινάκων καθώς και η γνώση της έννοιας των αντίστροφων πινάκων.

			Από τα εγχειρίδια που παρουσιάζουν με πληρότητα την ύλη του συγκεκριμένου κεφαλαίου αναφέρονται ενδεικτικά τα βιβλία των Carver και Nash, Καρώνη, Οικονόμου και Καρώνη, Coakes και Steed, Field,  Norusis, Howit Cramer και Montgomery and Peck κ.ά. (βλ. βιβλιογραφικές αναφορές). Ακόμα για το συγκεκριμένο κεφάλαιο όπως για τα Κεφάλαια 3-6 σημαντική πηγή πληροφοριών αποτελεί ο ιστότοπος του.

			7.1 Απλή και Πολλαπλή Γραμμική Παλινδρόμηση (Linear Regression)

			Στην απλή παλινδρόμηση ο στόχος είναι να βρεθεί η μαθηματική σχέση που συνδέει τις παρατηρήσεις δύο μεταβλητών. Έχουμε ήδη δει ότι ο συντελεστής συσχέτισης μας δείχνει το αν και κατά πόσο δύο μεταβλητές σχετίζονται, χωρίς όμως να μας παρέχει τον τρόπο με τον οποίο μεταβάλλονται οι τιμές της μιας σε σχέση με τις τιμές της άλλης.

			Αρχικά, γίνεται η γραφική παράσταση των δεδομένων (scatter plot) ώστε να προσεγγιστεί η μορφή της καμπύλης που τα συνδέει. Οι παρατηρήσεις των μεταβλητών απεικονίζονται σε ένα σύστημα ορθογωνίων συντεταγμένων. Παρατηρώντας στη συνέχεια το διάγραμμα διασποράς προκύπτει το συμπέρασμα ότι δεν υπάρχει καμπύλη που να ενώνει όλα τα σημεία και για τον λόγο αυτό αναζητάμε εκείνη την καμπύλη που προσαρμόζεται όσο το δυνατό καλύτερα στα δεδομένα που υπάρχουν. Η απλούστερη μορφή συσχέτισης δύο μεταβλητών είναι η γραμμική, δηλ. θα μελετηθεί η απλή γραμμική παλινδρόμηση και στη συνέχεια θα γίνει μια γενίκευση για περισσότερες από δύο μεταβλητές (πολλαπλή γραμμική παλινδρόμηση).

			Η γραμμική συσχέτιση εκφράζεται μαθηματικά από τη σχέση:
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			Εξίσωση 7.1

			Όπου:

			Υ η εξαρτημένη μεταβλητή, x η ανεξάρτητη μεταβλητή, β0 η τεταγμένη, δηλ. η τιμή της εξαρτημένης για x = 0, β1 η κλίση της ευθείας, και εi το τυχαίο σφάλμα με Ε(εi) = 0, που είναι η απόκλιση της Υ από την ευθεία γραμμικής παλινδρόμησης E(Yi) = β0 + β1x.

			Η ευθεία γραμμικής παλινδρόμησης δεν περνάει απαραίτητα από όλα τα σημεία των παρατηρήσεων Yi. Αυτό έχει ως αποτέλεσμα στις περισσότερες περιπτώσεις για κάθε xi να παράγεται μια προβλεπόμενη τιμή για τη μεταβλητή:

			[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\7.2.wmf]

			Εξίσωση 7.2

			Όπου:
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			Εξίσωση 7.3
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			Εικόνα 7.1: Γραφική απεικόνιση των δεδομένων της ευθείας παλινδρόμησης και των σφαλμάτων

			Όπως βλέπουμε και από το παραπάνω σχήμα, σκοπός μας είναι να πετύχουμε μια καλή προσαρμογή της ευθείας στα δεδομένα, δηλαδή να ελαχιστοποιηθούν όσο το δυνατόν οι αποκλίσεις (σφάλματα εi) των δεδομένων από τις εκτιμώμενες τιμές. Συνεπώς, για την εκτίμηση των παραμέτρων β0 και β1 χρησιμοποιείται η μέθοδος των ελάχιστων τετραγώνων. Με τη μέθοδο αυτή η ευθεία που προσαρμόζεται καλύτερα στα δεδομένα που έχουν δοθεί είναι αυτή που ελαχιστοποιεί το άθροισμα των τετραγώνων των σφαλμάτων (καταλοίπων-residuals).
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			Εξίσωση 7.4

			Από τη σχέση αυτή λαμβάνουμε τις πρώτες μερικές παραγώγους, τις οποίες θέτουμε ίσες με το μηδέν και από το 2x2 γραμμικό σύστημα εκτιμάμε τις παραμέτρους, όπου:
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			Εξίσωση 7.5

			Και
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			Εξίσωση 7.6

			Αυτό που εξετάζουμε στα γραμμικά μοντέλα (Y = Β0 + β1xi), είναι η ύπαρξη ή μη γραμμικής σχέσης μεταξύ της εξαρτημένης (dependent) μεταβλητής Υ και της ανεξάρτητης (independent) μεταβλητής X. Οπότε ορίζουμε ως μηδενική υπόθεση: «Δεν υπάρχει γραμμική σχέση μεταξύ Y και X», δηλαδή:
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			Εξίσωση 7.7

			Έναντι της εναλλακτικής υπόθεσης: «Υπάρχει γραμμική σχέση μεταξύ Y και X», δηλαδή:
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			Εξίσωση 7.8: Δίπλευρος έλεγχος

			Ο έλεγχος γίνεται σε (1-α)% επίπεδο σημαντικότητας και η στατιστική συνάρτηση υπό την H0 είναι:
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			Εξίσωση 7.9

			Ακολουθεί  την t-κατανομή με n-2 βαθμούς ελευθερίας (T-test). Περιοχή απόρριψης: απορρίπτουμε την H0 αν:
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			Εξίσωση 7.10: Δίπλευρος έλεγχος

			Αντίστοιχος έλεγχος για τη διατομή (intercept) β0 δεν έχει νόημα. Στο σύνολο των παρατηρήσεων η ολική διακύμανση, δηλαδή η ολική μεταβλητότητα των παρατηρήσεων (SST), δίδεται από τη σχέση:
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			Εξίσωση 7.11

			Η οποία αναλύεται σε δύο μέρη:
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			Εξίσωση 7.12

			Αποδεικνύεται ότι:
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			Εξίσωση 7.13

			Ένα μέρος εξηγείται από την ευθεία παλινδρόμησης (regression sum of squares):
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			Εξίσωση 7.14

			Ένα άλλο παραμένει ανερμήνευτο (error sum of squares):
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			Εξίσωση 7.15

			Οπότε:
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			Εξίσωση 7.16

			Η ανάλυση γίνεται για να ερμηνευτεί η μεταβλητότητα των παρατηρήσεων που μελετώνται. Βέβαια ο αρχικός στόχος είναι να ελαττωθεί το μέρος της συνολικής μεταβλητότητας που παραμένει ανερμήνευτο.

			Συνεπώς, ένα μέτρο για να κρίνουμε αν η ευθεία παλινδρόμησης προσαρμόζεται ικανοποιητικά στα δεδομένα είναι ο συντελεστής προσδιορισμού (coefficient of determination) που δίνεται από τη σχέση:
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			Εξίσωση 7.17

			Πρέπει να είναι όσο το δυνατό μεγαλύτερος. Αν R2 = 0,78 σημαίνει ότι 78% της μεταβλητότητας των αποδόσεων της επένδυσης σχετίζεται με τις αποδόσεις δείκτη αναφοράς και το 22% δεν συνδέεται. Μ’ άλλα λόγια ο συντελεστής προσδιορισμού R2 εκφράζει το ποσοστό της συνολικής μεταβλητότητας που εξηγείται από το μοντέλο παλινδρόμησης. Μια παραλλαγή του συντελεστή προσδιορισμού είναι ο τροποποιημένος συντελεστής προσδιορισμού (adjusted coefficient of the termination) που δίνεται από τη σχέση:
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			Εξίσωση 7.18

			Χρησιμοποιείται για τη σύγκριση nested μοντέλων. Όλα τα παραπάνω συνοψίζονται στον πίνακα Ανάλυσης Διασποράς της Παλινδρόμησης (ANOVA-Τable).
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			Πίνακας 7.1: F-test για το γραμμικό μοντέλο

			Είδαμε ότι η ολική διακύμανση των δεδομένων χωρίζεται σε δύο μέρη, ένα εξαιτίας της παλινδρόμησης και ένα που παραμένει ανερμήνευτο.

			Από τη θεωρία πιθανοτήτων ξέρουμε ότι:
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			Εξίσωση 7.19

			Από την άλλη αν β0 = 0 έχουμε ότι:
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			Εξίσωση 7.20

			Ο λόγος αυτών των δύο θα μας δώσει:
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			Εξίσωση 7.21

			Ο F-έλεγχος για το αν υπάρχει γραμμική σχέση μεταξύ των X και Y (δηλαδή για το αν μια ευθεία είναι χρήσιμη για την ερμηνεία μέρους της μεταβλητότητας των δεδομένων) βασίζεται στην παρατήρηση ότι:
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			Εξίσωση 7.22

			Και:
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			Εξίσωση 7.23

			Όταν το μοντέλο παλινδρόμησης είναι σωστά καθορισμένο. Εάν η β1 ≈ 0 (slope), δηλαδή η παλινδρόμηση δεν προσθέτει τίποτα επιπλέον για την ερμηνεία της μεταβλητότητας των παρατηρήσεων τα δύο μέσα αθροίσματα τετραγώνων MSR και MSE και έχουν την ίδια μέση τιμή σ2. Επομένως έχουμε το λόγο:
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			Εξίσωση 7.24

			Αν η υπόθεση της γραμμικής σχέσης των X και Y δεν ευσταθεί τότε έχουμε το λόγο:

			[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\7.25.wmf]

			Εξίσωση 7.25

			Αν ευσταθεί η γραμμική σχέση (β1 ≠ 0). Ο F-έλεγχος για την ύπαρξη ή όχι γραμμικής σχέσης των X και Y ορίζεται ως εξής:

			H0: δεν υπάρχει γραμμική σχέση μεταξύ των Χ και Υ

			Εξίσωση 7.26

			H1: υπάρχει γραμμική σχέση μεταξύ των Χ και Υ

			Εξίσωση 7.27
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			Εξίσωση 7.28

			Απορρίπτουμε την H0 αν:
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			Εξίσωση 7.29

			Στην απλή γραμμική παλινδρόμηση το F-test είναι ισοδύναμο με το T-test για μηδενική κλίση. Αυτό συμβαίνει επειδή T2 = F όπου T~tn-2;α και F̴F1,n-2;α.

			Πολλαπλή γραμμική παλινδρόμηση

			Η πολλαπλή γραμμική παλινδρόμηση (Multiple Linear Regression) είναι επέκταση της απλής γραμμικής παλινδρόμησης από το μοντέλο.
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			Εξίσωση 7.30

			Μεταφερόμαστε στο πολλαπλό γραμμικό μοντέλο:
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			Εξίσωση 7.31

			Ο όρος γραμμικό μοντέλο αναφέρεται στις παραμέτρους βj, j = 1,…, p-1 (και όχι στις ανεξάρτητες μεταβλητές xij) και κατ’ επέκταση τα μοντέλα:
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			Εξίσωση 7.32: Πολυωνυμικό μοντέλο
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			Εξίσωση 7.33: Μοντέλο με αλληλεπίδραση

			Θεωρούνται ως πολλαπλά γραμμικά μοντέλα. Απεικόνιση της πολλαπλής παλινδρόμησης με χρήση πινάκων. Για n ανεξάρτητες παρατηρήσεις έχουμε:
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			Εξισώσεις 7.34

			Ισοδύναμα:
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			Εξίσωση 7.35

			Όπου:
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			Εξίσωση 7.36: Πίνακας σχεδιασμού (Design Matrix)

			Ομοίως, με την απλή παλινδρόμηση για την εκτίμηση των συντελεστών:

			β̂j, j=1, …, p-1, εφαρμόζουμε τη μέθοδο των ελαχίστων τετραγώνων

			Εξίσωση 7.37

			[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\7.38.wmf]

			Εξίσωση 7.38

			Παίρνοντας τις πρώτες μερικές παραγώγους προκύπτει ένα σύστημα με p εξισώσεις και p αγνώστους. Ισοδύναμα:
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			Εξίσωση 7.39

			Οι εκτιμήτριες β μπορούν να υπολογιστούν είτε λύνοντας το pxp σύστημα είτε πολλαπλασιάζοντας τους πίνακες:
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			Πίνακας 7.2: F- έλεγχοι στην πολλαπλή γραμμική παλινδρόμηση

			F-έλεγχος για τη σημαντικότητα όλου του μοντέλου (overall F-test)

			Όπως και στην απλή παλινδρόμηση, έτσι και εδώ, έχουμε έναν F- έλεγχο για όλο το μοντέλο. Οπότε:
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			Εξίσωση 7.40

			Έναντι της:

			H1: τουλάχιστον ένα βj ≠ 0, j=1,…, p-1

			Εξίσωση 7.41

			Συνεπώς:
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			Εξίσωση 7.42

			Απορρίπτεται η Η0 για:
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			Εξίσωση 7.43

			Το SSR λαμβάνει τη συνεισφορά όλων των ανεξάρτητων μεταβλητών. Ωστόσο δεν συνεισφέρουν όλες το ίδιο σημαντικά στην ερμηνεία της μεταβλητότητας των Yi και επίσης κάποιες από αυτές σχετίζονται μεταξύ τους, άρα δεν είναι αναγκαίες μέσα στο μοντέλο.

			Partial F-tests (variables-added-in-order ή Type I F-tests)

			Ένας τρόπος για να ελεγχθεί η μεμονωμένη συνεισφορά κάθε ανεξάρτητης μεταβλητής στο τετραγωνικό άθροισμα της παλινδρόμησης (SSR) είναι η χρήση των partial F-tests. To SSR μπορεί να αναλυθεί στο άθροισμα:
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			Εξίσωση 7.44

			Όπου, SS (β2 | β1) το επιπλέον άθροισμα τετραγώνων από την προσθήκη της X2 στο μοντέλο παλινδρόμησης, δηλαδή η επιπλέον μεταβλητότητα της Y που ερμηνεύεται από την προσθήκη της X2 στο μοντέλο αφού έχει ήδη συμπεριληφθεί η X1.

			Παρατηρούμε ότι η σειρά της προσθήκης των ανεξάρτητων μεταβλητών είναι τρομερά σημαντική για τον υπολογισμό αυτών των partial F-tests. Εάν θέλουμε απλά να εξετάσουμε το κατά πόσο για παράδειγμα μια X1. είναι σημαντική για την πρόβλεψη της Y τότε θα κάνουμε μια μονοπαραγοντική ανάλυση (απλή γραμμική παλινδρόμηση).

			Για να απαντήσουμε όμως στο ερώτημα το κατά πόσο η προσθήκη της X2 συνεισφέρει στατιστικά σημαντικά στην πρόβλεψη της Y αφού έχουμε ήδη λογαριάσει τη συνεισφορά της X1, χρησιμοποιούμε ένα partial F-test. Όπου:
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			Εξίσωση 7.45

			Πιο γενικά:
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			Εξίσωση 7.46

			Ένας άλλος τρόπος για να ελέγχουμε αν η προσθήκη μιας νέας μεταβλητής, αφού έχουμε ήδη p μεταβλητές στο μοντέλο, συμβάλλει στατιστικά σημαντικά στην πρόβλεψη της Y είναι η χρήση ενός T-test.

			Ορίζουμε:
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			Εξίσωση 7.47

			Έναντι της:
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			Εξίσωση 7.48
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			Εξίσωση 7.49

			Απορρίπτουμε την H0 για:
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			Εξίσωση 7.50

			Παρατήρηση:
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			Εξίσωση 7.51

			Variables-added-last ή Type III F-tests

			Ένας τελευταίος F-έλεγχος είναι ο Type III F-test που βασίζεται στο άθροισμα τετραγώνων κάθε μεταβλητής αν είναι γνωστές όλες οι υπόλοιπες μεταβλητές του μοντέλου. Εάν έχουμε [image: ]-μεταβλητές τότε υπολογίζουμε τα:
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			Εξισώσεις 7.52

			Όπου η υπό εξέταση μεταβλητή προστίθεται κάθε φορά τελευταία στο μοντέλο.

			Υποθέσεις του πολλαπλού γραμμικού μοντέλου

			
					Ανεξαρτησία: Οι παρατηρήσεις Yi πρέπει να είναι στατιστικά ανεξάρτητες μεταξύ τους (όταν λαμβάνονται πολλαπλές μετρήσεις από το ίδιο υποκείμενο τότε θα πρέπει να χρησιμοποιηθούν άλλες τεχνικές αναλύσεις).

					Γραμμικότητα: Ο μέσος των παρατηρήσεων Yi για κάθε συνδυασμό των X1, X2. …., Xp-1 είναι ένας γραμμικός συνδυασμός αυτών:[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\7.53.wmf]
Εξίσωση 7.53


					Ομοσκεδαστικότητα: Η διασπορά των Yi είναι ίδια για κάθε συνδυασμούς X1, X2. …., Xp-1 με:[image: ]
Εξίσωση 7.54


					Κανονικότητα: Για κάθε συνδυασμό X1, X2. …., Xp-1 η μεταβλητή Y κατανέμεται κανονικά:

			

			[image: ]

			Εξίσωση 7.55

			Κατ’ επέκταση των παραπάνω οι προϋποθέσεις για την εφαρμογή της μεθόδου είναι:

			
					Τα σφάλματα:[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\7.56.wmf]
Εξίσωση 7.56
Έχουν μηδενική μέση τιμή και άγνωστη διακύμανση σ2.


					Τα ε1, …., εn είναι ασυσχέτιστα δηλαδή:[image: ]
Εξίσωση 7.57


					Άμεση συνέπεια των παραπάνω υποθέσεων είναι ότι κάθε παρατήρηση Yi έχει:[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\7.58.wmf]
Εξίσωση 7.58
Με κοινή διακύμανση σ2 και ότι οι παρατηρήσεις Yi και Yj όπου I ≠ j είναι ασυσχέτιστες.


					Τα σφάλματα εi ακολουθούν N(0, σ2), το οποίο συνεπάγεται ότι τα εi εκτός από ασυσχέτιστα είναι και ανεξάρτητα μεταξύ τους.

			

			Ο έλεγχος της εγκυρότητας του μοντέλου γίνεται με τη χρήση των σφαλμάτων (καταλοίπων). Τα σφάλματα χρησιμοποιούνται επίσης, για την ανίχνευση παρατηρήσεων που συμπεριφέρονται αντιφατικά με όλο το μοντέλο. Πολύ υψηλά σφάλματα μπορεί να υποδεικνύουν μια ασυνήθιστα υψηλή παρατήρηση ή απλά μια κοινή εφαρμογή. Από την άλλη, μια παρατήρηση μπορεί να αξίζει να ληφθεί υπόψη ακόμα και αν το σφάλμα της είναι μικρό, επειδή καθορίζει σε μεγάλο βαθμό την ευθεία παλινδρόμησης.

			Αναλυτικότερα τα διαγνωστικά ελέγχου των υποθέσεων του πολλαπλού μοντέλου παλινδρόμησης θα παρουσιαστούν ακολούθως μέσα από τις δυνατές επιλογές του προγράμματος.

			Βήματα για την επιλογή του «βέλτιστου» μοντέλου παλινδρόμησης

			Ορίζουμε το μέγιστο δυνατό μοντέλο (πλήρες) δηλαδή το μοντέλο που θα έχει:

			
					όλους τους predictors Xi, i= 1, …, k,

					όλους τους μεγαλύτερου βαθμού όρους (που επιθυμούμε),

					τις μεταξύ τους αλληλεπιδράσεις.

			

			Εάν το πλήθος των μεταβλητών- predictors και της διατομής είναι k + 1 = n (όπου n το πλήθος των παρατηρήσεων), τότε οι βαθμοί ελευθερίας του σφάλματος θα είναι μηδέν. Έτσι δεν θα έχει νόημα πόσους predictors θα επιλέξουμε γιατί:
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			Εξίσωση 7.59

			αδιαφορώντας αν το μοντέλο παλινδρόμησης είναι λογικό ή όχι.

			Ελάχιστοι απαιτούμενοι βαθμοί ελευθερίας για το σφάλμα n-k-1 > 10. Μια άλλη πρόταση είναι η επιλογή n > 5k ή ακόμα n ≥ 10k. Έτσι, αν έχουμε 50 παρατηρήσεις το μεγαλύτερο μοντέλο θα έχει predictors μεταξύ k = 5 και k-10.

			Ορίζουμε το κριτήριο με το οποίο θα γίνει η επιλογή των predictors Xi. Υποθέτουμε ότι το πλήρες μοντέλο είναι το:
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			Εξίσωση 7.60

			Το μειωμένο μοντέλο είναι το:

			[image: ]

			Εξίσωση 7.61

			Υποψήφια κριτήρια για την επιλογή μοντέλου είναι:

			α) Ο συντελεστής προσδιορισμού R:
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			Εξίσωση 7.62α

			Μεγιστοποιεί το πλήρες μοντέλο. Η εναλλακτική του μορφή είναι:

			[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\7.63.wmf]

			Εξίσωση 7.62β

			Προσαρμόζει το R2 για το μέγεθος του κάθε μοντέλου.

			β) Η F-στατιστική συνάρτηση με την οποία συγκρίνουμε το πλήρες με το περιορισμένο μοντέλο:

			[image: ] όπου [image: ]

			Εξίσωση 7.63

			Η Fp μετράει σχετικές αλλαγές στο σφάλμα, έπειτα από την προσθήκη ενός πλήθους από k-p predictors και συγκρίνεται με την F(k-p)(,n-k-1) κατανομή.

			γ) Η διασπορά στο περιορισμένο μοντέλο:
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			Εξίσωση 7.64

			Θέλουμε να ελαχιστοποιηθεί.

			δ) Η [image: ] Mallow’ s στατιστική συνάρτηση:
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			Εξίσωση 7.65

			Όπου σ̂:

			η καλύτερη εκτίμηση της διασποράς των Y και συνήθως:
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			Εξίσωση 7.66

			Σημειώνουμε ότι αν θεωρήσουμε  ως καλύτερη εκτίμηση της διασποράς την MSE(k), τότε Cp = k+1 για το πλήρες μοντέλο. Έτσι αν ένα περιορισμένο p- μεταβλητών μοντέλο έχει διασπορά κοντά στο MSE(k) τότε Cp ≈ p+1.

			Όλα τα προαναφερθέντα κριτήρια εμπεριέχουν την ίδια πληροφορία. Έτσι, ισχύουν οι σχέσεις:
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			Εξίσωση 7.67

			Και:
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			Εξίσωση 7.68

			Ελέγχουμε την αξιοπιστία (reliability) του γραμμικού μοντέλου (split-sample προσέγγιση):

			Για να ελέγξουμε την αξιοπιστία του μοντέλου, δηλαδή το κατά πόσο το μοντέλο κάνει καλή πρόβλεψη, ακολουθούμε την εξής διαδικασία:

			
					Χωρίζουμε τα δεδομένα μας σε δύο μέρη, ένα δοκιμαστικό δείγμα (training sample) και ένα κύριο δείγμα (validation sample).

					Προσαρμόζουμε το «βέλτιστο» μοντέλο στο δοκιμαστικό δείγμα[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\7.69.wmf]
Εξίσωση 7.69
Συγκεκριμένα θέτουμε:
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Εξίσωση 7.70
Το διάνυσμα των ni προσαρμοσμένων τιμών Yi από το δοκιμαστικό δείγμα με:
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Εξίσωση 7.71


					Χρησιμοποιούμε τα:
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			Εξίσωση 7.72

			Για να υπολογίσουμε το διάνυσμα των προσαρμοσμένων Yi από το κύριο δείγμα βασιζόμενο στους συντελεστές παλινδρόμησης που υπολογίστηκαν για το δοκιμαστικό μοντέλο με:

			[image: C:\Users\Chrysa\Desktop\Equations_Xalikias\7.73.wmf]

			Εξίσωση 7.73

			Η ποσότητα R2(1)-R2*(2) καλείται shrinkage on cross-validation. Τιμές της shrinkage μικρότερες από 0,10 υποδεικνύουν ένα αξιόπιστο μοντέλο και τιμές κοντά στο 0,9 χαρακτηρίζουν ένα μοντέλο ως προβληματικό.

			Σημείωση

			Για να πραγματοποιηθεί η split-sample προσέγγιση θα πρέπει να έχουμε ένα αρκετά μεγάλο δείγμα ώστε να είμαστε σε θέση να το χωρίσουμε. Ο διαχωρισμός των δύο ομάδων γίνεται με μεθόδους δειγματοληψίας, όπως απλή τυχαία δειγματοληψία, στρωματοποιημένη και άλλα.

			Για την εκτέλεση της μεθόδου στο SPSS, η δυνατότητα προσφέρεται από την επιλογή Analyze > Regression > Linear Regression.

			[image: ]

			Εικόνα 7.2: Το menu Linear Regression

			Στο πλαίσιο Dependent ορίζουμε την εξαρτημένη συνεχή μεταβλητή, και στο πλαίσιο Independent(s) εισάγουμε τις ανεξάρτητες προς εξέταση μεταβλητές. Στη συνέχεια στο πεδίο Method επιλέγουμε τη μέθοδο επιλογής του βέλτιστου μοντέλου. Οι δυνατές επιλογές είναι:

			
					Enter: Με αυτή τη μέθοδο εισάγονται στο μοντέλο όλες οι μεταβλητές ανεξάρτητα από το αν είναι στατιστικά σημαντικές σε σχέση με την εξαρτημένη μεταβλητή.

					Stepwise: Είναι μια παραλλαγή της διαδικασίας forward, που μας επιτρέπει να επανεξετάσουμε αν κάποια από τις μεταβλητές (εκτός από αυτήν που έχει μόλις εισαχθεί στο μοντέλο), μπορεί να αφαιρεθεί χρησιμοποιώντας τη διαδικασία backward. Βήμα 1, αρχικά ορίζεται ένα μέγιστο p-value για την αφαίρεση κάποιας μεταβλητής και ένα ελάχιστο για την είσοδο κάποιας μεταβλητής. Έτσι ώστε p-valueOUT < p < p-valueIN για να είμαστε σίγουροι ότι καμιά μεταβλητή που θα αφαιρεθεί από το μοντέλο δεν θα μπορεί να ξαναμπεί στο ίδιο βήμα της διαδικασίας. Βήμα 2, στη συνέχεια, υπολογίζονται όλα τα Τύπου III partial F-tests για κάθε υποψήφια μεταβλητή που δεν είναι ακόμα προσαρμοσμένη στο μοντέλο (adjusted) με όσες είναι ήδη μέσα στο μοντέλο. Εάν το χαμηλότερο p-value είναι χαμηλότερο από το p-valueIN η μεταβλητή εισέρχεται. Βήμα 3, έπειτα, υπολογίζονται όλα τα partial F-tests για όλες τις μεταβλητές. Εάν το υψηλότερο p-value είναι υψηλότερο από το p-valueOUT τότε η μεταβλητή απομακρύνεται. Το μοντέλο ξαναπροσαρμόζεται και το Bήμα 3 επαναλαμβάνεται μέχρις ότου καμιά μεταβλητή να μη μπορεί να μπει στο μοντέλο. Η διαδικασία πηγαίνει στο Bήμα 2 και συνεχίζεται μέχρις ότου καμιά μεταβλητή να μην μπορεί ούτε να μπει ούτε να αφαιρεθεί από το μοντέλο.

					Remove: Σ’ αυτή τη μέθοδο όλες οι μεταβλητές (σε ένα μπλοκ) απομακρύνονται σε ένα μόνο βήμα.

					Backward: Είναι μια διαδικασία επιλογής στην οποία αρχικά εισάγονται στο μοντέλο όλες οι μεταβλητές και στη συνέχεια απομακρύνονται μία προς μία διαδοχικά. Βήμα 1 προσαρμόζεται ένα πλήρες μοντέλο και ορίζεται ένα μέγιστο p-value για την απομάκρυνση κάθε παράγοντα (για παράδειγμα 10%). Βήμα 2, πραγματοποιούνται όλα τα partial F-tests. Βήμα 3, αν το υψηλότερο p-value είναι μεγαλύτερο από το p-value που ορίσαμε στο Βήμα 1 τότε η αντίστοιχη μεταβλητή απομακρύνεται. Βήμα 4, αν καμιά μεταβλητή δεν απομακρυνθεί, η διαδικασία σταματάει και οι εναπομείνασες μεταβλητές ορίζουν το «βέλτιστο» μοντέλο. Εάν όμως, κάποια μεταβλητή απομακρυνθεί, τότε το νέο μοντέλο προσαρμόζεται (θεωρείται ως πλήρες) και η διαδικασία επαναλαμβάνεται από το Βήμα 2 μέχρις ότου καμία μεταβλητή να μην μπορεί να απομακρυνθεί.

					Forward: Είναι μια διαδικασία στην οποία οι μεταβλητές εισέρχονται σταδιακά στο μοντέλο. Βήμα 1, προσδιορίζεται ένα μέγιστο p-value για την είσοδο κάθε μεταβλητής στο μοντέλο. Βήμα 2, εκτελούνται όλες οι μονοπαραγοντικές αναλύσεις, δηλαδή προσαρμόζονται όλες οι μεταβλητές κάθε μια μόνη της. Βήμα 3, υπολογίζονται όλες οι F στατιστικές για τα απλά μοντέλα παλινδρόμησης του Βήματος 2. Βήμα 4, αν το χαμηλότερο p-value του Τύπου ΙΙΙ F-test είναι μεγαλύτερο από το p-value που ορίσαμε στο Βήμα 1 τότε σταματάμε, αλλιώς ενσωματώνουμε αυτή τη μεταβλητή στο μοντέλο. Βήμα 5, για τις εναπομείνασες μεταβλητές που δεν είναι ακόμα στο μοντέλο, υπολογίζουμε τα Τύπου ΙΙΙ partial F-tests ελέγχοντάς τα (controlling) για όλες τις μεταβλητές του μοντέλου. Έπειτα, επανερχόμαστε στο Βήμα 4 και επαναλαμβάνουμε τη διαδικασία έως ότου καμιά μεταβλητή να μην μπορεί να μπει στο μοντέλο.

			

			Ανεξάρτητα από τη μέθοδο που θα επιλέξει ο κάθε ερευνητής για την επιλογή του «βέλτιστου» (optimum) μοντέλου παλινδρόμησης, θα πρέπει να έχει υπόψη του ότι το μοντέλο θα πρέπει να πληροί δύο βασικές αρχές.

			
					Αξιοπιστία (Reliability): Εάν στόχος μας είναι να προβλέψουμε το Y τότε το μοντέλο που προβλέπει καλύτερα το Y λέγεται ότι είναι «ακριβές» (be reliable). Στην περίπτωση αυτή ο βασικός στόχος είναι η ακριβής (accurate) εκτίμηση της Y και όχι τόσο οι ιδιαιτερότητες του ίδιου του μοντέλου.

					Εγκυρότητα (Validity): Όταν δίνουμε έμφαση στη σχέση της Y με τις Xi τότε εμβαθύνουμε στην πρόβλεψη των συντελεστών της παλινδρόμησης, αναζητώντας ένα έγκυρο (valid) γραμμικό μοντέλο παλινδρόμησης.

			

			Στο πλαίσιο Selection Variable μπορούμε να ορίσουμε μια μεταβλητή καθώς και τη συνθήκη Rule μέσω της οποίας θα απομονώσουμε το υποσύνολο των δεδομένων στο οποίο επιθυμούμε να εφαρμόσουμε την παλινδρόμηση.

			Από το πλήκτρο Statistics μπορούμε να επιλέξουμε την εμφάνιση των αποτελεσμάτων της παλινδρόμησης και κυρίως διαγνωστικών μέτρων ελέγχου αυτής. Αναλυτικότερα έχουμε:

			
					Estimates: Εμφανίζει τον πίνακα με τους συντελεστές παλινδρόμησης Β, τα τυπικά σφάλματα αυτών, τους τυποποιημένους συντελεστές παλινδρόμησης, την τιμή του T-test και το αποτέλεσμα του δίπλευρου ελέγχου.
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			Εικόνα 7.3: Το menu Linear Regression > Statistics

			
					Confidence intervals: Εμφανίζει τα διαστήματα εμπιστοσύνης των συντελεστών παλινδρόμησης και του πίνακα συνδιακυμάνσεων, σύμφωνα με το οριζόμενο επίπεδο στο πεδίο Level.

					Covariance matrix: Εμφανίζει έναν πίνακα διακυμάνσεων-συνδιακυμάνσεων των συντελεστών παλινδρόμησης. Υπενθυμίζουμε ότι τα στοιχεία της διαγωνίου του πίνακα είναι οι διακυμάνσεις, ενώ τα στοιχεία εκτός διαγωνίου είναι οι συνδιακυμάνσεις.

					Model fit: Εμφανίζει κατάσταση των μεταβλητών που εισήχθησαν ή/και αφαιρέθηκαν από το μοντέλο, καθώς και τις τιμές διαγνωστικών μέτρων καταλληλότητας του μοντέλου, όπως τον συντελεστή προσδιορισμού R2, τον προσαρμοσμένο συντελεστή προσδιορισμού R2, το τυπικό σφάλμα της εκτίμησης και τον πίνακα ανάλυσης διασποράς ANOVA.

					R squared change: Εμφανίζει τις ενδιάμεσες μεταβολές του συντελεστή προσδιορισμού R2 οι οποίες λαμβάνουν χώρα κατά την προσθήκη ή αφαίρεση των ανεξάρτητων μεταβλητών στο μοντέλο. Εάν η είσοδος μιας μεταβλητής οδηγεί σε σημαντική αύξηση της τιμής του συντελεστή προσδιορισμού, τότε αυτό συνεπάγεται ότι η μεταβλητή είναι σημαντική για το μοντέλο.

					Descriptives: Εμφανίζει πίνακα συνήθων περιγραφικών μέτρων των μεταβλητών του μοντέλου, όπως το πλήθος έγκυρων παρατηρήσεων, τη μέση τιμή και την τυπική απόκλιση. Επιπρόσθετα, εμφανίζεται και ο πίνακας των συσχετίσεων μεταξύ των μεταβλητών.

					Part and Partial Correlations: Εμφανίζει τις μερικές συσχετίσεις, δηλ. τη συσχέτιση η οποία απομένει μεταξύ δύο μεταβλητών μετά από την αφαίρεση της συσχέτισης που οφείλεται στην αμοιβαία ένωσή τους με τις υπόλοιπες μεταβλητές. Η συσχέτιση μεταξύ της εξαρτημένης μεταβλητής και μιας ανεξάρτητης μεταβλητής, όταν οι γραμμικές επιδράσεις των άλλων ανεξάρτητων μεταβλητών στο μοντέλο έχουν αφαιρεθεί από αυτές.

					Collinearity diagnostics: Για την πραγματοποίηση του ελέγχου πολυσυγραμμικότητας στο μοντέλο. Συγγραμμικότητα (Collinearity) ή πολυσυγραμμικότητα (multicollinearity) εμφανίζεται όταν μια ανεξάρτητη μεταβλητή είναι μια γραμμική συνάρτηση μιας άλλης ανεξάρτητης μεταβλητής. Σε περίπτωση που υπάρχουν υψηλές συσχετίσεις μεταξύ των ανεξάρτητων μεταβλητών, αυτό αποτελεί ισχυρή ένδειξη πολυσυγραμμικότητας. Η πολυσυγραμμικότητα δημιουργεί προβλήματα, όχι στην προσαρμογή του υποδείγματος, αλλά στο να διαπιστωθούν πραγματικά οι στατιστικά σημαντικοί παράγοντες στην επίδραση της εξαρτημένης μεταβλητής, και αυτό γιατί η παρουσία της πολυσυγραμμικότητας οδηγεί σε αυξημένα τυπικά σφάλματα. Στην ακραία περίπτωση που μια ανεξάρτητη μεταβλητή είναι γραμμικός συνδυασμός μερικών ή όλων των υπόλοιπων ανεξάρτητων μεταβλητών, τότε προκύπτει ότι η ορίζουσα του πίνακα X’X ισούται με μηδέν, το οποίο καθιστά τον πίνακα X’X η αντιστρέψιμο, και κατ’ επέκταση δεν μπορεί να γίνει ο υπολογισμός των συντελεστών παλινδρόμησης:
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			Εξίσωση 7.74: Συντελεστής παλινδρόμησης

			Μέτρα για τον έλεγχο της πολυσυγραμμικότητας είναι ο παράγοντας μεγέθυνσης διασποράς (Variance inflation factor-VIF), ο οποίος παρέχεται σε κάθε μεταβλητή και μας δείχνει πόσο αυξάνεται η διασπορά ενός εκτιμημένου συντελεστή παλινδρόμησης.

			Όταν υπάρχουν συσχετίσεις μεταξύ των επεξηγηματικών μεταβλητών. Τιμές του VIF > 5 θεωρούνται ως ένδειξη πολυσυγραμμικότητας. Για να μειωθεί το φαινόμενο της πολυσυγραμμικότητας αφαιρούμε από το μοντέλο τους μη σημαντικούς παράγοντες.

			
					Durbin-Watson: Για την πραγματοποίηση του ελέγχου Durbin-Watson προκειμένου να διαπιστωθεί η σειριακή συσχέτιση των σφαλμάτων (αυτοσυσχέτιση). Αυτοσυσχέτιση έχουμε όταν σε μια μεταβλητή οι μετρήσεις λαμβάνονται σειριακά κατά τον χρόνο και υπάρχει συσχέτιση μεταξύ των Yt και Yt-1, η μέτρηση στον χρόνο t σε σχέση με την προηγούμενη παρατήρηση. Η ύπαρξη αυτοσυσχέτισης ή serial correlation μεταξύ των παρατηρήσεων εξετάζεται με το Durbin-Watson test.	Αν d < dL ή d > 4-dL υπάρχει αυτοσυσχέτιση.
	Αν d < du ή d > 4-du δεν υπάρχει αυτοσυσχέτιση.
	Αλλιώς δεν μπορούμε να αποφανθούμε.



					Casewise Diagnostics: Για την πραγματοποίηση διαγνωστικών ελέγχων με βάση το κριτήριο επιλογής, όπως των ακραίων τιμών (τιμών μεγαλύτερων από προκαθορισμένο μέγεθος που προκύπτει από την προσθαφαίρεση των τυπικών αποκλίσεων). Στόχος είναι να εξεταστούν πιθανές ακραίες τιμές (outliers) και παρατηρήσεις υψηλής επίδρασης (influential-points). Μια ακραία τιμή (outliers) είναι μια ασυνήθιστη τιμή που δεν συμφωνεί με το pattern των υπόλοιπων δεδομένων. Μια παρατήρηση υψηλής επίδρασης μπορεί να είναι μια ακραία τιμή, αλλά, επίσης, μπορεί να είναι μια τιμή των δεδομένων που να έχει μεγάλη συνεισφορά στο σχηματισμό της ευθείας παλινδρόμησης. Το μέτρο που χρησιμοποιείται για την εύρεση της επιρροής μιας παρατήρησης στο μοντέλο είναι η Cook’s distance. Περισσότερα για την Cook’s distance βλ. στην ανάλυση των επιλογών του πλήκτρου Save.

			

			Από το πλήκτρο Plots μπορούμε πολύ αποτελεσματικά να εξετάσουμε αν ισχύουν οι υποθέσεις του μοντέλου, καθώς και να εξεταστεί η προσαρμογή του. Έτσι χρησιμοποιούμε γραφήματα των σφαλμάτων έναντι των προσαρμοσμένων τιμών (Yi) και μελετάμε τα patterns που εμφανίζουν. Ο λόγος που χρησιμοποιούμε γραφήματα των σφαλμάτων έναντι των προσαρμοσμένων τιμών (Yi) και όχι των παρατηρούμενων (Yi), είναι γιατί τα σφάλματα συσχετίζονται με τις παρατηρούμενες τιμές, ενώ με τις προσαρμοσμένες όχι.
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			Εικόνα 7.4: Το menu Linear Regression > Plots

			Ο χρήστης μπορεί να δηλώσει τη δημιουργία γραφημάτων διαφόρων συνδυασμών, αλλάζοντας τα στοιχεία των τεταγμένων Υ και Χ μέσω των πλήκτρων Next και Previous.
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			Εικόνα 7.5: Μοντέλα υπολοίπων ( πρότυπη γραφική παράσταση)

			Τα προβλήματα που μπορούν να ανιχνευθούν από τα γραφήματα των σφαλμάτων είναι:

			
					Η διασπορά να μην είναι σταθερή, δηλαδή να μην υπάρχει ομοσκεδαστικότητα. Στην περίπτωση αυτή το γράφημα συνήθως θα «ανοίγει σαν χωνί» (will funneling) καθώς τα Yi θα αυξάνονται.[image: 7.6]
Εικόνα 7.6: Μοντέλα σφαλμάτων με μη σταθερή διακύμανση


					Οι παρατηρήσεις να αποκλίνουν από το γραμμικό μοντέλο. Τότε θα υπάρχει ένα συστηματικό pattern των σφαλμάτων που θα υποδεικνύει τη χρήση επιπλέον όρων (τετραγωνικών ή πολυωνυμικών, curvilinear) στο μοντέλο παλινδρόμησης.[image: 7.7]
Εικόνα 7.7: Μοντέλα σφαλμάτων με μη γραμμικό μοντέλο


					Η ύπαρξη τάσης με την πάροδο του χρόνου. Τα σφάλματα τότε θα είναι «roughly» ανεξάρτητα. Όταν υπάρχει χρονική τάση ή άλλου είδους εξάρτηση στα δεδομένα, το μοντέλο δεν είναι ανεξάρτητο.
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			Εικόνα 7.8: Μοντέλα υπολοίπων με εξάρτηση μεταξύ των [image: ]

			Η υπόθεση της κανονικότητας εξετάζεται με έλεγχο της κανονικότητας των σφαλμάτων μέσω των ελέγχων Kolmogorov-Smirnov και Shapiro-Wilks, και γραφικά από τα διαγράμματα Q-Q και P-P plots (βλέπε ομώνυμες ενότητες). Η εφαρμογή έχει τη δυνατότητα να δημιουργήσει ιστόγραμμα, Q-Q και P-P plots των τυποποιημένων σφαλμάτων, από τις επιλογές Histogram και Normal Probability Plots, αντίστοιχα.

			Από το πλήκτρο Save μπορούμε να αποθηκεύσουμε τις εκτιμώμενες παρατηρήσεις, τα σφάλματα, και άλλα χρήσιμα στατιστικά για τους διαγνωστικούς ελέγχους του μοντέλου. Μέσω αυτών αντλούμε τα στοιχεία εκείνα που θα μας οδηγήσουν στην επιλογή του «βέλτιστου» μοντέλου.

			Σχετικά με τις εκτιμώμενες παρατηρήσεις Predicted Values έχουμε:

			
					Unstandardized: Η μη τυποποιημένη εκτιμώμενη παρατήρηση, δηλ. η τιμή που προβλέπει το μοντέλο για τις παρατηρήσεις των ανεξάρτητων μεταβλητών.

					Standardized: Οι τυποποιημένες εκτιμώμενες παρατηρήσεις, οι οποίες προκύπτουν μέσω μετασχηματισμού, όπου η μέση προβλεπόμενη τιμή αφαιρείται από την προβλεπόμενη τιμή, και η διαφορά διαιρείται με την τυπική απόκλιση των προβλεπόμενων τιμών. Οι τυποποιημένες προβλεπόμενες τιμές έχουν μέση τιμή μηδέν και τυπική απόκλιση ίση με τη μονάδα.

					Adjusted: Η προβλεπόμενη τιμή για μια παρατήρηση, κατά την οποία η παρατήρηση αυτή εξαιρείται από τον υπολογισμό των συντελεστών παλινδρόμησης.

					S.E. of mean predictions: Τα τυπικά σφάλματα των προβλεπόμενων τιμών (τα οποία αποτελούν και την τυπική απόκλιση της μέσης τιμής).
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			Εικόνα 7.9: Το menu Linear Regression > Save

			Σχετικά με τα σφάλματα (Residuals) έχουμε:

			
					Unstandardized: Η διαφορά μεταξύ μιας παρατήρησης και της εκτιμώμενης τιμής που προβλέπεται από το μοντέλο.
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			Εξίσωση 7.75

			
					Standardized: Τα τυποποιημένα σφάλματα είναι τα σφάλματα διαιρεμένα με την τυπική του απόκλιση αφού η μέση τιμή αυτών ισούται με μηδέν.
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			Εξίσωση 7.76

			
					Studentized: Το σφάλμα διαιρείται από μια εκτίμηση της τυπικής του απόκλισης, η οποία ποικίλλει από παρατήρηση σε παρατήρηση, αναλόγως της απόστασης μεταξύ της κάθε παρατήρησης της εξαρτημένης από τις μέσες τιμές των ανεξάρτητων μεταβλητών.
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			Εξίσωση 7.77

			
					Όπου hi είναι το i-οστό διαγώνιο στοιχείο (leverage) του πίνακα H = X(XT X)-1 XT (hat matrix) ri ~ tn- p-1 (για p-μεταβλητές).

			

			
					Deleted: Είναι μια τροποποίηση των τυποποιημένων σφαλμάτων σύμφωνα με την οποία χρησιμοποιείται μια εναλλακτική εκτιμήτρια της σ2, η οποία προκύπτει με την προσαρμογή του μοντέλου με όλες τις παρατηρήσεις εξαιρώντας την i-οστή παρατήρηση.
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			Εξίσωση 7.78

			Όπου S2(i) είναι η εκτιμήτρια της διασποράς σ2 που προκύπτει από την προσαρμογή του μοντέλου στις n-1 παρατηρήσεις, έχοντας δηλ. εξαιρέσει την i-οστή παρατήρηση.

			
					Studentized deleted: Τα deleted σφάλματα διαιρεμένα με το τυπικό τους σφάλμα. Η διαφορά μεταξύ των Studentized deleted και των Studentized σφαλμάτων υποδεικνύει πόση διαφορά εξαλείφει η παρατήρηση στην πρόβλεψή της.

			

			Οι επιλογές της ενότητας Distances έχουν ως σκοπό τον εντοπισμό περιπτώσεων με ασυνήθιστους συνδυασμούς παρατηρήσεων στις ανεξάρτητες μεταβλητές, όπου ενδέχεται να έχουν μεγάλο αντίκτυπο στο μοντέλο παλινδρόμησης. Αναλυτικά:

			
					Mahalanobis: Ένα μέτρο για την εξέταση του κατά πόσο οι τιμές μιας υπόθεσης σχετικά με τις ανεξάρτητες μεταβλητές διαφέρουν από το μέσο όρο του συνόλου των τιμών. Μεγάλες τιμές απόστασης Mahalanobis προσδιορίζουν ότι το αντικείμενο έχει ακραίες τιμές σε μία ή περισσότερες από τις ανεξάρτητες μεταβλητές.

					Cook’s: Όπως προαναφέραμε είναι το μέτρο που χρησιμοποιείται για την εύρεση της επιρροής μιας παρατήρησης στο μοντέλο. Αυτή η στατιστική συνάρτηση μετράει την αλλαγή στους συντελεστές παλινδρόμησης βi όταν η i-οστή παρατήρηση αφαιρείται από τα δεδομένα. Η στατιστική είναι ανάλογη ενός σταθμισμένου μέσου των τετραγωνικών διαφορών των βj και βj(-i) και εκφράζεται με όρους των studentized σφαλμάτων (ri) και των leverages (hi) από τον τύπο:
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			Εξίσωση 7.79

			Με άλλα λόγια, αν μια παρατήρηση είναι σημείο επιρροής τότε θα υπάρχει μια σημαντική διαφορά μεταξύ των τιμών των εκτιμώμενων συντελεστών παλινδρόμησης, αν αυτή η παρατήρηση απουσιάζει. Πρακτικά αν di > 1 προτείνεται περαιτέρω μελέτη της συγκεκριμένης παρατήρησης.

			
					Leverage values: Είναι οι τιμές της διαγώνιου (στοιχεία hii) του πίνακα προβολής H = X(X’ X)-1 X’ που ονομάζεται μόχλευση (leverage). Αν ένα σημείο έχει πολύ μεγάλη μόχλευση, τότε το σημείο αυτό επιδρά στην προσαρμογή της παλινδρόμησης ώστε η ευθεία παλινδρόμησης να περνά πολύ κοντά από το σημείο αυτό. Σημεία με μόχλευση hij > 2p/n θεωρούνται υποψήφια σημεία επιρροής και χρίζουν περαιτέρω εξέτασης.

			

			Στα διαστήματα εμπιστοσύνης Prediction Intervals παρέχονται τα άνω και κάτω όρια για τη μέση ή μεμονωμένη τιμή πρόβλεψης. Το ποσοστό του διαστήματος εμπιστοσύνης καθορίζεται στο πεδίο Confidence Interval.

			
					Mean: Χρησιμοποιείται για την εμφάνιση διαστήματος εμπιστοσύνης για τη μέση προβλεπόμενη τιμή.

					Individual: Χρησιμοποιείται για την εμφάνιση διαστήματος εμπιστοσύνης για την εξαρτημένη μεταβλητή σε μια και μοναδική περίπτωση.

			

			 Influence Statistics εκφράζουν την αλλαγή των συντελεστών παλινδρόμησης DfBeta(s) και των προβλεπόμενων τιμών (DfFit) που προκύπτουν από τον αποκλεισμό μιας συγκεκριμένης περίπτωσης. Αναλυτικά:

			
					DfBeta(s): Είναι η διαφορά στην τιμή του συντελεστή παλινδρόμησης B που προκύπτει από τον αποκλεισμό μιας συγκεκριμένης περίπτωσης από την ανάλυση παλινδρόμησης. Οι τιμές αυτές υπολογίζονται για όλους τους συντελεστές παλινδρόμησης του μοντέλου, συμπεριλαμβανομένου και του σταθερού όρου.

					Standardized DfBeta(s): Είναι η τυποποιημένη διαφορά στο συντελεστή παλινδρόμησης. Υπό εξέταση περιπτώσεις είναι αυτές με απόλυτη τιμή μεγαλύτερη του 2 / √Ν όπου Ν είναι ο αριθμός των περιπτώσεων.

					DfFit: Είναι η μεταβολή στην προβλεπόμενη τιμή που προκύπτει από τον αποκλεισμό μιας συγκεκριμένης περίπτωσης.

					Standardized DfFit: Είναι οι τυποποιημένες τιμές των παραπάνω διαφορών. Υπό εξέταση περιπτώσεις είναι αυτές με απόλυτη τιμή μεγαλύτερη του 2 √ρ/Ν όπου ρ είναι ο αριθμός των παραμέτρων στο μοντέλο και Ν είναι ο αριθμός των περιπτώσεων.

					Covariance Ratio: Είναι η αναλογία της ορίζουσας του πίνακα συνδιασποράς, όταν μια συγκεκριμένη περίπτωση εξαιρείται από τον υπολογισμό των συντελεστών παλινδρόμησης, με την ορίζουσα του πίνακα συνδιασποράς και όλες τις περιπτώσεις να περιλαμβάνονται στην ανάλυση. Αν η αναλογία είναι κοντά στο 1, συνεπάγεται ότι η περίπτωση αυτή δε μεταβάλλει σημαντικά τη μήτρα συνδιακύμανσης.

			

			Από το πλήκτρο Options παρέχονται οι επιλογές:

			
					Stepping Method Criteria: Στο σημείο αυτό ορίζεται ο τρόπος επιλογής για το αν μια μεταβλητή θα εισαχθεί ή θα αφαιρεθεί από το μοντέλο, όταν εκτελούνται οι αυτόματες διαδικασίες επιλογής μοντέλου (forward, backward ή stepwise). Ο χρήστης μπορεί είτε να ορίσει επίπεδα στατιστικής σημαντικότητας Use Probability of F είτε να δηλώσει απευθείας την τιμή του κριτηρίου F-test Use F Value. Έτσι, μια μεταβλητή θα εισαχθεί στο μοντέλο αν το επίπεδο σημαντικότητάς της είναι μικρότερο από την τιμή εισαγωγής (Entry) και θα αφαιρεθεί αν είναι μεγαλύτερο από την τιμή αποκλεισμού (Removal). Αντίστοιχα, θα εισαχθεί αν η τιμή του F-test είναι μεγαλύτερη από την τιμή του F-test κριτηρίου εισαγωγής, και θα αφαιρεθεί αν είναι μικρότερη από την τιμή αποκλεισμού.
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			Εικόνα 7.10: Το menu Linear Regression > Options

			
					Include constant in equation: Η παράμετρος είναι προεπιλεγμένη, έτσι ώστε στο μοντέλο παλινδρόμησης να συμπεριλαμβάνεται ο σταθερός όρος. Επιλέγοντας την παράμετρο αυτή θα πρέπει να έχουμε υπόψη ότι τα μοντέλα που θα προκύψουν δεν είναι συγκρίσιμα με ένα μοντέλο στο οποίο περιέχεται η σταθερά, καθώς για παράδειγμα ο συντελεστής προσδιορισμού R2 δεν μπορεί να ερμηνευτεί με τον συνήθη τρόπο.

			

			Τέλος, σε αυτή την ενότητα γίνεται και η διαχείριση των ελλειπουσών τιμών.

			Εφαρμογή παραδείγματος στο SPSS

			Χρησιμοποιήθηκε το αρχείο δεδομένων solar.sav (βλ. σύνοψη) όπου περιέχονται δεδομένα ηλιακής ενέργειας Ν = ٢٩ συλλεκτών. Στόχος είναι να μελετηθούν οι παράγοντες που επηρεάζουν το ύψος της συνολικής θερμικής ροής ανά τετραγωνικό μέτρο (Υ = kwatts/m2). Οι παράγοντες που μετρήθηκαν είναι:

			
					X1 – «Ηλιοφάνεια (watts/m2)»,

					X2 - «Ανατολική θέση ακτίνας (inches)»,

					X3 - «Νότια θέση ακτίνας (inches)»,

					X4 - «Βόρεια θέση ακτίνας (inches)»,

					X5 - «H ώρα της ημέρας (σε δεκαδική κλίμακα)».

			

			Η εισαγωγή των μεταβλητών εμφανίζεται στην Εικόνα 7.2. Στη συνέχεια γίνεται επιλογή των κατάλληλων μέτρων όπως αυτά περιγράφηκαν παραπάνω. Τέλος, η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε:
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			Εικόνα 7.11: Περιγραφικά μέτρα των μεταβλητών του μοντέλου
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			Εικόνα 7.12: Πίνακας Συσχετίσεων μεταξύ των παραγόντων

			Κάτω από τον συντελεστή συσχέτισης εμφανίζεται το p-value του ελέγχου σημαντικότητας της τιμής του συντελεστή, δηλ. η υπόθεση που εξετάζεται είναι αν οι δύο μεταβλητές είναι ασυσχέτιστες, ή όχι.
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			Εξίσωση 7.80

			Από τον πίνακα των συσχετίσεων διαπιστώνουμε στατιστικά σημαντική συσχέτιση σε επίπεδο 1% μεταξύ των παραγόντων:

			
					Χ1 - Χ4: «Ηλιοφάνεια (watts/m2)» και «Βόρεια θέση ακτίνας (inches)»,

					Χ1 - Χ5: «Ηλιοφάνεια (watts/m2)» και «Ώρα της ημέρας (σε δεκαδική κλίμακα)»,

					Χ3 - Χ5: «Νότια θέση ακτίνας (inches)» και «Ώρα της ημέρας (σε δεκαδική κλίμακα)»,

					Χ4 - Χ5: «Βόρεια θέση ακτίνας (inches)» και «Ώρα της ημέρας (σε δεκαδική κλίμακα)».

			

			Ειδικότερα ο παράγοντας «Ώρα της ημέρας» πιθανόν να πρέπει να αφαιρεθεί από το μοντέλο, καθώς όχι μόνο δεν είναι στατιστικά σημαντικός στο μοντέλο (T-test p-value = 0,199), αλλά επίσης έχει στατιστικά σημαντικές συσχετίσεις με 3 από τους υπόλοιπους 4 παράγοντες.

			Τα αποτελέσματα μπορούν να θεωρηθούν αναμενόμενα δεδομένου ότι ανάλογα με την πορεία του ήλιου εντός της ημέρας, άρα και μεταβολή της ώρας εντός της ημέρας, αλλάζει η θέση της ακτίνας του ήλιου και η έκταση/ένταση της ηλιοφάνειας.
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			Εικόνα 7.13: Πίνακας συντελεστών του μοντέλου

			Regression Equation

			Το μοντέλο που προσαρμόσαμε είναι το εξής:

			Συνολική Θερμική Ροή (kwatts/m2) = 324,6 + 0,067 Ηλιοφάνεια(watts/m2) + 2,56 Ανατολική (inches) + 3,82 Νότια (inches) - 22,93 Βόρεια (inches) + 2,39 Ώρα (σε δεκαδική κλίμακα).

			Για Δυτική θέση ακτίνας, χωρίς ηλιοφάνεια στις 00:00 (τα μεσάνυχτα), η συνολική θερμική ροή ανά τετραγωνικό μέτρο εκτιμάται κατά μέσο όρο κατά 324.6 kwatts/m2.

			Σε περίπτωση που η ακτίνα τοποθετηθεί Ανατολικά ο μέσος όρος της συνολικής θερμικής ροής αυξάνεται κατά 2,56 kwatts/m2 σε σχέση με το αν η ακτίνα παραμείνει σε Δυτική θέση. Εάν η ακτίνα τοποθετηθεί Νότια ή Βόρεια, η μεταβολή που εκτιμάται να προκύψει κατά μέσο όρο ανέρχεται σε αύξηση κατά 3,82 kwatts/m2 και μείωση κατά 22,93 kwatts/m2, αντίστοιχα.

			Επίσης για αύξηση της ηλιοφάνειας κατά 10 watts η συνολική θερμική ροή αναμένεται να αυξηθεί κατά 6,73 kwatts/m2. Τέλος, ομοίως η μεταβολή της ώρας της ημέρας κατά 1 ώρα αναμένεται να οδηγήσει κατά μέσο όρο σε αύξηση της συνολικής θερμικής ροής.

			Από τους ελέγχους T-test της ισότητας των συντελεστών του υποδείγματος με το μηδέν, προκύπτει ότι ο παράγοντας «Ώρα της ημέρας» δεν είναι στατιστικά σημαντικός στην ερμηνεία της συνολικής θερμικής ροής (p-value = 0,199 > 0,05) σε επίπεδο σημαντικότητας 5%, και οριακά ο παράγοντας «Ανατολική θέση της ακτίνας» (p-value = 0,052 > 0,05) σε επίπεδο σημαντικότητας 5%.
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			Εικόνα 7.14: ANOVA Table
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			Εικόνα 7.15: Περιγραφικά μέτρα των μεταβλητών του μοντέλου

			Το συγκεκριμένο υπόδειγμα έχει καλή προσαρμογή (F-test value = 40.77, p-value <0.000) και εξηγεί το 78,84% (R2adj = 78,84%) της μεταβλητότητας της συνολικής θερμικής ροής.
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			Εικόνα 7.16: Πίνακας διαγνωστικών πολυσυγραμμικότητας

			Τα μέτρα ελέγχου της πολυσυγραμμικότητας Ανοχή (tolerance) και VIF έχουν υπολογιστεί και παρουσιάζονται στον πίνακα των συντελεστών παλινδρόμησης. Τιμές του VIF > 5 θεωρούνται ως ένδειξη πολυσυγραμμικότητας. Από τα αποτελέσματα επιβεβαιώνουμε την προηγούμενη διαπίστωση ότι ο παράγοντας «Ώρα της ημέρας» δύναται να εξαιρεθεί από το μοντέλο της παλινδρόμησης.
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			Εικόνα 7.17: Πίνακας περιγραφικών μέτρων των προβλεπόμενων τιμών και των διαφόρων ειδών σφαλμάτων

			Έλεγχος Υπολοίπων
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			Εικόνα 7.18: Ιστόγραμμα για τον έλεγχο κανονικότητας των τυποποιημένων υπολοίπων
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			Εικόνα 7.19: P-P plot για τον έλεγχο κανονικότητας των τυποποιημένων υπολοίπων
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			Εικόνα 7.20: Έλεγχος ομοσκεδαστικότητας των τυποποιημένων υπολοίπων σε σχέση με τις εκτιμώμενες τιμές της εξαρτημένης μεταβλητής

			Διαπιστώνουμε ότι τα σφάλματα κατανέμονται με τυχαίο τρόπο, συνεπώς ισχύει και η υπόθεση της ομοσκεδαστικότητας.Για να κατασκευάζουμε την ευθεία παλινδρόμησης σε ένα διάγραμμα διασποράς μεταξύ των δύο μεταβλητών, π.χ. «Συνολική θερμική ροή» και «Ηλιοφάνεια», με διπλό κλικ πάνω στο γράφημα επιλέγουμε Chart editor > Elements > Fit line at Total.
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			Εικόνα 7.21: Προσαρμογή μοντέλου παλινδρόμησης μεταξύ της εξαρτημένης «Συνολική θερμική ροή» και της ανεξάρτητης «Ηλιοφάνεια»

			Στη συνέχεια έχοντας ορίσει την αποθήκευση τον αποστάσεων Cook, κατασκευάζουμε ένα διάγραμμα για τον έλεγχο ύπαρξης σημείων επιρροής. Από το διάγραμμα προκύπτει ότι η 4η παρατήρηση αποτελεί σημείο επιρροής.
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			Εικόνα 7.22: Αποστάσεις Cook για τον έλεγχο ύπαρξης σημείων επιρροής

			Γραφικές Παραστάσεις Πρόσθετων Μεταβλητών και Μερικών Υπολοίπων

			Για να εξετάσουμε αν υπάρχει η ανάγκη στο μοντέλο μας να εισαχθεί η μεταβλητή «Ώρα της Ημέρας» θα χρησιμοποιούμε το διάγραμμα πρόσθετων μεταβλητών (added variable plot) και μερικών υπολοίπων (partial residual plot).

			Υπενθυμίζουμε ότι οι παράγοντες που μετρήθηκαν είναι:

			
					X1 – «Ηλιοφάνεια (watts/m2)»,

					X2 - «Ανατολική θέση ακτίνας (inches)»,

					X3 - «Νότια θέση ακτίνας (inches)»,

					X4 - «Βόρεια θέση ακτίνας (inches)»,

					X5 - «H ώρα της ημέρας (σε δεκαδική κλίμακα)».

			

			Διάγραμμα Πρόσθετων Μεταβλητών

			Σ’ αυτή την τεχνική, στο πρώτο βήμα εφαρμόζουμε ένα μοντέλο πολλαπλής παλινδρόμησης της εξαρτημένης μεταβλητής σε σχέση με τις ανεξάρτητες Χ1-Χ4, και αποθηκεύουμε τα υπόλοιπα (RESI1). Στη συνέχεια εφαρμόζουμε πάλι ένα μοντέλο πολλαπλής παλινδρόμησης, όμως πλέον ως εξαρτημένη μεταβλητή θα δηλώσουμε τη μεταβλητή Χ5 και ως ανεξάρτητες τις υπόλοιπες Χ1-Χ4. Ομοίως από το μοντέλο αυτό αποθηκεύουμε τα υπόλοιπα (RESI2).

			Στη συνέχεια δημιουργούμε το διάγραμμα διασποράς των υπολοίπων των δύο παλινδρομήσεων. Από το διάγραμμα δεν παρατηρούμε ότι υπάρχει μια κάποια μορφή συσχέτισης. Συνεπώς η μεταβλητή Χ5 θα μπορούσε να αφαιρεθεί από το μοντέλο.
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			Εικόνα 7.23: Διάγραμμα πρόσθετων μεταβλητών για την ανεξάρτητη μεταβλητή «Ώρα της Ημέρας» (Χ5)

			Διάγραμμα Μερικών Υπολοίπων

			Σ’ αυτή την τεχνική, στο πρώτο βήμα εφαρμόζουμε ένα μοντέλο πολλαπλής παλινδρόμησης της εξαρτημένης μεταβλητής σε σχέση με όλες τις ανεξάρτητες Χ1-Χ5, και αποθηκεύουμε τα υπόλοιπα (RESI3). Από την προσαρμογή του μοντέλου κρατάμε τον συντελεστή παλινδρόμησης της μεταβλητής που εξετάζουμε:
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			Εξίσωση 7.81

			Στη συνέχεια δημιουργούμε τα μερικά υπόλοιπα (RESI4) από τη σχέση: RESI4 = RESI3 + (2,39 * Χ5). Στη συνέχεια δημιουργούμε το διάγραμμα διασποράς των μερικών υπολοίπων σε σχέση με τις παρατηρήσεις της υπό εξέταση μεταβλητής (Χ5).
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			Εικόνα 7.24: Διάγραμμα μερικών υπολοίπων για την ανεξάρτητη μεταβλητή «Ώρα της Ημέρας» (Χ5)

			7.2 Λογιστική Παλινδρόμηση (Logistic Regression)

			Στη λογιστική παλινδρόμηση η εξαρτημένη μεταβλητή είναι κατηγορική και δίτιμη. Για αυτήν εξετάζουμε την πιθανότητα (τα ποσοστά) εμφάνισης των δύο κατηγοριών σε σχέση με τις ανεξάρτητες μεταβλητές - παράγοντες. Επειδή σκοπός είναι να εκτιμηθεί η πιθανότητα εμφάνισης ενός συμβάντος, συνεπάγεται ότι οι τιμές που θα πρέπει να προκύπτουν από το γραμμικό υπόδειγμα περιέχονται στο διάστημα [0,1].

			Για τον λόγο αυτό υποθέτουμε ότι η μεταβλητή ακολουθεί διωνυμική κατανομή και ότι η σύνδεση της πιθανότητας εμφάνισης του γεγονότος pi συνδέεται με το γραμμικό υπόδειγμα μέσω της link function:
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			Εξίσωση 7.82

			Όπου:
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			Εξίσωση 7.83

			Ο λογάριθμος του λόγου σχετικής πιθανότητας. Απολογαριθμίζοντας προκύπτει ότι η πιθανότητα της κατηγορίας της εξαρτημένης μεταβλητής θα είναι:
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			Εξίσωση 7.84

			Στο μοντέλο της λογιστικής παλινδρόμησης η εκτίμηση των συντελεστών πραγματοποιείται με τη μέθοδο μέγιστης πιθανοφάνειας (maximum likelihood method) αντί της μεθόδου ελαχίστων τετραγώνων.

			Η ερμηνεία τους, όμως, δεν προκύπτει με τον ίδιο τρόπο όπως στη γραμμική παλινδρόμησης, και θα πρέπει να γίνει τροποποίηση, ώστε να εκφραστούν με την κατάλληλη μορφή, δηλ. eβ. Τα περισσότερα προγράμματα στον πίνακα των συντελεστών εμφανίζουν και την σχέση eβ. Κάθε συντελεστής εκφράζει τη μεταβολή του λογαρίθμου της σχετικής πιθανότητας (Εξίσωση 7.83) για μια μονάδα αύξησης της ανεξάρτητης μεταβλητής.

			Έστω ότι έχουμε ένα μοντέλο με μια ανεξάρτητη δίτιμη μεταβλητή (π.χ. το φύλο όπου 0 = γυναίκες και 1 = άνδρες). Οπότε έχουμε:
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			Εξίσωση 7.85

			Είναι η σχετική πιθανότητα πραγματοποίησης του συμβάντος στους άνδρες, και:
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			Εξίσωση 7.86

			Είναι η σχετική πιθανότητα πραγματοποίησης του συμβάντος στις γυναίκες. Διαιρώντας τα δύο μέλη λαμβάνουμε τον λόγο συμπληρωματικών πιθανοτήτων (odds ratio) πραγματοποίησης του συμβάντος των ανδρών προς την πραγματοποίηση του συμβάντος των γυναικών, δηλ.:
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			Εξίσωση 7.87

			Όπως και στη γραμμική παλινδρόμηση, ομοίως οι συντελεστές του μοντέλου, οι οποίοι αποτελούν σημειακές εκτιμήσεις, υπόκεινται σε έλεγχο για τη σημαντικότητά τους στο μοντέλο. Δηλαδή η υπόθεση που εξετάζεται είναι η:
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			Εξίσωση 7.88

			Ο έλεγχος γίνεται σε (1-α)% επίπεδο σημαντικότητας και η στατιστική συνάρτηση υπό την H0 είναι η:
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			Εξίσωση 7.89

			Η οποία καλείται Wald, ακολουθεί ασυμπτωτικά την κανονική κατανομή, ενώ το τετράγωνο αυτής ακολουθεί την X2-κατανομή με 1 βαθμό ελευθερίας. Η υπόθεση απορρίπτεται αν η τιμή του ελέγχου είναι μεγαλύτερη από X21;α/2.

			Η σύγκριση μοντέλων με σκοπό την επιλογή βέλτιστου μοντέλου, πραγματοποιείται με τη βοήθεια της ελεγχοσυνάρτησης Deviance (που στην ουσία είναι ένα likelihood ratio test) η οποία ορίζεται ως:
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			Εξίσωση 7.90

			Όπου:
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			Η λογαριθμοποιημένη συνάρτηση πιθανοφάνειας του μοντέλου 2.
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			H λογαριθμοποιημένη συνάρτηση πιθανοφάνειας του μοντέλου 1. Επίσης το μοντέλο 2 είναι υποσύνολο (nested) του μοντέλου 1, και ακολουθεί την X2 κατανομή με k-p-1 βαθμούς ελευθερίας.

			Έστω ότι θέλουμε να εξετάσουμε την πιθανότητα επιβίωσης του οδηγού σε ένα τροχαίο ατύχημα, σε σχέση με τους παράγοντες «Ηλικία Οδηγού», «Ταχύτητα Οχήματος» και «Επιτάχυνση Οχήματος». Η δυνατότητα προσφέρεται από την επιλογή Analyze > Regression > Binary Logistic.
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			Εικόνα 7.25: Το menu Logistic Regression

			Στο πλαίσιο Dependent ορίζουμε την εξαρτημένη δίτιμη μεταβλητή, και στο πλαίσιο Covariates εισάγουμε τους προς εξέταση παράγοντες. Στη συνέχεια στο πεδίο Method επιλέγουμε τη μέθοδο επιλογής του βέλτιστου μοντέλου. Οι δυνατές επιλογές είναι:

			
					Enter: Μ’ αυτή την μέθοδο εισάγονται στο μοντέλο όλες οι μεταβλητές ανεξάρτητα από το αν είναι στατιστικά σημαντικές σε σχέση με την εξαρτημένη μεταβλητή.

					Forward Selection (Conditional): Είναι μια διαδικασία στην οποία οι μεταβλητές εισέρχονται σταδιακά στο μοντέλο. Ο έλεγχος για την εισαγωγή μιας μεταβλητής βασίζεται στη στατιστική σημαντικότητα της μεταβλητής, και ο έλεγχος για την αφαίρεση μιας μεταβλητής βασίζεται στην πιθανότητα του λόγου πιθανοφάνειας βασιζόμενου στην υπό συνθήκη εκτίμηση των παραμέτρων.

					Forward Selection (Likelihood Ratio): Είναι μια διαδικασία στην οποία οι μεταβλητές εισέρχονται σταδιακά στο μοντέλο. Ο έλεγχος για την εισαγωγή μιας μεταβλητής βασίζεται στη στατιστική σημαντικότητα της μεταβλητής, και ο έλεγχος για την αφαίρεση μιας μεταβλητής βασίζεται στην πιθανότητα του λόγου πιθανοφάνειας βασιζόμενου στην εκτίμηση της μέγιστης μερικής πιθανοφάνειας.

					Forward Selection (Wald): Είναι μια διαδικασία στην οποία οι μεταβλητές εισέρχονται σταδιακά στο μοντέλο. Ο έλεγχος για την εισαγωγή μιας μεταβλητής βασίζεται στη στατιστική σημαντικότητα της μεταβλητής, και ο έλεγχος για την αφαίρεση μιας μεταβλητής βασίζεται στην πιθανότητα της στατιστικής Wald.

					Backward Elimination (Conditional): Είναι μια διαδικασία στην οποία οι μεταβλητές αφαιρούνται σταδιακά από το μοντέλο. Ο έλεγχος για την αφαίρεση μιας μεταβλητής βασίζεται στην πιθανότητα του λόγου πιθανοφανειών υπολογισμένου με βάση την υπό συνθήκη εκτίμηση των παραμέτρων.

					Backward Elimination (Likelihood Ratio): Είναι μια διαδικασία στην οποία οι μεταβλητές αφαιρούνται σταδιακά από το μοντέλο. Ο έλεγχος για την αφαίρεση μιας μεταβλητής βασίζεται στην πιθανότητα του λόγου πιθανοφανειών υπολογισμένου με βάση την εκτίμηση της μέγιστης μερικής πιθανοφάνειας.

					Backward Elimination (Wald): Είναι μια διαδικασία στην οποία οι μεταβλητές αφαιρούνται σταδιακά από το μοντέλο. Ο έλεγχος για την αφαίρεση μιας μεταβλητής είναι βασισμένος στην πιθανότητα της στατιστικής Wald.

			

			Στο πλαίσιο Selection Variable μπορούμε να ορίσουμε μια μεταβλητή καθώς και τη συνθήκη μέσω της οποίας θα απομονώσουμε το υποσύνολο των δεδομένων στο οποίο επιθυμούμε να εφαρμόσουμε την παλινδρόμηση.

			Από το πλήκτρο Categorical ορίζουμε τις κατηγορικές μεταβλητές του μοντέλου με σκοπό τη δημιουργία ψευδομεταβλητών. Όμως, και οι τρεις ανεξάρτητες μεταβλητές είναι συνεχείς, συνεπώς δεν απαιτείται ούτε η δημιουργία ψευδομεταβλητών ούτε κάποια αλλαγή στην κωδικοποίηση των δεδομένων. Ωστόσο, να αναφέρουμε ότι αν για παράδειγμα η μεταβλητή «Ταχύτητα» (velocity) είχε μετατραπεί σε κατηγορική με περισσότερες από δύο κατηγορίες, τότε θα έπρεπε για την εισαγωγή της στο μοντέλο να οριστούν οι αντίστοιχες δείκτριες κατηγορικές, μεταφέροντας τη μεταβλητή στο πλαίσιο Categorical Covariates και επιλέγοντας Contrast = Indicator.
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			Εικόνα 7.26: Το menu Logistic Regression > Define Categorical Variables

			Αναλυτικότερα οι δυνατές επιλογές που προσφέρονται από την εφαρμογή είναι:

			
					Indicator: Με την επιλογή αυτή γίνεται επανακωδικοποίηση της κατηγορικής, δημιουργώντας ψευδομεταβλητές-δείκτες, όπου θα δηλώνει την παρουσία με την τιμή 1 και την απουσία της κατηγορίας με την τιμή 0. Προφανώς για την εισαγωγή μιας κατηγορικής με k κατηγορίες, απαιτούνται k-1 δείκτες. Έτσι η σχετική πιθανότητα της παρουσίας της κάθε κατηγορίας θα συγκρίνεται με τη σχετική πιθανότητα της κατηγορίας αναφοράς.

					Simple: Μ’ αυτή την επιλογή ομοίως δημιουργούνται ψευδομεταβλητές-δείκτες, όμως αλλάζει ο τρόπος κωδικοποίησης της κατηγορίας αναφοράς. Ομοίως κάθε κατηγορία της ανεξάρτητης μεταβλητής (εκτός από την κατηγορία αναφοράς) θα συγκρίνεται με την κατηγορία αναφοράς.

					Difference: Μ’ αυτή την επιλογή, κάθε κατηγορία της ανεξάρτητης μεταβλητής εκτός από την πρώτη κατηγορία, θα συγκρίνεται με τη μέση σχετική πιθανότητα των προηγούμενων κατηγοριών. Η μέθοδος είναι επίσης γνωστή με την ονομασία αντίστροφη Helmert.

					Helmert: Μ’ αυτή την επιλογή, κάθε κατηγορία της ανεξάρτητης μεταβλητής εκτός από την τελευταία κατηγορία, θα συγκρίνεται με τη μέση σχετική πιθανότητα των μεταγενέστερων κατηγοριών.

					Repeated: Μ’ αυτή την επιλογή, η σχετική πιθανότητα κάθε κατηγορίας της ανεξάρτητης μεταβλητής εκτός από την πρώτη κατηγορία, θα συγκρίνεται με την κατηγορία που προηγήθηκε.

					Polynomial: Χρησιμοποιήθηκε για τη δημιουργία ορθογώνιων πολυωνυμικών αντιθέσεων, με σκοπό ελέγχους γραμμικής φύσεως, όπου οι κατηγορίες υποτίθεται ότι ισαπέχουν, ελέγχοντας αν υπάρχουν γραμμικού τύπου μεταβολές στη σχετική πιθανότητα. Πολυωνυμικές αντιθέσεις παρέχονται μόνο για συνεχείς μεταβλητές.

					Deviation: Μ’ αυτή την επιλογή κάθε κατηγορία της ανεξάρτητης μεταβλητής εκτός από την κατηγορία αναφοράς θα συγκρίνεται με τη συνολική σχετική πιθανότητα.

			

			Σημεία προσοχής

			Αν επιλεγούν Deviation, Simple, ή Indicator, θα πρέπει επίσης να οριστεί αν ως κατηγορία αναφοράς θα είναι η πρώτη (First) ή η τελευταία (Last) κατηγορία στην επιλογή Reference Category.

			Από το πλήκτρο Save μπορούμε να αποθηκεύσουμε ως νέες μεταβλητές τις εκτιμώμενες παρατηρήσεις, τα σφάλματα, και άλλα χρήσιμα στατιστικά για τα διαγνωστικά του μοντέλου. Μέσω αυτών αντλούμε τα στοιχεία εκείνα που θα μας οδηγήσουν στην επιλογή του «βέλτιστου» μοντέλου.
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			Εικόνα 7.27: Το menu Logistic Regression > Save

			Σχετικά με τις εκτιμώμενες παρατηρήσεις (Predicted Values) έχουμε:

			
					Probabilities: Για κάθε παρατήρηση εκτιμάται η προβλεπόμενη πιθανότητα εμφάνισης του συμβάντος. Το πρόγραμμα λαμβάνει ως συμβάν την κατηγορία με την υψηλότερη τιμή κωδικοποίησης.

					Predicted Group membership: Είναι ο κωδικός της κατηγορίας της εξαρτημένης μεταβλητής, στην οποία θα έπρεπε να ανήκει η κάθε παρατήρηση βασιζόμενη σε διαχωριστική ανάλυση.

			

			Για την εύρεση σημείων επιρροής (Influence) έχουμε:

			
					Cook’s: Ένα μέτρο ανάλογο της γραμμικής παλινδρόμησης, που δείχνει το κατά πόσο τα σφάλματα όλων των παρατηρήσεων θα αλλάξουν αν η συγκεκριμένη παρατήρηση αποκλειστεί από τον υπολογισμό των συντελεστών παλινδρόμησης.

					Leverage Values: Η σχετική επίδραση της κάθε παρατήρησης στην προσαρμογή του μοντέλου.

					DfBeta(s): Υπολογίζεται η διαφορά στους συντελεστές παλινδρόμησης από τον αποκλεισμό μιας συγκεκριμένης παρατήρησης από την παλινδρόμηση. Οι διαφορές υπολογίζονται για όλους τους όρους του μοντέλου, συμπεριλαμβανομένου και του σταθερού όρου.

			

			Για την εκτίμηση των σφαλμάτων (Residuals) έχουμε:

			
					Unstandardized Residuals: Μη τυποποιημένα σφάλματα, δηλ. η διαφορά μεταξύ μιας παρατήρησης και της εκτιμώμενης τιμής από το μοντέλο.

			

			
					Logit Residual: Είναι τα σφάλματα που προκύπτουν αν τα μη τυποποιημένα σφάλματα διαιρεθούν με το γινόμενο p(1-p), όπου p η προβλεπόμενη πιθανότητα.

			

			
					Studentized Residual: Είναι η μεταβολή στη deviance του μοντέλου, αν η παρατήρηση εξαιρεθεί από την ανάλυση.

					Standardized Residuals: Είναι τα τυποποιημένα σφάλματα, ή αλλιώς σφάλματα Pearson, δηλαδή τα μη τυποποιημένα σφάλματα διαιρεμένα με την εκτίμηση της τυπικής τους απόκλισης.
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			Εξίσωση 7.91

			
					Deviance: σφάλματα βασιζόμενα στην deviance του μοντέλου.
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			Εικόνα 7.28: Το menu Logistic Regression > Options

			Πρόσθετα στατιστικά που προσφέρονται μέσω του πλήκτρου Options.

			
					Classification plots: Για την εμφάνιση γραφήματος ταξινόμησης των παρατηρήσεων.

					Hosmer-Lemeshow goodness-of-fit: Είναι ένα μέτρο καλής προσαρμογής του μοντέλου, πιο ισχυρό από τη συνήθη στατιστική καλής προσαρμογής (goodness-of-fit), ειδικότερα για μοντέλα με συνεχείς συμεταβλητές και μικρό μέγεθος δεδομένων. Βασίζεται στην ομαδοποίηση των παρατηρήσεων σε δεκατημόρια κινδύνου και στη σύγκριση της παρατηρούμενης με την εκτιμώμενη πιθανότητα σε κάθε δεκατημόριο.

					Correlations of estimates: Συσχετίσεις των εκτιμήσεων.

					CI for exp(B): Την εμφάνιση διαστημάτων εμπιστοσύνης της σχέσης eβι.

			

			Τα παραπάνω δύναται να εμφανιστούν είτε σε κάθε στάδιο της ανάλυσης (At each step) είτε μόνο στο τελικό μοντέλο (At last step).

			
					Probability for Stepwise: Σ’ αυτό το σημείο ορίζονται τα κριτήρια εισόδου ή εξόδου μιας μεταβλητής στο μοντέλο, όταν εκτελούνται οι αυτόματες διαδικασίες επιλογής μοντέλου (forward, backward ή stepwise). Έτσι, μια μεταβλητή θα εισαχθεί στο μοντέλο αν το επίπεδο σημαντικότητάς της (με βάση το αντίστοιχο κριτήριο εισαγωγής, π.χ. likelihood ratio statistic) είναι μικρότερο από την τιμή εισαγωγής (Entry), και θα αφαιρεθεί αν είναι μεγαλύτερο από την τιμή αποκλεισμού (Removal).

					Classification cutoff: Στο σημείο αυτό ορίζεται η τιμή της πιθανότητας με την οποία θα γίνει ο διαχωρισμός / ταξινόμηση των παρατηρήσεων. Παρατηρήσεις των οποίων η προβλεπόμενη πιθανότητα που υπερβαίνει τη δηλωθείσα τιμή χαρακτηρίζεται ως θετική, αλλιώς ως αρνητική.

					Maximum Iterations: Ορίζεται το πλήθος των επαναλήψεων του αλγορίθμου που εκτιμά τους συντελεστές του μοντέλου.

					Include constant in model: Είναι προεπιλεγμένη παράμετρος προκειμένου στο μοντέλο να περιέχεται και ο σταθερός όρος.

			

			Χρησιμοποιήθηκε το αρχείο δεδομένων carcrash.sav (βλ. σύνοψη) όπου περιέχονται δεδομένα ηλιακής ενέργειας Ν = ٥٨ παρατηρήσεων. Έτσι εφαρμόζοντας τη διαδικασία λαμβάνουμε:
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			Εικόνα 7.29: Πλήθος δεδομένων

			Ο πίνακας αποτυπώνει το πλήθος των έγκυρων και των ελλειπουσών τιμών. Εάν σε κάποια εκ των ανεξάρτητων μεταβλητών υπάρχει ελλείπουσα παρατήρηση τότε η περίπτωση αυτή εξαιρείται από την ανάλυση. Είναι σημαντικό να γίνεται έλεγχος του πλήθους των ελλειπουσών τιμών καθώς η ύπαρξή τους μειώνει το μέγεθος του δείγματος στην ανάλυση.
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			Εικόνα 7.30: Εσωτερική κωδικοποίηση της εξαρτημένης μεταβλητής

			Ο πίνακας μας δείχνει την εσωτερική κωδικοποίηση των τιμών της δίτιμης εξαρτημένης μεταβλητής. Στην περίπτωσή μας η μεταβλητή είχε εξ αρχής κωδικοποιηθεί με τις τιμές 0 και 1, όπου σύμφωνα και με την παραμετροποίηση στο πλήκτρο Categorical > Reference Category, 0 σημαίνει την απουσία του συμβάντος (θάνατος) και 1 σημαίνει την εμφάνιση του συμβάντος.
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			Εικόνα 7.31: Περιγραφικά μέτρα των ανεξάρτητων μεταβλητών

			Η ηλικία των οδηγών κυμαίνεται από 19-65 με μέση ηλικία 40 ετών, οι οποίοι οδηγούσαν με ταχύτητα από 40 - 61 km/h και μέση ταχύτητα τα 50 km/h, ενώ η επιτάχυνση κυμαίνεται από 58-268 m/sec2, με μέση επιτάχυνση 123 m/sec2.
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			Εικόνα 7.32: Πίνακας των συντελεστών παλινδρόμησης του μοντέλου

			Το μοντέλο που προσαρμόστηκε είναι το:
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			Εξίσωση 7.92

			Από το μοντέλο προκύπτει ότι:

			
					Αύξηση της ηλικίας κατά 1 έτος αναμένεται να αυξήσει κατά 18,6% την πιθανότητα αποβίωσης. Η αύξηση στο odds ratio υπολογίζεται από τη σχέση (1,186 - 1 ) * 100 = 18,6%. Εκφράζοντας διαφορετικά το αποτέλεσμα έχουμε ότι σε αύξηση της ηλικίας κατά μια δεκαετία (πολλαπλασιάζουμε τον συντελεστή παλινδρόμησης επί 10 και απολογαριθμούμε), η πιθανότητα αποβίωσης του οδηγού είναι 5,53 φορές μεγαλύτερη από την πιθανότητα επιβίωσης.

					Σε αύξηση της ταχύτητας κατά 10 km/h, η πιθανότητα αποβίωσης θα είναι 4,3 φορές μεγαλύτερη από την πιθανότητα επιβίωσης.

					Σε αύξηση της επιτάχυνσης κατά 10 m/sec2, η πιθανότητα αποβίωσης θα είναι 1,173 φορές μεγαλύτερη από την πιθανότητα επιβίωσης.

			

			Ωστόσο, από τα παραπάνω μόνο η ηλικία προκύπτει στατιστικά σημαντική για την πιθανότητα αποβίωσης (p-value < 0,001) σύμφωνα με τον έλεγχο Wald. Στις τελευταίες θέσεις του πίνακα προσφέρονται και τα διαστήματα εμπιστοσύνης των odds ratio.
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			Εικόνα 7.33: Συντελεστές Προσδιορισμού και λογαριθμο-πιθανοφάνεια

			Από τον συντελεστή προσδιορισμού του Nagelkerke R έχουμε ότι περίπου το 61% της μεταβλητότητας της εξαρτημένης μεταβλητής ερμηνεύεται από τις ανεξάρτητες μεταβλητές του μοντέλου.

			[image: ]

			Εικόνα 7.34: Ακρίβεια πρόβλεψης του μοντέλου

			Η συνολική ακρίβεια του μοντέλου να προβλέψει αν ένα άτομο που θα εμπλακεί σε ατύχημα, θα πεθάνει ή όχι είναι 82,8%. Από τον παραπάνω πίνακα μπορούμε επίσης να λάβουμε την ευαισθησία 30/34 = 88,2% και την ειδικότητα 18/24=75%. Η θετική διαγνωστική αξία (PPV-Positive Predictive Value) μπορεί να υπολογιστεί από τη σχέση 30/36=83,3% και η αρνητική διαγνωστική αξία (NPV-Negative Predictive Value) από τη σχέση 18/22=81,8%.

			Στην περίπτωση που έχουμε μια νέα υπόθεση, τότε έχοντας τις τιμές του ατόμου στις ανεξάρτητες μεταβλητές, μπορούμε να προβλέψουμε τι θα συμβεί μέσω του μοντέλου που εκτιμήθηκε. Τα παραπάνω προέκυψαν έχοντας ως σημείο διαχωρισμού (cutoff) την προεπιλεγμένη τιμή 0,5 για την οποία προκύπτουν καλά αποτελέσματα. Θα μπορούσαμε όμως να αλλάξουμε το σημείο διαχωρισμού δηλώνοντας όπως είπαμε μια διαφορετική τιμή στο ομώνυμο πεδίο του πλήκτρου Options.
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			Εικόνα 7.35: Αποτελέσματα ελέγχου καλής προσαρμογής

			Ο έλεγχος των Hosmer-Lemeshow είναι ένα στατιστικό τεστ καλής προσαρμογής για μοντέλα λογιστικής παλινδρόμησης, το οποίο αξιολογεί κατά πόσο οι παρατηρούμενες τιμές του λόγου πιθανότητας του γεγονότος (συμβάντος) συμφωνούν με τους αναμενόμενους λόγους σε υποομάδες του πληθυσμού του μοντέλου. Από τον έλεγχο συμπεραίνουμε καλή προσαρμογή του μοντέλου.
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			Εικόνα 7.36: Αποστάσεις Cook για τον έλεγχο πιθανών σημείων επιρροής.

			Όλες οι αποστάσεις Cook είναι μικρότερες της μονάδας, συνεπώς δεν διαπιστώνεται η ύπαρξη σημείων επιρροής.
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			Εικόνα 7.37: Leverage αποστάσεις για τον έλεγχο πιθανών ακραίων παρατηρήσεων

			Από το γράφημα διαπιστώνουμε την ύπαρξη μερικών πιθανών ακραίων παρατηρήσεων:
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			Εξίσωση 7.93
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			Εικόνα 7.38: Πίνακας συσχετίσεων για τον έλεγχο πολυσυγραμμικότητας στο μοντέλο

			Από τον πίνακα των συντελεστών συσχέτισης του μοντέλου διαπιστώνουμε μια κάπως υψηλή συσχέτιση μεταξύ «Ταχύτητας» και «Επιτάχυνσης», συνεπώς ενδεχομένως να υπάρχει πολυσυγγραμμικότητα. Ομοίως και μεταξύ της «Ηλικίας» και της «Ταχύτητας» σε σχέση με τη σταθερά.

			ROC Curve

			Ένα μέτρο για τον έλεγχο καλής προσαρμογής που χρησιμοποιείται συχνά στη λογιστική παλινδρόμηση είναι η καμπύλη λειτουργικού χαρακτηριστικού δείκτη (ROC-Receiver Operating Characteristic).

			Η καμπύλη δημιουργείται με τη γραφική αναπαράσταση του πραγματικού θετικού ποσοστού (TPR-True Positive Rate), έναντι του ποσοστού ψευδών θετικών (FPR-False Positive Rate) σε διάφορα σημεία διαχωρισμού. Το πραγματικό θετικό ποσοστό είναι επίσης γνωστό ως «ευαισθησία», ενώ το ψευδώς θετικό ποσοστό είναι γνωστό ως 1-ειδικότητα (se-sensitivity), όπου ως ειδικότητα (sp-specificity) ορίζεται το πραγματικά αρνητικό ποσοστό. Η καμπύλη ROC είναι συνεπώς η se σε σχέση με την 1-sp.

			Η δυνατότητα προσφέρεται από την επιλογή Analyze > ROC Curve.

			Στο πεδίο Test Variable εισάγουμε τις προβλεπόμενες πιθανότητες που δημιουργήθηκαν ως νέα μεταβλητή μέσα από το πλήκτρο Save > Probabilities κατά την εκτέλεση της λογιστικής παλινδρόμησης. Στο πεδίο State Variable εισάγουμε την κατηγορική (εξαρτημένη) μεταβλητή, δηλαδή τη μεταβλητή που δείχνει την πραγματική κατηγορία στην οποία ανήκει το άτομο, και στο πεδίο Value of State Variable την τιμή που αντιπροσωπεύει την παρουσία του συμβάντος.
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			Εικόνα 7.39: Το menu ROC Curve

			Επιπροσθέτως, μπορούμε να επιλέξουμε την εμφάνιση της διαγώνιας ευθείας With diagonal reference line, του τυπικού σφάλματος της εκτίμησης του εμβαδού κάτω από την καμπύλη καθώς και διάστημα εμπιστοσύνης της εκτίμησης του Standard error and confidence interval.

			Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ όπου και λαμβάνουμε:
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			Εικόνα 7.40: Καμπύλη ROC (Receiver Operating Characteristic curve)

			[image: ]

			Εικόνα 7.41: Περιοχή κάτω από την καμπύλη (Area Under Curve)

			Η περιοχή κάτω από την καμπύλη (area under curve) αντιπροσωπεύει την πιθανότητα ένας διαγνωστικός έλεγχος να διαχωρίσει ορθά ένα τυχαίο ζεύγος ενός ατόμου με την παρουσία του συμβάντος, και ενός ατόμου με την απουσία του συμβάντος. Λαμβάνει τιμές από 0 έως 1, και όσο μεγαλύτερη είναι η τιμή του εμβαδού κάτω από την καμπύλη, τόσο μεγαλύτερη είναι η ακρίβεια του διαγνωστικού ελέγχου.

			
					Για τιμές 0,90-1 > Εξαιρετικό διαχωρισμό.

					Για τιμές 0,80-0,90 > Καλό διαχωρισμό.

					Για τιμές 0,70-0,80 > Σχετικά καλό διαχωρισμό.

					Για τιμές 0,60-0,70 > Φτωχό διαχωρισμό.

					Για τιμές 0,50-0,60 > Τότε ο διαγνωστικός έλεγχος αποτυγχάνει να κάνει ορθό διαχωρισμό.

					Για τιμές από 0-0,5 > Ο διαχωρισμός λειτουργεί προς την αντίθετη κατεύθυνση.

			

			Η 3η στήλη του πίνακα περιέχει τις p-value για τον έλεγχο της μη καλής ορθής ταξινόμησης του διαγνωστικού ελέγχου, ενώ η 4η και η 5η στήλη μας δίνουν το 95% διάστημα εμπιστοσύνης για την πραγματική τιμή του εμβαδού κάτω από την καμπύλη.
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For example, the variable may be widih. Ifitis recorded in three separate measurements, each
one representing a different point in ime—w1, w2, and w3, then the data are aanged in a group.
ofvariables.
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®[ne (for example, wi, w2, and wa)|

© More than one (for example, w1, w2, w3 and 1, h2, 13, etc)






OEBPS/image/7.33.png
Model Summary

Step “2lop Co&Snell R | Nagelkerke R
likelihood Square Square
1 435767 450 606

a. Estimation terminated at eration number &
because parameter estimates changed by less than

i






OEBPS/image/Image3063.png





OEBPS/image/Image3020.png
SSR:SS(ﬁ])+SS(ﬁ2 |ﬁl)+"'+SS(ﬁp71 |:Bl aaaaa :Bpfz)





OEBPS/image/Image3098.png
Yie ™ N(,ul.j,az)





OEBPS/image/Image2479.png
T = —'Bl ~
s.e(f,)





OEBPS/image/2.15.png
500-1.000

1.001-1.500

1.501-2.000

Avo Tov 2.000






OEBPS/image/7.41.png
Test Result Variable(s) Predicted probabiliy

Area Under the Curve

‘Asymptolic 85% Confidence

interval
Asymptotic

area | st Enor? Sig® LowerBound | Upper Bound

905 04 000 23 989

The fest resul vaniable(s): Predicted probabily has af [sast one fie between

the posilive actual state Group and the negative actual state group. Statistics
may be biased.

a Under the nonparametric assumption
b Null hypothesis: true area

5






OEBPS/image/Image3691.png
D=-2{,-1I)





OEBPS/image/3.9.png
[ Sort Cases

& CountryType [Co. E
& Totalfertilty at 19.

& Life expectancy at.

Aoy 2 . [ rompapmonao]

# e swscancy at. Sortorder

£ mameaneme O
Pupit and sude.

& Suentsnterar © Descending

& Linemnlovment

@@@@W






OEBPS/image/Image2855.png
nse Sets T T N———
[ Define Multple Response Sets |t

-— e
Setpemton Wulie Response Ses
Varies n set
CER = il pinakas
& tipe. ol com
puter
oo ot
primerstle teamwork
& primerpostion @ i
& picprosimo
& picstyle
& PrpicPROSINO
& A1 =

Variables Are Coded As
© Dienotomes counedvatue: ;]

O Categories

Name: [Lassans ]
o | \

Note: Sets defined here are only available in the Multiple Response Frequencies and Crosstabs
procedures. Use Define Multiple Response Sets on the Data menu for sets used elsewhere.

(cse) (vep )






OEBPS/image/Image2529.png
L o
= oemre
M D1 Aztia
Pt
Papdw

Valmmngarge v £

Sa B9 (b
3 T e oA b
& Camarms o






OEBPS/image/Image3515.png





OEBPS/image/2.35.png
>1 ypovo

1-5 ypévia

6-10 ypoévia

<10 ypovia





OEBPS/image/Image2499.png
Rerar Sy el






OEBPS/image/Image2456.png
B it Daase - 1 s Do ey U et i it M= BN

[vsie: o 1 varties

o [ v [

Ctrl+F4

cti+s.

£ Exportto Database...
I ark File Read Only
 Rename Dataset...
Display Data File Information »

@ Stop Processor Ctri+Period
% Switch Server..
Repository »
2 Print Preview
& Print.. ctri+P
Recently Used Data »






OEBPS/image/Image31601.png
2

1 5E _

SST

1,





OEBPS/image/Image4294.png
N )2
n= (Zl—a/z ﬁ





OEBPS/image/Image3306.png
] Nonparametic Tests: Two or More Related Samples

‘Selectan item:

Test Options

User-Missing Values

© Automatically choose the tests based on the data
® Gustomize tests

Test for Change in Binary D: “Compare Median Di to Hypothesi:
g &l &
McNemars test (2 samples) Sign test (2 samples)
T T )
&
S
Hodges-Lehman (2 samples)
= &
Kendall's coefficient of concordance (k samples)
4 &
Friedman's 2-way ANOVA by ranks (k samples)
Marginal Homogeneity test (2 samples) 5
-






OEBPS/image/Image2548.png
[ "peopleineuropesav [Datasetl] - PASW Statistics Data Editre 0 =l

Fle Edt View Data Iransform Analze DirectMarketing Graphs Ulifies Add-ons Window Help

e B R EE BaE .4%\ %

| Mame | Type | Width |Decimals Label I I

5 lifeexpg Numeric 8 1 Life expectancy at bitth -giis None " hang
|6 ifeexpd Numeric: 8 1 Life expectancy at birth boys None. None.
hithgdp Numeric 8 1 Total health expenditure as a % of GDP. None None
students  Numeic 8 0 Pupils and students ( 1000s ) None None
|9 Jterteduc Numeric 8 0 ‘Students in tertiary education None None
unemmw  Numeic 8 1 Unemployment rate of men and women None None
| 11 Junempop  Numeric 8 1 Unemployment rate of population aged less t._. None. None
| 12 Jrcia Numeric 1 5 REGR factor score 1 for analysis 1 None None
| 13 Jrc21 Numeric 1 5 REGR factor score 2 for analysis 1 None None
| 14 Jrc Numeric 1 5 REGR factor score 3 for analysis 1 None None
| 15 fters Numeric 1 0 Country_type=1 (FILTER) {0, Not Sele__. None.

PASW Statistics Processor is ready |

[Fitter On |






OEBPS/image/Image2505.png
[ Transpose - ||

Variable(s):

ol country = & Total population at ...
& Country Type [Co.
& Total fertity at 19

% scomean || &
& Life expectancy at.
& Pupils and stude.

& Students in tertar
& Unemploymentr... i ittameatiae

2 linamninument ¢

(Lox  (ste ) (sosat) (cancel i )






OEBPS/image/Image2916.png
[ Define Simple Bar: Summaries for Groups of Cases 8 =
& Subject D] E

G ]| ousas Osoas (gama)
& Population [pop] (©Emn CEmes
© Other statistic (e.g., mean)

Variable:

Change Stafistic.

Category Ats:
‘G Smoking Status [smoke]

Panel by

®

Rows:

I Nestvariabies (no empty rows)
Columns:

®

I Nestvarizbles (no smpty colurns)

Template
7] Use chart specifcations from:

ES e






OEBPS/image/Image2959.png
M _ 1227 _1 2058
N 5

pls





OEBPS/image/Image3213.png
| N — -
[ Histogram - ° ()

Variable:
& Subject D] W & Number of deaths [dead) @

a pgelage] ¥/ Display normal cund
ol Sex(sex)

& Smoking Status [sm..| Panel by

& Popuiation [pop] Rows.

Il Nestvariables (no empty rows
Colurmns

Il Nestvariables (no emply columns

Template
7] Use chart specificatons from:

(Lo (ste ) (smosat) (cancel i )






OEBPS/image/3.37.png
[ Recode into Same Variables & =]

Numeric Variables:

deww [ [ commpeicom |

2 Tt popuaton
2 Toaltm 1o
# eeoscancra | (€
# Ut supeconcrs.

% Total nean e

 rPupssnasue.
% susens ntrt [0 anaew values..)

& Unemployment .
@ Unemploymentr.. <] (1] optionat case setection conditon)

(st (cancet _hets ]






OEBPS/image/Image2742.png
> (5, =), - )

=

\/i (v, %) \/Z (=77

i=1





OEBPS/image/Image37951.png
9% C.Liw EXP(E)
e iE wakd sg | Bpm [Tlowe | Uppar
e op an AT | e T T N T T
reny KIUS IRKTEN ' ae | e a
ccatarisen s o 1048 1 L 18 -
Corwtart 15,08 439° 877 1 oo oo

& VARIGR{E] #1OATES N 1D 1. D, YHICRY, S TSI





OEBPS/image/Image2670.png
B Momporometic Tests T o wve e e U BN SR~ S

Selectan item:

Choose Tests.
Test Options

User-Missing Values

© Automatically choose the tests based on the data

® Gustomize tests

Testfor Ghange in Binary Data——————|
ad

MeNemars test 2 samples)

-Compare Median Difference to Hypothesized:

&

Sign test (2 samples)
Wicoxon matchedpair signed-rank (2 samples)

Cochran's @ (k samples)

Estimate Confidence Interval—————————————

&

Hodges-Lehman (2 samples)

Muttiple comparisons:

[l painwise —

Quantity Associations————————————————

&

(endall's coeficient of concordance (k samples)

Multiple comparisons: [All painwise —

Testfor Change in Multinomial Data

a

Marginal Homogeneity test (2 samples)

-Compare Distributions————————————————

&

riedman's 2-way ANOVA by ranks (k samples)

Multiple comparisons: [All pairwise —






OEBPS/image/Image2777.png
] Random Number Generators

Acte Generator

[ Set Active Generator
© SPSS 12 Compatible
© Mersenne Twister

Acive Generator Intalzation
[/Set Starting Point

© Random

O ExedValue

Current Active Generator: PSS 12 Compatible.

‘The acive generator setiing applies
immediately and to future sessions

(Lox ) (ste ) (smosat) (cancel i )






OEBPS/image/1.7.png
1,9207757 8,458064 24,66444 6,370311 8,184563





OEBPS/image/7.61.png
Y=p+ X+t B, X, +..+& OnOv: p<k





OEBPS/image/Image2408.png
YAi = :Bo +181xi





OEBPS/image/Image2433.png
ma::‘l-
(7]






OEBPS/image/Image3415.png
P(D' |E")

al(a+c)

o P |E)

c/(a+c)

T P(D'|E) bl/(b+d)

P(D"|E")

d/(b+d)

a
c_ud
b be

d





OEBPS/image/Image24141.png





OEBPS/image/Image25221.png
SSR = Zn:(ﬁ. -Yy

i=1





OEBPS/image/1.10.png
T
Iporostsig 65%18% =11,7% 6,3% 18%
AgvTepoeTeic 10,40% 5,6% 16%
Tprrogteic 9,75% 5,25% 15%
TetopToeTeic 9,75% 5,25% 15%
Em atvygio 23.4% 12,6% 36%
Xvvoro 65% 35% 100%





OEBPS/image/Image2441.png
Frequencies: Statistics S5

Central Tendency

Percentile Values

¥[Quarties ¥ bean

[ Cutpoinis for: 10 equal groups | | ¥ Median

[F] Percentie(s): ¥ Hgge
[ sum

‘

7] Values are group midpoints

Dispersion Distribution
[ Sta. deviation ¥ Minimum ¥ Skewness
[ variance [/ Maxmum ¥ Kurtosis
[¥Range W SE mean

(contnue) (cance J{_rieo |






OEBPS/image/7.29.png
Case Processing Summary

Unweighted Cases? N Fercent
Selected Cases  Included in Analysis 58 | 1000
Missing Cases 0 0
Total 58 | 1000
Unselected Cases 0 0
Total 58 | 1000

a Ifweights in eflect, see classification table for the total
number of cases.






OEBPS/image/Image4394.png





OEBPS/image/2.20.png
Apove
anolTa

EvOappiver ny evepyd coppetoyri
o1 Mjym aropacsov

Ovte 19OV
0VTE GVNPOVA

Zopeove

- .
VHOOVE .
i ambéTa

Evévvapdver T 6uvadsAgikotTa
KO TV OpaoKOTNTO

HOPODVEL UTTO KOVOY 6TOYOVG
KoL VoL TOVG VAOTTOLSE

Evoweéperon yio o suvorsOijpata
TOV VPGTEPEVOV TOV

Evown@épetar o TG TPOCOMTIKES
AVAYKES TOV VOLGTAPEVOV TOV

EmBpafeder m karij anédoon

Avtihapfaveron Tic ahhayés oG
NI EES

XpNoonoiEi oroTEAEONUTIKG THY
avartoélaxn péfoodo embsopnong
TOV TPOCOTIKOY PECM TG
TAPAKOLOVONGNG TG EPYAGING TOV
£KA0TOTE VTUAM|AOV

TPopodoTel pe VEES 106G TOVG
VOIGTAPEVOVG TOV Y10 TIV
OVTIHETATLON TOV KOWVAV

npofinuarov

Tpom0si ko vo. peTadidel Tig
TPOGOOKIES TOV Y10 VYN addoen

Evromilel T onNpavTikég StuQopig
peTaED TOV VOLGTAREVOV TOV

Hysita meprecéTepo pe g mpatelg
TOV TUPG pE TA MoY10 TOV

Hopoxohovdsi cveTNROTIKG TIG
£vEPYELES TOV KGO vradiijhov yia
va givan 6iyovpog 6Tt cuvoLovTan
GUEGH, PE TO EMOLOKOUEV
OmOTELEGATO,

Avtipetoniler ToVg Kivovvoug, va
a&omorei TIg EVKONPIES KL VO
«mapoKxorovdsi To TEPParlovy’
VTEP TG KMVIKIG

Avayvopile Tig 6movdaisg
£moooeIg

Avonticost TpoTofovriss Ka
Voot PilE TPOYPaPPOTE TOV
OLEVKOAOVOLV T1) ONpovpyia vog
0TIK0) KMpaTog






OEBPS/image/Image2758.png
[ Compute Variable ARSI

Targetvariae: Numeric Expression:
Unempl_rate_new - [unemmwiod

(Tpesiabe. ]

Al couniry

& Country Type [Coun.
& Total population at
& Total fetity at 1995.
& Lie expectancy atbi.
& Life expeciancy atbi.
& Total heath expend.
& Pupils and student.
& Students in tertary
& Unemployment rate...
& Unemploymentrate.
& REGR factor score
& REGR factor score
& REGR factor score

‘Function group:

(] optioni case setection coniton)

Al

Arthmetic

CDF & Noncentral CDF
Conversion
Current DaterTime
Date Arithmetic
Date Creation

Functions and Special Variables:

(Lo ) (ease ) (ose] (canct) (e )






OEBPS/image/Image3400.png
W
Tooar Ay

For cohot vemot
g:rmmmﬂnv;'

For sohod Ssaamy
BepeTeG Tt »
(™

N ofvass Caren

e
s
vows [Tioew | oew
0 | s
105 s | e
o T
P






OEBPS/image/Cover1.png
MeBodoAoyiu Epsuvus Kl
Elgayoyn o Itauotki Aviluon
ASOOUEVGV JIE TO
IBM SPSS STATISTICS

paa

ENIXEIPHZIAKO NPOTPAMMA
EKMAIAEYZH KAI AIA BIOY

EAANnvika Akadnpaika HAekTpovika
z 5 B e » £nEVIyon TNV UowVia TN YViene.
UYYpu[l[l(ITCI Kat on nuuTG YNOYPTEIO MAIAEIAL KAl 6PHIKEYMATON

www.kallipos.gr Zivdeapog EMnvikév Akadnyaikev BiBMoBnkdv EvpwmaikiEvwon ~ EIATKH YIHPELIA AIAXEIPIZHL
Evpumeixé Kowwvid Tapsio Me. 'E

XXX N}





OEBPS/image/Image3091.png
&, ~N(0,07)





OEBPS/image/Image3206.png
@
i ® e
¥
To| o °2 o
i5 o . A .
ks S j 3
‘.R @ B
a
¥
T = o
- L@
iz :
Fr 5 &

Total populatien al LIk sxpactancyat  Students i tortiay
01041959, 10005 airth s education.





OEBPS/image/Image2448.png





OEBPS/image/Image24971.png





OEBPS/image/2.27.png
>1 ypovo

1-5 ypévia

6-10 ypoévia

<10 ypovia





OEBPS/image/Image2642.png





OEBPS/image/Image26571.png
B L e e e





OEBPS/image/Image2956.png





OEBPS/image/2.42.png
_

Meioon TIn®OV TOAMGNG TPOIOVTOV
K01 VT PEGLAV

Mzsimon aeprt0®piov KEPOOVS

Meioon mopoyoyig

Meimon K06ToVG






OEBPS/image/Image26831.png
SSR _ (n—2)MSE

~ X2
-2
o’ o’ "





OEBPS/image/Image2999.png





OEBPS/image/Image3787.png
gi

ketweraon
Vaid H fiswna)






OEBPS/image/2.12.png
"E





OEBPS/image/Image3027.png
7 SSR(B, B,) = SSR(B) /1

SSR(IBU ,Bz)/ (I’l - p)





OEBPS/image/Image3264.png
o R —R)/ (k= p)

P(1=RY)/ (n—k—1)





OEBPS/image/Image3616.png
IOg(ﬁ) =B, + X, + B X, +..+ BX,





OEBPS/image/3.22.png
[l Add Variables from C:\Users\mano\Desktop\Data\AeSopéva_oto_excelsav X

‘Excluded Variables New Actve Dataset:
sext+) )
age(+) age()
education(+) education(’)
aie)
€ |
a3
Qi)

¥ Match cases on key variables in sorted fes Key Variables

@ 5omtis provse cases @

© Non-aciive dataset s keyedtable.
© Active datasetis keyedtable

) ndicate case source as variable: <

(¥)=Active dataset
(+)=C:lUsersimano\DeskiopData\Acbopiva_oTo_excel.sav.

(Lo ) (ease ) (ose] (canct) (i )






OEBPS/image/Image2514.png





OEBPS/image/Image2606.png





OEBPS/image/Image2858.png





OEBPS/image/Image3221.png
1264

00

757

@ o 3
Number of deaths






OEBPS/image/Image2561.png
Selectan item:

Choose Tests.
Test Options

User-Missing Values

© Automatically choose the tests based on the data
® Gustomize tests

Compare Distributions across Groups

Kruskal-Wallis 1-way ANOVA (k samples)
ann Whitney U (2 samples}
Multiple comparisons: [All painwise -

Testfor ordered altematives
(Jonckheere-Terpsira for k samples)

Test sequence for randomness Hypothesis order.  [Smallestl fargest 1%
for2 sar ) Multiple comparisons: |All painwise -

Kolmogoroy-Smimov (2 samples)

Compare Ranges across Groups Compare Medians across Groups

Median test (k samples)

@ Pooled sample median

Moses extreme reaction (2 samples)

@ Compute outers rom sample

® Custom number of outiiers © Custom

Hedian: [0

Muttiple comparisons: [All painwise

B
Outiers: fl |

Estimate Confidence Interval across Groups

Hodges-Lehman estimate (2 samples)






OEBPS/image/Image3390.png
Aeme 5. | Emeibip | Eneitn
Vel a Guon) | (aed) | (sited
von Cre SR e T s
[ . Bl 1 1.000
Lnincod Rty Y 1 B3
(ishors Beact Teal e
e i s ' s
e *
4 Computedonviorj2otatis
5.1 cots G0%) have expected count hess Tan £-The rimum aipecied ounis

L






OEBPS/image/Image3844.png
o

o

a

2o

osmer

020000
s
0.10000

onjen sBeisA

"

0.00000





OEBPS/image/Image3242.png
Tt of Mestmasen Susbdects [Tt

CHpescent Varibi sukome

o e wesnawes | 1| os
Comected wooil A 3 @130 | 10508 L]
Hewrcaot measr: 1 90ery | 2eraan oo
trugs 192,072 1 143372 1864 oo
dngl 170082 1 120,062 1848 o
ugh® dgs o ' s oon A%
[ nar » e

Toes teato 4

Comected Total 585438 £l

4 R Sqaanet = 44T (Adpssted R Squined = 420)






OEBPS/image/7.40.png
ROC Curve

Sensitivity

02 04 o6
1 - Specificity

Diagonal segments are produced by ties.






OEBPS/image/2.40.png
.

pX I % TOL TPOCOMIKOV






OEBPS/image/Image3056.png
Wi
[






OEBPS/image/Image2461.png
] One-Sample TTest

o county

# couny_cat

& Totl ety at 10
& Ui expectancy at.
& Ui expectancy at.
& Totaneaih expe.

& Pupits and stuce.

& Students ntertar.
& \inemnloyment

Testvariable(s):

Testyalue: [1000

(Lo (ste ) (smosat) (cancel i )

L
[optons.. ]
(oot






OEBPS/image/2.49.png
XopnMig s10ikevong TpocOTIKS (epyaTES TAPUAYOYNS,
Pondntiké TpoocomKo K.ATT.)

AvornTikol vrdAiniot

E101kg0pévo Teviko TpocOmTiKo Ko epyoonyotl

Yynia erdtkeopévor vwaAAnAot Kot 6TEAEYN OL0TKN61G






OEBPS/image/Image4250.png
)—CZ

C2





OEBPS/image/Image3321.png





OEBPS/image/Image2399.png
Yi :/Bo+/81xi+gi





OEBPS/image/Image2613.png





OEBPS/image/2.7.png
Karo tov 25 26-35 36-45 46-55 Avo Tov 55
ETAV ETOV ETOV ETOV ETOV






OEBPS/image/Image2791.png
Yi ::B0+131Xi+:32Xi2 +é& i





OEBPS/image/Image3214.png
MSE,, =

SSE,,,






OEBPS/image/Image3257.png
A2
o° = MSE,,,





OEBPS/image/Image2540.png





OEBPS/image/Image2842.png
2

SSE(B) =& = 2| Xi=(By+ BXu+ BX o+ B+ 6,4 B, X,
i=1

i=1

=(Y-XB)' (Y -Xp)





OEBPS/image/Image2885.png
o Cort 15 E] | 13 2]
Frrertaes sxakiat vu baaed or masenderts
& Chchatemy gorng tabsiabc ol sahss |






OEBPS/image/Image2978.png
[ Define Multiple Line: Summaries for Groups of Cases |

Lines

& 1[exertype]
& Indext
& wans2

ONofcases
ocumn
® Other statistic (e.g., mean)

Represent
© % of cases
Ocum %

Variable:

£ vEANG@S[rans 1)
Change Stafistic.

®

®

Panel by

Rows:

I Nestvariabies (no empty rows)
Columns:

I Nestvarizbles (no smpty colurns)

s

o
7] Use chart specifcatons from:

(Lo (ste ) (smosat) (cancel i )






OEBPS/image/Image2714.png
Q‘WW =1

File Edt View Data Transform Analze DirectMarkeing Graphs Utiies Add-ons Window Help

2 M e ~ B, 8 HE BauH m.:Q1

\.:s..n..u [ [Visil: 5 of 5 Variables
exetype | diet [ mdext [ wenst [ v [ v [

IE

FAFSFN PSPPI NN
Llwlmolalwlm|alw/m|alw/m|a

bEFTHHH] i

a






OEBPS/image/Image3859.png





OEBPS/image/Image2757.png
SST =S8, +S8S,,





OEBPS/image/7.12.png
Correlations

Ewvone
espuc poi)
(i) ovs | Hhogéues | Avaronwi eéen | Nna 6ion g |Bépsasionms
modven | (wetism2) | mgawims | amhag asiag | Dea
Pasrson Corstin  Euvohh S 007 1,000 o2 102 12 “ass|  -as2
(ovatts) avé crpévon
Hhogéusa (wstisimd) 52 1,000 208 -107 e
Avarohuch i msaivas 102 208 1,000 329 Larr| -oer
Nérasion mgaxivas 112 -107 329 1,000 E
Bépaasionmgaiag -aes e - 287 1000| o5
Doa 352 53 o7 555 ses| 1000
s (1aiea) R r—— 000 25 281 00| oa1
(ovatts) avé crpévon
] 000 145 291 00| 000
Avarohuch i msaivas 25 145 o8t 2| e
Nérasion mgaxivas 281 291 o8t e
Bépaasionmgaia 000 000 a2 005 00
Doa 031 000 365 000 000
N R r—— 2 2 2 2 2 )
(ovatts) avé crpévon
Hhogéusa (wstisimd) 2 2 2 2 2 2
Avarohuch i msaivas 2 2 2 2 2 2
Nérasion mgaxivas 2 2 2 2 2 2
Bépaasionmgaiag 2 2 2 2 2 2
Doa 2 2 2 2 B B






OEBPS/image/3.14.png
] Select Cases: Random Sample

Sample Sz
© soproumatehy [17] soraicases

O Exactly cases from the first cases

(contnue) _cance J(_ e ]






OEBPS/image/Image3508.png





OEBPS/image/7.55.png
Y, NN(,uY‘Xr »XH,O'Z) N adlog &, ~N(0,6%)





OEBPS/image/Image3084.png
Yijk =Myt Ey





OEBPS/image/Image34511.png





OEBPS/image/Image2870.png
Tetw (o LTS
 Crchakrmy o Wadsnd o reos |






OEBPS/image/2.34.png
AnoporTog Avkeiov

Anéporroc AEL/ TEI

Kétoyoc Metomtotokod AtTAORATOS

Al)o:






OEBPS/image/7.9.png
Buerersor S5 0 & BBS, &8

Predicted Values Residuals
] Unstandardized ] Unstandardized
¥ Standardized ¥ Standardized
7] Adjusted ¥ Studentized

¥ SE. of mean precictions [ Deleted

1) Studentized deleted

Distances Influence Staistcs
] Mahalanobis ¥ DiBeta(s)

¥ Cooks ] Standardized DiBeta(s)
¥ Leverage values [ ot

Prediction Infervls
[ ean 7] Individual
Confidence Interva:

1] Siandardized DFFit
[ Coyariance ratio

Coeffcient statistics

[{Create coeficint staisted

Export model information to XL fle-

L (eems)

¥ Include the covariance matrix

(Contnue) _cance J(_rip_J






OEBPS/image/Image2708.png
E(MSR) =0’ + ﬂfzn: (x,—%)°

i=1





OEBPS/image/Image2583.png





OEBPS/image/Image2929.png
Dencriiaes

fres,pement
[y
W

N wear | M4 Coniaion Lowss P | (gperfore | warnan | sesiewr
T EL FI = Taee | B =
2 L] rarny k= e nn e
2 2| nwn LR wen T nn
. 2 | 2230 154 eea wrar [ e se
ot = | s ) Er) Mt | am | e






OEBPS/image/Image38351.png
:

3 °
g asoon|
2
£ =
I}
3
3
% L o °
gnm—
® o 0w . -
o % ° 030
000000 o e © PP ¥ caac® @ Cad
i » = i B o






OEBPS/image/Image2836.png
H,opy=py ==, = p
H, :3 0<ig<k:py # i,





OEBPS/image/Image3336.png
2

~

(r-1)(c—1);a





OEBPS/image/Image3429.png





OEBPS/image/Image3263.png
k 2

12
nk(kﬂ);n—{—sh(kﬂ) X2,





OEBPS/image/7.28.png
] Logistic Regression: Options.

Statistics and Plots-
(7] Classifcation plots

¥ Hosmer-Lemeshow goodness-oFfit
] Casewise listing o resicuals

[ Carrelations of estimates
[ feration history

wiGimme) ] %

Display

© Ateachstep O Atlaststep

Probability for Stepwise-

ear s e

Classification cutoft.

waxmum teraions: o]

¥ Include constantin model

(contnue) _cance J(_ e






OEBPS/image/Image3034.png
.....

.....

X,)

_[SSR(B",. 5",

SSR(B . B 5seees





OEBPS/image/1.11.png
1
2
3
4
5
6
7
8

DD B BN DD NN N B = = = =
O 01NN WN—OOVLXXINWNRAWND—~O

12,706
4,303
3,182
2,776
2,571
2,447
2,365
2,306
2,262
2,208
2,201
2,179
2,160
2,145
2,131
2,12
2,11
2,101
2,093
2,086
2,08
2,074
2,069
2,06
2,056
2,052
2,048
2,045

30,80242
10,43152
7,713939
6,729697
6,232727
5,932121
5,733333
5,590303
5,483636
5,401212
5,335758
5,282424
5,236364
52
5,166061
5,139394
5,115152
5,093333
5,073939
5,05697
5,042424
5,027879
5,015758
5,003636
4,993939
4,984242
4,974545
4,964848
4,957576

948,7893
108,8165
59,50486
45,28882
38,84689
35,19006
32,87111
31,25149
30,07027
29,17309
28,47031
27,90401
27,4195
27,04

26,68818
26,41337
26,16478
25,94204
25,74486
25,57294
25,42604
25,27957
25,15782
25,03638
24,93943
24,84267
24,7461

24,64972
24,57756

645,7697
74,06324
40,5005
30,8247
26,44016
23,95124
22,3729
21,27054
20,46658
19,85594
19,3776
18,99216
18,6624
18,4041
18,16464
17,9776
17,8084
17,6568
17,5226
17.40558
17,3056
17,2059
17,12304
17,04038
16,9744
16,90854
16,84282
16,77722
16,7281





OEBPS/image/Image4271.png





OEBPS/image/Image3220.png
] Univariate: Options — B

Estimated Marginal Means

Factor(s) and Factor Interactions: Display Means for:

Display

[ Descriptive statistics [¥ Homogeneity tests.

[F] Estimates of ffectsize: [F] Spreadvs. level plot

] Opserved power ¥ Residual plot

¥ Parameter estimates [F] Lackofit

[F] Contrast coeffcient matrix [ General estimable funciion

Sinitcance vel Contidence ntenals are 95.0%

comne) (canct ||y | |






OEBPS/image/Image2963.png
[ Define Simple Line: Summariesfor Groups of Cases (8 0, =~ =S

Line Represents

& 1[exertype]
& 1die]
& ndext

ONofcases O %ofcases
OgumN Ocum %
® Other statstc (e, mean)

Variable:

& MEAN(@S[rans 1)
Ghange Statstic

P —

Panelby—————————————————

Re

I st variables (no empty rows)
Coumns:

I Nestvarizbles (no smpty colurns)

Temp

7] se chart specificatons from:

ES e






OEBPS/image/Image4158.png
C

[
) 1 ! ] [
TREIHBEEER






OEBPS/image/Image26751.png
Sax Casa roamber | vae
Numoerofdesms  Maw  Hghest 1 E 001
2 Y] oot

3 n e

] El 613

5 * 432

Towest 1 n T

2 1 "

3 3 "

l (] »

5 4 3

Fomala  vghest 1 ] T
2 n s

3 n s

] % 3

5 " 2

Towest 1 0] 7

2 12 ]

3 2 7

Il 9 m

5 L] 10






OEBPS/image/Image25621.png
] Descriptives - ° ()
Variable(s):
- e
2 ouni_oa 2 Uieemecancyauoi. | (22081,

& Total fertity at 19
& Lite expectancy at

@ pupis nasuce. | (8
& Students n tetiar.
& Unemployment .
& Country Type [Co.

2 linemninument . 5]

7] Save standardized values as variables ‘

(Lo (ste ) (smoset) (cancel i )






OEBPS/image/1.6.png
1,6851819 7,462948 2295228 5,757278 6,453888





OEBPS/image/Image3041.png
EAAnvika Akadnpaika HAekrpovika
Zuyypauuara kat BonBnyara

www.kallipos.gr





OEBPS/image/Image25291.png
A

SSE = Z( ~Y)’





OEBPS/image/Image2970.png
Maan Number of deathe

1i48eta

ERETIRS) ll‘zlﬂ! "%

Tieoss

Subjoct

21z s g e e





OEBPS/image/Image2635.png





OEBPS/image/Image2449.png
B Uit (DtaScs]_PAW ot i iy S S

File Edt View Dala Transform Analge DirectMarketing Graphs Ut

SHE E e ~ Bl 8 ¢
[

| vAR00001 | VAR00002 | VAR00003 | VAR00004 | var |
1 |ABCO00T 1,00 10,00 11,00

—






OEBPS/image/Image4386.png
(

J

Tl (N—n)!





OEBPS/image/2.28.png





OEBPS/image/Image2440.png
3= D01 = DBt s

i=1 i=1





OEBPS/image/Image2678.png
& e+ Qe
- e
£ M= Defere





OEBPS/image/2.13.png





OEBPS/image/Image2562.png
‘[l Add Cases From CAUsers\mano\Desktop\Data\AcBopéva_oto_excel... SESS)

Unpaired variables Variables in New Acive Dataset:
country() =
Country_type(*)
fac1_1)
fac2_1)
faca_1)

fer)
ieexpa(r)
popC’)
terteduce)
lunemmwey 5 [] Indicate case source as variable:

(f)=Actve dataset
(+)=C:lUsersimanoDeskiop\Data\Acbopiva_oTo_excel2.sav.

(Lo (ste ) (smosat) (cancel i )






OEBPS/image/Image2656.png
Identifies differences between two o more related fields using one o more nonparameric tests. Nonparametric tests do not assume.
your data follow the normal distribution.

Whatis your objective’
Each objective corresponds to a distinct default configuration on the Settings Tab that you can further customize, if desired.

® Automatically compare observed data o hypothesized

© Gustomize analysis

Descript

compare datato ized data using s Test, Cochran's Q, Wilcoron Matched-Pair Signed-Rank,
or Friedman's 2-Way ANOVA by Ranks. The test chosen varies based on your data.

(eun ) (ste ) moset (cancel i )






OEBPS/image/7.34.png
Classification Table®

Ohserved Predicted
death
Percentage
0 1 Carrect
Step1 death 0 18 & 750
1 4 Ell 882
Overall Percentage 828

a. The cutvalue Is 500






OEBPS/image/3.21.png
[ PASW Statistics 18 o

‘Warning: Keyed match will fail if data are not sorted in ascending order of Key

(5] (eaal)






OEBPS/image/Image2699.png
[ Means

& SubjectID]

a Age [age]

& Smoking Status [sm.
& Number of deaths [






OEBPS/image/Image2528.png
U =min(U,,U,)





OEBPS/image/Image2398.png
PASW Statistics [~
[N

Whatwould you like to do?

% @] Gpen an sxising daia source H

© Run the tutorial

CiUsersimanoiDesktop\SSP_manualiDafnhH|

CUsers\mano\Desktop\SSP_manuallOBE25) © Type in data

@ © Run an existing query
© Open ancther ype ofe
> O Create newquery
using Database
Wizarg

(Lo (canca)

Wore Files
CilUsersimanolDeskiop!SSP_manualDafnhis|
CilUsersimanolDeskiop|SSP_manualiDafnh's:
CilUsersimanoDeskiop\SSP_manualBana_n






OEBPS/image/Image3199.png
saaterplot watre SR O DR

Matrix Variables:

& Country_Cat

& Totalfertity at 1998
& Total heath expendi.
& Pupils and students.
& Students n teriary e.
& Unemployment rate
& Country Type [Count.
& Unemployment rate

% recracorecore | 4]
& REGR factor score
& REGR factor score.

3

& Total population at 01/01/1998.
& Lite expectancy at birtn -girs [
& Life expectancy at birth:boys [if...

SetMarkers by

Label Cases by:

Panel by

Rows:

I estvariabies (no empty ows
Columns,

I Nestvariables (no empy columns)

Template
[] Use chart specifications from:

(Lox ) (ste ) (smosat) (cancel i )

-
(e
ozt






OEBPS/image/Image2863.png





OEBPS/image/Image2690.png
Restructure Data Wizard - Step 6 of 7 S5

Variables to Cases: Options
Inthis step you can set options that will be applied to the restructured data fle.

| Handiing of Variables not Selectet

@] Drop variable(s) from the new data file
| © Keep and treat as fxed variale(s)

| System Missing or Blank Values in all Transposed Variables

| © Create a case in the new file
© Digcard the data

Case Count Variable:

(] Countthe number of new cases created by the case n the current data

[ (1 -] (P (cancet Lt ]






OEBPS/image/Image26021.png
Q ol Sex(sex]
i Label Cases by:

Display
®3Boh O statistics O Plots

(Lo (ste ) (smosat) (cancel i )

— - (o]
Dependent List
v e | )
Ao lage »J [ros. |
$a Smoking Status [sm. ﬁ
& Population [pop] Factor List —






OEBPS/image/Image2735.png
i(xi _)_C)(yi _J_})

=

\/i(xi _f)z \/i(y; _J_})z

i=1





OEBPS/image/Image3184.png
x,)

_ SSE

SST





OEBPS/image/Image3408.png
Aqﬁlnm

Napayovias Na (£ atd
Eacllenr U (F~) crd

-I!. | ]





OEBPS/image/3.7.png
R Opening Excel Data Source ==

CiUsersimanoiDesKtop\DatalAsBopéva_oro_excelxlsx

[¥ Read variable names from the first row of data

Worksheet:

Range: 0
[@6o1 @) (a1F11)

Maximum width for sting columns;

(Lox ) (canca) (1en )






OEBPS/image/1.xkais.png
Txars.





OEBPS/image/Image3107.png





